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Cameră foto digitală cu obiectiv interschimbabil ILME-FR7 / ILME-
FR7K

Prezentare generală

Situații tipice de utilizare

Configurarea sistemului [1]

Controlarea unei singure unități utilizând telecomanda cu infraroșu
furnizată [2]

Controlarea unei singure unități utilizând o tabletă sau un computer [3]

Controlarea unei singure unități utilizând o telecomandă externă [4]

Controlarea mai multor unități utilizând o telecomandă externă [5]

Localizarea şi funcţiile pieselor

Vedere din față [6]

Vedere din spate [7]

Bloc de conectori [8]

Vedere laterală [9]

Vedere de sus [10]

Vedere de jos [11]

Suportul obiectivului [12]
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Localizarea și funcțiile pieselor telecomenzii cu infraroșu (furnizată)
[13]

Ecranul aplicației web

Prezentare generală a ecranului aplicației web [14]

Structura zonei comune a ecranelor [15]

Structura ecranului de operare în timp real [16]

Structura ecranului de control al redării [17]

Structura ecranului cu setări [18]

Meniul camerei [19]

Afișajul ecranului camerei [20]

Pregătire

Montarea unității

Montarea în poziție verticală într-o locație fixă [21]

Montarea în poziție verticală într-o locație fixă, la înălțime [22]

Montarea pe tavan [23]

Atașarea/detașarea unui obiectiv

Măsuri de precauție la atașarea/detașarea unui obiectiv [24]

Verificarea comutatoarelor obiectivului [25]
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Măsuri de precauție la utilizarea unui obiectiv cu zoom [26]

Atașarea unui obiectiv [27]

Detașarea unui obiectiv [28]

Conectarea cablurilor [29]

Conectarea unității la un dispozitiv din rețea prin cablu [30]

Conectarea unei surse de alimentare

Utilizarea alimentării la o sursă de curent alternativ [31]

Utilizarea alimentării prin PoE++ [32]

Resetarea panoramării/înclinării [33]

Configurarea înainte de înregistrare

Inițializarea unității utilizând aplicația web

Accesarea aplicației web dintr-un browser [34]

Inițializarea unității [35]

Configurarea operării de bază [36]

Pregătirea cardurilor de memorie

Cardurile de memorie acceptate [37]

Introducerea cardurilor de memorie [38]

Scoaterea unui card de memorie [39]

Formatarea (inițializarea) cardurilor de memorie [40]

Verificarea timpului de înregistrare rămas [41]
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Restaurarea cardurilor de memorie [42]

Shooting

Operarea de bază

Începerea/oprirea înregistrării [43]

Comutarea între cardurile de memorie [44]

Verificarea sunetului [45]

Specificarea datelor despre timp [46]

Revizualizarea înregistrării (Rec Review) [47]

Reglarea încadrării

Ecranul de reglare a încadrării [48]

Reglarea direcției de înregistrare

Reglarea direcției de înregistrare utilizând aplicația web [49]

Setarea vitezei de operare pentru panoramare/înclinare [50]

Setarea accelerării operației de panoramare/înclinare [51]

Reglarea direcției de înregistrare utilizând telecomanda cu infraroșu furnizată [52]

Reglarea zoomului

Setarea tipului de zoom [53]

Reglarea zoomului utilizând aplicația web [54]
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Setarea vitezei de operare pentru zoom [55]

Reglarea zoomului utilizând telecomanda cu infraroșu furnizată [56]

Salvarea/restaurarea poziției camerei pentru panoramare/înclinare/zoom

Calibrarea unui obiectiv cu montură E [57]

Salvarea/restaurarea poziției de panoramare/înclinare/zoom și a setării de
focalizare utilizând aplicația web [58]

Redenumirea pozițiilor presetate utilizând aplicația web [59]

Înlocuirea unei poziții salvate cu alta nouă utilizând aplicația web [60]

Ștergerea unei poziții salvate utilizând aplicația web [61]

Schimbarea vitezei de tranziție a pozițiilor presetate [62]

Salvarea/restaurarea poziției de panoramare/înclinare și zoom utilizând
telecomanda cu infraroșu furnizată [63]

Reglarea focalizării

Ecranul de reglare a focalizării [64]

Reglarea manuală a focalizării (Manual Focus)

Reglarea manuală utilizând aplicația web [65]

Reglarea manuală utilizând telecomanda cu infraroșu furnizată [66]

Focalizarea specificând o poziție de focalizare (Spot Focus) [67]

Utilizarea temporară a focalizării automate (Push Auto Focus (AF)) [68]

Utilizarea Single-Shot Auto Focus (Push Auto Focus (AF-S)) [69]

Reglarea automată a focalizării (Auto Focus)

Reglarea automată utilizând aplicația web [70]

Reglarea automată utilizând telecomanda cu infraroșu furnizată [71]

Setarea zonei/poziției de focalizare automată (Focus Area) [72]
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Modificarea rapidă a zonei de focalizare (Focus Setting) [73]

Mutarea cadrului zonei de focalizare utilizând operarea tactilă (Touch Focus Area)
[74]

Ajustarea operării cu focalizare automată (AF Transition Speed, AF Subject Shift
Sensitivity) [75]

Setarea manuală a țintei focalizării automate (AF Assist) utilizând aplicația web
[76]

Focalizarea manuală în timpul focalizării automate utilizând telecomandă cu
infraroșu furnizată [77]

Utilizarea temporară a focalizării manuale în timpul focalizării automate (Push
Manual Focus) [78]

Urmărirea utilizând detecția feței și a ochilor (Face/Eye Detection AF) [79]

Urmărirea unui anumit subiect (Realtime Tracking AF) [80]

Reglarea luminozității

Ecranul de reglare a luminozității [81]

Setarea sensibilității de bază [82]

Setarea nivelului țintă pentru reglarea automată a luminozității [83]

Reglarea diafragmei

Reglarea automată a diafragmei [84]

Reglarea manuală a diafragmei [85]

Reglarea amplificării

Reglarea automată a amplificării [86]

Reglarea manuală a amplificării [87]

Ajustarea obturatorului

Reglarea automată a obturatorului [88]
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Reglarea manuală a obturatorului [89]

Reglarea nivelului de lumină (ND Filter)

Despre filtrul ND [90]

Reglarea în modul presetat [91]

Reglarea automată în modul variabil [92]

Reglarea manuală în modul variabil [93]

Ajustarea pentru culori naturale (balans de alb)

Ecranul de reglare a balansului de alb [94]

Reglarea automată a balansului de alb [95]

Reglarea manuală a balansului de alb [96]

Rularea automată a balansului de alb [97]

Configurarea sunetului pentru înregistrare

Ecranul de configurare a sunetului [98]

Selectarea dispozitivului de intrare audio [99]

Ajustarea automată a nivelului de înregistrare audio [100]

Ajustarea manuală a nivelului de înregistrare audio [101]

Funcţii utile

Utilizarea meniului direct [102]
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Butoane alocabile [103]

Mișcare cu încetinitorul și rapidă [104]

Înregistrarea video în mod intermitent (Interval Rec) [105]

Înregistrarea imaginilor în memoria cache (Picture Cache Rec) [106]

Înregistrarea pe cardurile de memorie A și B simultan (2-slot Simul
Rec) [107]

Video Signal Monitor [108]

Marcajele din clipuri [109]

Compensarea respirației [110]

Înregistrare pe server proxy

Prezentarea generală a înregistrării proxy [111]

Înregistrarea unui proxy [112]

Înregistrarea cu aspectul dorit

Prezentarea generală a aspectelor [113]

Selectarea unui aspect [114]

Importul unui aspect de bază dorit [115]

Personalizarea unui aspect [116]
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Salvarea unui aspect [117]

Ștergerea unui aspect de bază [118]

Înregistrarea cu ajustarea aspectului în post-producţie

Captura cu ajustarea aspectului în post-producție [119]

Aplicarea unui LUT pentru ieșirea HDMI și redarea în timp real [120]

Schimbarea unui LUT [121]

Modificarea distribuției zonelor întunecate și luminoase în imaginile
înregistrate [122]

Înregistrarea RAW

Înregistrarea video RAW [123]

Înregistrarea video RAW în modul Slow & Quick Motion [124]

Ajustarea bokeh (funcție de control pentru bokeh)

Activarea/dezactivarea funcției de control pentru bokeh [125]

Ajustarea nivelului de efect bokeh [126]

Salvarea și încărcarea datelor de configurare

Prezentare generală a salvării și încărcării datelor de configurare [127]

Salvarea unui fișier ALL [128]

Încărcarea unui fișier ALL [129]

Funcţii de reţea
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Transferarea fișierelor

Despre transferul de fișiere [130]

Înregistrarea unei destinații de transfer al fișierelor [131]

Selectarea și încărcarea unui fișier

Încărcarea unui fișier proxy pe un card de memorie din ecranul cu miniaturi [132]

Încărcarea unui fișier original pe un card de memorie din ecranul cu miniaturi [133]

Verificarea stării transferului de fișiere [134]

Încărcarea utilizând un server FTP securizat [135]

Configurarea redării în timp real

Despre redarea în timp real [136]

Setarea formatului de redare în timp real [137]

Setarea codecului video pentru redarea în timp real [138]

Setarea codecului audio pentru redarea în timp real [139]

Pornirea/oprirea redării în timp real [140]

Ecranul miniatural

Ecranul cu miniaturi [141]

Redarea clipurilor și alte operații cu clipurile

Redarea clipurilor înregistrate [142]

Operații asupra clipurilor înregistrate [143]
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Meniul camerei și setări detaliate

Configurația meniului camerei [144]

Utilizarea meniului camerei

Utilizarea meniului camerei [145]

Introducerea unui șir de caractere [146]

User Menu

User [147]

Edit User Menu

Edit User [148]

Meniul Shooting

ISO/Gain/EI [149]

ND Filter [150]

Shutter [151]

Iris [152]

Auto Exposure [153]

White [154]

White Setting [155]

Offset White [156]

Focus [157]
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S&Q Motion [158]

LUT On/Off [159]

Noise Suppression [160]

Flicker Reduce [161]

SteadyShot [162]

Meniul Project

Base Setting [163]

Rec Format [164]

Cine EI Setting [165]

Simul Rec [166]

Proxy Rec [167]

Interval Rec [168]

Picture Cache Rec [169]

SDI/HDMI Rec Control [170]

Assignable Button [171]

Meniul Paint/Look

Scene File [172]

Base Look [173]

Reset Paint Settings [174]

Black [175]

Knee [176]

Deta [177]

Matrix [178]
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Multi Matrix [179]

Meniul Pan-Tilt

P/T Acceleration [180]

Meniul TC/Media

Timecode [181]

TC Display [182]

Users Bit [183]

HDMI TC Out [184]

Clip Name Format [185]

Update Media [186]

Format Media [187]

Media Life [188]

Meniul Monitoring

Output Format [189]

Display On/Off [190]

Video Signal Monitor [191]

Marker [192]

Meniul Audio

Audio Input [193]

Audio Output [194]
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Meniul Thumbnail

Display Clip Properties [195]

Set Clip Flag [196]

Lock/Unlock Clip [197]

Delete Clip [198]

Transfer Clip [199]

Transfer Clip (Proxy) [200]

Filter Clips [201]

Customize View [202]

Meniul Technical

Color Bars [203]

Genlock [204]

Tally [205]

Rec Review [206]

Zoom [207]

Lens [208]

APR [209]

Meniul Network

Wired LAN [210]

File Transfer [211]

Meniul Maintenance
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Language [212]

Clock Set [213]

Hours Meter [214]

Setările şi valorile implicite ale meniului Shooting

Setările și valorile implicite pentru ISO/Gain [215]

Setările și valorile implicite pentru AGC Limit [216]

Setările de calitate a imaginii salvate pentru fiecare mod de captură
[217]

Meniul web și setări detaliate

Configurația meniului web [218]

Operații cu meniul web [219]

Meniul Shooting

Focus [220]

Meniul Project

Base Setting [221]

Rec Format [222]

Simul Rec [223]

Proxy Rec [224]
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Interval Rec [225]

Picture Cache Rec [226]

All File [227]

Meniul Paint/Look

Base Look [228]

Meniul Pan-Tilt

P/T Speed [229]

P/T Acceleration [230]

P/T Range Limit [231]

P/T Direction [232]

P/T Preset [233]

Meniul Monitoring

Output Format [234]

Output Display [235]

Meniul Audio

Audio Input [236]

Audio Output [237]

Meniul Technical

Tally [238]

IR Remote [239]
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Meniul Network

Camera Name [240]

User [241]

Wired LAN [242]

File Transfer [243]

FTP Server 1 to 3 [244]

SSL [245]

Referer Check [246]

Brute Force Attack Protection [247]

Meniul Stream

Stream [248]

Video Stream [249]

Audio Stream [250]

Meniul Maintenance

Language [251]

Accessibility [252]

Clock Set [253]

Reset [254]

Information [255]

System Log [256]

HTTP Access Log [257]

Service [258]
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EULA [259]

Software [260]

Conexiunea dispozitivelor externe

Conectarea monitoarelor și a dispozitivelor de înregistrare externe
[261]

Operarea utilizând o telecomandă RM-IP500 (opțiune)

Despre operarea utilizând o telecomandă RM-IP500 (opțiune) [262]

Conectarea unei telecomenzi RM-IP500 [263]

Sincronizarea cu un dispozitiv extern

Despre sincronizarea cu un dispozitiv extern [264]

Sincronizarea fazei semnalului video (Genlock) [265]

Blocarea codului de timp pe alte dispozitive [266]

Conectarea unui microfon extern sau a unui dispozitiv audio extern
[267]

Gestionarea/editarea clipurilor folosind un computer [268]

Transmiterea unui semnal prin fibră optică [269]

Conectarea unui indicator de semnalizare [270]
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Anexă

Măsuri de precauție la utilizare [271]

Formate de ieșire și limitări [272]

Depanarea [273]

Mesaje de eroare/avertizare [274]

Lista elementelor de meniu [275]

Elementele salvate în pozițiile presetate [276]

Scheme sinoptice [277]

Actualizarea software-ului obiectivului cu montură E [278]

Atașarea capacului butonului de eliberare a obiectivului [279]

Licențe [280]

Specificații [281]

Mărci comerciale [282]
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[1] Prezentare generală Situații tipice de utilizare

Configurarea sistemului

Această unitate poate fi combinată cu dispozitive periferice pentru a crea diferite configurații de
sistem.

Obiectiv cu soclu E1.

Adaptor cu montură A LA-EA3/LA-EA42.

Telecomandă cu infraroșu (furnizată)3.

Carduri de memorie CFexpress tip A/carduri de memorie SDXC4.

Cititor de carduri CFexpress tip A/cititor de carduri SD5.

Microfon ECM-680S, ECM-678*, ECM-674*6.
EC-0.5X3F5M cu 3 pini → este necesar un cablu cu adaptor XLR cu 5 pini.*

Adaptor c.a. (furnizat)7.
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[2] Prezentare generală Situații tipice de utilizare

Controlarea unei singure unități utilizând telecomanda
cu infraroșu furnizată

Puteți controla o singură unitate de la distanță utilizând telecomanda cu infraroșu furnizată.

 Semnal video
 Flux semnal

[3] Prezentare generală Situații tipice de utilizare

Controlarea unei singure unități utilizând o tabletă sau
un computer

Puteți conecta o tabletă sau un computer la unitate și apoi o puteți controla printr-un browser
web.

Monitor video8.

Telecomandă RM-IP5009.

Telecomandă cu infraroșu (furnizată)1.

Monitor video2.
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 Semnal video
 Semnal telecomandă

 Flux semnal

[4] Prezentare generală Situații tipice de utilizare

Controlarea unei singure unități utilizând o
telecomandă externă

Puteți controla unitatea de la distanță utilizând o telecomandă.

Monitor video1.

Tabletă2.

Computer3.

Punct de acces4.
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 Semnal video
 Semnal telecomandă

 Flux semnal

[5] Prezentare generală Situații tipice de utilizare

Controlarea mai multor unități utilizând o telecomandă
externă

Puteți controla până la 100 de unități de la distanță, utilizând o singură telecomandă (RM-
IP500).

Monitor video1.

Telecomandă RM-IP5002.
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 Semnal video
 Semnal telecomandă
 Indicator de semnalizare/contact

 Flux semnal

[6] Prezentare generală Localizarea și funcțiile pieselor

Vedere din față

Monitor video1.

Comutator video2.

Hub de Ethernet3.

Telecomandă RM-IP5004.
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Acest subiect descrie localizarea și funcțiile pieselor pe partea din față a unității.

Sugestie

Această descriere face referire la ilustrația cu unitatea fără obiectiv atașat.

Capul camerei

Notă

Nu supuneți capul camerei la impacturi puternice.

1.

Lampă de înregistrare/semnalizare
Când este configurată ca lampă de înregistrare, lampa se aprinde în roșu când se
înregistrează pe un card de memorie. Lampa se aprinde intermitent când spațiul liber rămas
pe suportul de înregistrare este redus sau când apare o eroare.

2.
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Pentru detalii, consultați „Mesaje de eroare/avertizare”.

Când este configurată ca lampă de semnalizare, lampa se aprinde în roșu sau verde în
funcție de indicatorul de semnalizare extern.

Pentru detalii, consultați „Conectarea unui indicator de semnalizare”.
Senzor de imagine

Notă

Nu atingeţi direct cu mâinile.

3.

Buton de eliberare a obiectivului
Apăsați pentru a scoate obiectivul.

Pentru detalii, consultați „Detașarea unui obiectiv”.

4.

Contacte semnal obiectiv

Notă

Nu atingeţi direct cu mâinile.

5.

Lampă POWER6.

Lampă NETWORK
Starea unității este indicată de combinația dintre culoarea afișajului și starea de aprindere
(aprinsă, luminează intermitent, stinsă) a lămpii POWER și a lămpii NETWORK.

Lampă
POWER

Lampă
NETWORK Starea unităţii

Aprinsă în
verde*1

Aprinsă în
verde

Pornită (rețea conectată)

Stinsă Pornită (rețea neconectată)

Luminează
intermitent
verde

Stinsă Proces de pornire în curs

Aprinsă în Stinsă Stare de standby

7.
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[7] Prezentare generală Localizarea și funcțiile pieselor

Vedere din spate

Acest subiect descrie localizarea și funcțiile pieselor de pe partea din spate a unității.

Lampă
POWER

Lampă
NETWORK Starea unităţii

portocaliu

Luminează
intermitent
galben

Stinsă Actualizare de software în curs

Luminează
intermitent lent
portocaliu*2

Luminează
intermitent lent
verde*2

Unitatea nu poate să funcționeze normal.
Pentru detalii, consultați jurnalul sistemului.
Dacă problema persistă chiar și după trecerea
unității în modul standby sau după oprire și
repornire, contactați reprezentantul de service
Sony.

Luminează
intermitent
rapid
portocaliu*3

Luminează
intermitent
rapid verde*3

Unitatea are o defecțiune. Contactați
reprezentantul de service Sony.

Luminează intermitent verde când se primește o comandă de la telecomanda cu infraroșu furnizată.*1

Luminează intermitent lent: luminează o dată pe secundă*2

Luminează intermitent rapid: luminează de patru ori pe secundă*3

Senzorul telecomenzii cu infraroșu
Primește semnalul de comandă de la telecomanda cu infraroșu furnizată.

8.

Admisie de aer

Notă

Nu blocați fluxul de aer. Acest lucru poate provoca o defecţiune.

9.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/03… 28/464

[8] Prezentare generală Localizarea și funcțiile pieselor

Blocul de conectori

Acest subiect descrie localizarea și funcțiile pieselor de pe blocul de conectori al unității.

Clapeta de blocare a capului camerei
Blochează mișcarea înainte/înapoi a capului camerei.

Notă

Opriți alimentarea unității și blocați capul camerei pe orizontală utilizând clapeta de blocare
pentru panoramare/înclinare înainte de a acționa clapeta de blocare pentru a evita prinderea și
accidentarea degetelor. Pentru detalii despre clapeta de blocare pentru panoramare/înclinare,
consultați „Clapeta de blocare pentru panoramare/înclinare” din „Vedere laterală”.

1.

Baza glisantă2.
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Conectarea (masă)
Conectați la masă prin cuplarea la terminalul de împământare al prizei de alimentare sau la
o bară de împământare.

1.

Conectorul DC IN (mufă DC standard)
Conectați la un adaptor c.a.

Notă

Nu utilizați niciun alt adaptor c.a. în afară de cel furnizat. Conectarea altui adaptor poate
provoca un incendiu sau o defecțiune.

2.

Conectorul (RJ-45) pentru LAN (rețea)
Conectați un cablu de rețea (din categoria 5e sau alta superioară) pentru comunicarea cu
rețeaua și sursa de alimentare PoE++*.

Starea afișajului LED pentru viteză
Indică viteza conexiunii la rețea.

3.

PoE++: alimentare prin Ethernet Plus Plus. Respectă IEEE802.3bt (tipul 4, clasa 8). Pentru detalii referitoare
la conectare, consultați instrucțiunile de utilizare ale dispozitivului de alimentare.

*
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Display  Viteză conexiune

Stinsă
10 Mbps

100 Mbps

Aprinsă în portocaliu 1000 Mbps

Stare afișaj LED pentru portul Link/ACT
Indică starea conexiunii la rețea.

Display  Stare conexiune

 Stinsă Fără legătură

Luminează intermitent verde Legătură stabilită, date active

Aprinsă în verde Legătură activă

Notă

Când conectați acest produs la Internet, conectați-l printr-un sistem care oferă o funcție de
protecție, cum ar fi un router sau un firewall. Dacă produsul este conectat printr-un sistem care
nu oferă o astfel de protecţie, pot apărea probleme de securitate.

Conector TC IN
Introduce un semnal care conține codul de timp cu o referință externă.

Pentru detalii, consultați „Blocarea codului de timp pe alte dispozitive”.

4.

Conector HDMI
Transmite imagini video din unitate ca semnal HDMI.

Pentru detalii, consultați „Conector HDMI (conector tip A)” din „Conectarea monitoarelor
și a dispozitivelor de înregistrare externe”.

5.

Șurub de montare a plăcii pentru fixarea cablului HDMI
Pentru a preveni scoaterea cablului HDMI, atașați placa de fixare a cablului HDMI inclusă,
cu ajutorul șurubului de montare furnizat (M2.6×6) și prindeți cablul HDMI cu un colier sau
bandă pentru cablu disponibilă în comerț.

6.
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Pentru detalii despre atașarea plăcii de fixare a cablului HDMI, consultați „Conectarea
cablurilor”.

Conector OPTION
Se utilizează pentru conectarea unui indicator de semnalizare de la un dispozitiv extern.

Pentru detalii, consultați „Conectarea unui indicator de semnalizare”.

7.

Clemă de cablu
Se utilizează pentru fixarea cablului adaptorului c.a.

8.

Comutator RESET
Apăsați timp de cel puțin 5 secunde cu vârful unui creion sau cu un obiect similar pentru a
reinițializa setările unității la valorile implicite din fabrică.
Puteți selecta dacă doriți să resetați doar setările de conexiune la rețea sau toate setările
folosind comutatorul SETUP 1.

9.

Conectorul de ieșire OPTICAL
Transmite un semnal SDI convertit în format optic când este conectat un modul SFP+
(opțiune).

Pentru detalii, consultați „Transmiterea unui semnal prin fibră optică”.

10.

Comutatoarele SETUP

Configurează setările de mai jos.
Comutatorul 1: stabilește care setări sunt reinițializate când este apăsat comutatorul
RESET.

Setting Descriere

OPRIT
(implicit)

Resetează numai setările conexiunii la rețea. Setările rețelei, setările de
securitate și informațiile utilizatorului (nume de utilizator și parolă) unității
vor fi resetate.

PORNIT Resetează toate setările la valorile implicite din fabrică.

11.
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Comutatorul 2: setează dacă alimentarea cu +48 V (alimentare fantomă) este
activată/dezactivată când este conectat un dispozitiv de intrare audio. Setarea este aplicată
imediat.
Această funcție este activată când opțiunea [Audio] > [Audio Input] > [AUDIO IN Select] este
setată la [MIC] din meniul camerei.

Setting Descriere

OPRIT
(implicit)

Nu furnizați alimentarea cu +48 V (alimentare fantomă). Configurați
această setare la utilizarea unui dispozitiv audio extern (cum ar fi un
mixer), microfon dinamic sau cu baterie încorporată.

PORNIT
Furnizați alimentare cu +48 V (alimentare fantomă) către un microfon
compatibil cu alimentarea fantomă conectat la conectorul AUDIO IN
(CH-1 sau CH-2).

Notă

Dacă rotiți comutatorul 2 la poziția ON și conectați un microfon care nu este compatibil cu
alimentarea cu +48 V, dispozitivul conectat poate fi deteriorat. Verificaţi setarea înainte de
conectarea dispozitivului.

Comutatorul 3: activează/dezactivează comunicarea VISCA prin IP. Setările sunt aplicate
când camera este pornită.
Rotiți la poziția ON pentru a utiliza unitatea când este conectată la o telecomandă (RM-
IP500).

Setting Descriere

OPRIT (implicit) Nu va răspunde la comenzile VISCA prin IP.

PORNIT Acceptă comenzile VISCA prin IP.

Notă

Dacă parola administratorului nu a fost configurată, comunicarea VISCA prin IP este
dezactivată, indiferent de poziția comutatorului. Pentru detalii despre configurarea parolei
administratorului, consultați „Inițializarea unității”.
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[9] Prezentare generală Localizarea și funcțiile pieselor

Comutatorul 4: schimbă viteza operațiilor de panoramare/înclinare transmise de
telecomanda cu infraroșu. Setarea este aplicată imediat.

Setting Descriere

OPRIT (implicit) Funcționează la viteză normală.

PORNIT Funcționează la viteză maximă.

Conector SDI OUT
Transmite imagini video din unitate ca semnal 12G/6G/3G/HD-SDI.
Unitatea poate fi configurată și pentru transmiterea semnalelor RAW.

Pentru detalii, consultați „Conector SDI OUT (tip BNC)” din „Conectarea monitoarelor și
a dispozitivelor de înregistrare externe”.

12.

Senzorul telecomenzii cu infraroșu (spate)
Senzorul de infraroșu pentru telecomanda cu infraroșu furnizată.

13.

Ventilator/evacuare aer
Dispersează căldura din interiorul unității.

Notă

Nu acoperiți evacuarea de aer. Acest lucru poate provoca o defecţiune.

Rețineți că zona de lângă evacuarea aerului se poate încălzi.

14.

Conector GENLOCK
Se utilizează pentru intrarea unui semnal de sincronizare extern.

Pentru detalii, consultați „Sincronizarea fazei semnalului video (Genlock)”.

15.

Conector AUDIO IN (tip XLR cu 5 pini)
Se utilizează pentru intrarea semnalului de la un microfon extern sau dispozitiv audio.
Funcționează în calitate de conector AUDIO IN CH-1 sau AUDIO IN CH-2.

Pentru detalii, consultați „Conectarea unui microfon extern sau a unui dispozitiv audio
extern”.

16.
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Vedere laterală

Acest subiect descrie localizarea și funcțiile pieselor de pe partea laterală a unității.

Sugestie

Această descriere face referire la ilustrația cu unitatea fără obiectiv atașat.

Clapetă de blocare panoramare/înclinare
Blochează mecanismul de panoramare/înclinare al unității. Se utilizează în cazurile
enumerate mai jos.

La transportarea sau ambalarea unității.
La atașarea sau detașarea unui obiectiv. Pentru detalii, consultați „Atașarea unui
obiectiv” sau „Detașarea unui obiectiv”.

1.
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Când utilizați un obiectiv care nu acceptă operația de panoramare/înclinare (de exemplu,
obiectivele Sony SEL100400GM / SEL200600G / SEL400F28GM / SEL600F40GM).

Sugestie

Mișcarea de panoramare/înclinare poate fi fixată în unghiurile de mai jos.

Baza glisantă2.

Orificii de șuruburi pentru dispozitive externe (4 locuri)
Pentru șuruburi M3 de până la 6 mm (1/4 inch) lungime.

Notă

Nu utilizați șuruburi mai lungi de 6 mm (1/4 inch). Acest lucru poate provoca o defecţiune.

3.

Indicator de acces A4.

Indicator de acces B
Indicatorul este aprins sau luminează intermitent când este inserat un suport de înregistrare.

Pentru detalii, consultați „Introducerea cardurilor de memorie”.

5.

Slot pentru card CFexpress Type A/SD (A)6.

Slot pentru card CFexpress Type A/SD (B)
Se utilizează pentru introducerea suporturilor de înregistrare.

Pentru detalii, consultați „Introducerea cardurilor de memorie”.

7.

Cod QR pentru conexiunea la rețea
Se utilizează la configurarea setărilor inițiale.

Pentru detalii, consultați „Accesarea aplicației web dintr-un browser web”.

8.
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[10] Prezentare generală Localizarea și funcțiile pieselor

Vedere de sus

Acest subiect descrie localizarea și funcțiile pieselor de pe partea de sus a unității.

Sugestie

Această descriere face referire la ilustrația cu unitatea fără obiectiv atașat.

Orificii de șuruburi pentru dispozitive externe (2 locuri)
Compatibile cu șuruburile 1/4-20 UNC pentru trepied.
Lungimea maximă de 6 mm (1/4 inch).

1.

ɸ (marcaj de imagine)
Marcajul de imagine se află în același plan cu senzorul de imagine.
Pentru a măsura cu exactitate distanța dintre unitate și subiect, folosiți acest marcaj de
imagine ca punct de referință.

2.
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[11] Prezentare generală Localizarea și funcțiile pieselor

Vedere de jos

Acest subiect descrie localizarea și funcțiile pieselor de pe partea de jos a unității.

Sugestie

Această descriere face referire la ilustrația cu unitatea fără obiectiv atașat.

Orificii de șuruburi pentru montarea suportului pentru tavan (6 puncte)
La montarea unității pe tavan sau pe un raft aflat la înălțime, fixați suportul pentru corp
(opțiune) la baza unității cu ajutorul celor șase șuruburi pentru montarea suportului pentru
corp, în aceste orificii.

1.
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[12] Prezentare generală Localizarea și funcțiile pieselor

Suportul obiectivului

Acest subiect descrie localizarea și funcțiile pieselor de pe suportul obiectivului unității.

Sugestie

Această descriere face referire la ilustrația cu unitatea fără obiectiv atașat.

Pentru detalii despre montare, consultați „Montarea în poziție verticală într-o locație fixă,
la înălțime” și „Montarea pe tavan”.

Șuruburi de montare a trepiedului (2 puncte)
Se utilizează la montarea unității pe un trepied de cameră (opțiune, șuruburi 1/4-20 UNC de
până la 5,5 mm (1/4 inch) lungime).

Notă

Nu utilizați șuruburi mai lungi de 5,5 mm (1/4 inch). Acest lucru poate provoca o defecţiune.

2.
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Tija suportului obiectivului (2)
Susține obiectivul.
Poate fi utilizată și pentru montarea accesoriilor generale a tijei de Ø15.

1.

Unitatea suportului obiectivului
Suportul obiectivului poate glisa înainte/înapoi în funcție de obiectiv și apoi se fixează.

2.

Șurub de atașare a bazei suportului obiectivului
Atașați la baza suportului obiectivului. Puteți să reglați șurubul mai sus/jos în funcție de
înălțimea bazei suportului obiectivului.

3.

Manetă de fixare a tijei suportului obiectivului (2 puncte)4.
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[13] Prezentare generală

Fixează poziția înainte/înapoi a unității suportului obiectivului.
Maneta de fixare a șurubului de atașare a bazei suportului obiectivului
Fixează poziția verticală a șurubului de atașare a bazei suportului obiectivului.

Sugestie

Dacă o manetă de fixare se află într-o poziție care face dificilă rotirea, eliberați maneta și rotiți-o
într-un unghi care va facilita utilizarea. Când este în poziția dorită, închideți maneta de fixare.

A: Maneta de fixare a șurubului de atașare a bazei suportului obiectivului
B: Manetă de fixare a tijei suportului obiectivului

Notă

Pentru a nu permite unității suportului obiectivului să perturbe operația de panoramare/
înclinare, deplasați unitatea suportului obiectivului spre capul camerei când nu o utilizați și
șurubul de atașare a bazei suportului obiectivului în cea mai înaltă poziție (cel mai aproape de
obiectiv).

5.
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Localizarea și funcțiile pieselor telecomenzii cu
infraroșu (furnizată)

Acest subiect descrie localizarea și funcțiile pieselor telecomenzii cu infraroșu (furnizată).

Butonul REC● (record START/STOP)
Apăsați-l pentru a porni sau opri înregistrarea.

1.

Buton MENU
Apăsați-l pentru a afișa sau ascunde meniul camerei.

2.

Butoanele de control GUI
Apăsați-le pentru a efectua operații în meniul camerei, în dialogurile cu mesaje care includ
butoane și alte funcții de afișare pe ecran.

3.
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Butonul CANC./BACK
Apăsați-l pentru a anula o setare sau pentru a reveni la ecranul anterior al meniul camerei
unității.

4.

Butoanele de control pentru deplasare și înclinare
Apăsați butoanele săgeată pentru a controla panoramarea/înclinarea camerei. Apăsați
butonul HOME pentru a reveni la orientarea camerei cu fața înainte.

5.

Butoanele de control pentru pozițiile presetate
Țineți apăsat butonul PRESET și apăsați unul din butoanele 1 până la 3, pentru a memora
starea de reglare a direcției, zoomului și focalizării camerei la butonul numerotat apăsat.
Apăsați un buton numerotat cu setări memorate pentru a reapela starea salvată.

6.

Butoanele de control pentru focalizare
Se utilizează pentru reglarea focalizării.
Pentru reglarea automată a focalizării, apăsați butonul AF.
Pentru reglarea manuală a focalizării, apăsați butonul MF, apoi apăsați fie butonul F (Far)
(departe) pentru focalizat pe un subiect îndepărtat sau pe butonul N (Near) (aproape) pentru
a focaliza pe un subiect apropiat.

7.

Butoane alocabile de la 1 la 3
Execută funcții atribuite butoanelor alocabile utilizând meniul camerei.
Dacă atribuiți funcția [Direct Menu] unul buton alocabil, puteți regla expunerea, balansul de
alb și alte setări utilizând butoanele de control GUI.

Pentru detalii despre alocare utilizând meniul camerei, consultați „Butoanele alocabile”.

Pentru detalii despre meniul direct, consultați „Utilizarea meniului direct”.

8.

Butonul de pornire
Apăsați-l pentru a porni unitatea sau pentru a comuta alimentarea în starea de standby.

9.

Butonul THUMBNAIL
Afișează meniul cu miniaturi care prezintă clipurile înregistrate pe cardul de memorie al
unității.

Pentru detalii despre ecranul cu miniaturi, consultați „Ecranul cu miniaturi”.

Puteți selecta clipuri și controla redarea pe ecranul cu miniaturi utilizând butoanele de
control GUI.

Pentru detalii despre selectarea clipurilor și controlarea redării, consultați „Redarea
clipurilor înregistrate” și „Operații cu clipurile înregistrate”.

10.
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Bateriile telecomenzii cu infraroșu

Telecomanda cu infraroșu are nevoie de două baterii AA (LR6).
Introduceți bateriile în telecomanda cu infraroșu așa cum se indică în diagrama următoare.

Notă

Nu utilizați alte baterii în afară de cele alcaline și mangan, deoarece pot să explodeze.

Eliminați bateriile uzate conform legislației și reglementărilor din țara sau regiunea dvs.

Butonul SLOT SEL (de selectare a slotului cardului de memorie (A)/(B))
Când sunt introduse două carduri de memorie, apăsați butonul pentru a comuta între carduri
pentru înregistrare.
Apăsați acest buton când este afișat ecranul cu miniaturi pentru a comuta între cardurile de
memorie de vizualizat.

11.

Butonul P/T RESET (resetarea panoramării/înclinării)
Resetează funcțiile de panoramare/înclinare. Apăsați butonul când lampa POWER și lampa
NETWORK luminează intermitent simultan sau când se afișează [Execute Pan-Tilt Reset]
pe panoul de control de încadrare din aplicația web.

12.

Butoanele de control pentru zoom
Pentru mărire, apăsați pe butonul T (teleobiectiv).
Pentru micșorare, apăsați pe butonul W (superangular).

13.
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[14] Prezentare generală Ecranul aplicației web

Prezentare generală a ecranului aplicației web

Conectând o tabletă sau un computer, puteți efectua operații de panoramare/înclinare, zoom,
înregistrare, redare a imaginilor înregistrate și de configurare a unității dintr-un browser (în
continuare, această funcție va fi denumită „aplicația web”).

Pentru detalii despre deschiderea aplicației web, consultați „Accesarea aplicației web dintr-
un browser”.

Notă

Aplicația web nu acceptă ieșirea audio a camerei.

Când Aplicația web se deschide, va apărea următorul ecran de operare în timp real.

Ecran de operare în timp real
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Pentru detalii despre ecranul de operare în timp real, consultați „Structura ecranului de
operare în timp real”.
Butoanele și pictogramele comune pentru ecranele de operare în timp real și de redare sunt
afișate în partea de sus a ecranului.

Pentru detalii despre zona comună a ecranelor, consultați „Structura zonei comune a
ecranelor”.
Puteți să comutați între ecrane apăsând pe filele de comutare a ecranelor din zona comună.

Ecranul de control al redării

Apăsați pe fila [Playback] pentru a afișa ecranul de control al redării.

Pentru detalii despre ecranul de control al redării, consultați „Structura ecranului de control
al redării”.
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Ecran Setări

Apăsați pe fila [Settings] pentru a afișa ecranul cu setări (denumit în continuare „meniul web”).

Notă

În meniul web, setările nu sunt aplicate până când nu apăsați pe butonul [OK]. Dacă schimbați
setările pe o pagină care are un buton [OK], asigurați-vă că apăsați butonul [OK].

Pentru detalii despre ecranul cu setări, consultați „Structura ecranului cu setări”.
În acest Ghid de asistență, ecranul cu setări al aplicației web este denumit „meniul web”.

[15] Prezentare generală Ecranul aplicației web

Structura zonei comune a ecranelor

Acest subiect descrie structura zonei comune a ecranelor.
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Numele camerei
Afișează numele camerei.
Puteți să schimbați numele utilizând opțiunea [Network] > [Camera Name] din meniul web.
Culoarea fundalului se schimbă în funcție de indicatorul de semnalizare extern.

1.

Comutator de alimentare
Când unitatea este pornită, se afișează mesajul [Power ON]. Puteți să apăsați comutatorul
și să selectați [Power Standby] pentru a seta alimentarea unității la starea de standby.
Când se afișează mesajul [Power Standby], puteți să apăsați comutatorul și să selectați
[Power ON] pentru a porni alimentarea unității.

2.

Filele de comutare a ecranelor de operare
Apăsați pe o filă pentru a afișa ecranul de operare corespunzător.
Fila [Live]: afișează ecranul de operare în timp real.
Fila [Playback]: afișează ecranul de control al redării.
Fila [Settings]: afișează ecranul cu setări (meniul web).

3.

Marcajul notificărilor
Când se primește un mesaj, marcajul se modifică așa cum se indică mai jos.

 (notificări active)
Efectuați acțiunea necesară în funcție de mesajul afișat în panoul cu imaginea camerei.

Notă

Mesajele nu sunt afișate când opțiunea [Monitoring] > [Output Display] > [HDMI] este setată la
[Off] în meniul web. Setați la [On] pentru a vedea conținutul mesajelor.

4.

Butonul stare cameră
Apăsați acest buton pentru a afișa informații despre imaginile înregistrate/semnalul video
transmis de cameră și informații despre obiectiv pe un ecran separat.

5.
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[16] Prezentare generală Ecranul aplicației web

Structura ecranului de operare în timp real

Acest subiect descrie structura ecranului de operare în timp real.

Comutator de blocare a funcționării ecranelor
 (funcționare deblocată): setați comutatorul în poziția din stânga pentru a controla

operațiile de pe ecranul de operare în timp real și ecranul de control al redării.
 (funcționare blocată): setați comutatorul în poziția din dreapta pentru a bloca operațiile

pe ecranul de operare în timp real și ecranul de control al redării pentru a preveni comenzile
accidentale.

6.
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Panoul de control al pozițiilor presetate
Afișează poziția înregistrată a unei presetări utilizând o miniatură. Atingeți de două ori
miniatura pentru a reveni la poziția memorată în presetare.

Pentru detalii despre pozițiilor presetate, consultați „Salvarea/restaurarea poziției de
panoramare/înclinare/zoom și a setării de focalizare utilizând aplicația web”.

1.

Panoul cu imaginea camerei
Afișează imaginea curentă a camerei și starea unității.
Afișează aceeași imagine ca ieșirea HDMI.
Următoarea stare este afișată deasupra imaginii. Este afișat și un cadru roșu sau unul verde
în jurul imaginii în funcție de indicatorul de semnalizare extern care este primit.

2.
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Nu. Display Descriere

2-1
Indicator pentru modul de
focalizare

Consultați „Indicator pentru modul de
focalizare” din „Afișajul ecranului camerei.”

2-2
Mod de înregistrare, slot A/B,
indicator interval de
înregistrare Interval Rec

Consultați „Mod de înregistrare, slot A/B,
indicator interval de înregistrare Interval Rec”
din „Afișajul ecranului camerei”

2-3
Indicator pentru starea de
redare

Este afișat în timpul redării în timp real
(numai când opțiunea [Stream Setting] este
setată la [SRT-Caller])

2-4
Indicator de stare a operării
ieșirii RAW

Afişează starea de ieşire a semnalului RAW.
Pentru detalii despre RAW, consultați
„Înregistrarea clipurilor video RAW”.

2-5
Indicator capacitate rămasă pe
suportul media

Consultați „Indicator capacitate rămasă pe
suportul media” din „Afișajul ecranului
camerei.”

2-6 Indicator poziție zoom
Consultați „Indicator poziție zoom” din
„Afișajul ecranului camerei.”

2-7
Indicator pentru modul
AE/nivelul AE

Afișează indicatorul pentru modul AE/nivelul
AE. Pentru detalii despre AE, consultați
„Reglarea luminozității”.
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Butonul [Display]
Apăsați acest buton pentru a afișa informațiile despre cameră pe imagine.
Apăsați-l din nou când informațiile despre cameră sunt afișate, pentru a le ascunde.

Pe lângă marcaje, indicatorii și mesajele privind focalizarea automată sunt afișate în funcție
de stare.

Pentru detalii privind informațiile afișate despre cameră, consultați „Afișajul ecranului
camerei”.

Butonul pentru oprirea focalizării automate cu urmărire în timp real
Apăsați butonul pentru a opri urmărirea unui subiect.

Pentru detalii despre urmărire, consultați „Urmărirea unui anumit subiect (Realtime
Tracking AF).”

Buton Record START/STOP
Apăsați butonul pentru a începe înregistrarea. În timpul înregistrării, butonul record
START/STOP se aprinde în roșu.
Apăsați-l în timpul înregistrării pentru a opri înregistrarea.
Puteți seta comutatorul Hold în starea Hold pentru a preveni acționarea accidentală a
butonului record START/STOP.

3.

Panoul de configurare de bază a camerei
Afișează setările pentru funcțiile de bază necesare pentru captură pe butoane. Apăsați un
buton pentru a afișa ecranul de configurare corespunzător pentru fiecare funcție de pe
panoul de ajustare a configurației de bază a camerei, de mai jos (5).

4-1 [FPS]

4.
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4-2 [ISO/Gain / Exposure Index]
4-3 [Shutter]
4-4 [Iris]
4-5 [ND Filter]
4-6 [Scene File / Base Look/LUT]
4-7 [White Balance]

Pentru detalii, consultați descrierea fiecărei funcții.

Function Referință

FPS „Mișcare cu încetinitorul și rapidă”

ISO/Gain
„Setarea sensibilității de bază” și „Reglarea automată a amplificării” și
„Reglarea manuală a amplificării” din „Reglarea amplificării”

Exposure
Index

„Setarea sensibilității de bază”, „Modificarea distribuției zonelor
întunecate și luminoase în imaginile înregistrate”

Shutter
„Reglarea automată a obturatorului” și “Reglarea manuală a
obturatorului” din „Ajustarea obturatorului”

Iris
„Reglarea automată a diafragmei” și “Reglarea manuală a diafragmei”
din „Ajustarea diafragmei”

ND Filter „Despre filtrul ND” din „Reglarea nivelului de lumină (filtrul ND)”

Scene File
„Prezentarea generală a aspectelor” și alte subiecte din „Înregistrarea
cu aspectul dorit”

Base
Look/LUT

„Captura cu ajustarea aspectului în post-producție”

White
Balance

„Ecranul de reglare a balansului de alb”

Panoul de ajustare a configurației de bază a butoanelor alocabile/camerei
Afișează butoanele alocabile în timpul funcționării normale. Apăsați pe butonul „Panou de
configurare a camerei” pentru a afișa elementele de configurare corespunzătoare. Apăsați
pe butonul [X] sau apăsați din nou pe butonul de pe panoul de configurare a camerei pentru
a reveni la afișajul butoanelor alocabile.

5.
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Pentru detalii despre butoanele alocabile, consultați „Butoanele alocabile”.
Pentru detalii despre panoul de ajustare a configurației de bază a camerei, consultați
descrierea fiecărei funcții.

Panoul de control al încadrării/panoul de control GUI
Comutați între panoul de control al încadrării/panoul de control GUI utilizând filele de sus.
Utilizați panoul de control al încadrării pentru a ajusta încadrarea. Apăsați pe fila [Pan-Tilt-
Zoom] pentru a afișa panoul de control al încadrării.

Pentru detalii despre operare, consultați „Reglarea încadrării”.

Sugestie

Partea cu joystick a panoului de control al încadrării este afișată așa cum se afișează mai jos
când operația de panoramare/înclinare este dezactivată și când este necesară inițializarea
panoramării/înclinării.

Când operația de panoramare/înclinare este blocată utilizând clapeta de blocare a
panoramării/înclinării

Când operația de panoramare/înclinare nu este inițializată

6.
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Când operația de panoramare/înclinare trebuie resetată

Când operația de panoramare/înclinare este dezactivată

Când operația de panoramare/înclinare nu este inițializată sau trebuie să fie resetată, puteți să
accesați rapid butonul [Pan-Tilt Reset] de pe panoul de control al camerei apăsând pe mesajul
afișat sub joystick.

Utilizați panoul de control GUI pentru a utiliza meniul camerei, redarea clipurilor și alte
funcții. Apăsați pe fila [Cam GUI] pentru a afișa panoul de control GUI.
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Pentru detalii despre operare, consultați „Utilizarea meniului camerei” și „Redarea
clipurilor și alte operații cu clipurile”.

Panoul de control al camerei
Utilizați-l pentru a configura funcțiile necesare pentru a opera camera.
Comutați între ecrane pentru a le afișa utilizând filele de sus.

Pentru detalii, consultați descrierea fiecărei funcții.

Fila (Main)
Afișează elementele de configurare pentru funcțiile utilizate frecvent.
Funcțiile glisorului de sus și de jos pot fi schimbate apăsând pe butonul [▼] și selectând un
element din lista afișată. Pot fi selectate următoarele funcții.

ND Filter
Iris
ISO*

Gain*

Exposure Index*

AE Level
Viteză zoom
Pan-Tilt Speed

 Fila (Focus)
Afișează elementele de configurare referitoare la focalizare.

7.

Se afișează în funcție de setările meniului.*
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 Fila (Audio)

Afișează elementele de configurare referitoare la sunet.

Fila (Stream)
Afișează elementele de configurare referitoare la redarea în timp real.
Elementele afișate variază în funcție de setarea formatului de redare în timp real.
Când este setată la [SRT-Caller], redarea în timp real poate fi pornită/oprită pe acest ecran.

Pentru detalii, consultați „Despre redarea în timp real” și alte subiecte din secțiunea
„Configurarea redării în timp real”.
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[17] Prezentare generală Ecranul aplicației web

Structura ecranului de control al redării

Acest subiect descrie structura ecranului de control al redării.

Fila (Others)
Afișează elementele de configurare pentru alte funcții.
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Panoul cu imaginea camerei
Afișează imaginea de redat și informațiile asociate. Când redarea este oprită, apare ecranul
cu imaginea camerei.

1-1 Data și ora filmării

1.
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1-2 Indicator pentru starea de redare
1-3 Indicator format de redare (dimensiune imagine)
1-4 Indicator format de redare (codec)
1-5 Afișare denumire clip
1-6 Număr clip/număr total de clipuri
1-7 Indicator pentru starea de redare în timp real
1-8 Indicator format de redare (rată de cadre și metodă de scanare)
1-9 Indicator aspect de bază
Panoul de control al redării

Afișează butoanele de control al redării.

Buton Function

Butonul  (redare/pauză) Redă un clip. În timpul redării, întrerupe clipul.

Butonul  (derulare rapidă
înainte),  (derulare rapidă
înapoi)

Redă un clip la viteză mare. Când butonul este
apăsat, viteza de redare se schimbă în trei pași.

Butonul  (următor), butonul
 (anterior)

Sare la începutul clipului sau la clipul
anterior/următor.

Butonul  (oprire) Opreşte redarea.

Butonul [Display]
Apăsați-l pentru a comuta între afișarea ecranului peste imagine.

Butonul [Thumbnail]
Afișează clipurile înregistrate pe cardul de memorie pe panoul cu imaginea camerei sub
formă de miniaturi.

2.
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Dacă apăsați butonul [Thumbnail] când este afișat ecranul cu miniaturi, acesta va fi închis și
se revine la imaginea camerei.

Pentru detalii despre ecranul cu miniaturi, consultați „Ecranul cu miniaturi”.

Butonul [Slot Select]
Comută între suporturile de redare țintă.
Butoanele alocabile
Afișează butoanele alocabile, care au fost atribuite funcțiilor unității.

Pentru detalii despre butoanele alocabile, consultați „Butoanele alocabile”.

3.

Panoul de control GUI
Utilizați panoul de control GUI pentru a utiliza meniul camerei, redarea clipurilor și alte
funcții.

Pentru detalii despre operare, consultați „Utilizarea meniului camerei” și „Redarea
clipurilor înregistrate”.

4.
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[18] Prezentare generală Ecranul aplicației web

Structura ecranului cu setări

Utilizați ecranul cu setări pentru a seta diferitele elemente de configurare a unității, inclusiv
setările inițiale, setările rețelei, setările de captură/redare utilizând meniul web.

Notă

Ca regulă generală, în meniul web, setările nu sunt aplicate până când nu apăsați pe butonul [OK].
Dacă schimbați setările pe o pagină care are un buton [OK], asigurați-vă că apăsați butonul [OK].

Pentru detalii despre ecranul cu setări, consultați „Meniul web și setări detaliate”.

[19] Prezentare generală Ecranul aplicației web

Meniul camerei
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Apăsați butonul [Menu] din panoul de control GUI al ecranului de operare în timp real, pentru a
afișa meniul camerei în panoul cu imaginea camerei.

Puteți să configurați setările necesare pentru filmare și redare utilizând meniul camerei.
Apăsați butonul [Menu] când meniul camerei este afișat, pentru a-l ascunde.
Meniul camerei este utilizat cu ajutorul panoului de control GUI.

Pentru detalii despre meniul camerei, consultați „Meniul camerei și setări detaliate”.

Notă

Când opțiunea [Monitoring] > [Output Display] > [HDMI/Stream] este setată la Off (Dezactivat) în
meniul web (dezactivează suprapunerea informațiilor pe afișajul ecranului), meniul camerei nu mai
este afișat în panoul cu imaginea camerei. Cu toate acestea, rețineți că operațiile în meniu din
panoul de control GUI sunt în continuare active. Pentru a evita acționarea accidentală, aveți grijă să
nu efectuați operații în meniu utilizând panoul de control GUI când [HDMI/Stream] este setată la Off
(Dezactivat).

[20] Prezentare generală
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Afișajul ecranului camerei

Puteți afișa starea și setările unității suprapuse pe imaginea transmisă de cameră. Puteți să
setați ieșirile pentru care afișajul ecranului este activat utilizând [Monitoring] > [Output Display]
din meniul web.
Puteți afișa/ascunde informațiile folosind butonul [Display]. Chiar și atunci când sunt ascunse,
acestea vor apărea în timp ce efectuați operații în meniul direct.
Puteți să afișați/ascundeți elementele individual utilizând [Monitoring] > [Display On/Off] din
meniul camerei.

Informaţii afişate pe ecran în timpul filmării

Indicator de încărcare/indicator de fișiere rămase

Pentru detalii despre transferul fișierelor, consultați „Despre transferul de fișiere” și alte
subiecte din „Transferarea fișierelor”.

1.

Indicatorul pentru zona de focalizare
Afișează zona de focalizare pentru focalizare automată.

Pentru detalii despre focalizarea automată, consultați „Reglarea automată utilizând
aplicația web” și alte subiecte din „Reglarea automată a focalizării (Auto Focus)”.

2.

Mod de înregistrare, slot A/B, indicator interval de înregistrare Interval Rec3.
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Display Semnificație

●Rec Înregistrare

Stby Înregistrare în așteptare

Pentru detalii despre funcția Interval Rec, consultați „Înregistrarea video în mod
intermitent (Interval Rec)”.

Indicator profunzime de câmp4.

Indicator pentru modul de scanare a imaginii
Se afișează un marcaj  (nepotrivire) dacă există o nepotrivire între dimensiunea cercului
de imagine al obiectivului și dimensiunea efectivă a imaginii din setarea modului de scanare
a imaginii.
Când Imager Scan Mode este setat la FF, un semn „C” este afişat în modurile cu unghi de
vizualizare mai îngust (trunchiere).
Trunchierea are loc în următoarele moduri.

Când formatul de înregistrare este de 3840×2160 și rata cadrelor S&Q Motion este de
100 cps sau 120 cps
Când [Codec] este setat la RAW sau RAW & XAVC-I și formatul de ieșire RAW este
3840×2160
Pentru detalii despre modul de scanare a imaginii, consultați „Setarea modului de
scanare a imaginii” din „Configurarea funcționării de bază”.

5.

Indicator de stare a operării ieșirii RAW
Afişează starea de ieşire a semnalului RAW.

Pentru detalii despre RAW, consultați „Înregistrarea clipurilor video RAW”.

6.

Indicator rată de cadre de filmare Slow & Quick Motion (Mişcare cu încetinitorul şi
rapidă)

Pentru detalii despre modul Slow & Quick Motion, consultați „Mișcare cu încetinitorul și
rapidă”.

7.

Indicatorul poziției de focalizare

Afișează poziția de focalizare.

8.

Indicator pentru modul de focalizare9.
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Display Semnificație

Focus Hold Modul Focus Hold

MF Modul MF

AF Mod AF

 (modul de focalizare automată cu
urmărire în timp real)

Modul de focalizare automată cu
urmărire în timp real

Focalizare automată cu detecția feței/ochilor

Display Semnificație

 (Focalizare automată cu detecția
feței/ochilor)

Indică dacă este activă focalizarea automată
cu detectarea feței/ochilor

 (Focalizare automată numai pe
față/ochi)

Indică dacă este activă focalizarea automată
doar pentru față/ochi

 (Față de urmărit salvată)
Indică faptul că a fost salvată o față de
urmărit

 (Focalizare automată întreruptă în
timpul focalizării automate cu detecția
feței/ochilor)

Indică faptul că focalizarea automată a fost
întreruptă în timpul focalizării automate cu
detecția feței/ochilor*

Pentru detalii despre focalizarea automată cu detecția feței/ochilor, consultați „Urmărirea
utilizând detecția feței și a ochilor (Face/Eye Detection AF).”

Se afișează atunci când nu există o față de urmărit salvată și nu este detectată o față sau când există o față
de urmărit salvată, dar aceasta nu este detectată.

*

Indicator poziție zoom
Afișează poziția de zoom în intervalul 0 (superangular) până la 99 (teleobiectiv) (dacă este
atașat un obiectiv care acceptă afișarea poziției de zoom).
Puteți să schimbați indicatorul la un afișaj cu bare sau cu distanțe focale utilizând setarea
[Technical] > [Lens] > [Zoom Position Display] din meniul camerei.
Următoarele elemente sunt adăugate pe afişaj când este activată tehnologia Clear Image
Zoom.

10.
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Display Semnificație

 (Tehnologia Clear Image Zoom este
activată)

Tehnologia Clear Image Zoom este
activată

Valoare factor de mărire
Când este utilizată tehnologia Clear
Image Zoom

Pentru detalii despre zoom, consultați „Setarea tipului de zoom” și alte subiecte din
„Reglarea zoomului”.

Indicator mod de stabilizare a imaginii11.

Indicator de stare a ieșirii SDI/ieșirii HDMI pentru Rec Control
Afișează starea de ieșire a semnalului de control REC.

Pentru detalii, consultați „Conectarea monitoarelor și a dispozitivelor de înregistrare
externe”.

12.

Indicator de focalizare

Pentru detalii, consultați „Utilizarea Single-Shot Auto Focus (Push Auto Focus (AF-S))”
din „Reglarea focalizării”.

13.

Indicator capacitate rămasă pe suportul media
Apare o pictogramă  (protejat) atunci când cardul de memorie este protejat împotriva
scrierii.

14.

Indicator modul balans de alb

Display Semnificație

 (ATW) Mod automat

 (ATW Hold) Mod automat întrerupt

W:P Modul presetat

W:A Modul de memorie A

15.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/03… 67/464

Indicator de blocare externă cod de timp/afișare date timp
Afișează „EXT-LK” când este blocat la codul de timp al unui dispozitiv extern.

Pentru detalii despre codul de timp, consultați „Specificarea datelor de timp.”

16.

Indicator de filtru ND

Display Semnificație

 (A) Mod automat

 (B) Mod de control pentru bokeh

Pentru detalii despre filtrele ND, consultați „Reglarea nivelului de lumină (filtrul ND)”.
Pentru detalii despre controlul efectului bokeh, consultați „Ajustarea bokeh (funcție de
control pentru bokeh)”.

17.

Indicator de fișier scenă

Pentru detalii despre fișierele scenă, consultați „Prezentarea generală a aspectelor” și
alte subiecte din „Înregistrarea cu aspectul dorit”.

18.

Indicator iris
Afişează poziţia irisului (valoarea F) (dacă este ataşat un obiectiv care acceptă afişarea
setării irisului).

Pentru detalii despre diafragmă, consultați „Reglarea automată a diafragmei” și
„Reglarea manuală a diafragmei”.

19.

Indicator de avertizare nivel video20.

Indicator de amplificare
Afișează valoarea EI în modul Cine EI.

Display Semnificație

 (A) Mod automat

L Modul Preset L

 (Mod de ajustare temporară) Mod de ajustare temporară

21.
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Display Semnificație

 (B) Mod de control pentru bokeh

Pentru detalii despre amplificare, consultați „Reglarea automată a amplificării” și
„Reglarea manuală a amplificării”.
Pentru detalii despre modul Cine EI, consultați „Setarea modului de captură” din
„Configurarea operării de bază”.

Afișare denumire clip
Afișează numele clipului în curs de înregistrare sau al următorului care va fi înregistrat.

22.

Indicatorul obturatorului

Pentru detalii despre obturator, consultați „Reglarea automată a obturatorului” și
„Reglarea manuală a obturatorului”.

23.

Indicator pentru modul AE/nivelul AE

Pentru detalii despre expunerea automată (AE), consultați „Setarea nivelului țintă pentru
reglarea automată a luminozității”.

24.

Indicator nivelă cu bulă de aer
Afișează nivelul orizontal în pași de câte ±1° până la ±15°.

25.

Decibelmetru audio
Afișează nivelul audio al fiecărui canal.

26.

Monitor de semnal video
Afișează o formă de undă, un vectorscop și o histogramă.
Linia portocalie indică valoarea setată pentru marcajul nivelului de luminozitate.
În modul Cine EI, afișează tipul LUT al semnalului monitorizat.

Pentru detalii, consultați „Monitor de semnal video”.
Pentru detalii despre modul Cine EI, consultați „Setarea modului de captură” din
„Configurarea operării de bază”.

27.

Indicator sensibilitate de bază/indicator ISO de bază
În modul Custom, afișează sensibilitatea de bază setată cu butonul [ISO/Gain / Exposure
Index] din panoul de configurare de bază a camerei sau cu setarea [Shooting] >
[ISO/Gain/EI] > [Base Sensitivity] din meniul camerei.
În modul Cine EI, afișează sensibilitatea Base ISO setată cu butonul [ISO/Gain / Exposure
Index] din panoul de configurare de bază a camerei sau cu setarea [Shooting] >

28.
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Informații afișate pe ecran în timpul redării

[ISO/Gain/EI] > [Base ISO] din meniul camerei.

Pentru detalii despre sensibilitatea de bază, consultați „Selectarea sensibilității de bază”.
Pentru detalii despre modul Cine EI, consultați „Setarea modului de captură” din
„Configurarea operării de bază”.

Indicator aspect de monitorizare
În modul Cine EI, afișează setarea LUT a monitorului.

Pentru detalii despre setarea LUT, consultați „Captura cu ajustarea aspectului în post-
producție” și alte subiecte corelate.
Pentru detalii despre modul Cine EI, consultați „Setarea modului de captură” din
„Configurarea operării de bază”.

29.

Indicator aspect de bază/aspect înregistrare
Afișează setarea pentru aspectul de bază.
În modul Cine EI, afișează semnalul video de înregistrat pe cardurile de memorie.

Pentru detalii despre aspectul de bază, consultați „Prezentarea generală a aspectelor” și
din „Captura cu aspectul dorit”.
Pentru detalii despre modul Cine EI, consultați „Setarea modului de captură” din
„Configurarea operării de bază”.

30.

Indicator stare proxy31.

Indicator format de înregistrare (codec)
Afişează numele formatului pentru înregistrarea pe cardurile de memorie.
Setați formatul de înregistrare (codec) utilizând [Project] > [Rec Format] > [Codec] din
meniul web sau meniul camerei.

32.

Indicator format de înregistrare (rată de cadre și metodă de scanare)33.

Indicator format de înregistrare (dimensiune imagine)
Afişează dimensiunea imaginii pentru înregistrarea pe cardurile de memorie.
Setați formatul de înregistrare (dimensiune imagine) utilizând [Project] > [Rec Format] >
[Codec] din meniul web sau meniul camerei.

34.

Indicator de semnalizare
Afișează un cadru roșu sau unul verde în jurul imaginii în funcție de indicatorul de
semnalizare extern care este primit.

35.
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Următoarele informații sunt suprapuse imaginii de redare.

Indicator de încărcare/indicator de fișiere rămase1.

Număr clip/număr total de clipuri2.

Indicator pentru starea de redare3.

Indicator format de redare (rată de cadre și metodă de scanare)4.

Indicator format de redare (dimensiune imagine)5.

Indicator format de redare (codec)6.

Indicator suport media
Apare o pictogramă  (protejat) atunci când cardul de memorie este protejat împotriva
scrierii.

7.

Afișarea orei și a datei8.

Afișare denumire clip9.

Indicator asistență la afișarea gamma10.

Decibelmetru audio
Afişează nivelul sunetului de redare.

11.

Indicator aspect de bază/aspect înregistrare12.
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[21] Pregătire Montarea unității

Montarea în poziție verticală într-o locație fixă

Acest subiect descrie montarea unității pe un birou sau trepied.

Notă despre instalare
Pentru a proteja obiectivul și blocul de conectori al unității, mențineți obiectivul și capacul
unității atașate până când fixați obiectivul.
Pentru a preveni defectarea obiectivului, nu țineți în mână piesele acestuia în timp ce lucrați.
Pentru a preveni defectarea unității, nu țineți camera în mână în timp ce lucrați.

Indicator de semnalizare13.

Verificați spațiul de montare.
La montarea pe un birou
Montați această unitate pe o suprafață plată, luând în calcul spațiul necesar pentru rotirea
obiectivului și pentru cablurile din spatele unității.

Notă

Montați-o într-un loc stabil care nu este supus vibrațiilor. Locurile supuse vibrațiilor pot
provoca tremurul imaginilor.

Dacă unitatea trebuie montată pe o suprafață înclinată, mențineți-o la ±15° de planul
orizontal și luați măsuri de precauție pentru a preveni căderea unității.

1
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Apoi atașați obiectivul. Consultați „Atașarea unui obiectiv”, luând în considerare informațiile din
„Măsuri de precauție la atașarea/detașarea unui obiectiv”, „Verificarea comutatoarelor
obiectivului” și „Măsuri de precauție la utilizarea unui obiectiv cu zoom”.

[22] Pregătire Montarea unității

Montarea în poziție verticală într-o locație fixă, la
înălțime

Acest subiect descrie procedura de montare a unității în poziție verticală într-o locație la
înălțime, utilizând suportul pentru tavan (CIB-PCM1 (opțiune)).

La montarea pe un trepied
Fixați trepiedul în orificiul pentru șurubul de montare a trepiedului, din partea de jos.
Utilizați un șurub de montare a trepiedului cu următorul nivel de proeminență față de
suprafața de montare și strângeți-l cu o șurubelniță manuală.

A: Șuruburi de montare a trepiedului 1/4-20 UNC, ISO 1222 (6,35 mm)
B: Proeminență (4,5 mm - 5,5 mm)

Nu utilizați șuruburi de trepied pentru montarea unității într-o locație la înălțime.

Notă

Alegeți un trepied care nu se va răsturna când obiectivul se întoarce.
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Pentru a monta unitatea într-o poziție la înălțime, apelați la un tehnician profesionist.
La montarea într-o locație la înălțime, asigurați-vă că suprafața de montare și materialul de
montare (excluzând accesoriile) pot să susțină 200 kg (440 lb și 14,8 oz) sau mai mult și
montați unitatea așa cum se descrie în acest Ghid de asistență. Dacă montajul nu este
suficient de rezistent, unitatea poate să cadă și să cauzeze vătămări grave.
Atașați cablul cu sârmă furnizat pentru prevenirea căderii la suportul pentru tavan CIB-
PCM1 (opțiune) pentru a preveni căderea unității.
Când unitatea este montată într-o locație la înălțime, verificați o dată pe an dacă s-a slăbit
structura. Scurtați intervalul de inspecție în funcție de condițiile de utilizare.

Notă despre instalare
Pentru a proteja obiectivul și blocul de conectori al obiectivului unității, mențineți capacul
pentru obiectiv și husa pe acesta până obiectivul este fixat.
Pentru a preveni defectarea obiectivului, nu țineți în mână piesele acestuia în timp ce lucrați.
Pentru a preveni defectarea unității, nu țineți camera în mână în timp ce lucrați.

Verificați accesoriile de montare la înălțime și spațiul de montare.
Kitul suportului pentru tavan CIB-PCM1 (opțiune)
Înainte de a începe, verificați dacă aveți următoarele piese.

Suportul corpului (1)
Suportul pentru tavan (1)
Capacul butonului de eliberare a obiectivului [1]
Cablul cu sârmă pentru prevenirea căderii (1)
Șuruburi +PSW M3×8 (9)
Șurub +PSW M4x8 din oțel inoxidabil pentru cablul cu sârmă pentru prevenirea căderii
(1)

1
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Notă

Cablul cu sârmă pentru prevenirea căderii este proiectat să susțină unitatea când este
suspendată. Nu aplicați nicio sarcină pe acesta în afară de cea a unității.

Spațiul de montare
Consultați schema de mai jos când stabiliți locația de montare și direcția, luând în calcul
spațiul necesar pentru rotirea obiectivului și pentru cablurile din spatele unității.

A: Raza de mișcare a capului camerei (de exemplu, SEL70200GM2 (cu SEL20TC atașat):
Ø340)
B: Suport de tavan (orificiu pe partea suprafeței de montare (Ø60))
C: Orificiu de aliniere la montare

Notă

Montați-o într-un loc stabil care nu este supus vibrațiilor. Locurile supuse vibrațiilor pot
provoca tremurul imaginilor.

Dacă unitatea trebuie montată pe o suprafață înclinată, mențineți-o la ±15° de planul
orizontal și luați măsuri de precauție pentru a preveni căderea unității.

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

2
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Notă

Dacă panoramarea/înclinarea capului camerei nu se blochează când clapeta de blocare este
în poziția LOCK, mișcați capul camerei manual până când se blochează în poziție.

Atașați suportul corpului pe partea de jos a unității utilizând cele
șase șuruburi furnizate (M3×8).

3
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Utilizați șuruburile furnizate. Dacă utilizați alte șuruburi decât cele furnizate, puteți
deteriora interiorul unității.

Atașați cablul cu sârmă pentru prevenirea căderii la suportul
corpului.

4
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A: Cablul cu sârmă furnizat　
B: Șurubul Phillips (M4×8) furnizat
C: Bucla de metal al cablului cu sârmă

Utilizați șurubul furnizat. Dacă utilizați alt șurub decât cel furnizat, puteți reduce eficiența
cablului cu sârmă.

Atașați suportul pentru tavan de suprafața, precum un raft, pe care
va fi montată unitatea.

5
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A: Perete　
B: Marcajul △ (camera în direcția înainte)
C: Orificiu pentru cablurile de conectare
D: Raft sau altă suprafață de montare

Atașați cablul cu sârmă pentru prevenirea căderii lângă suprafața
de montare.
Utilizați un șurub cu cap crenelat cu locaș hexagonal M5 (3/16 inch) (opțiune) și atașați-l
la un obiect de lângă raft sau suprafața pe care este fixat suportul pentru tavan.

6
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A: Cablu cu sârmă　
B: Șurub cu cap crenelat cu locaș hexagonal (M5, 3/16 inch)

Aliniați orificiul pentru șurub 〇 din partea din față a suportului
corpului cu orificiul ◇ al suportului pentru tavan, introduceți
unitatea și fixați temporar suportul corpului în suportul pentru
tavan rotind unitatea spre dreapta.

7
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A: Orificiul 〇
B: Orificiul ◇

Atașați suportul corpului și cel pentru tavan utilizând cele trei
șuruburi de blocare la rotire (M3×8).

8
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Apoi atașați obiectivul. Consultați „Atașarea unui obiectiv”, luând în considerare informațiile din
„Măsuri de precauție la atașarea/detașarea unui obiectiv”, „Verificarea comutatoarelor
obiectivului” și „Măsuri de precauție la utilizarea unui obiectiv cu zoom”.

Notă

După atașarea unui obiectiv, verificați dacă acesta este fixat bine.
Obiectivul nu are nicio protecție împotriva căderii. Sony nu-și asumă răspunderea dacă obiectivul
cade din unitate.

Verificați starea monturii.
Verificați în special aspectele de mai jos. 

Șuruburile de montare sunt fixate corect.
Cablul cu sârmă de prevenire a căderii este atașat corect și nu este răsucit.
Unitatea este montată la nivel (fără să se încline sau clatine).
Unitatea nu se rotește liber când este mișcată.

9
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[23] Pregătire Montarea unității

Montarea pe tavan

Acest subiect descrie procedura de montare a unității pe tavan, utilizând suportul pentru tavan
(CIB-PCM1 (opțiune)).

Pentru a monta unitatea pe tavan, apelați la un tehnician profesionist.
La montarea pe tavan, asigurați-vă că suprafața și materialul de montare (excluzând
accesoriile) pot să susțină 200 kg (440 lb 14,8 oz) sau mai mult și montați unitatea așa cum
se descrie în acest Ghid de asistență. Dacă montajul nu este suficient de rezistent, unitatea
poate să cadă și să cauzeze vătămări grave.
Atașați cablul cu sârmă furnizat pentru prevenirea căderii la suportul pentru tavan CIB-
PCM1 (opțiune) pentru a preveni căderea unității.
Când unitatea este montată pe tavan, verificați dacă structura nu s-a slăbit o dată pe an.
Scurtați intervalul de inspecție în funcție de condițiile de utilizare.

Notă despre instalare
Pentru a proteja obiectivul și blocul de conectori al obiectivului unității, mențineți capacul
pentru obiectiv și husa pe acesta până obiectivul este fixat.
Pentru a preveni defectarea obiectivului, nu țineți în mână piesele acestuia în timp ce lucrați.
Pentru a preveni defectarea unității, nu țineți camera în mână în timp ce lucrați.

Verificați accesoriile de montare pe tavan și spațiul de montare.1



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/03… 83/464

Kitul suportului pentru tavan CIB-PCM1 (opțiune)
Înainte de a începe, verificați dacă aveți următoarele piese.

Suportul corpului (1)
Suportul pentru tavan (1)
Capacul butonului de eliberare a obiectivului [1]
Cablul cu sârmă pentru prevenirea căderii (1)
Șuruburi +PSW M3×8 (9)
Șurub +PSW M4×8 din oțel inoxidabil pentru cablul cu sârmă pentru prevenirea căderii
(1)

Notă

Cablul cu sârmă pentru prevenirea căderii este proiectat să susțină unitatea când este
suspendată. Nu aplicați nicio sarcină pe acesta în afară de cea a unității.

Spațiul de montare
Consultați schema de mai jos când stabiliți locația de montare și direcția, luând în calcul
spațiul necesar pentru rotirea obiectivului și pentru cablurile din spatele unității.

A: Raza de mișcare a capului camerei (de exemplu, SEL70200GM2 (cu SEL20TC atașat):
Ø340)
B: Suport de tavan (orificiu pe partea tavanului (Ø60))
C: Orificiu de aliniere la montare

Notă
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Montați pe un tavan (din beton) care este suficient de rezistent.

Pentru a monta unitatea pe un tavan insuficient de rezistent, asigurați o ranforsare adecvată.

Montați-o într-un loc stabil care nu este supus vibrațiilor. Locurile supuse vibrațiilor pot
provoca tremurul imaginilor.

Dacă unitatea trebuie montată pe o suprafață înclinată, mențineți-o la ±15° de planul
orizontal și luați măsuri de precauție pentru a preveni căderea unității.

Partea opusă orificiului △ de pe suportul pentru tavan este direcția de captură (partea din
față a camerei).

Glisați clapeta de blocare a panoramării/înclinării în poziția
UNLOCK pentru a debloca panoramarea/înclinarea și rotiți capul
camerei cu 180° în direcția de înclinare.

2

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

Capul camerei rotit la 180°

Notă

3
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Dacă panoramarea/înclinarea capului camerei nu se blochează când clapeta de blocare este
în poziția LOCK, mișcați capul camerei manual până când se blochează în poziție.

Atașați suportul corpului pe partea de jos a unității utilizând cele
șase șuruburi furnizate (M3×8).

Utilizați șuruburile furnizate. Dacă utilizați alte șuruburi decât cele furnizate, puteți
deteriora interiorul unității.

4
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Atașați suportul pentru tavan la o placă de montare (opțiune) și
apoi fixați placa pe tavan.

A: Suport pentru tavan
B: Tavan
C: Placă de montare
D: Orificiul △
Atașați suportul în funcție de orientarea suportului pentru tavan
Rețineți că atunci când este montată pe tavan, partea din față a camerei este pe partea
opusă a suportului pentru tavan în comparație cu montarea în poziție verticală normală.
Montați corect consultând diagrama care indică direcția de montare.

A: Partea frontală pentru montarea în poziție verticală (orientarea orificiului △)
B: Partea frontală pentru montarea pe tavan

Notă

Clientul este responsabil pentru materialul suprafeței de montare.

5
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Fixați cablul cu sârmă pentru prevenirea căderii pe tavan.

A: Suport pentru tavan
B: Șurub cu cap crenelat cu locaș hexagonal (M5, 3/16 inch)
C: Cablul cu sârmă (furnizat)
D: Placă de montare
E: Tavan

6

Trageți cablul cu sârmă pentru prevenirea căderii prin orificiul din
centrul suportului pentru tavan și fixați de suportul corpului.
Treceți cablul cu sârmă pentru prevenirea căderii prin bucla metalică a cablului cu sârmă
al suportului corpului și fixați-l bine pe suport utilizând șurubul din oțel inoxidabil furnizat
(M4×8).

7
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A: Cablul cu sârmă furnizat
B: Șurubul Phillips (M4×8) furnizat
C: Bucla de metal al cablului cu sârmă

Utilizați șurubul furnizat. Dacă utilizați alt șurub decât cel furnizat, puteți reduce eficiența
cablului cu sârmă.

Notă

Se recomandă ca o persoană să țină cu mâinile unitatea așa cum se indică în diagrama
următoare, iar altă persoană să monteze unitatea.
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Nu țineți cu mâna capul camerei sau suportul obiectivului în timp ce montați unitatea. Există
riscul de deteriorare și vătămare corporală dacă unitatea este scăpată sau cade.

La cablare, aveți grijă să nu se scurtcircuiteze conectorii electrici și cablurile din cauza
cablului cu sârmă pentru prevenirea căderii.

Structura poate să susține o masă suspendată de până la 8,8 kg (19 lb 6,4 oz) (inclusiv
obiectivul). Pentru a preveni căderea unității, nu depășiți masa maximum preconizată.

Aliniați orificiul pentru șurub (A) de pe suportul corpului cu
orificiul ◇ (B) de pe suportul pentru tavan, introduceți unitatea și
rotiți-o la aproximativ 60 de grade spre dreapta până când orificiul
pentru șurub (A) și orificiul pentru șurub (C) sunt aliniate.

8
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A: Orificiul pentru șurub de pe suportul corpului
B: Orificiul pentru șurub de pe suportul pentru tavan (orificiul ◇)
C: Orificiu pentru șurub
D: Tavan
E: Placă de montare

Atașați suportul corpului și cel pentru tavan utilizând cele trei
șuruburi de blocare la rotire (M3×8).

9
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Apoi atașați obiectivul. Consultați „Atașarea unui obiectiv”, luând în considerare informațiile din
„Măsuri de precauție la atașarea/detașarea unui obiectiv”, „Verificarea comutatoarelor
obiectivului” și „Măsuri de precauție la utilizarea unui obiectiv cu zoom”.

Notă

Pentru a realiza panoramarea/înclinarea corect, când unitatea este montată pe tavan, setați [Pan-
Tilt] > [Direction] > [Ceiling] la [On] din meniul web.

Verificați starea monturii.
Verificați în special aspectele de mai jos.

Șuruburile de montare sunt fixate corect.
Cablul cu sârmă de prevenire a căderii este atașat corect și nu este răsucit.
Unitatea este montată la nivel (fără să se încline sau clatine).
Unitatea nu se rotește liber când este mișcată.

10
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După atașarea unui obiectiv, verificați dacă acesta este fixat bine.
Obiectivul nu are nicio protecție împotriva căderii. Sony nu-și asumă răspunderea dacă obiectivul
cade din unitate.

[24] Pregătire Atașarea/detașarea unui obiectiv

Măsuri de precauție la atașarea/detașarea unui
obiectiv

Nu lăsați obiectivul orientat spre soare. Lumina directă a soarelui poate intra prin obiectiv, poate
fi focalizată în unitate și poate provoca un incendiu.

Notă

Atașați/îndepărtați obiectivul când unitatea este oprită.

Un obiectiv este o componentă de precizie. Nu așezați obiectivul pe o suprafață cu montura
obiectivului orientată în jos. Atașați capacul de montare al obiectivului furnizat.

Sugestie

Pentru detalii despre obiectivele acceptate de unitate, contactați reprezentanța de service Sony
locală.

[25] Pregătire Atașarea/detașarea unui obiectiv

Verificarea comutatoarelor obiectivului

Următoarele verificări și setări sunt obligatorii în funcție de tipul de obiectiv.

Pentru un obiectiv cu un comutator de zoom

Setați comutatorul la SERVO.
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Când comutatorul este setat la MANUAL, zoomul poate fi reglat numai cu ajutorul inelului de
zoom. Controlul zoomului de pe unitate nu are niciun efect.

Pentru un obiectiv cu un comutator pentru modul de focalizare

Setați comutatorul la AF/MF sau AF.
Când comutatorul este setat la MF, focalizarea poate fi reglată numai cu ajutorul inelului
obiectivului sau manual cu telecomanda. Când comutatorul este setat la Full MF, focalizarea
poate fi reglată numai cu ajutorul inelului obiectivului.

Notă

Când utilizați un obiectiv cu montură A, este posibil să nu fie disponibilă reglarea manuală de pe o
unitate de telecomandă.

Pentru un obiectiv cu un comutator Auto Iris

Setați comutatorul la AUTO.
Când comutatorul nu este setat la AUTO, diafragma poate fi reglată numai cu ajutorul inelului
obiectivului. Operarea diafragmei de pe unitate nu are efect.

Pentru un obiectiv cu un comutator de stabilizare a imaginii

Setați comutatorul la OFF.
Când comutatorul este setat la ON, poate apărea un comportament imprevizibil la utilizarea
panoramării/înclinării.

SELP28135G
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A: Setați comutatorul ZOOM la SERVO.
B: Rotiți inelul de focalizare în poziția înainte (modul AF/MF).
C: Setați comutatorul stabilizatorului de imagine la OFF.

[26] Pregătire Atașarea/detașarea unui obiectiv

Măsuri de precauție la utilizarea unui obiectiv cu zoom

Când utilizați un obiectiv cu zoom altul decât un obiectiv cu zoom electronic, poziția zoomului se
poate schimba în funcție de mediul în care este montat. Fixați inelul de zoom în poziție utilizând
bandă adezivă în funcție de scopul utilizării.

Bandă adezivă din plastic: 471 BLA 50 sau un produs echivalent

[27] Pregătire Atașarea/detașarea unui obiectiv
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Atașarea unui obiectiv

Acest subiect descrie cum se atașează un obiectiv cu montură E sau cu montură A.

Notă

Când utilizați un obiectiv cu montură A, diafragma este setată manual și focalizarea este setată la
MF.

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

Notă

Dacă panoramarea/înclinarea capului camerei nu se blochează când clapeta de blocare este
în poziția LOCK, mișcați capul camerei manual până când se blochează în poziție.

1

Rotiți maneta de fixare pentru șurubul de atașare a bazei
suportului obiectivului spre stânga pentru a slăbi blocarea, apoi
mișcați acest șurubul de atașare a bazei suportului obiectivului
într-o poziție care nu deranjează obiectivul.

2
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A: Corect
B: Incorect

Rotiți clapeta de blocare a capului camerei în direcția săgeții
pentru deblocarea capului camerei.

Notă

Până când capul camerei nu este blocat din nou, există riscul ca acesta să se miște din loc
sub acțiunea propriei greutăți. Susțineți capul camerei cu mâna în timp ce efectuați acțiunea.

3

Glisați capul camerei în poziția cea mai în față.4
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Rotiți clapeta de blocare a capului camerei în direcția săgeții
pentru blocarea capului camerei.

5

Scoateți capacul și husa de pe unitate și obiectiv.6

Aliniați marcajul de montare (alb) a obiectivului cu unitatea,
introduceți cu atenție obiectivul în capul camerei și apoi rotiți
obiectivul spre dreapta până se fixează cu un clic în poziția
blocată.

7
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A: Marcaje de montare (albe)

Notă

Pentru a utiliza un obiectiv cu montură A, atașați un adaptor de montare a obiectivului
(opțiune) la unitatea la și apoi fixați obiectivul cu montură A.

Rotiți clapeta de blocare a capului camerei în direcția săgeții
pentru deblocarea capului camerei.

Notă

Până când capul camerei nu este blocat din nou, există riscul ca acesta să se miște din loc
sub acțiunea propriei greutăți. Susțineți capul camerei cu mâna în timp ce efectuați acțiunea.

8
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Mențineți echilibrul față/spate al capului camerei astfel încât baza
glisantă să fie orizontală.

Dacă utilizați unul dintre următoarele obiective, puteți să echilibrați în mare unitatea și
obiectivul consultând scala de pe baza glisantă.

Poziția scalei Denumire obiectiv

0,5 SEL70200GM (cu SEL20TC atașat)

1,7 SEL70200GM

2.0 SEL70200GM2 (cu SEL20TC atașat)

3,0 SELP28135G, SEL70200GM2

3,5 SELP18110G

3,6 SELC1635G

4,3 SEL70200G

5.0 sau mai
mult

SEL1224GM, SEL1635GM, SELP1635G, SELP18105G,
SELP1020G

Notă

Utilizați scala bazei glisante ca referință pentru echilibrarea aproximativă.

9
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Când atașați obiectivul, reglați echilibrul în mod adecvat, astfel încât unitatea să nu se încline
în spate și în față.

Reglați echilibrul pe o suprafață orizontală.

Rotiți clapeta de blocare a capului camerei în direcția săgeții
pentru blocarea capului camerei.

10

Rotiți maneta de fixare a suportului obiectivului spre stânga pentru
a slăbi unitatea suportului obiectivului.

A: Maneta de fixare a tijei suportului obiectivului (2 puncte)
B: Unitatea suportului obiectivului

11
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Deplasați unitatea suportului obiectivului astfel încât baza
suportului obiectivului să fie aliniată cu șurubul de atașare a
acesteia, apoi rotiți șurubul spre dreapta pentru a fixa baza
suportului obiectivului.

Notă

Asigurați-vă că baza suportului obiectivului este perpendiculară pe șurubul de atașare a
acesteia și apoi strângeți-l.

12

Rotiți maneta de fixare pentru șurubul de atașare a bazei
suportului obiectivului spre dreapta pentru a-l bloca.

A: Șurub de atașare a bazei suportului obiectivului
B: Orificiu pentru șurubul de atașare
C: Maneta de fixare a șurubului de atașare a bazei suportului obiectivului

Sugestie

Dacă o manetă de fixare se află într-o poziție care face dificilă rotirea, eliberați maneta și
rotiți-o într-un unghi care va facilita utilizarea. Când este în poziția dorită, închideți maneta de
fixare.

13
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[28] Pregătire Atașarea/detașarea unui obiectiv

Detașarea unui obiectiv

Detașați obiectivul urmând procedura de atașare în ordine inversă.

A: Maneta de fixare a șurubului de atașare a bazei suportului obiectivului
B: Manetă de fixare a tijei suportului obiectivului

Rotiți cele două manete de fixare a tijei suportului obiectivului spre
dreapta pentru a fixa unitatea suportului obiectivului.

14

Verificați dacă ambele manete sunt strânse și nu se mișcă liber,
dacă obiectivul este fixat bine și comutatoarele acestuia sunt
setate corect.

Dacă maneta este slăbită sau obiectivul nu este fixat bine, acesta poate să cadă și să
se deterioreze.
Când utilizați un obiectiv cu zoom electronic și montură E, obiectivul trebuie calibrat și
separat, pentru a restabili cu precizie pozițiile de zoom stocate în pozițiile presetate ale
camerei. Pentru detalii, consultați „Calibrarea unui obiectiv cu montură E”.

15

Verificați dacă panoramarea/înclinarea este blocată.1
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Notă

Prindeți obiectivul bine în mână pentru a preveni căderea acestuia.

Dacă nu se atașează imediat un alt obiectiv, atașați întotdeauna capacul corpului.

[29] Pregătire

Conectarea cablurilor

Acest subiect descrie conexiunile cablurilor.

Rotiți maneta de fixare pentru șurubul de atașare a bazei
suportului obiectivului spre stânga pentru a-l slăbi.

2

Scoateți șurubul de atașare a bazei suportului obiectivului din
unitatea suportului obiectivului și deplasați-l într-o poziție care nu
deranjează obiectivul.

3

Deblocați capul camerei și glisați-l în poziția cea mai în față.
Pentru detalii, consultați pașii 3 – 5 din „Atașarea unui obiectiv”.

4

Ţineţi apăsat butonul de decuplare a obiectivului şi rotiţi obiectivul
spre stânga în timp ce ţineţi obiectivul.

5

Când marcajele de montare (albe) ale camerei și obiectivului
aliniate, trageți obiectivul în afară și spre înainte.

6

Conectați cablurile necesare la conectorii de pe panoul din spate.
Pentru a preveni desprinderea cablului HDMI, scoateți șurubul de montare a plăcii pentru
fixarea cablului HDMI (M2.6×6, negru) din blocul de conectori și atașați placa de fixare a
cablului HDMI furnizat cu ajutorul șurubului de montare. Fixați cablul HDMI pe placa

1
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[30] Pregătire

Conectarea unității la un dispozitiv din rețea prin cablu

Acest subiect descrie conectarea unității la un dispozitiv din rețea prin cablu.

pentru fixarea cablului HDMI cu ajutorul unui colier sau a unei benzi pentru cablu
disponibile în comerț.

A: Șurub de montare a plăcii pentru fixarea cablului HDMI (M2.6×6, negru)
B: Colier sau bandă pentru cablu disponibilă în comerț
C: Placă pentru fixarea cablului HDMI (furnizată)

Conectați unitatea la un dispozitiv din rețea (cum ar fi un punct de
acces Wi-Fi sau un hub de comutare) folosind un cablu LAN din
categoria 5e sau alta superioară.

1
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[31] Pregătire Conectarea unei surse de alimentare

Utilizarea alimentării de la o sursă de curent alternativ

Acest subiect descrie procedura de alimentare a unității de la o sursă de curent alternativ.

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

1

Conectați adaptorul c.a. (furnizat) la conectorul DC IN al unității
video și conectați cablul de alimentare (furnizat) la o sursă de
curent alternativ.

2
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A: Conectorul DC IN
B: Cablul de alimentare
C: Adaptorul c.a.

Fixați cablul adaptorului c.a. utilizând clema de cablu dacă doriți să
preveniți deconectarea cablului.
Deblocați clema de cablu, treceți cablul prin aceasta așa cum se indică mai jos și blocați
clema.

A: Clema de cablu
B: Blocarea clemei de cablu
C: Cablul adaptorului c.a.

3

Verificați dacă lampa POWER de pe partea din față a unității trece
de la verde intermitent la verde continuu și dacă procedura de
pornire s-a încheiat.
Când unitatea pornește normal și se conectează la rețea, lampa NETWORK se va
aprinde în verde.

4
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Notă

Nu utilizați niciun alt adaptor c.a. sau cablu de alimentare în afară de cele furnizate odată cu
unitatea. Conectarea altui adaptor sau cablu de alimentare poate provoca un incendiu sau o
defecțiune.

Nu conectați și nu folosiţi un adaptor c.a. într-un spaţiu îngust, cum ar fi între perete şi mobilier.

Nu scurtcircuitați părțile metalice ale fișei adaptorului de curent alternativ. Acest lucru poate provoca
o defecţiune.

Conectați adaptorul c.a. la cea mai apropiată sursă de alimentare c.a. Dacă apare o problemă în
timpul funcționării, deconectați imediat cablul de alimentare de la sursa de curent alternativ.

Când deconectaţi adaptorul pentru c.a. de la unitate, apucaţi conectorul şi trageţi-l drept în afară.
Tragerea cablului poate provoca o defecţiune.

[32] Pregătire Conectarea unei surse de alimentare

Utilizarea alimentării prin PoE++

Când unitatea este conectată la un dispozitiv de alimentare compatibil cu PoE++, unitatea este
alimentată printr-un cablu de rețea disponibil în comerț.
Această metodă permite furnizarea energiei către unitate fără a fi necesare cabluri de
alimentare în medii unde nu există nicio priză lângă locația de montare.

Când utilizați un obiectiv care nu acceptă operația de panoramare/înclinare, blocați
clapeta de blocare a panoramării/înclinării și treceți peste pașii următori. Pentru detalii
despre obiectivele care acceptă panoramarea/înclinarea, contactați reprezentanța de
service Sony locală.

Glisați clapeta de blocare a panoramării/înclinării în poziția
UNLOCK pentru a debloca panoramarea/înclinarea capului
camerei.

5

Resetați panoramarea/înclinarea.
Pentru detalii, consultați „Resetarea panoramării/înclinării”.

6
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Notă

Când alimentarea este asigurată prin PoE++, funcțiile de înregistrare și redare nu pot fi utilizate cu
suportul de înregistrare introdus în unitate.

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

1

Conectați unitatea și un dispozitiv de alimentare compatibil cu
PoE++ utilizând un cablu de rețea disponibil în comerț.

A: Cablul de rețea
B: Dispozitiv de alimentare compatibil cu PoE++

2

Verificați dacă lampa POWER de pe partea din față a unității trece
de la verde intermitent la verde continuu și dacă procedura de
pornire s-a încheiat.

3
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Notă

Unitatea respectă IEEE802.3bt, tipul 4, clasa 8. Pentru detalii despre dispozitivele de alimentare
compatibile cu PoE++, contactați reprezentanța de service Sony locală.

Unitatea este compatibilă cu autentificarea soft (LLDP), dar poate fi necesar să configurați
dispozitivele din rețea (conform IEEE802.3bt).

Nu conectați un adaptor c.a. când utilizați alimentarea prin PoE++ cu autentificarea soft (LLDP)
activată.

Dacă un adaptor c.a. și dispozitivul de alimentare prin PoE++ sunt conectate simultan, alimentarea
este asigurată prin adaptorul c.a.

Când furnizați alimentarea prin PoE++, utilizați un cablu de rețea din categoria 5e sau alta
superioară.

Așteptați aproximativ 10 secunde după repornirea unității când este alimentată prin PoE++.

Când utilizați alimentarea prin PoE++, conectați terminalul de împământare la masă.

La conectarea la alimentarea prin PoE++, nu treceți firele prin zone în aer liber.

Când unitatea pornește normal și se conectează la rețea, lampa NETWORK se va
aprinde în verde.

Notă

Când alimentarea este asigurată prin PoE++, autentificarea inițială este efectuată în
intervalul dinaintea finalizării procedurii de pornire.

Când utilizați un obiectiv care nu acceptă operația de panoramare/înclinare, blocați clapeta
de blocare a panoramării/înclinării și treceți peste pașii următori. Pentru detalii despre
obiectivele care acceptă panoramarea/înclinarea, contactați reprezentanța de service Sony
locală.

Glisați clapeta de blocare a panoramării/înclinării în poziția
UNLOCK pentru a debloca panoramarea/înclinarea capului
camerei.

4

Resetați panoramarea/înclinarea.
Pentru detalii, consultați „Resetarea panoramării/înclinării”.

5
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[33] Pregătire

Resetarea panoramării/înclinării

Puteți să resetați panoramarea/înclinarea, de exemplu, când înlocuiți obiectivul, urmând
procedura de mai jos.

[34] Pregătire Configurarea înainte de captură Inițializarea unității utilizând aplicația web

Glisați clapeta de blocare a panoramării/înclinării în poziția
UNLOCK și verificați dacă panoramarea/înclinarea capului camerei
este deblocată.

1

Executați funcția de resetare a panoramării/înclinării.
Resetarea panoramării/înclinării poate fi executată de pe telecomanda cu infraroșu, din
aplicația web sau telecomanda RM-IP500 (opțiune).
Operarea utilizând telecomanda cu infraroșu: apăsați butonul P/T RESET.

Operarea utilizând telecomanda cu infraroșu: apăsați butonul P/T RESET.
Operarea utilizând aplicația web: apăsați butonul [Pan-Tilt Reset] din fila  (Others)
de pe ecranul de operare în timp real.
Operarea utilizând telecomanda RM-IP500: consultați instrucțiunile de utilizare pentru
telecomanda RM-IP500.

Notă

Executarea resetării panoramării/înclinării determină rotirea capul camerei și a obiectivului.
Verificați dacă obiectivul nu este obstrucționat înainte de executare.

Unitatea are o funcție care limitează intervalul de panoramare/înclinare, dar aceasta este
dezactivată când unitatea este pornită sau când se execută resetarea panoramării/înclinării.

Sugestie

Când resetarea panoramării/înclinării este finalizată, unitatea revine în poziția dinainte de
executarea acesteia.

2
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Accesarea aplicației web dintr-un browser

Conectând unitatea la o tabletă sau un computer, puteți să controlați sau să configurați unitatea
dintr-un browser.

Verificați dacă tableta sau computerul acceptă operațiile din
aplicația web.

Element Cerință

Display

Se recomandă un model cu
1080×810 pixeli sau altul superior
Dimensiunea afișajului tabletei:
se recomandă un model de 10
inch sau mai mare

Sistemul de
operare și
browserul acceptat

Windows

Sistem de
operare

Windows 10 sau o versiune
ulterioară

Browser Google Chrome

Mac

Sistem de
operare

macOS 10.15 sau o versiune
ulterioară

Browser
Google Chrome
Safari

iPad

Sistem de
operare

iPadOS 15 sau o versiune
ulterioară

Browser
Google Chrome
Safari

Android

Sistem de
operare

Android 12 sau o versiune
ulterioară

Browser Google Chrome

Notă

1
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Dacă nu sunt îndeplinite cerințele obligatorii privind mediul sau în funcție de utilizarea
tabletei/computerului, afișarea imaginilor video în browser poate fi afectată negativ.

Aplicația web a acestei unități utilizează JavaScript. Dacă utilizați software antivirus pe
tabletă/computer, pagina web poate să nu fie afișată corect.

Verificați dacă unitatea, tableta sau computerul și dispozitivele
periferice sunt pornite.

2

Verificați dacă unitatea și tableta sau computerul sunt conectate
prin Wi-Fi sau conexiunea LAN locală cu fir.

3

Conectați-vă la unitate din browserul tabletei sau computerului.
Conectarea utilizând un cod QR
Scanați codul QR imprimat pe capacul media de pe partea laterală a unității utilizând
camera tabletei.

Deschideți linkul afișat pe tabletă.
Browserul de pe tabletă se deschide și afișează ecranul aplicației web al unității.

Conectarea prin introducerea unui URL în bara de adresă a unui browser
Deschideți browserul pe tabletă sau computer și introduceți URL-ul de pe capacul media
de pe latura unității.
Browserul ar trebui să afișeze ecranul aplicației web al unității.

Conectarea prin introducerea adresei IP a unității în bara de adresă a unui browser

4
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Notă

Dacă numărul portului HTTP s-a schimbat de la valoarea 80, introduceți „http://adresa IP a
unității:număr port” în bara de adresă.

La conectarea cu un cod QR sau introducând URL-ul în bara de adresă a browserului, utilizați un
dispozitiv care acceptă mDNS*.

Sugestie

Ulterior puteți accesa unitatea rapid cu ajutorul funcției de marcaje a browserului.

[35] Pregătire Configurarea înainte de captură Inițializarea unității utilizând aplicația web

Inițializarea unității

Asigurați-vă că configurați unitatea urmând procedura următoare când utilizați unitatea prima
dată.

Sugestie

Dacă bateria de rezervă se descarcă complet, trebuie să refaceți configurarea inițială.

Deschideți browserul pe tabletă sau computer și introduceți „http://adresa IP a unității” în
bara de adresă.
Browserul ar trebui să afișeze ecranul aplicației web al unității.

mDNS: un protocol de comunicare utilizat pentru a stabili adresa IP de la un nume de gazdă pe o rețea locală.*

Conectați-vă la unitate de pe o tabletă sau computer și deschideți
aplicația web.
Când unitatea este utilizată prima dată, vi se va cere să introduceți un nume de utilizator
și parola în browserul web. Configurați setările de mai jos.

Nume de utilizator: admin
Parolă: (lăsați necompletat)

Urmați instrucțiunile de pe ecran pentru a realiza configurarea inițială.

1



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 114/464

Introduceți numele de utilizator al administratorului (Administrator)
și parola și apăsați butonul [OK].

1: Introduceți numele de utilizator al administratorului.
2: Setați parola administratorului.
3: Reintroduceți aceeași parolă pentru confirmare.

Notă

Se pot utiliza următoarele caractere pentru numele de utilizator și parolă. Parola trebuie să
includă cel puțin o literă mare, o literă mică, o cifră și să aibă între 8 și 64 de caractere
lungime.

Caractere alfanumerice
Simboluri (!$%`*+-./<=>?@[]^_{|}~)

Browserul se va reîncărca și vi se va cere să introduceți numele de utilizator și parola.

2

Introduceți numele de utilizator și parola care au fost configurate la
pasul 2.
Apare ecranul pentru configurarea limbii și a ceasului.

3
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Apare ecranul de operare în timp real pentru operațiuni de captură. Continuați să configurați
operarea de bază a unității în funcție de modul de operare.

Specificați următoarele elemente și apăsați butonul [OK].
[Language]
Selectați limba pe care doriți să o utilizați în Aplicația web și pe afișajul de pe ecranul
camerei. Schimbarea limbii va schimba limba afișajului Aplicației web.
[Date & Time Format]
Selectați formatul de afișare a datei și orei dintre opțiunile de mai jos.
[yyyy-mm-dd hh:mm:ss], [mm-dd-yyyy hh:mm:ss], [dd-mm-yyyy hh:mm:ss]
[y] indică anul, [m] indică luna, [d] indică ziua, [h] indică ora, [m] indică minutul și respectiv
[s] indică secunda.
[12 h/24 h]
Selectați [12 h] (formatul cu 12 ore) sau [24 h] (formatul cu 24 de ore) pentru afișarea
ceasului.
[Time Setting]
Selectați metoda de setare a datei/orei.
[Synchronize with PC]: sincronizare cu data/ora computerului sau tabletei.
[Manual setting]: setați manual. Când este selectată această metodă, câmpurile de
introducere pentru dată și oră vor dispărea.
[Time Zone]
Selectați fusul orar.

4
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[36] Pregătire Configurarea înainte de captură

Configurarea operării de bază

Acest subiect descrie cum se configurează unitatea pentru operații de bază.

Setarea modului de înregistrare a imaginilor

Puteți să comutați modul de captură între „modul Custom” pentru a crea imagini la fața locului în
mod flexibil și „modul Cine EI” pentru a utiliza unitatea ca pe o cameră de filmare cu montaj
realizat în post-producție.
Comutați modul de captură cu [Project] > [Base Setting] > [Shooting Mode] din meniul web sau
meniul camerei.

Modul Custom
În modul de captură Custom, puteţi selecta standardul video.
Comutați cu [Project] > [Base Setting] > [Target Display] din meniul web sau meniul camerei.
[SDR(BT.709)]: captură conform standardului pentru transmisia HD
[HDR(HLG)]: captură conform standardului de difuzare 4K de generație următoare

Pentru detalii, consultați „Prezentarea generală a aspectelor” și alte subiecte din „Captura
cu aspectul dorit”.

Modul Cine EI
Când modul de filmare este setat la modul Cine EI, selectați spațiul de culoare de bază pentru
semnalul de înregistrare și de ieșire. Spațiul de culoare selectat aici este spațiul de culoare al
ieșirii video atunci când [MLUT] este setat la [Off].
Comutați cu [Project] > [Cine EI Setting] > [Color Gamut] din meniul camerei.
[S-Gamut3.Cine/SLog3]: gamă de culori ușor de reglat pentru cinematografia digitală (DCI-
P3).
[S-Gamut3/SLog3]: gamă largă de culori Sony care acoperă spațiul de culori ITU-R BT.2020.

Pentru detalii, consultați „Captura cu ajustarea aspectului în post-producție”.

Notă

În modul Cine EI, funcțiile de mai jos nu pot fi reglate automat (urmărire).
Echilibru de alb
Amplificare
Shutter
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În modul Cine EI, setările pentru funcțiile de mai jos nu pot fi modificate.

ISO sensitivity/gain (setați la base ISO sensitivity (fix))
Setările meniului [Paint/Look] (cu excepția Base Look)
Scene File (dezactivat)

Funcțiile următoare sunt disponibile doar în modul Cine EI.
Monitor LUT
Exposure Index

Sugestie

În modul Cine EI, captura are loc la sensibilitatea ISO de bază fără a utiliza amplificarea pentru a
maximiza performanța senzorului de imagine. Luminozitatea este ajustată utilizând iluminatul și
filtrul ND pentru a regla cantitatea de lumină care ajunge la senzorul de imagine.

Setarea frecvenței sistemului

Comutați cu [Project] > [Rec Format] > [Frequency] din meniul web sau meniul camerei.
Unitatea poate reporni automat după comutare, în funcție de valoarea selectată.

Notă

Nu puteți comuta frecvența sistemului în timpul înregistrării sau redării.

Setarea modului de scanare a imaginii

Puteți seta dimensiunea efectivă a imaginii și rezoluția senzorului de imagine.
Comutați cu [Project] > [Rec Format] > [Imager Scan Mode] din meniul web sau meniul
camerei.
[FF]: dimensiunea cadrului întreg.
[S35]: dimensiunea super de 35 mm.

Notă

Nu puteți comuta modul de scanare a imaginilor în timpul înregistrării sau al redării.

Când este setat la S35, formatul video este limitat la 1920×1080.

Setarea codecului
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Puteți să setați codecul pentru înregistrare.
Comutați cu [Project] > [Rec Format] > [Codec] din meniul web sau meniul camerei.

Notă

Nu puteți comuta codecul în timpul înregistrării sau al redării.

Setarea formatului video

Puteți să setați formatul video pentru înregistrare și formatul de ieșire de la cameră.

Setați formatul video pentru înregistrare utilizând [Project] > [Rec Format] > [Video Format]
din meniul web sau meniul camerei.
Comutați formatul de ieșire de la conectorii SDI OUT și HDMI OUT, utilizând [Monitoring] >
[Output Format] din meniul web sau meniul camerei.

Notă

Nu puteți comuta formatul video în timpul înregistrării sau al redării.

Se pot aplica restricții pentru semnalul de la conectorii SDI OUT și HDMI OUT, în funcție de setarea
formatului video.

[37] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Cardurile de memorie acceptate

Unitatea înregistrează audio și video pe carduri de memorie CFexpress Type A (disponibile
separat) sau carduri de memorie SDXC (disponibile separat) introduse în sloturile pentru
carduri. Cardurile de memorie sunt utilizate și pentru înregistrarea proxy.

Carduri de memorie CFexpress Type A

Utilizați cardurile de memorie Sony CFexpress Type A* enumerate în „Suporturi media
recomandate” pentru unitate.
Pentru detalii despre operațiunile cu suporturi media de la alți producători, consultați
instrucțiunile de utilizare pentru suportul media sau consultați informațiile producătorului.
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Carduri de memorie SDXC

Utilizați cardurile de memorie SDXC* enumerate în „Suporturi media recomandate” pentru
unitate.

Suporturi media recomandate

Condițiile de operare garantate vor varia în funcție de setările Rec Format și Recording.

CFexpress Type A
Conform VPG400
Acceptat pentru toate formatele de înregistrare ale unității.

SDXC
Acceptat în condițiile indicate în tabelul de mai jos. „Da” indică faptul că funcționarea a fost
verificată și „Nu” că funcționarea nu este garantată.

RAW Out & XAVC-I, 4096×2160 clasa 300, modul normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

24P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

Denumite „carduri CFexpress” în acest Ghid de asistență.*

Denumite „carduri SD” în acest Ghid de asistență.*



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 120/464

RAW Out & XAVC-I, 3840×2160 clasa 300, modul normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

RAW Out & XAVC-I, 3840×2160 clasa 300, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da

RAW Out & XAVC-I, 3840×2160 clasa 300, S&Q (100 cps, 120 cps)
Suporturile media verificate nu sunt disponibile.

XAVC-I, 4096×2160 clasa 300, modul Normal
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

24P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

XAVC-I, 4096×2160 clasa 300, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

24P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da

XAVC-I, 3840×2160 clasa 300, modul Normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

XAVC-I, 3840×2160 clasa 300, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da

XAVC-I, 3840×2160 clasa 300, S&Q (100 cps, 120 cps)
Suporturile media verificate nu sunt disponibile.

XAVC-I, 1920×1080 clasa 100, modul Normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Da Da

50P Nu Nu Nu Nu Nu Da Da
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

29.97P Nu Nu Da Nu Da Da Da

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Da Nu Da Da Da

XAVC-I, 1920×1080 clasa 100, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Da Da

50P Nu Nu Nu Nu Nu Da Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

XAVC-I, 1920×1080 clasa 100, S&Q (100 cps, 120 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Nu Da

50P Nu Nu Nu Nu Nu Nu Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da
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XAVC-I, 1920×1080 clasa 100, S&Q (150 cps, 180 cps)
Suporturile media verificate nu sunt disponibile.

XAVC-I, 1920×1080 clasa 100, S&Q (200 cps, 240 cps)
Suporturile media verificate nu sunt disponibile.

XAVC-L, 3840×2160 420, modul Normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Da Nu Da Da Da

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Da Nu Da Da Da

XAVC-L, 3840×2160 420, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Nu Da

XAVC-L, 3840×2160 420, S&Q (100 cps, 120 cps)
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Da Da

50P Nu Nu Nu Nu Nu Da Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Nu

XAVC-L, 1920×1080 HD50, modul Normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Da Nu Da Da Da

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Da Nu Da Da Da

XAVC-L, 1920×1080 HD50, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29.97P Nu Nu Da Nu Da Da Da
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Da Nu Da Da Da

XAVC-L, 1920×1080 HD50, S&Q (100 cps, 120 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da

XAVC-L, 1920×1080 HD50, S&Q (150 cps, 180 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Da Da

50P Nu Nu Nu Nu Nu Da Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da
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XAVC-L, 1920×1080 HD50, S&Q (200 cps, 240 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Nu Nu Nu Da Da

50P Nu Nu Nu Nu Nu Da Da

29.97P Nu Nu Nu Nu Nu Nu Da

25P Nu Nu Nu Nu Nu Nu Da

23,98P Nu Nu Nu Nu Nu Nu Da

XAVC-L, 1920×1080 HD35, modul Normal

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da

29.97P Da Da Da Da Da Da Da

25P Da Da Da Da Da Da Da

23,98P Da Da Da Da Da Da Da

XAVC-L, 1920×1080 HD35, S&Q (60 cps sau mai puțin)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Da Da Da Da Da Da Da

50P Da Da Da Da Da Da Da
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Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

29.97P Nu Nu Da Nu Da Da Da

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Da Nu Da Da Da

XAVC-L, 1920×1080 HD35, S&Q (100 cps, 120 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Da Nu Da Da Da

25P Nu Nu Da Nu Da Da Da

23,98P Nu Nu Nu Nu Nu Da Da

XAVC-L, 1920×1080 HD35, S&Q (150 cps, 180 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Da Da
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XAVC-L, 1920×1080 HD35, S&Q (200 cps, 240 cps)

Frecvența
sistemului

Clasa
10 U1 U3 VSC

V10
VSC
V30

VSC
V60

VSC
V90

59.94P Nu Nu Da Nu Da Da Da

50P Nu Nu Da Nu Da Da Da

29.97P Nu Nu Nu Nu Nu Da Da

25P Nu Nu Nu Nu Nu Da Da

23,98P Nu Nu Nu Nu Nu Nu Da

[38] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Introducerea cardurilor de memorie

Acest subiect descrie măsurile de precauție care trebuie luate la introducerea cardurilor de
memorie.

Deschideți capacul suportului media al secțiunii slotului pentru
card.

1

Introduceţi un card de memorie.
Pentru cardurile CFexpress, eticheta este orientată în sus.

2
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Notă

Cardul de memorie, slotul pentru carduri de memorie și datele de imagine de pe cardul de memorie
pot fi deteriorate dacă forțați cardul în slot cu orientarea greșită.

Când înregistrați pe suporturi media introduse în ambele sloturi CFexpress Type A/SD A și B,
introduceți suportul media în ambele sloturi recomandate pentru a funcționa cu formatul
înregistrării.

Notă

Pe o unitate montată pe tavan, eticheta este orientată în jos.

Pentru cardurile SD, eticheta este orientată în jos.

Notă

Pe o unitate montată pe tavan, eticheta este orientată în sus.

Indicatorul de acces luminează în roșu, apoi se schimbă în verde dacă poate fi utilizat
cardul.

Notă

Dacă indicatorul de acces se aprinde intermitent în roșu în mod continuu și nu devine verde,
opriți temporar unitatea și scoateți și reintroduceți cardul de memorie.

Închideţi capacul suportului media.3
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[39] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Scoaterea unui card de memorie

Deschideţi capacul suportului media al secţiunii de slot pentru card şi apăsaţi uşor cardul de
memorie pentru a scoate cardul.

Notă

În cazul în care unitatea este oprită sau cardul de memorie este scos în timp ce accesați cardul de
memorie, nu poate fi garantată integritatea datelor de pe card. Toate datele înregistrate pe card pot
fi eliminate. Asigurați-vă întotdeauna că indicatorul de acces este verde sau stins înainte de a opri
unitatea sau de a scoate cardul de memorie.

Când scoateţi un card de memorie imediat după ce aţi terminat de înregistrat, cardul de memorie
poate fi fierbinte, însă acest lucru nu indică o problemă.

[40] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Formatarea (inițializarea) cardurilor de memorie

Dacă este introdus un card de memorie neformatat sau un card de memorie formatat pentru
alte specificații, pe panoul cu imaginea camerei este afișat mesajul „Media Needs to be
Formatted” (Suportul media trebuie formatat).
Formatați cardul folosind procedura următoare.

Selectați [TC/Media] > [Format Media] din meniul camerei.1

Selectaţi Media(A) (slot A) sau Media(B) (slot B), apoi selectaţi
metoda de formatare (Full Format sau Quick Format).
Apare un mesaj de confirmare.
[Full Format]: inițializează complet suportul media, inclusiv regiunea de date și
informațiile legate de gestionarea datelor.
[Quick Format]: inițializează informațiile legate de gestionarea datelor numai pentru
suportul media.

2

Selectați [Execute].3
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Notă

Formatarea unui card de memorie șterge toate datele, inclusiv datele video înregistrate și fișierele
de configurare.

În timpul execuţiei pot apărea mesaje, în funcţie de durata procesului de formatare.

Dacă formatarea eșuează
Cardurile de memorie care nu sunt acceptate de unitate nu pot fi formatate.
Este afișat un mesaj de avertizare. Urmaţi instrucţiunile pentru a înlocui cardul cu un card de
memorie acceptat.

Pentru a utiliza un card formatat în unitate în slotul altui dispozitiv
Mai întâi, faceți o copie de rezervă a cardului, apoi reformatați cardul în dispozitivul care va fi
utilizat.

[41] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Verificarea timpului de înregistrare rămas

În timpul capturii (înregistrare/standby), puteți monitoriza capacitatea rămasă a cardului de
memorie din fiecare slot utilizând indicatoarele pentru sloturile A/B pentru capacitatea rămasă a
suporturilor media, pe panoul cu imaginea camerei.
Timpul rămas de înregistrare este calculat pe baza capacității rămase a suportului media din
fiecare slot și a formatului de înregistrare curent (rata de biți de înregistrare) și este afișat în
minute.

Sincronizarea înlocuirii cardului de memorie
Când timpul de înregistrare total rămas pe cele două carduri de memorie devine mai mic de 5
minute, apare mesajul „Media Near Full” (Suporturi media aproape pline) și lampa de
înregistrare/semnalizare începe să lumineze intermitent pentru a vă va avertiza.
Înlocuiți cu un suport media care are spațiu liber.
Dacă veți continua înregistrarea până când timpul total rămas de înregistrare ajunge la zero,
mesajul se schimbă în „Media Full” (Suporturi media pline) și înregistrarea se oprește.

Un mesaj este afișat în timp ce formatarea este în curs, iar indicatorul de acces luminează
în roșu.
Când formatarea se încheie, apare un mesaj de finalizare.
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Notă

Pe un card de memorie pot fi înregistrate maximum 600 de clipuri.

[42] Pregătire Configurarea înainte de captură Pregătirea cardurilor de memorie

Restaurarea cardurilor de memorie

Dacă din orice motiv apare o eroare la un card de memorie, cardul trebuie să fie restaurat
înainte de utilizare.
Când încărcați un card de memorie care trebuie restaurat, pe panoul cu imaginea camerei
apare un mesaj în care sunteți întrebat dacă doriți să îl restaurați.

Pentru restaurarea unui card
Selectați [Execute] utilizând butoanele cu săgeți din panoul de control GUI și apăsați butonul
[Set].
Un mesaj și starea de progres (%) sunt afișate în timp ce formatarea este în curs, iar indicatorul
de acces este aprins în roșu.
Când restaurarea se încheie, apare un mesaj de finalizare.

Dacă restaurarea eșuează
Cardurile de memorie pe care au apărut erori de memorie nu pot fi restaurate. Este afișat un
mesaj de avertizare. Urmaţi instrucţiunile pentru a înlocui cardul de memorie.
Cardurile de memorie pe care au apărut erori de memorie pot deveni utilizabile dacă sunt
reformatate.
În unele cazuri, unele clipuri pot fi restaurate, altele nu. Clipurile restaurate pot fi redate
normal.

Notă

Pentru restaurarea suporturilor media înregistrate cu această unitate, asigurați-vă că utilizați
această unitate.

Suporturile media înregistrate cu un dispozitiv diferit de această unitate sau cu o altă versiune a
acestei unități (chiar cu același model) nu pot fi restaurate folosind această unitate.

Clipurile mai scurte de 2 secunde nu pot fi restaurate.
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[43] Captura Operarea de bază

Începerea/oprirea înregistrării

Acest subiect descrie cum se pornește/oprește înregistrarea.

Notă

Înregistrarea și redarea nu sunt acceptate când unitatea este alimentată prin PoE++.

Conectați dispozitivele necesare și verificați dacă unitatea și
dispozitivele periferice sunt alimentate.

1

Introduceţi cardul (cardurile) de memorie.2

Verificați starea alimentării unității indicată în colțul din stânga sus
al ecranul aplicației web.
Când alimentarea este activă
Când unitatea este pornită, se afișează mesajul [Power ON] pe comutatorul de alimentare
din partea de sus a ecranului aplicației web.

Lampa POWER se aprinde pe partea din față a unității și apare imaginea camerei pe
ecranul de operare în timp al aplicației web.

Notă

Dacă parola administratorului nu a fost configurată, apare un ecran care vă solicită să o
configurați. Consultați „Inițializarea unității”.

Când alimentarea este în starea de standby
Când alimentarea unității este în starea de standby, se afișează [Power Standby] pe
comutatorul de alimentare din aplicația web.

3
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În această stare, apăsați comutatorul de alimentare și selectați [Power ON]. Unitatea
pornește, lampa POWER se aprinde pe partea din față a unității și apare imaginea
camerei pe ecranul de operare în timp al aplicației web.

Sugestie

De asemenea, puteți porni unitatea și cu ajutorul butonului de pornire de pe telecomanda cu
infraroșu furnizată.

Apăsați butonul record START/STOP.
Înregistrarea începe și lampa de înregistrare/semnalizare (2 locuri) a unității se aprinde.
În timpul înregistrării, butonul record START/STOP se aprinde. De asemenea, se afișează
o pictogramă pentru suportul de înregistrare țintă și [●Rec].

4
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Pentru a comuta sursa de alimentare a unității în starea standby
Apăsați comutatorul de alimentare din aplicația web și selectați [Power Standby] pentru a seta
alimentarea unității la starea de standby.

Sugestie

Pentru a opri înregistrarea, apăsaţi din nou butonul de
PORNIRE/OPRIRE a înregistrării.
Înregistrarea se oprește și lampa de înregistrare/semnalizare (2 locuri) a unității se stinge.
În starea de standby a înregistrării, butonul record START/STOP nu este aprins. De
asemenea se afișează o pictogramă pentru suportul de înregistrare destinație și [Stby].

Sugestie

Puteți porni/opri înregistrarea și utilizând butonul record START/STOP de pe telecomanda cu
infraroșu furnizată.

5
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De asemenea, puteți seta alimentarea la starea de standby și cu ajutorul butonului de pornire de pe
telecomanda cu infraroșu furnizată.

[44] Captura Operarea de bază

Comutarea între cardurile de memorie

Când sunt introduse două carduri de memorie, puteți să apăsați butonul [Slot Select] de pe
panoul de control al redării al aplicației web pentru a comuta între cardurile de memorie.

Sugestie

De asemenea, puteți să apăsați butonul SLOT SEL (de selectare a slotului cardului de memorie
(A)/(B)) de pe telecomanda cu infraroșu furnizată pentru a comuta între cardurile de memorie.

Despre înregistrarea succesivă

În timpul înregistrării, unitatea trece automat la al doilea card de memorie, chiar înainte de
reducerea la zero a capacității rămase pe primul card (înregistrare succesivă). Puteți continua
să înregistrați fără întrerupere atunci când comutați între cardurile de memorie, prin înlocuirea
cardului de memorie plin cu un card de memorie nou.

Notă

Nu puteți comuta între cardurile de memorie în modul de redare. De asemenea, redarea continuă a
unui clip aflat pe suportul media din slotul A și slotul B nu este acceptată.

Despre datele înregistrate

Când opriţi înregistrarea, datele video, audio şi însoţitoare de la începutul până la sfârşitul
înregistrării sunt salvate ca un singur „clip” pe un card de memorie.

Denumirea clipului cu date înregistrate
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Denumirea fiecărui clip înregistrat de unitate este atribuită automat utilizând opțiunea
[TC/Media] > [Clip Name Format] din meniul camerei.

Durata maximă a clipurilor

Până la 6 ore pe clip.
Durata maximă a înregistrării continue este aceeași cu durata maximă a unui clip. Dacă timpul
de înregistrare depășește durata maximă a unui clip, un clip nou este creat automat și
înregistrarea continuă. Noul clip apare ca un clip separat pe ecranul miniatural.
Mai multe clipuri sunt înregistrate succesiv în timpul înregistrării continue, dar înregistrarea se
va opri automat după aproximativ 24 de ore.

Notă

Nu scoateţi un card de memorie în timp ce este utilizat pentru înregistrare. Când înregistrați,
schimbați numai cardurile de memorie din sloturile al căror indicator de acces este stins.

Când capacitatea rămasă pe cardul de memorie pe care se înregistrează este mai mică de un
minut și în celălalt slot este introdus un card de memorie înregistrabil, apare mesajul „Will Switch
Slots Soon” (Comutare la celălalt slot în curând). Mesajul dispare după comutarea sloturilor pentru
carduri de memorie.

Este posibil ca înregistrarea continuă să nu funcționeze dacă înregistrarea este pornită atunci când
capacitatea rămasă a cardului de memorie este mai mică de un minut. Pentru o înregistrare
continuă corectă, verificați capacitatea rămasă a cardului de memorie, pentru a vedea dacă este
mai mare de un minut, înainte de a începe înregistrarea.

Filmările create cu funcția de înregistrare succesivă a unității nu pot fi redate continuu pe unitate.

Pentru a combina filmările create cu funcția de înregistrare succesivă a unității, utilizați software-ul
„Catalyst Browse”.

[45] Captura Operarea de bază

Verificarea sunetului

Sunetul este transmis de conectorii SDI și HDMI ai unității. Selectați combinația de canale audio
pentru ieșire de la conectorul HDMI utilizând opțiunea [Audio] > [Audio Output] > [HDMI/Stream
Output CH] din meniul camerei.
CH1/CH2: combinație între CH1 și CH2
CH3/CH4: combinație între CH3 și CH4
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La monitorizarea sunetului din aplicația web, utilizați contorul pentru nivelul audio din partea din
dreapta jos a imaginii camerei.

[46] Captura

Specificarea datelor de timp

Acest subiect descrie cum se setează datele privind ora.

Setarea codului de timp

Setați codul de timp de înregistrat utilizând opțiunea [TC/Media] > [Timecode] din meniul
camerei.

Setarea biților de utilizator

Puteți adăuga un număr hexazecimal de 8 cifre pe imaginea înregistrată, ca biți de utilizator. De
asemenea, puteți seta biții de utilizator la ora curentă. Setați utilizând opțiunea [TC/Media] >
[Users Bit] din meniul camerei.

Afișarea datelor de timp

Setați codul de timp de afișat, utilizând opțiunea [TC/Media] > [TC Display] > [Display Select]
din meniul camerei.
Apăsarea unui buton alocabil, căruia i-a fost atribuită opțiunea [DURATION/TC/U-BIT], va
comuta succesiv afișajul între codul de timp, biții de utilizator și durată.

[47] Captura

Revizualizarea înregistrării (Rec Review)

Puteți revizualiza ultimul clip înregistrat pe ecran (revizualizarea înregistrării).
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Notă

Rec Review nu este acceptat dacă formatul video este modificat după înregistrarea unui clip.

Setarea poziției de pornire pentru Rec Review

Puteți să setați poziția de pornire pentru redare la una dintre valorile de mai jos, utilizând
opțiunea [Technical] > [Rec Review] din meniul camerei.

Ultimele 3 secunde ale clipului
Ultimele 10 secunde ale clipului
Începutul clipului

Sugestie

Dacă doriți să examinați un anumit clip după înregistrarea mai multor clipuri, apăsați butonul
[Thumbnail] a afișa ecranul cu miniaturi și selectați clipul pentru a începe redarea.

De asemenea, puteți să apăsați butonul THUMBNAIL de pe telecomanda cu infraroșu furnizată
pentru a afișa ecranul cu miniaturi.

Metoda Rec Review

Atribuiți dinainte funcția Rec Review unuia dintre butoanele alocabile de pe panoul de ajustare a
configurației de bază.

Pentru detalii despre alocare, consultați „Butoanele alocabile” din „Funcții utile”.

Opriți înregistrarea și apoi apăsați pe un buton alocabil căruia i-a fost atribuită funcția Rec
Review pentru a începe redarea clipului înregistrat anterior.
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Clipul este redat până la sfârșit, Rec Review se încheie, iar unitatea revine la modul Stby
(standby).

Oprirea Rec Review
Apăsați butonul alocabil, căruia i-a fost atribuită funcția Rec Review sau apăsați butonul
[Cancel/Back].
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Sugestie

De asemenea, puteți să apăsați butonul [Cancel/Back] de pe telecomanda cu infraroșu furnizată
pentru a opri funcția Rec Review.

[48] Captura Reglarea încadrării

Ecranul de reglare a încadrării

Încadrarea este ajustată utilizând elementele de mai jos ale ecranului de operare în timp real.
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Notă

În funcție de direcția camerei, distanța focală a obiectivului și poziția zoomul, poate fi vizibilă o parte
a unității sau a cablurilor conectate la blocul de conectori. Înainte de captură, verificați câmpul
vizual al obiectivului și distanța focală pe care le utilizați. De asemenea, puteți să controlați
intervalul de panoramare/înclinare utilizând opțiunea [Pan-Tilt] > [P/T Range Limit] din meniul web.
Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a
limitei intervalului este ignorată. Pentru detalii, consultați [Pan-Tilt] > [P/T Range Limit] din meniul
web.

Sugestie

De asemenea, puteți controla încadrarea utilizând telecomanda cu infraroșu furnizată.

[49] Captura Reglarea încadrării Reglarea direcției de înregistrare

Panoul de control al pozițiilor presetate1.

Fila (Main)/fila (Others)2.

Panoul de control al încadrării3.
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Reglarea direcției de înregistrare utilizând aplicația
web

Deplasarea camerei în plan orizontal se numește panoramare, iar deplasarea camerei în plan
vertical se numește înclinare.
Puteți să reglați direcția de captură cu operațiile de panoramare/înclinare.

Sugestie

Dacă se afișează [Execute Pan-Tilt Reset] sub joystick, a apărut o inconsecvență în informațiile
despre originea controlului panoramării/înclinării unității. Executați funcția de resetare a
panoramării/înclinării pentru a actualiza informațiile despre origine. Pentru detalii, consultați
„Resetarea panoramării/înclinării”.

Pentru a reorienta camera spre înainte
Apăsați butonul [Pan-Tilt Home] de pe fila  (Others) din panoul de control al camerei.

Notă

Apăsați pe fila [Pan-Tilt-Zoom] din panoul de control al încadrării
pentru a afișa joystickul.

1

Trageți centrul joystickului în direcția pe care doriți s-o vedeți și în
același timp urmăriți panoul cu imaginea camerei.
Direcția și viteza camerei se schimbă în funcție de direcția și nivelul la care trageți.
Puteți să reglați panoramarea/înclinarea cu mai multă precizie apăsând pe zonele
periferice ale joystickului.

2
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În funcție de direcția camerei, distanța focală a obiectivului și poziția zoomul, poate fi vizibilă o parte
a unității sau a cablurilor conectate la blocul de conectori. Înainte de captură, verificați câmpul
vizual al obiectivului și distanța focală pe care le utilizați. De asemenea, puteți să controlați
intervalul de panoramare/înclinare utilizând opțiunea [Pan-Tilt] > [P/T Range Limit] din meniul web.
Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a
limitei intervalului este ignorată. Pentru detalii, consultați [Pan-Tilt] > [P/T Range Limit] din meniul
web.

[50] Captura Reglarea încadrării Reglarea direcției de captură

Setarea vitezei de operare pentru panoramare/înclinare

Puteți să modificați viteza de operare pentru panoramare/înclinare cu glisorul [Pan-Tilt Speed]
din panoul de control al camerei acționând joystickul din panoul de control al încadrării.

Apăsați pe fila  (Main) din panoul de control al camerei.1

Selectați glisorul [Pan-Tilt Speed] din listă.
Dacă glisorul [Pan-Tilt Speed] nu este afișat, selectați unul dintre cele două butoanele de
selectare cu funcție de glisare, pentru a afișa glisorul.

2

Deplasați indicatorul glisorului la stânga sau la dreapta.
Deplasarea indicatorului glisorului la stânga reduce viteza de operare, iar deplasarea
acestuia la dreapta mărește viteza de operare.

3
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Notă

Dacă există un perete sau alt obstacol în aria de panoramare a camerei, atenție să nu fie lovită
camera sau obiectivul în timpul operației de panoramare/înclinare.

Accelerarea panoramării/înclinării depinde de caracteristicile fizice, cum ar fi echilibrul greutății
obiectivului. Puteți schimba setarea pentru accelerare utilizând opțiunea [Pan-Tilt] > [P/T
Acceleration] > [Ramp Curve] din meniul web sau meniul camerei.

[51] Captura Reglarea încadrării Reglarea direcției de captură

Setarea accelerării operației de panoramare/înclinare

Puteți seta accelerarea operației în nouă trepte, utilizând opțiunea [Pan-Tilt] > [P/T Acceleration]
> [Ramp Curve] din meniul web sau meniul camerei. Măriți valoarea pentru schimbări mai
rapide ale vitezei sau reduceți viteza pentru schimbări mai graduale ale vitezei.
Pentru o viteză mai mare de răspuns la utilizarea panoramării/înclinării, selectați o valoarea
între 7 și 9.
Pentru o mai mare precizie a poziționării la începutul/sfârșitul mișcării într-o poziție presetată, se
recomandă o valoare între 1 și 6.

Pentru detalii despre poziția presetată, consultați „Salvarea/restaurarea poziției de
panoramare/înclinare și zoom”.

Notă

Când valoarea setată este mare, este posibil ca funcția să nu acționeze corect dacă este atașat un
obiectiv greu. Verificați operarea înainte de utilizarea efectivă.

Relația dintre setarea [Ramp Curve] și operația de panoramare/
înclinare

Când este utilizată panoramarea/înclinarea
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Când este reapelată o poziție presetată

[52] Captura Reglarea încadrării Reglarea direcției de înregistrare
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Reglarea direcției de captură utilizând telecomanda cu
infraroșu furnizată

Puteți să reglați direcției de captură utilizând butoanele de acționare a panoramării/înclinării de
pe telecomanda cu infraroșu furnizată.

Pentru a reorienta camera spre înainte
Apăsați butonul HOME (Pagină de pornire).

Notă

În funcție de direcția camerei, distanța focală a obiectivului și poziția zoomul, poate fi vizibilă o parte
a unității sau a cablurilor conectate la blocul de conectori. Înainte de captură, verificați câmpul
vizual al obiectivului și distanța focală pe care le utilizați. De asemenea, puteți să controlați
intervalul de panoramare/înclinare utilizând opțiunea [Pan-Tilt] > [P/T Range Limit] din meniul web.
Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a

Apăsați butoanele cu săgeți pentru a controla panoramarea/
înclinarea.
Apăsați butonul cu săgeata în direcția pe care doriți s-o vedeți și în același timp urmăriți
imaginea camerei.
Pentru deplasarea pe o distanță scurtă, apăsați scurt butonul cu săgeată.
Pentru deplasarea pe o distanță lungă, apăsați lung butonul cu săgeată.
Pentru deplasarea pe diagonală, apăsați lung butonul  (săgeată sus) sau  (săgeată
jos) și butonul  (săgeată stânga) au  (săgeată dreapta).

1
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limitei intervalului este ignorată. Pentru detalii, consultați [Pan-Tilt] > [P/T Range Limit] din meniul
web.

[53] Captura Reglarea încadrării Reglarea zoomului

Setarea tipului de zoom

Setați tipul de zoom utilizând opțiunea [Technical] > [Zoom] > [Zoom Type] din meniul camerei.
Tipul de zoom va varia în funcţie de tipul de obiectiv ataşat.

Tipul de obiectiv atașat
Setarea [Zoom Type]

[Optical Zoom Only] [On(Clear Image Zoom)]

Obiectiv cu focalizare
fixă/obiectiv cu zoom
manual

Acționarea zoomului
nu este acceptată.

Este acceptată tehnologia Clear
Image Zoom.

Obiectiv cu zoom electronic
Este acceptat doar
zoomul optic.

Sunt acceptate zoomul optic şi
tehnologia Clear Image Zoom.

Notă

Tehnologia Clear Image Zoom nu este disponibilă în următoarele cazuri.
Când opțiunea [Shooting] > [S&Q Motion] > [Setting] este setată la On și setarea pentru [Frame
Rate] din meniul camerei este mai mare de 60 cps
Când opțiunea [Project] > [Rec Format] > [Codec] din meniul camerei este setată la [RAW] sau la
o altă opțiune care include formatul RAW

Prin operarea comutatorului de selectare SERVO/MANUAL pe un obiectiv se resetează factorul de
mărire Clear Image Zoom la 1×.

În timpul utilizării tehnologiei Clear Image Zoom, zona de focalizare este setată pe Wide. De
asemenea, focalizarea automată cu detecția feței/ochilor este dezactivată.

Când este activă setarea [On(Clear Image Zoom)], funcția de presetare a panoramării/înclinării este
dezactivată.

Clear Image Zoom
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Unitatea este echipată cu o funcție de zoom care utilizează tehnologia numită Clear Image
Zoom pentru procesarea semnalului de imagine. Când tehnologia Clear Image Zoom este
activată, zoomul este acceptat chiar și pentru obiectivele cu focalizare fixă. Se poate utiliza şi
pentru a extinde raza de acţiune dincolo de raza optică a unui obiectiv cu zoom puternic.
Raportul de zoom maxim cu utilizarea tehnologiei Clear Image Zoom variază în funcţie de
rezoluţia de înregistrare.

Pentru înregistrare în rezoluția QFHD/4K: 1,5×
Pentru înregistrare în rezoluția HD: 2×

[54] Captura Reglarea încadrării Reglarea zoomului

Reglarea zoomului cu aplicația web

Puteți să reglați zoomul unității utilizând zoomul optic sau tehnologia Clear Image Zoom. Acest
subiect descrie cum se realizează reglajele cu ajutorul aplicației web. Pentru detalii despre
tehnologia Clear Image Zoom, consultați „Setarea tipului de zoom”.

Notă

În funcție de direcția camerei, distanța focală a obiectivului și poziția zoomul, poate fi vizibilă o parte
a unității sau a cablurilor conectate la blocul de conectori. Înainte de captură, verificați câmpul

Apăsați pe fila [Pan-Tilt-Zoom] din panoul de control al încadrării
pentru a afișa panoul de control pentru panoramare/înclinare.

1

Deplasați glisorul [Zoom] în direcția [T] (teleobiectiv) sau [W]
(superangular) pentru a regla zoomul.

2
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vizual al obiectivului și distanța focală pe care le utilizați. De asemenea, puteți să controlați
intervalul de panoramare/înclinare utilizând opțiunea [Pan-Tilt] > [P/T Range Limit] din meniul web.
Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a
limitei intervalului este ignorată. Pentru detalii, consultați [Pan-Tilt] > [P/T Range Limit] din meniul
web.

[55] Captura Reglarea încadrării Reglarea zoomului

Setarea vitezei de operare pentru zoom

Puteți schimba viteza de operare pentru zoom a glisorului [Zoom] din panoul de control al
încadrării utilizând glisorul [Zoom Speed] din panoul de control al camerei.

Apăsați pe fila  (Main) din panoul de control al camerei.1

Selectați glisorul [Zoom Speed] din listă.
Dacă glisorul [Zoom Speed] nu este afișat, selectați unul dintre cele două butoanele de
selectare cu funcție de glisare, pentru a afișa glisorul.

 

2

Deplasați indicatorul glisorului [Zoom Speed] la stânga sau la
dreapta.
Deplasarea indicatorului glisorului la stânga reduce viteza de operare, iar deplasarea
acestuia la dreapta mărește viteza de operare.

3
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[56] Captura Reglarea încadrării Reglarea zoomului

Reglarea zoomului utilizând telecomanda cu infraroșu
furnizată

Puteți să reglați zoomul unității utilizând zoomul optic sau tehnologia Clear Image Zoom. Acest
subiect descrie cum se realizează reglajele cu ajutorul telecomenzii cu infraroșu furnizată.
Pentru detalii despre tehnologia Clear Image Zoom, consultați „Setarea tipului de zoom”.

Notă

În funcție de direcția camerei, distanța focală a obiectivului și poziția zoomul, poate fi vizibilă o parte
a unității sau a cablurilor conectate la blocul de conectori. Înainte de captură, verificați câmpul
vizual al obiectivului și distanța focală pe care le utilizați. De asemenea, puteți să controlați
intervalul de panoramare/înclinare utilizând opțiunea [Pan-Tilt] > [P/T Range Limit] din meniul web.
Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a
limitei intervalului este ignorată. Pentru detalii, consultați [Pan-Tilt] > [P/T Range Limit] din meniul
web.

Apăsați butonul de zoom pentru a regla zoomul.
Apăsați butonul T (teleobiectiv) sau W (superangular) și în același timp monitorizați
ecranul pentru reglarea zoomului.
Pentru mărire, apăsați pe butonul T.
Pentru micșorare, apăsați pe butonul W.

1
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[57] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Calibrarea unui obiectiv cu montură E

Calibrarea compensează diferențele privind poziția de zoom din cauza diferențelor între
obiectivele individuale când se utilizează un obiectiv cu zoom electronic și montură E.
Pentru a calcula cu precizie poziția de zoom, calibrați obiectivul pentru a compensa diferențele
individuale ale obiectivului, urmând procedura următoare.

Date de calibrare
În unitate pot fi salvate datele de calibrare pentru maximum cinci obiective. Cele mai vechi
date vor fi suprascrise când este calibrat al 6-lea obiectiv sau următorul.
Puteți verifica dacă datelor de calibrare sunt disponibile pentru obiectivul atașat apăsând
butonul  (stare cameră) din zona comună a ecranului aplicației web și selectând [Lens] >
[Calibration Data].

[58] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

În cazul în care obiectivul are un comutator SERVO/MANUAL,
setați-l în poziția SERVO.

Notă

Obiectul nu va putea primi instrucțiuni pentru zoom de la unitate când comutatorul este setat
la MANUAL.

1

Rulați calibrarea utilizând opțiunea [Technical] > [Lens] > [Lens
Calibration] din meniul camerei.
În timpul calibrării, obiectivul cu zoom se mișcă automat și este măsurat.

2
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Salvarea/restaurarea poziției de panoramare/
înclinare/zoom și a setării de focalizare cu aplicația
web

Puteți să salvați poziția de panoramare/înclinare și zoom și setarea de focalizare și să le
reapelați când este necesar utilizând aplicația web.

Pentru detalii despre elementele care pot fi salvate/restaurate, consultați „Elementele
salvate în pozițiile presetate”.

Notă

Această funcție este dezactivată când opțiunea [Technical] > [Zoom] > [Zoom Type] este setată la
[On(Clear Image Zoom)] din meniul camerei

Dacă setarea [Pan-Tilt] > [P/T Direction] [Ceiling] din meniul web este schimbată, toate pozițiile
presetate salvate sunt șterse.

Stabiliți poziția pe care doriți să o salvați utilizând operațiile de
panoramare/înclinare și zoom.

1

Apăsați butonul [+] din panoul de control al pozițiilor presetate.
Imaginea cu poziția salvată este afișată în panoul de control al pozițiilor presetate.

2
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[59] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Redenumirea pozițiilor presetate cu aplicația web

Puteți redenumi pozițiile presetate.

Sugestie

Dacă panoul de control al pozițiilor presetate nu este afișat, apăsați butonul  (Open)
pentru a-l afișa.

Pozițiile sunt salvate în ordine, începând de la [Preset1].

Dacă există presetări neutilizate într-o secvență de presetări, pozițiile vor fi salvate începând
cu presetările neutilizate. De exemplu, dacă pozițiile presetate sunt salvate în [Preset1] și
[Preset3] dar nu și în [Preset2], următoarele poziții presetate vor fi salvate în [Preset2] și apoi
în [Preset4].

Pot fi salvate până la 100 de poziții presetate.

Puteți redenumi fiecare poziție presetată. Pentru detalii, consultați „Redenumirea pozițiilor
presetate cu aplicația web”.

Restaurați o poziție salvată.
Apăsați de două ori pe miniatura poziției pe care doriți să o restaurați în panoul de control
al pozițiilor presetate pentru a restaura poziția respectivă.

Sugestie

De asemenea, puteți să restaurați o poziție apăsând pe imagine și apoi pe butonul 
(meniul pozițiilor presetate), care apare, și selectând [Recall].

Viteza de tranziție la poziția salvată este stabilită de setarea [Pan-Tilt] > [P/T Preset] >
[Common Speed] din meniul web de când a fost salvată poziția. Puteți schimba viteza de
tranziție și după salvare. Pentru detalii, consultați „Schimbarea vitezei de tranziție a pozițiilor
presetate”.

Gradul de schimbare din poziția de panoramare/înclinare când se trece la o poziție presetată
poate fi ajustat utilizând setările pentru viteza de tranziție și [Ramp Curve]. Pentru detalii,
consultați „Schimbarea vitezei de tranziție a pozițiilor presetate” și „Setarea accelerării
operației de panoramare/înclinare”.

3
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[60] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Înlocuirea unei poziții salvate cu alta nouă utilizând
aplicația web

Puteți înlocui o poziție salvată cu alta nouă.

[61] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Apăsați poziția presetată pe care doriți s-o redenumiți.
Butonul  (meniul pozițiilor presetate) apare în partea dreaptă sus a imaginii.

1

Apăsați butonul  (meniul pozițiilor presetate) și selectați
[Rename] din meniul afișat.

2

Introduceți un nume nou pentru presetare.3

Stabiliți poziția pe care doriți să o salvați utilizând operațiile de
panoramare/înclinare și zoom.

1

Apăsați pe imaginea poziției pe care doriți s-o înlocuiți în panoul
de control al pozițiilor presetate.
Butonul  (meniul pozițiilor presetate) apare în partea dreaptă sus a ecranului.

2

Apăsați butonul  (meniul pozițiilor presetate) și selectați
[Replace] din meniul afișat.
Noua poziție înlocuiește setarea curentă.

3
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Ștergerea unei poziții salvate utilizând aplicația web

Puteți șterge pozițiile presetate.

[62] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Schimbarea vitezei de tranziție a pozițiilor presetate

Puteți să schimbați viteza de tranziție la restaurarea unei poziții salvate .

Apăsați pe imaginea poziției pe care doriți s-o ștergeți în panoul de
control al pozițiilor presetate.
Butonul  (meniul pozițiilor presetate) apare în partea dreaptă sus a imaginii.

1

Apăsați butonul  (meniul pozițiilor presetate) și selectați [Delete]
din meniul afișat.
Poziția salvată este ștearsă.

2

Setați opțiunea [Pan-Tilt] > [P/T Preset] > [Speed Select] la
[Separate] în meniul web.

1

Apăsați imaginea poziției pentru care doriți să schimbați viteza de
tranziție din panoul de control al pozițiilor presetate.
Butonul  (meniul pozițiilor presetate) apare în partea dreaptă sus a imaginii.

2

Apăsați butonul  (meniul pozițiilor presetate) și selectați [Speed]
din meniul afișat.

3

Selectați viteza de tranziție dorită.4
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Sugestie

Când opțiunea [Pan-Tilt] > [P/T Preset] > [Speed Select] este setată la [Common], toate pozițiile vor
fi restaurate la viteza setată utilizând [Pan-Tilt] > [P/T Preset] > [Common Speed].

[63] Captura Reglarea încadrării Salvarea/restaurarea poziției camerei pentru panoramare/
înclinare/zoom

Salvarea/restaurarea poziției de panoramare/înclinare
și zoom utilizând telecomanda cu infraroșu furnizată

Puteți salva poziția de panoramare/înclinare și zoom și să o reapelați când este necesar
utilizând telecomanda cu infraroșu furnizată.

Data viitoare când este restaurată o poziție salvată, camera se va deplasa la viteza
configurată.

Reglați panoramarea/înclinarea și zoomul camerei.1

Apăsați lung butonul PRESET și apăsați unul dintre butoanele de
la 1 la 3.
Poziția este salvată.

2
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[64] Captura Reglarea focalizării

Ecranul de reglare a focalizării

Focalizarea este ajustată utilizând elementele de mai jos ale ecranului de operare în timp real.

Restaurați o poziție salvată.
Apăsați unul dintre butoanele de la 1 la 3 cu o poziție salvată, pentru a restaura poziția
respectivă.

Sugestie

În cazul telecomenzii cu infraroșu, imaginea se deplasează în poziția salvată la viteză
maximă.
Puteți schimba viteza de tranziție și după salvare. Pentru detalii, consultați „Schimbarea
vitezei de tranziție a pozițiilor presetate”.

3

Panoul cu imaginea camerei1.
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[65] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Reglarea manuală utilizând aplicația web

Puteți să reglați manual focalizarea, de exemplu, în cazurile următoare.

Subiecți ascunși parțial în spatele picăturilor de apă
Subiecți cu contrast scăzut față de fundal
Subiecți mai îndepărtaţi decât subiecții din apropiere

Sugestie

Puteți să reglați focalizarea atingând imaginea camerei. Puteți să dezactivați operarea
tactilă dezactivând comutatorul [Touch Focus] din fila  (Focus) din panoul de control al
camerei.
Panoul de control al camerei  fila (Focus)2.

Panoul de control GUI3.

Dacă obiectivul este echipat cu un comutator de selectare a
focalizării, setați comutatorul în poziția „AF/MF” sau „AF”.

Notă

În cazul în care comutatorul este setat la poziția „Full MF” sau „MF”, focalizarea obiectivului
nu poate fi acționată de pe unitate. Consultați „Reglarea focalizării pentru obiectivele cu
comutator de focalizare” din „Verificarea comutatoarelor obiectivului”.

1

Glisați comutatorul [Auto Focus] în poziția din stânga în panoul de
control al camerei pentru a dezactiva focalizarea automată.
Modul de focalizare manuală este activat.

 (MF)

2

Reglați ajustând glisorul din partea de jos a filei  (Focus).3
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Puteți utiliza focalizarea automată chiar și când principala metodă de operare este reglarea
manuală. Pentru detalii, consultați „Setarea manuală a țintei focalizării automate (AF Assist)
utilizând aplicația web”.

[66] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Reglarea manuală utilizând telecomanda cu infraroșu
furnizată

Puteți regla focalizarea manual, utilizând telecomanda cu infraroșu furnizată.

Sugestie

Puteți utiliza focalizarea automată chiar și când principala metodă de operare este reglarea
manuală. Pentru detalii, consultați „Focalizarea manuală în timpul focalizării automate utilizând
telecomandă cu infraroșu furnizată”.

Apăsați butonul MF de pe telecomanda cu infraroșu.1

Reglați manual focalizarea utilizând butoanele F (departe) și N
(aproape).
Pentru a focaliza pe un subiect aflat departe, apăsați butonul F.
Pentru a focaliza pe un subiect aflat aproape, apăsați butonul N.

2
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[67] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Focalizarea specificând o poziție de focalizare (Spot
Focus)

În modul de focalizare manuală, puteți specifica poziția în care doriți să reglați focalizarea în
panoul cu imaginea camerei.

Notă

Setați opțiunea [Shooting] > [Focus] > [Touch Function in MF] la
[Spot Focus] din meniul web sau meniul camerei.

1

Glisați comutatorul [Touch Focus] de pe fila  (Focus) în poziția
din dreapta pentru a-l activa.

2

Glisați comutatorul [Auto Focus] de pe fila  (Focus) în poziția
din stânga pentru a-l dezactiva.

3

Specificați poziția de focalizare.
Marcajul pentru focalizarea punctuală apare și imaginea este ajustată astfel încât să fie
focalizată în poziția respectivă.

Exemplu de specificare a poziției prin operare tactilă

4
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Funcția de focalizare punctuală nu funcționează dacă obiectivul este setat pentru focalizarea
manuală.

Sugestie

În modul de focalizare punctuală, puteți să apăsați un buton alocabil căruia i-a fost atribuită
opțiunea [Push AF/MF] pentru a opri temporar focalizarea punctuală și a activa focalizarea
automată cât timp este apăsat butonul. Focalizarea revine la focalizarea manuală atunci când
eliberați butonul.

[68] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Utilizarea temporară a focalizării automate (Push Auto
Focus (AF))

În modul de focalizare manuală, puteți să reglați focalizarea temporar utilizând focalizarea
automată prin apăsarea butonului [Push AF/MF] pentru a focaliza automat cât timp butonul este
apăsat.
Acest lucru este util atunci când doriți să mutați focalizarea lent de la un subiect la alt subiect în
timpul focalizării manuale.

Setați opțiunea [Shooting] > [Focus] > [Push AF Mode] la [AF] din
meniul camerei.

1

Glisați comutatorul [Auto Focus] de pe fila  (Focus) în poziția
din stânga pentru a-l dezactiva.

2

Apăsați butonul [Push AF/MF].
Focalizarea automată este activă cât timp este apăsat butonul.

3
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Notă

Funcția Push Auto Focus nu funcționează dacă obiectivul este setat la focalizarea manuală.

Sugestie

Aceeași operație este acceptată folosind un buton alocabil căruia i-a fost atribuită opțiunea [Push
AF/MF].

[69] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Utilizarea Single-Shot Auto Focus (Push Auto Focus
(AF-S))

Puteți să apăsați butonul [Push AF/MF] când sunteți în modul de focalizare manuală pentru a
focaliza automat la viteză mare.
Această funcție este comodă când focalizați pe un subiect înainte de captură.

Push Auto Focus este eliberat și focalizarea revine la modul manual atunci când eliberați
butonul.

Setați opțiunea [Shooting] > [Focus] > [Push AF Mode] la [Single-
shot AF(AF-S)] din meniul web sau meniul camerei.

1
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Notă

Funcția Push Auto Focus nu funcționează dacă obiectivul este setat la focalizarea manuală.

Cadrul zonei de focalizare nu este ascuns atunci când utilizați butonul [Display].

Specificați poziția pentru care doriți să reglați focalizarea utilizând
[Shooting] > [Focus] > [Focus Area (AF-S)] din meniul camerei.

Sugestie

Puteți să schimbați poziția apăsând un buton alocabil căruia i-a fost atribuită funcția [Focus
Setting] pentru a afișa un cadru portocaliu în jurul zonei de focalizare și selectând o poziție
utilizând operarea tactilă.

2

Glisați comutatorul [Auto Focus] de pe fila  (Focus) în poziția
din stânga pentru a-l dezactiva.

3

Apăsați butonul [Push AF/MF].
Dacă eliberați butonul înainte de finalizarea focalizării, funcția Push Auto Focus se
oprește.

În timpul utilizării Push Auto Focus, starea focalizării este afișată de indicatorul de
focalizare.
Aprins: focalizarea este fixată în poziția de focalizare.
Luminează intermitent: fără focalizare. Deoarece unitatea nu focalizează automat,
trebuie să schimbați compoziția și setările de focalizare pentru a obține focalizarea.
Focalizarea revine la focalizarea manuală atunci când eliberați butonul.

4
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În timpul funcționării tehnologiei Clear Image Zoom, poziția cadrului [Focus Area (AF-S)] nu poate fi
setată. Când Push Auto Focus este activă, focalizarea automată dă prioritate tot porțiunii centrale.

Sugestie

Aceeași operație este acceptată folosind un buton alocabil căruia i-a fost atribuită opțiunea [Push
AF/MF].

De asemenea, puteți atribui opțiunea [Push AF Mode] unui buton alocabil.

De asemenea, puteți atribui opțiunea [Focus Area (AF-S)] unui buton alocabil.

Puteți afișa/ascunde cadrul zonei de focalizare utilizând [Monitoring] > [Display On/Off] > [Focus
Area Ind.(AF-S)] din meniul camerei.

[70] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Reglarea automată utilizând aplicația web

Unitatea utilizează funcția Phase Detection AF pentru focalizare de mare viteză și contrast AF
pentru focalizare de mare precizie.
Combinația acestor două metode AF asigură focalizarea automată cu o viteză ridicată și o
precizie ridicată.

Dacă obiectivul este echipat cu un comutator de selectare a
focalizării, setați comutatorul în poziția „AF/MF” sau „AF”.

Notă

În cazul în care comutatorul este setat la poziția „Full MF” sau „MF”, focalizarea obiectivului
nu poate fi acționată de pe unitate. Consultați „Reglarea focalizării pentru obiectivele cu
comutator de focalizare” din „Verificarea comutatoarelor obiectivului”.

1

Glisați comutatorul [Auto Focus] în poziția din dreapta în panoul
de control al camerei pentru a-l activa.
Modul de focalizare automată este activat.

 (AF)

2
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Notă

Este necesar un obiectiv care acceptă focalizarea automată.

Este posibil să nu se obțină precizia, în funcție de condițiile de înregistrare.

Focalizarea nu poate fi reglată automat pe un obiectiv cu montură A.

Sugestie

În modul de focalizare automată, puteți să reglați focalizarea utilizând glisorul Focus de pe panoul
de control al camerei. Pentru detalii, consultați „Setarea manuală a țintei focalizării automate (AF
Assist) utilizând aplicația web”.

[71] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Reglarea automată utilizând telecomanda cu infraroșu
furnizată

De asemenea, puteți regla focalizarea automat, utilizând telecomanda cu infraroșu furnizată.

Notă

Apăsați butonul AF de pe telecomanda cu infraroșu.
Focalizarea pe un subiect este reglată automat.

1
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Puteți utiliza focalizarea automată chiar și când principala metodă de operare este reglarea
manuală. Pentru detalii, consultați „Focalizarea manuală în timpul focalizării automate utilizând
telecomandă cu infraroșu furnizată”.

[72] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Setarea zonei/poziției de focalizare automată (Focus
Area)

Puteți să setați zona țintă pentru focalizare automată și să reglați focalizarea pentru zona
respectivă.

Apăsați butonul [Menu] de pe panoul de control GUI pentru a
deschide meniul camerei.

1

Setați zona țintă pentru focalizare automată, utilizând [Shooting] >
[Focus] > [Focus Area] din meniul camerei.
[Wide]:
Caută un subiect pe un unghi larg al imaginii în timpul focalizării. Nu este afișat un cadru.

2
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Notă

Cadrul zonei de focalizare nu este ascuns atunci când utilizați butonul [Display] de pe panoul cu
imaginea camerei.

În timpul utilizării tehnologiei Clear Image Zoom, zona de focalizare este setată la [Wide.

Sugestie

Puteți afișa/ascunde cadrul zonei de focalizare, utilizând [Monitoring] > [Display On/Off] > [Focus
Area Indicator] din meniul camerei.

[Zone]:
Caută automat o poziție de focalizare în zona specificată.
După selectare, specificați poziția utilizând butoanele cu săgeți de pe panoul de control
GUI.

Puteți reveni în poziția centrală apăsând lung pe butonul [Set].
[Flexible Spot]:
Focalizează pe o poziție specificată din imagine.
După selectare, specificați poziția utilizând butoanele cu săgeți de pe panoul de control
GUI.

Puteți reveni în poziția centrală apăsând lung pe butonul [Set].
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[73] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Modificarea rapidă a zonei de focalizare (Focus
Setting)

Puteți schimba rapid poziția și dimensiunea zonei de focalizare automată în timpul capturii
alocând funcția [Focus Setting] unui buton alocabil.

Pentru detalii despre butoanele alocabile, consultați „Butoanele alocabile”.

Operațiunea variază în funcție de setarea zonei de focalizare.

Când opțiunea [Shooting] > [Focus] > [Focus Area] este setată
la [Flexible Spot] sau [Zone] din meniul camerei

Puteți schimba poziția zonei de focalizare apăsând butonul care are atribuită funcția [Focus
Setting] și efectuând ajustări cu ajutorul butoanelor cu săgeți de pe panoul de control GUI.
Puteți readuce poziția zonei de focalizare în centru când reglați poziția apăsând butonul
[Set].
Puteți modifica dimensiunea zonei de focalizare apăsând lung un buton căruia i-a fost
atribuită funcția [Focus Setting]. După modificarea dimensiunii, puteți schimba poziția zonei
focalizare apăsând butonul [Set]. După ce ați terminat, apăsați butonul căruia i-a fost
alocată funcția [Focus Setting] pentru a reveni la ecranul inițial.

Când opțiunea [Shooting] > [Focus] > [Focus Area] este setată
la [Wide] din meniul camerei

Puteți modifica dimensiunea zonei de focalizare numai apăsând lung un buton căruia i-a fost
alocată funcția [Focus Setting]. Poziția poate fi, de asemenea, modificată schimbând mai întâi
tipul la [Flexible Spot] sau [Zone].

Sugestie

Când opțiunea [Shooting] > [Focus] > [Push AF Mode] este setată la [Single-shot AF(AF-S)] din
meniul camerei și comutatorul [Auto Focus] este în poziția Off (mod de focalizare manuală), puteți
schimba poziția zonei de focalizare [Focus Area (AF-S)].
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Cadrul zonei de focalizare este afişat în culoarea portocalie atunci când poziţia zonei de focalizare
poate fi modificată.

[74] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Mutarea cadrului zonei de focalizare utilizând operarea
tactilă (Touch Focus Area)

Puteți modifica poziția zonei de focalizare apăsând un buton căruia i-a fost alocată funcția
[Focus Setting], pentru a schimba afișajul zonei de focalizare la portocaliu și apoi o puteți muta
utilizând operarea tactilă din panoul cu imaginea camerei.
Atingeţi ecranul pentru a muta zona de focalizare, cu zona de focalizare centrată pe poziţia care
a fost atinsă. Glisați pe ecran pentru a muta zona de focalizare în poziția indicată de degetul
dvs.

Sugestie

Puteți activa/dezactiva zona de focalizare tactilă pe ecranul de captură utilizând butonul căruia i-a
fost alocată funcția [Focus Setting].

Atingeți orice poziție.

Poziția pe care ați apăsat devine centrul zonei de focalizare.

1
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Notă

Dacă atingeţi o poziţie sau glisaţi zona de focalizare într-o poziţie care depăşeşte intervalul de
setare, zona de focalizare este setată la marginea de sus/de jos/din stânga/din dreapta intervalului
de setări.

Această funcţie nu este disponibilă în următoarele situaţii.

Când comutatorul [Auto Focus] este dezactivat în panoul de control al camerei
Când comutatorul [Touch Focus] este dezactivat în panoul de control al camerei
Când cadrul zonei de focalizare este afișat în gri sau nu este afișat deloc

[75] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Trageți pentru a deplasa zona de focalizare, urmând poziția
degetului.

2
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Ajustarea operării cu focalizare automată (AF
Transition Speed, AF Subject Shift Sensitivity)

Puteți să ajustați operarea cu focalizare automată schimbând viteza de tranziție și sensibilitatea
la comutarea subiectului.

Setarea vitezei de tranziție la focalizare automată

Puteți seta viteza unității de focalizare atunci când subiectul se schimbă, utilizând butonul [AF
Transition Speed] de pe panoul de control al camerei.

Selectați o viteză din intervalul dintre [Speed 1] (redusă) și [Speed 7] (ridicată) în incremente de
1. Apăsați butonul < pentru a reduce valoarea (mai lent) sau butonul > pentru a mări valoarea
(mai rapid).
Când este setată la viteză redusă, focalizarea se mișcă încet atunci când subiectul care
urmează să fie focalizat se schimbă, permițând captura unor imagini impresionant de expresive.
Când este setată la viteză mare, focalizarea comută rapid între subiecți. În exemplul de mai jos,
focalizarea se schimbă rapid de la clădirea din fundal la persoana care merge în prim-plan.
Subiectul care intră în cadru este focalizat imediat, ceea ce face această setare ideală pentru
filmarea documentarelor, care necesită focalizare rapidă.
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AF subject shift sensitivity

Puteți seta sensibilitatea de comutare între subiecți folosind butonul [AF Subj. Shift Sens.] din
panoul de control al camerei.

Selectați un nivel de sensibilitate din intervalul dintre [Sens 1] (fixă) și [Sens 5] (sensibilă) în
incremente de 1. Apăsați butonul < pentru a reduce valoarea (schimbare lentă) sau butonul >
pentru a mări valoarea (schimbare rapidă).
Când este setată la o sensibilitate scăzută, focalizarea nu se schimbă ușor chiar dacă un alt
subiect se mișcă în fața subiectului focalizat.

Când este setată la o sensibilitate ridicată, focalizarea se schimbă pentru a da prioritate
subiectului care se mișcă în față.

Sugestie

Dacă funcția [AF Speed/Sens.] este atribuită unui buton alocabil, barele de nivel pentru reglarea
valorilor sunt afișate în panoul cu imaginea camerei, în ordinea următoare, la fiecare apăsare a
butonului, permițându-vă să modificați setările vitezei de tranziție AF și ale sensibilității la
comutarea subiectului AF.
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Viteză de tranziție AF → Sensibilitatea la comutarea subiectului AF → Fără afișaj…

[76] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Setarea manuală a țintei focalizării automate (AF
Assist) utilizând aplicația web

După schimbarea și reglarea manuală a focalizării, puteți transfera controlul asupra focalizării
către funcția de focalizare automată pentru o ajustare fină.

Setați opțiunea [Shooting] > [Focus] > [AF Assist] la [On] din
meniul camerei.

1

Setați opțiunea [Shooting] > [Focus] > [AF Assist Control] la [On]
în meniul web.

2

Glisați comutatorul [Auto Focus] în poziția din dreapta în panoul
de control al camerei pentru a-l activa.
Modul de focalizare automată este activat.

3

Setați ținta focalizării utilizând glisorul [Focus] de pe panoul de
control al camerei.
[Near]: focalizați pe un subiect aflat în apropiere.
[Far]: focalizați pe un subiect aflat în depărtare.

4
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Notă

În starea de asistență la focalizarea automată, schimbarea focalizării devine dificilă, indiferent de
setarea [Shooting] > [Focus] > [AF Subj. Shift Sens.] din meniul camerei.

Starea de asistenţă pentru focalizarea automată este anulată de următoarele.
Când subiectul focalizat cu glisorul [Focus] nu mai este vizibil
Când se comută la focalizarea manuală
Când se înregistrează o faţă

Sugestie

Asistența pentru focalizarea automată poate fi anulată rapid utilizând un buton alocabil căruia i-a
fost atribuită funcția [Push AF/MF].

Acționarea glisorului [Focus] șterge selecția feței înregistrate.

În modul Face/Eye Only AF, focalizarea automată se focalizează pe fața cea mai apropiată de
poziția de focalizare a glisorului [Focus].

[77] Captura Reglarea focalizării Reglarea automată a focalizării (Auto Focus)

Focalizarea manuală în timpul focalizării automate
utilizând telecomanda cu infraroșu furnizată

Când opțiunea [Shooting] > [Focus] > [AF Assist] este setată la [On] din meniul camerei, puteți
utiliza butonul F (departe) și N (aproape) de pe telecomanda cu infraroșu furnizată chiar și în
timpul focalizării automate pentru a regla focalizarea pe un subiect.

[78] Captura Reglarea focalizării Reglarea manuală a focalizării (Manual Focus)

Utilizarea temporară a focalizării manuale în timpul
focalizării automate (Push Manual Focus)

Când este activă asistența pentru focalizarea automată, un subiect aflat la distanță, setat
cu glisorul [Focus], va fi focalizat automat.
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Apăsați butonul [Push AF/MF] când sunteți în modul de focalizare automată pentru a focaliza
manual în timp ce butonul este apăsat. Focalizarea revine la focalizarea automată atunci când
eliberați butonul.
Acest lucru vă permite să opriți temporar focalizarea automată și focalizarea manuală atunci
când ceva, care nu este subiectul fotografierii, trece prin fața subiectului.

Sugestie

Aceeași operație este acceptată folosind un buton alocabil căruia i-a fost atribuită opțiunea [Push
AF/MF].

[79] Filmarea Reglarea focalizării

Urmărirea utilizând detecția feței și a ochilor (Face/Eye
Detection AF)

Unitatea poate detecta fețele și ochii oamenilor ca țintă de urmărit și apoi poate regla
focalizarea pe fețe și pe ochi în zona de focalizare.
Când sunt detectate feţe, sunt afişate cadre gri de detectare a feţei/ochilor. Când este posibilă
focalizarea automată, cadrele devin albe și începe urmărirea. Când sunt detectaţi ochii şi
focalizarea este reglată, cadrul de detectare a feţei/ochilor este afişat pe ochi. Dacă sunt
detectate mai multe persoane, subiectul principal este determinat automat.
Această funcție este disponibilă numai atunci când modul de focalizare utilizat este AF sau
Push Auto Focus.

Sugestie

Când zona de focalizare este setată la [Zone] sau [Flexible Spot], iar fețele sau ochii se suprapun în
zona de focalizare specificată, cadrele de detecție a feței/ochilor devin albe, iar unitatea focalizează
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automat pe fețele respective/ochii respectivi.

Când se utilizează funcţia de focalizare automată prin apăsare (AF-S), cadrele de detectare a
feţelor/ochilor care sunt focalizate se schimbă în verde.

Setarea utilizând butonul [Face/Eye Detection AF] de pe panoul
de control al camerei

Apăsați butonul [Face/Eye Detection AF] și setați focalizare automată cu detecția feței/ochilor.

[Face/Eye Only AF]: camera detectează fețele/ochii subiecților (persoanelor) și focalizează și
le urmărește doar fețele/ochii acestora. Dacă nu se detectează fața sau ochii, focalizarea
automată este oprită temporar și este afișată pictograma  (focalizare automată întreruptă în
modul Face/Eye Only AF). Acest mod este eficient atunci când doriți să focalizați automat și să
urmăriți doar fețele/ochii.
[Face/Eye Priority AF]: camera detectează fețele/ochii subiecților (persoanelor) și prioritizează
focalizarea/urmărirea fețelor/ochilor. Când nu se detectează feţe sau ochi, focalizarea este în
modul AF (setarea implicită).
[AF]: funcția de focalizare automată cu detecția feței/ochilor este dezactivată.

Notă

În timpul funcționării Push Auto Focus, funcția [Face/Eye Priority AF] este activată, chiar dacă în
momentul respectiv este selectată funcția [Face/Eye Only AF].

Când comutatorul [Auto Focus] este dezactivat, focalizarea automată cu detecția feței/ochilor este
și ea dezactivată (excluzând cazul când funcționează Push Auto Focus).

Dacă opriți camera video în timp ce este selectată funcția [Face/Eye Only AF], modul comută
automat la [Face/Eye Priority AF] la următoarea pornire a camerei video.

Sugestie
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Puteți seta focalizare automată cu detecția feței/ochilor utilizând opțiunea [Shooting] > [Focus] >
[Face/Eye Detection AF] din meniul camerei.

Pentru ascunderea cadrelor de detecție a feței/ochilor
Puteți afișa/ascunde cadrele de detecție a feței/ochilor utilizând [Monitoring] > [Display On/Off] >
[Face/Eye Detection Frame] din meniul camerei.

Notă

Cadrele de detecție a feței/ochilor de culoare verde sunt afișate pentru fețele și ochii focalizați
utilizând focalizarea automată prin apăsare (AF-S) și nu sunt ascunse cu butonul [Display] sau
când funcția [Face/Eye Detection Frame] este setată la [Off].

Pentru comutarea operării focalizării automate cu detecția feței/ochilor
utilizând un buton alocabil
Atribuiți funcția [Face/Eye Detection AF] unui buton alocabil. Puteți apoi să comutați operarea
focalizării automate cu detecția feței/ochilor în ordinea [Face/Eye Priority AF], [Face/Eye Only
AF] și [AF] de fiecare dată când apăsați butonul.

Setarea folosind meniul direct

Puteți seta operarea focalizării automate cu detecția feței/ochilor utilizând și meniul direct.

Pentru detalii despre meniul direct, consultați „Utilizarea meniului direct”.

[80] Captură Reglarea focalizării

Urmărirea unui anumit subiect (Realtime Tracking AF)

Puneți menține focalizarea pe un subiect indicând subiectul prin operare tactilă sau selectând
un cadru de detecție a feței în panoul de control al camerei.
Când un subiect este selectat, este afișat un cadru de urmărire alb și urmărirea începe.

Sugestie

Urmărirea are loc pe toată suprafața imaginii, indiferent de setarea zonei de focalizare.

Când opțiunea [Shooting] > [Focus] > [Touch Function in MF] este setată la [Tracking AF] din meniul
web sau meniul camerei, focalizarea automată cu urmărire în timp real este acceptată chiar dacă
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focalizarea este în modul MF.

Au loc următoarele acțiuni pentru ținta urmărită, în funcție de setarea modului de focalizare
automată cu detecția feței/ochilor.

[Face/Eye Only AF] sau [Face/Eye Priority AF]: focalizarea și urmărirea subiectului indicat.
Dacă ținta urmărită este o persoană și este detectată o față/un ochi, camera focalizează pe
acea față/acel ochi.
Când este detectată o țintă urmărită (față/ochi), fața țintă de urmărit este salvată. După salvare,
este afișată pictograma  (față de urmărit salvată).

Notă

Dacă focalizarea automată cu urmărire începe în timpul focalizării manuale, fața țintă de urmărit nu
este salvată.

[AF]: focalizarea și urmărirea subiectului indicat. Detecția feței/ochilor nu are loc chiar dacă
ținta urmărită este o persoană.

Notă

Funcția Realtime Tracking AF (focalizare automată cu urmărire în timp real) nu este activă dacă
obiectivul este setat la focalizarea manuală.

Începerea focalizării automate cu urmărire în timp real

Când un anumit subiect este specificat drept țintă de urmărit, începe urmărirea acelei ținte.

Indicarea prin operare tactilă
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Glisați comutatorul [Touch Focus] de pe fila  (Focus) de pe panoul de control al camerei în
poziția din dreapta pentru a-l activa, apoi atingeți subiectul țintă pentru a urmări în oricare dintre
stările de mai jos.

În timpul focalizării manuale sau a focalizării manuale temporare și când opțiunea [Shooting]
> [Focus] > [Touch Function in MF] este setată la [Tracking AF] din meniul web sau meniul
camerei
În timpul focalizării automate sau al focalizării automate prin apăsare (AF)

Indicarea prin selectarea cadrului de detecție a fețelor
Deplasați cursorul pentru selectarea feței (subliniat cu portocaliu) pe subiectul țintă utilizând
butoanele cu săgeți de pe panoul de control GUI și apăsați butonul [Set].

A: Cadre de detecție a fețelor (gri)
B: Cadru de urmărire
C: Cursor de selectare a feței (portocaliu)

Notă

În timpul focalizării manuale, urmărirea nu poate începe prin selectarea cadrului de detecție a feței.

Sugestie

De asemenea, puteți să modificați ținta urmărită în timpul focalizării automate cu urmărire în timp
real.

Oprirea focalizării automate cu urmărire în timp real

Apăsați butonul  (oprirea focalizării automate cu urmărire în timp real).
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Sugestie

Focalizarea automată cu urmărire în timp real se va opri în următoarele cazuri:

Când comutatorul [Auto Focus] sau controlul AUTO/MANUAL de pe obiectiv este comutat
Când modul de focalizare este schimbat
Când se execută AF Assist
Când setarea zonei de focalizare sau acțiunea de focalizare automată cu detecția feței/ochilor
este schimbată
Când este apăsat un buton alocabil căruia i s-a atribuit funcția [Push AF/MF]
Când ținta urmărită nu este pe ecranul de captură sau când subiectul nu este focalizat câteva
secunde

Când față de urmărit este salvată (când se afișează  (față de urmărit salvată)), focalizarea
automată cu urmărire în timp real va fi reluată când fața urmărită salvată apare din nou în imagine.
Pentru a șterge fața de urmărit, opriți focalizarea automată cu urmărire în timp real descrisă mai
sus.

[81] Captura Reglarea luminozității

Ecranul de reglare a luminozității

Puteți ajusta luminozitatea prin reglarea diafragmei, amplificării, timpului de expunere și a
nivelului de lumină folosind filtrele ND de pe panourile de control de mai jos, de pe ecranul de
operare în timp real al aplicației web. Puteți regla luminozitatea și automat.
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Notă

Amplificarea nu poate fi reglată când opțiunea [Shooting Mode] este setată la [Cine EI]. De
asemenea, luminozitatea nu poate fi reglată automat folosind timpul de expunere. Reglarea
automată a luminozității folosind diafragma și filtrul ND este acceptată.

Sugestie

Modul Cine EI este destinat capturii la sensibilitatea de bază fără a utiliza amplificarea pentru a
maximiza performanța senzorului de imagine. Luminozitatea este ajustată utilizând iluminatul și
filtrul ND pentru a regla cantitatea de lumină care ajunge la senzorul de imagine. Pentru detalii

Panoul de control al camerei –  fila (Main)1.

Panoul de configurare de bază a camerei
Afișează starea setărilor pentru funcțiile de bază necesare pentru captură pe butoane.
Apăsați un buton pentru a afișa ecranul de configurare corespunzător pentru fiecare funcție
de pe panoul de ajustare a configurației de bază a camerei, de mai jos.

2.

Panoul de ajustare a configurației de bază a camerei
Afișează panoul de ajustare pentru elementul de configurat, selectat pe panoul de
configurare de bază a camerei.

3.
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despre indexul de expunere (El), consultați „Modificarea distribuției zonelor întunecate și luminoase
în imaginile înregistrate”.

[82] Captura Reglarea luminozității

Setarea sensibilității de bază

Puteți să setați sensibilitatea de bază înainte de a începe să reglați luminozitatea.

Când opțiunea [Shooting Mode] este setată la [Custom]

Apăsați butonul [ISO/Gain] de pe panoul de configurare de bază a camerei și setați opțiunea
[Base Sensitivity] de pe panoul de reglare a amplificării/ISO la [High] sau [Low].
Selectați [Low] în condiții de lumină normală și selectați [High] în condiții de lumină redusă.
Ecranul când opțiunea [AGC] este dezactivată

Ecranul când opțiunea [AGC] este activată

Când opțiunea [Shooting Mode] este setată la [Cine EI]



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 185/464

Apăsați butonul [Base ISO/Exposure Index] de pe panoul de configurare de bază a camerei și
setați opțiunea [Base ISO] de pe panoul de reglare a nivelului ISO de bază/indexului expunerii
la [ISO 12800] sau [ISO 800].
Selectați [ISO 800] în condiții de lumină normală și selectați [ISO 12800] în condiții de lumină
redusă.

Sugestie

Se poate seta și de pe fila  (Main) din panoul de control al camerei.

Se poate seta și utilizând [Shooting] > [ISO/Gain/EI] > [Base Sensitivity] sau [Base ISO] din meniul
camerei.

Puteți, de asemenea, să atribuiți opțiunea [Base ISO/Sensitivity] unui buton alocabil.

[83] Captura Reglarea luminozității

Setarea nivelului țintă pentru reglarea automată a
luminozității

Nivelul țintă pentru reglarea automată a luminozității se setează utilizând glisorul [AE Level] în
panoul de control al camerei.

Apăsați pe fila  (Main) din panoul de control al camerei.
Dacă glisorul [AE Level] nu este afișat, selectați unul dintre cele două butoanele de
selectare cu funcție de glisare și selectați glisorul [AE Level] din listă.

1
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[84] Captura Reglarea luminozității Reglarea diafragmei

Reglarea automată a diafragmei

Puteți să reglați luminozitatea automat în funcție de subiect. Este necesar un obiectiv
compatibil.

Apare glisorul [AE Level].

Setați nivelul țintă cu ajutorul glisorului.
Deplasați indicatorul glisorului spre stânga pentru a face imaginea mai întunecată.
Deplasați indicatorul glisorului spre dreapta pentru a face imaginea mai luminoasă.

Sugestie

Se poate seta și utilizând opțiunea [Shooting] > [Auto Exposure] > [Level] din meniul
camerei.

2

Dacă este atașat un obiectiv cu un comutator Auto Iris, setați
comutatorul la AUTO.

1

Apăsați butonul [Iris] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [Iris] devine portocaliu.

2
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Notă

Diafragma nu poate fi reglată automat pe un obiectiv cu montură A.

Sugestie

Puteți, de asemenea, să atribuiți [Auto Iris] unui buton alocabil.

[85] Captura Reglarea luminozității Reglarea diafragmei

Reglarea manuală a diafragmei

Puteți regla luminozitatea și manual.

Apare panoul de reglare a diafragmei.

Glisați comutatorul [Auto] în poziția din dreapta pentru a-l activa.

Diafragma trece în modul de reglare automată. Valoarea reglată automat pentru
diafragmă este afișată în partea dreaptă a comutatorului.

3

Dacă este atașat un obiectiv cu un comutator Auto Iris, setați
comutatorul la AUTO.

Notă

1
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Atunci când comutatorul Auto Iris al obiectivului este setat la MANUAL, funcțiile [Auto Iris] și
[Push Auto Iris] de pe unitate nu au niciun efect. De asemenea, nici ajustările manuale ale
diafragmei de pe unitate nu au niciun efect.

Apăsați butonul [Iris] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [Iris] devine portocaliu.

Apare panoul de reglare a diafragmei.

2

Glisați comutatorul [Auto] în poziția din stânga pentru a-l
dezactiva.

Diafragma trece în modul de reglare manuală.

3

Reglați diafragma utilizând glisorul [Iris] sau butoanele de reglare
[Iris].

Sugestie

Setările glisorului și ale butoanelor de reglare sunt conectate.

De asemenea, puteți atribui diafragma glisorului de pe fila  (Main) din panoul de control al
camerei.

4
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Pentru reglarea automată temporară a irisului
De asemenea, puteți să apăsați butonul [Push Auto] de pe panoul de reglare a diafragmei
pentru a regla diafragma automat în timp ce este apăsat butonul.

Sugestie

Apăsați butonul alocabil căruia îi este atribuită funcția [Push Auto Iris] pentru a regla automat
diafragma în timp ce este apăsat butonul.
Diafragma revine în modul manual când eliberați butonul.

[86] Captura Reglarea luminozității Reglarea amplificării

Reglarea automată a amplificării

Puteți să reglați automat luminozitatea utilizând setarea pentru amplificare când opțiunea
[Shooting Mode] este setată la [Custom].

Setați opțiunea [Project] > [Shooting Mode] la [Custom] în meniul
web sau meniul camerei.

1

Apăsați butonul [ISO/Gain] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [ISO/Gain] devine portocaliu.

Apare panoul de reglare a nivelului ISO/amplificării.

2

Glisați comutatorul [AGC] în poziția din dreapta pentru a-l activa.3
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[87] Captura Reglarea luminozității Reglarea amplificării

Reglarea manuală a amplificării

Puteți să reglați manual luminozitatea utilizând setarea pentru amplificare când opțiunea
[Shooting Mode] este setată la [Custom].
Puteți controla amplificarea atunci când doriți să reglați expunerea în timp ce folosiți o setare
fixă a diafragmei sau când doriți să împiedicați creșterea amplificării, generată de AGC.

Amplificarea trece în modul de reglare automată. Valoarea reglată automat pentru
amplificare este afișată în partea dreaptă a comutatorului.

Sugestie

Puteți efectua aceeași acțiune setând opțiunea [Shooting] > [Auto Exposure] > [AGC] la [On]
în meniul camerei.

Puteți, de asemenea, să atribuiți [AGC] unui buton alocabil.

Setați opțiunea [Project] > [Shooting Mode] la [Custom] în meniul
web sau meniul camerei.

1

Apăsați butonul [ISO/Gain] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [ISO/Gain] devine portocaliu.

Apare panoul de reglare a nivelului ISO/amplificării.

2
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Reglarea manuală temporară a amplificării
De asemenea, puteți să reglați amplificarea temporar atribuind funcția [ISO/Gain] unui buton de
selectare cu funcție de glisare de pe fila  (Main) din panoul de control al camerei și utilizând
glisorul respectiv.
Acest lucru este util atunci când doriți să reglați expunerea cu un pas fără a modifica
profunzimea câmpului.
Rezultatul reglării revine la valoarea presetată configurată utilizând [ISO/Gain<L>] după
efectuarea oricăror dintre operațiilor de mai jos.

Schimbarea elementelor de reglare a nivelului ISO/amplificării
Comutarea sensibilității de bază
Setarea comutatorului AGC la poziția On
Comutarea sursei de alimentare a unității în standby

Reglarea automată temporară a amplificării utilizând un buton alocabil
Apăsați butonul alocabil căruia îi este atribuită funcția [Push AGC] pentru a regla automat
amplificarea în timp ce este apăsat butonul.
Amplificarea revine la modul manual când eliberați butonul.

Glisați comutatorul [AGC] în poziția din stânga pentru a-l
dezactiva.

Amplificarea trece în modul de reglare manuală.

3

Reglați amplificarea utilizând glisorul [ISO/Gain] sau butoanele de
reglare [ISO/Gain].

Sugestie

Setările glisorului și ale butoanelor de reglare sunt conectate.

4
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Rezultatul reglării revine la valoarea presetată configurată utilizând [ISO/Gain<L>] după
efectuarea oricăror dintre operațiilor de mai jos.

Schimbarea elementelor de reglare a nivelului ISO/amplificării
Comutarea sensibilității de bază
Setarea comutatorului AGC la poziția On
Comutarea sursei de alimentare a unității în standby

Notă

Această funcție nu poate fi executată când opțiunea [Shooting] > [Iris] > [Bokeh Control] este setată
la [On] din meniul camerei.

[88] Captura Reglarea luminozității Reglarea obturatorului

Reglarea automată a obturatorului

Puteți să reglați automat obturatorul în funcție de luminozitatea imaginii.

Apăsați butonul [Shutter] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [Shutter] devine portocaliu.

Apare panoul de reglare a obturatorului.

1

Apăsați butonul [Shutter Type] și selectați [Auto] din listă.

Sugestie

Puteți efectua aceeași acțiune setând opțiunea [Shooting] > [Auto Exposure] > [Auto Shutter]
la [On] din meniul camerei.

2
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[89] Captura Reglarea luminozității Reglarea obturatorului

Reglarea manuală a obturatorului

Puteți regla obturatorul și manual.

Puteți, de asemenea, să atribuiți [Auto Shutter] unui buton alocabil.

Apăsați butonul [Shutter] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [Shutter] devine portocaliu.

Apare panoul de reglare a obturatorului.

1

Apăsați butonul [Shutter Type] și selectați [Speed] din listă.2

Reglați obturatorul utilizând glisorul [Speed] sau butoanele de
reglare [Speed].

Pentru a ajusta timpul de expunere pentru a se potrivi intervalului cadrului, selectați [Off]
la pasul 2. Puteți seta și o valoarea fixă utilizând [ECS] (frecvență) sau automat reglând cu
[Auto].
Exemplu: setați utilizând [ECS] (frecvență)

3
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[90] Captura Reglarea luminozității Reglarea nivelului de lumină (filtrul ND)

Despre filtrul ND

În condițiile în care iluminatul este prea puternic, puteți seta luminozitatea corespunzătoare
schimbând filtrul ND.
Când înregistraţi un subiect iluminat puternic, închiderea excesivă a diafragmei poate provoca
estomparea difracției, producând o imagine care începe să piardă focalizarea (fenomene tipice
la camerele video). Puteți suprima acest efect pentru a obține înregistrări mai bune, folosind
filtrul ND.
Unitatea dispune de următoarele moduri pentru filtrul ND.
Modul presetat

Consultați „Reglarea în modul presetat”.

Modul variabil (reglare automată)

Consultați „Reglarea automată în modul variabil”.

Modul variabil (reglare manuală)

Consultați „Reglarea manuală în modul variabil”.

[91] Captura Reglarea luminozității Reglarea nivelului de lumină (filtrul ND)

Sugestie

Setările glisorului și ale butoanelor de reglare sunt conectate.

Pentru a utiliza [Angle] în loc de [Speed] sau [Off], setați opțiunea [Shooting] > [Shutter] >
[Mode] la [Angle] din meniul camerei.
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Reglarea în modul presetat

Puteți să selectați trei valori pentru transmitanța filtrului ND dinainte și comuta rapid între ele în
timpul capturii.

Sugestie

Când este apăsat butonul alocabil căruia i-a fost atribuită funcția [ND Filter Position], filtrul ND este
schimbat în secvența [Clear] → [Preset1] → [Preset2] → [Preset3] → [Clear].

Setați opțiunea [Shooting] > [ND Filter] > [Mode] la [Preset] din
meniul camerei.

1

Apăsați butonul [ND Filter] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [ND Filter] devine portocaliu.

Apare panoul de reglare a filtrului ND.

2

Apăsați butonul [ND Filter] și selectați una din următoarele opțiuni
din listă.
[Clear]: fără filtru ND.
[Preset1]: transmitanță setată de [Shooting] > [ND Filter] > [Preset1] din meniul camerei.
[Preset2]: transmitanță setată de [Shooting] > [ND Filter] > [Preset2] din meniul camerei.
[Preset3]: transmitanță setată de [Shooting] > [ND Filter] > [Preset3] din meniul camerei.

Când este selectată una dintre opțiunile de la [Preset1] la [Preset3] pentru filtrul ND,
valoarea transmitanței este afișată lângă numele filtrului ND.

3
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[92] Captura Reglarea luminozității Reglarea nivelului de lumină (filtru ND)

Reglarea automată în modul variabil

Puteți activa reglarea automată a expunerii utilizând filtrul ND.

Notă

Când filtrul ND este comutat la sau de la [Clear] în timpul capturii, cadrul filtrului ND este afișat pe
imagine și se aude un sunet de operare.

Sugestie

Setați opțiunea [Shooting] > [ND Filter] > [Mode] la [Variable] din
meniul camerei.

1

Apăsați butonul [ND Filter] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [ND Filter] devine portocaliu.

Apare panoul de reglare a filtrului ND.

2

Apăsați butonul [ND Filter] și selectați [Auto] din listă.

Valoarea transmitanței filtrului ND, care a fost reglată automat, este afișată lângă butonul
[ND Filter].

3
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De asemenea, puteți atribui [Auto ND Filter] unui buton alocabil și apăsați butonul pentru a comuta
între [Auto] și [Manual].

[93] Captura Reglarea luminozității Reglarea nivelului de lumină (filtru ND)

Reglarea manuală în modul variabil

Puteți să efectuați manual reglarea expunerii utilizând filtrul ND.

Setați opțiunea [Shooting] > [ND Filter] > [Mode] la [Variable] din
meniul camerei.

1

Apăsați butonul [ND Filter] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [ND Filter] devine portocaliu.

Apare panoul de reglare a filtrului ND.

2

Apăsați butonul [ND Filter] și selectați [Manual] din listă.3

Reglați transmitanța filtrului ND utilizând glisorul [ND Filter] sau
butoanele de reglare [ND Filter].

Sugestie

4
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Pentru a regla automat temporar
Puteți atribui funcția [Push Auto ND] unui buton alocabil și să activați temporar funcția Auto ND
Filter în timp ce este apăsat butonul. Eliberarea butonului comută Auto ND Filter înapoi la Off.
Setați filtrul ND la [Manual].

Notă

Când filtrul ND este comutat la sau de la [Clear] în timpul capturii, cadrul filtrului ND este afișat pe
imagine și se aude un sunet de operare.

Sugestie

De asemenea, puteți atribui [ND Filter Position] unui buton alocabil și apăsa butonul pentru a
comuta între [Manual] și [Clear].

De asemenea, puteți să apăsați butonul [Push Auto] de pe panoul de reglare a filtrului ND, pentru a
activa funcția Auto ND Filter în timp ce este apăsat butonul.

[94] Captura Reglarea la culori naturale (balansul de alb)

Ecranul de reglare a balansului de alb

Puteți să reglați balansul de alb utilizând ecranul de operare în timp real al aplicației web, pentru
a obține un balans de alb care face imaginea să arate mai natural.

Setările glisorului și ale butoanelor de reglare sunt conectate.

De asemenea, puteți regla filtrul ND de pe fila  (Main) de pe panoul de control al camerei.
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[95] Captura Reglarea la culori naturale (balansul de alb)

Reglarea automată a balansului de alb

Puteți obține constant un balans de alb reglat în mod adecvat, utilizând ATW (balans de alb cu
urmărire automată).
Când funcția ATW este activată, balansul de alb este reglat automat atunci pe măsură ce
temperatura culorii sursei de lumină se modifică.

Panoul de configurare de bază a camerei1.

Panoul de ajustare a configurației de bază a camerei
Afișează panoul de ajustare pentru elementul de configurat, selectat pe panoul de
configurare de bază a camerei.

2.

Apăsați butonul [White Balance] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [White Balance] devine portocaliu.

1
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Notă

ATW nu poate fi utilizată când opțiunea [Shooting Mode] este setată la [Cine EI].

Este posibil să nu puteți ajusta culoarea corespunzătoare folosind ATW, în funcție de iluminare și
condițiile subiectului.
Exemple:

Când o singură culoare domină subiectul, cum ar fi cerul, marea, pământul sau florile.
Când temperatura culorii este extrem de mare sau extrem de mică.

Dacă viteza de urmărire automată ATW este redusă sau nu poate fi obținut efectul adecvat, apăsați
butonul [WB SET] pentru a rula balansul de alb automat.

Sugestie

În modul ATW, puteți selecta viteza de răspuns în cinci pași (1, 2, 3, 4, 5) utilizând [Shooting] >
[White Setting] > [ATW Speed] din meniul camerei. Cu când numărul este mai mic, cu atât viteza de
răspuns este mai mare.

Puteți îngheța setarea curentă a balansului de alb prin atribuirea funcției [ATW Hold] unui buton
alocabil și prin apăsarea butonului alocabil pentru a întrerupe temporar ATW în modul ATW.

[96] Captura Reglarea la culori naturale (balansul de alb)

Reglarea manuală a balansului de alb

Apare panoul de reglare a balansului de alb.

Apăsați butonul [White Mode] și selectați [ATW] din listă.2
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Puteți regla balansul de alb și manual.

Apăsați butonul [White Balance] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [White Balance] devine portocaliu.

Apare panoul de reglare a balansului de alb.

1

Apăsați butonul [White Mode] și selectați una din următoarele
opțiuni din listă.
[Memory A(T/T)]

[Memory A(R/B)]

[Preset]

2

Reglați balansul de alb utilizând glisoarele sau butoanele de
reglare.

Sugestie

Setările glisorului și ale butoanelor de reglare sunt conectate.

3
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[97] Captura Reglarea la culori naturale (balansul de alb)

Rularea automată a balansului de alb

În modul de memorie A, balansul de alb de salvat este reglat automat.

Diferența între [Memory A(T/T)] și [Memory A(R/B)] este aceea că axa de reglare este
diferită, dar rezultatele reglării sunt conectate.

Pentru [Memory A(T/T)]
Acest mod reglează balansul de alb salvat în memoria A reglând temperatura de culoare
(Temp) și a valorii Tint.
Puteți seta temperatura de culoare în incremente de 20 K în intervalul dintre 2000 K și
5600 K. Valorile peste 5600 K pot fi setate la intervale egale cu gradul de modificare a
temperaturii culorii (mired) de la 5580 K la 5600 K.
Apăsarea butonului [Reset] restaurează setarea pentru [Temp] (temperatura de culoare)
sau [Tint] la valoarea implicită.
Pentru [Memory A(R/B)]
Acest mod reglează balansul de alb salvat în memoria A reglând amplificarea R și
amplificarea B.
Apăsarea butonului [Reset] restaurează setarea pentru amplificării corespunzătoare la
valoarea implicită.
Pentru [Preset]
Acest mod reglează temperatura de culoare la o valoare presetată.
Puteți seta valoarea în incremente de 100 K.
În modul presetat, puteți să atribuiți și opțiunea [Preset White Select] unui buton alocabil și
să apăsați butonul pentru a trece la o valoare presetată preconfigurată.
Modul [Custom]: 3200 K → 4300 K → 5600 K → 6300 K → 3200 K…
Modul [Cine EI]: 3200 K → 4300 K → 5500 K → 3200 K…

Apăsați butonul [White Balance] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [White Balance] devine portocaliu.

Apare panoul de reglare a balansului de alb.

1
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Apăsați butonul [White Mode] și selectați [Memory A(T/T)] sau
[Memory A(R/B)] din listă.
[Memory A(T/T)]

[Memory A(R/B)]

2

Amplasați o hârtie albă (sau alt obiect) într-o locație cu aceeași
sursă de iluminat și condiții ca subiectul, apoi faceți zoom pe
hârtie pentru ca pe ecran să se afișeze alb.

3

Ajustați luminozitatea.
Reglați diafragma folosind procedura din „Reglarea manuală a diafragmei”.

4

Apăsați butonul [WB SET] de pe panoul de reglare a balansului de
alb.
[Memory A(T/T)]

[Memory A(R/B)]

5
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Notă

Dacă ajustarea nu reușește, pe ecran este afișat un mesaj de eroare timp de aproximativ trei
secunde. Dacă mesajul de eroare persistă după încercări repetate de a seta balansul de alb,
contactați reprezentanța de service Sony locală.

Sugestie

Îl puteți rula și în modul ATW. Puteți utiliza această metodă când doriți să reglați rapid balansul de
alb în timpul operării ATW. După reglare, modul revine la operarea ATW normală.

[98] Captura Configurarea sunetului pentru înregistrare

Ecranul de configurare a sunetului

Puteți să reglați nivelul audio care urmează să fie înregistrat de unitate pe ecranul de operare în
timp real al aplicației web. Configurați comutatoarele de pe blocul de conectori al unității și
sunetul utilizând meniul web.

Dacă balansul de alb automat este rulat în modul de memorie, rezultatul reglării automate
este salvat în memoria A.
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[99] Captura Configurarea sunetului pentru înregistrare

Selectarea dispozitivului de intrare audio

Setați următoarele comutatoare în funcție de dispozitivul conectat la conectorul AUDIO IN.

Panoul de control al camerei –  fila (Audio)1.

Când este conectat un microfon, setați comutatorul SETUP 2 de pe
blocul de conectori de pe partea din spate a unității.
CH-1 și CH-2 au setări comune.

Setting Descriere

OPRIT
(implicit)

Selectați la utilizarea unui microfon dinamic sau a unui microfon cu
baterie. Această acțiune dezactivează alimentarea fantomă +48 V și
setează intrarea LINE sau MIC ca sursă audio CH-1 și CH-2.

1
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Notă

Sunetul nu este înregistrat în modul Interval Rec sau în modul Slow & Quick Motion.

[100] Captura Configurarea sunetului pentru înregistrare

Ajustarea automată a nivelului de înregistrare audio

Setați canalul pentru care doriți să reglați automat nivelul de înregistrare audio la [Auto] pe
pagina [Audio] a meniului web sau utilizând opțiunea [Audio] > [Audio Input] > [CH1 Level
Control] la [CH4 Level Control] din meniul camerei.
Canalele specificate pentru reglarea automată sunt indicate de pictograma  (Auto) de lângă
canalele corespunzătoare de pe fila  (Audio) a ecranului de operare în timp real.

[101] Captura Configurarea sunetului pentru înregistrare

Ajustarea manuală a nivelului de înregistrare audio

Setting Descriere

PORNIT

Selectați la utilizarea unui microfon compatibil cu alimentarea fantomă
+48 V. Această acțiune activează alimentarea fantomă +48 V și
setează microfonul compatibil cu alimentarea fantomă ca sursă audio
CH-1 și CH-2.

Setați tipul de dispozitiv conectat utilizând [Audio] > [Audio Input]
> [AUDIO IN Select] din meniul camerei.

2

Selectați intrarea audio utilizând [Audio] > [Audio Input] > [CH1
Input Select] la [CH4 Input Select] din meniul web sau meniul
camerei.

3
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Puteți regla manual nivelul de înregistrare audio manual.

Setați canalul pentru care doriți să reglați manual nivelul de
înregistrare audio la [Manual] pe pagina [Audio] a meniului web
sau utilizând opțiunea [Audio] > [Audio Input] > [CH1 Level
Control] la [CH4 Level Control] din meniul camerei.

1

Apăsați pe fila  (Audio) din panoul de control al camerei.2

Pe ecranul [Audio] în panoul de control al camerei, setați nivelul de
înregistrare audio cu ajutorul glisorul sau butoanelor de reglare
pentru canalul al cărui nivelul de înregistrare audio doriți să-l setați
manual.

Notă

Canalele pentru care este afișată pictograma  (auto) sunt reglate automat. Schimbările
valorilor utilizând glisorul sau butoanele nu sunt aplicate pentru sunetul înregistrat.

Sugestie

Setările glisorului și ale butoanelor de reglare de pe fiecare rând sunt conectate.

Puteți să verificați nivelul de intrare audio utilizând afișajul contorului pentru nivelul audio de
pe ecranul de captură.

3
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[102] Funcții utile

Utilizarea meniului direct

Puteți să verificați starea și setările unității afișate suprapuse pe imaginea camerei și să
selectați și să schimbați setările utilizând butoanele de control GUI de pe telecomanda cu
infraroșu.
Pot fi configurate următoarele elemente.
[Face/Eye Detection AF]
[SteadyShot]
[White Mode]
[Color Temp]
[Scene File]
[ND Filter Position]
[Auto ND Filter]
Valoarea pentru [ND Filter]
[Auto Iris]
Valoarea pentru [Iris]
[AGC]
Valoarea pentru [Gain]
Valoarea pentru [ISO]
[Exposure Index]
[Shutter Type]
[Auto Shutter]
[Shutter]
[Auto Exposure Mode]
[Auto Exposure Level]
[S&Q Motion] and [Frame Rate]

Apăsați un buton alocabil căruia i-a fost atribuit [Direct Menu] pe
telecomanda cu infraroșu.
Butonul [Direct Menu] este atribuit butonului alocabil 1 în mod implicit din fabrică.
Doar elementele de pe ecran care pot fi configurate folosind meniul direct sunt selectabile
folosind cursorul portocaliu.

1

Deplasați cursorul pe elementul pe care doriți să-l setați utilizând
butoanele cu săgeți de pe panoul de control GUI și apăsați butonul
[Set].
Se afișează un meniu sau elementul este afișat pe un fundal alb.

2
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Sugestie

De asemenea, puteți efectua aceeași acțiune utilizând un buton alocabil și panoul de control GUI al
aplicației web.

[103] Funcții utile

Butoanele alocabile

Există zece butoane alocabile în aplicația a unității cărora le puteți atribui funcții.
Butoanele alocabile sunt afișate pe ecranul de operare în timp real și ecranul de control al
redării.

Notă

Lista de butoane alocabile nu este afișată la configurarea setărilor în panoul de operare de bază a
camerei de pe ecranul de operare în timp real. Pentru a opri operarea, apăsați butonul [X] din
partea dreaptă sus a panoului de reglare.

Următoarele funcții sunt atribuite butoanelor în mod implicit, din fabrică.
Butonul 1: [Direct Menu]
Butonul 2: [Focus Setting]
Butonul 3: [Rec Review]

Selectați o setare utilizând butoanele cu săgeți și apăsați butonul
[Set].
Meniul sau fundalul alb dispar și noua setare este afișată cu un cursor portocaliu.
Apăsați din nou butonul alocabil căruia i-a fost atribuită opțiunea [Direct Menu] sau
așteptați 3 secunde fără a efectua nicio acțiune pentru a ieși din meniul direct.

3
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Butoanele 1 – 3 sunt echivalente cu butoanele cu aceleași numele de pe telecomanda cu
infraroșu furnizată.

Butonul 4: [Push Auto ND]
Butonul 5: [Crop Select]
Butonul 6: [Marker]
Butonul 7: [Video Signal Monitor]
Butonul 8: [Clip Flag OK]
Butonul 9: [Color Bars]
Butonul de menținere a focalizării: [Focus Hold]

Butonul de menținere a focalizării este echivalent cu butonul Focus Hold de pe obiectivul cu
montură E.

Schimbarea funcției unui buton
Utilizați [Project] > [Assignable Button] din meniul camerei.
Când schimbați atribuirea, afișajul listei de butoane alocabile se schimbă.
Pentru detalii despre funcțiile care pot fi atribuite, consultați „Butoanele alocabile” din „Meniul
camerei și setări detaliate”.

[104] Funcții utile

Mișcare cu încetinitorul și rapidă

Când formatul de înregistrare este setat la următoarele valori, puteți specifica valori diferite
pentru rata de cadre de captură și rata de cadre de redare.
Următorul tabel prezintă ratele de cadre configurabile.

Frecvența sistemului: 59,94/50/29,97/25/23,98, Modul de scanare a imaginii: FF

Codec Format video Rate de cadre configurabile

RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120
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Codec Format video Rate de cadre configurabile

XAVC-I

4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

XAVC-L
3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 180, 200, 240

Frecvența sistemului: 59,94/50/29,97/25/23,98, Modul de scanare a imaginii: S35

Codec Format video Rate de cadre configurabile

XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

Frecvența sistemului: 24, Modul de scanare a imaginii: FF

Codec Format video Rate de cadre configurabile

XAVC-I 4096×2160P 1–60

Notă

Slow & Quick Motion nu poate fi setat în timpul înregistrării, redării sau în timp ce este afișat ecranul
miniatural.

Înregistrarea audio nu este acceptată în modul Slow & Quick Motion.

Funcția Auto Focus, funcția Auto Iris și funcția AutoShutter sunt dezactivate în modul Slow & Quick
Motion. Cu toate acestea, funcţia de focalizare automată poate fi utilizată atunci când rata cadrelor
este setată la următoarele.

Rata de cadre când frecvența sistemului este setată la 59,94/29,97/23,98: 30, 60, 120, 240
Rata de cadre când frecvența sistemului este setată la 50/25: 25, 50, 100, 200
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Pentru detalii despre utilizarea formatului RAW, consultați „Înregistrarea clipurilor video RAW”.

[105] Funcții utile

Înregistrarea video în mod intermitent (Interval Rec)

Funcția Interval Rec vă permite să înregistrați video intermitent în memoria internă a unității.
Această funcţie este o modalitate eficientă pentru înregistrarea subiecţilor în mişcare lentă.
Când începeți înregistrarea, unitatea înregistrează automat un număr specificat de cadre
(Number of Frames) la un interval de timp specificat (Interval Time).

A: Interval de captură (Interval Time)
B: Număr de cadre într-o singură filmare fără întrerupere (Number of Frames)

Notă

Poate fi utilizată o singură funcție de înregistrare specială la un moment dat, cum ar fi înregistrarea
Interval Rec.

Dacă este activat un alt mod special de înregistrare în timpul utilizării funcţiei Interval Rec, aceasta
din urmă este dezactivată automat.

Modul Interval Rec este dezactivat automat după modificarea setărilor sistemului, cum ar fi formatul
video.

Setările Interval Rec nu pot fi modificate în timpul înregistrării sau al redării sau în timp ce este
afișat ecranul miniatural.

Limitări în timpul înregistrării
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Conținutul audio nu este înregistrat.
Revizualizarea înregistrării (Rec Review) nu este posibilă.

În cazul în care unitatea este oprită în timpul înregistrării
În cazul în care comutatorul de alimentare al unității este setat în starea de standby, suportul
media este accesat timp de câteva secunde pentru a înregistra imaginile stocate în memorie
până în acel moment, apoi unitatea comută la în starea de standby automat.
În cazul în care cablul de alimentare c.c. este deconectat, alimentarea este oprită de la
adaptorul c.a. sau dacă alimentarea prin PoE++ este deconectată, atunci imaginile
înregistrate până în acel moment pot fi pierdute (maximum 10 secunde). Trebuie să aveți
grijă la aceste aspecte.

Setarea numărului de cadre și a intervalului între capturi

Setați opțiunea [Project] > [Interval Rec] > [Setting] la [On] în meniul web și apoi setați [Number
of Frames] și [Interval Time].
Unitatea iese din modul Interval Rec atunci când este oprită, dar setările [Number of Frames] și
[Interval Time] se păstrează. Nu este necesar să le setați din nou data viitoare când înregistrați
în modul Interval Rec.

Sugestie

Se poate seta și utilizând opțiunea [Project] > [Interval Rec] din meniul camerei.

Începerea capturii

Pentru a începe înregistrarea, apăsaţi butonul de START/STOP a înregistrării. „Int●Rec” și
„Int●Stby” apar alternativ.

Oprirea capturii

Opriți înregistrarea.
Când înregistrarea se încheie, datele video stocate în memorie până la acel moment sunt scrise
pe suportul media.
Pentru a ieși din modul Interval Rec, efectuați una dintre acțiunile de mai jos.

Setați alimentarea unității la standby.
În modul de standby pentru înregistrare, setați [Project] > [Interval Rec] > [Setting] la [Off].
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De asemenea, modul Interval Rec este dezactivat automat la repornirea unității.

[106] Funcții utile

Înregistrarea imaginilor în memoria cache (Picture
Cache Rec)

Funcția Picture Cache Rec vă permite să înregistrați videoclipuri retroactiv la începerea
înregistrării, menținând o memorie cache internă cu o durată specificată în timpul înregistrării.

Setarea dimensiunii memoriei cache

Setați opțiunea [Project] > [Picture Cache Rec] > [Setting] la [On] în meniul web și setați
dimensiunea memoriei cache cu [Cache Size].

Setarea [Cache Size] Timp cache (aproximativ)

[Short] 5 secunde

[Medium] 10 secunde

[Long] 20 de secunde

[Max] Valoarea maximă pentru fiecare format de înregistrare

Notă

Funcția Picture Cache Rec nu poate fi utilizată în combinație cu Interval Rec, înregistrarea
simultană în 2 sloturi sau cu înregistrarea proxy. Când Picture Cache Rec este setată la On,
celelalte moduri de înregistrare specială sunt setate forțat la Off.

Modul Picture Cache Rec nu poate fi selectat în timp ce înregistrarea sau Rec Review este în curs.

Când funcția Picture Cache este setată la On, codul de timp este înregistrat în modul [Free Run]
chiar și cu setarea [Regen] sau [Rec Run].

Este posibil ca setarea [Output Format] să nu fie configurabilă în modul Picture Cache Rec. Dacă
se întâmplă acest lucru, setați temporar Picture Cache Rec la Off, apoi modificați setarea.
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Sugestie

Timpul de cache poate fi mai scurt, în funcție de formatul de înregistrare. Verificați timpul afișat în
[Project] > [Picture Cache Rec] > [Cache Rec Time] din meniul web.

Se poate seta și utilizând opțiunea [Project] > [Picture Cache Rec] din meniul camerei.

De asemenea, puteți comuta [Picture Cache Rec] între On și Off utilizând un buton alocabil.

Pornirea Picture Cache Rec

Când modul [Picture Cache Rec] este setat la On, apare „●Cache” (● este verde).
Dacă apăsați butonul record START/STOP, înregistrarea începe și videoclipul este scris pe
cardurile de memorie începând cu videoclipul stocat în memoria cache.

Notă

Modificarea formatului de înregistrare sau a aspectului de bază șterge videoclipul stocat până la
acel moment din memoria cache și începe salvarea în memoria cache a videoclipului nou. În
consecință, înregistrarea în memoria cache a imaginilor înainte de schimbarea formatului nu este
posibilă, chiar dacă începeți înregistrarea imediat după modificarea formatului.

Dacă Picture Cache Rec este setat la On sau Off imediat după introducerea unui card de memorie,
este posibil ca datele din cache să nu fie înregistrate pe card.

Videoclipul este stocat în memoria cache când funcția Picture Cache Rec este setată la On.
Videoclipul anterior setării funcției la On nu este salvat în memoria cache.

Videoclipul nu este stocat în memoria cache în timp ce este accesat un card de memorie, cum ar fi
în timpul redării, Rec Review (Revizuire înregistrare) sau afişării ecranului cu miniaturi. Nu este
posibilă înregistrarea în memoria cache a videoclipului în intervalul respectiv.

Anularea Picture Cache Rec

Setați [Project] > [Picture Cache Rec] > [Setting] la [Off] în meniul web sau apăsați un buton
alocabil căruia i-a fost atribuită funcția [Picture Cache Rec].

[107] Funcții utile
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Înregistrarea pe cardurile de memorie A și B simultan
(2-slot Simul Rec)

Puteți înregistra simultan atât pe cardul de memorie A, cât și pe cardul de memorie B, setând
[Project] > [Simul Rec] > [Setting] la [On] din meniul web sau meniul camerei.

Înregistrarea separată pe cardul de memorie A și B

Puteți începe/opri înregistrarea pe fiecare card de memorie în mod independent, utilizând
butonul record START/STOP sau [2nd Rec START/STOP] de pe fila  (Others).
În mod implicit, din fabrică, ambele butoane sunt setate pentru a porni/opri înregistrarea
simultan pe ambele carduri de memorie A și B.
Când butoanele sunt setate pentru a controla înregistrarea pentru carduri de memorie diferite,
controlul de pornire/oprire a înregistrării [SDI/HDMI Rec Control] urmează starea de înregistrare
a slotului A.

Schimbarea setării

Setați următoarele funcții utilizând opțiunea [Project] > [Simul Rec] > [Rec Button Set] din
meniul camerei.

Setarea [Rec
Button Set] Butoane și carduri de memorie

Rec Button:
[SlotA SlotB]
2nd Rec
Button: [SlotA
SlotB]

Pornește/oprește înregistrarea simultan pe cardurile de memorie A și B
cu ajutorul oricărui buton.

Rec Button:
[SlotA]
2nd Rec
Button: [SlotB]

Butonul Record START/STOP pornește/oprește înregistrarea pe cardul
de memorie A, iar butonul [2nd Rec START/STOP] de pe fila  (Others)
pornește/oprește înregistrarea pe cardul de memorie B.

Rec Button:
[SlotB]

Butonul Record START/STOP pornește/oprește înregistrarea pe cardul
de memorie B, iar butonul [2nd Rec START/STOP] de pe fila  (Others)
pornește/oprește înregistrarea pe cardul de memorie A.
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Setarea [Rec
Button Set] Butoane și carduri de memorie

2nd Rec
Button: [SlotA]

[108] Funcții utile

Monitorul semnal video

Puteți seta tipul de semnal video care va fi afișat pe panoul cu imaginea camerei la formă de
undă, vectorscop sau histogramă, utilizând [Monitoring] > [Video Signal Monitor] > [Setting] din
meniul camerei.
Linia portocalie indică valorile setate pentru [Level Marker 1] și [Level Marker 2].
De asemenea, puteți atribui funcția [Video Signal Monitor] unui buton alocabil.

Monitorizarea afișării țintei
În modul Cine EI, informațiile privind setarea spațiului de culoare sau setarea LUT a monitorului
sunt afișate în partea dreaptă sus a monitorului de semnal video pentru a indica ținta
monitorizării.

[109] Funcții utile

Marcajele din clipuri

Puteți adăuga un marcaj de clip [OK] într-un clip apăsând un buton alocabil căruia i-a fost
atribuită funcția [Clip Flag OK] și selectând [Add OK].
Puteți șterge un marcaj de clip [OK] apăsând butonul de două ori și selectând [Delete Clip Flag].

Sugestie
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De asemenea, puteți adăuga un marcaj de clip utilizând [Thumbnail] > [Set Clip Flag] din meniul
camerei.

Ecranul cu miniaturi poate fi afișat sortat după tipul de marcaj din clip (ecranul cu miniaturile
clipurilor filtrate). Pentru detalii, consultați „Operații cu clipurile înregistrate” din „Ecranul cu
miniaturi”.

[110] Funcții utile

Compensarea respirației

Puteți seta dacă realizați compensarea respirației pentru obiectiv, utilizând [Technical] > [Lens]
> [Breathing Compensation] din meniul camerei.
Această funcție compensează fenomenul prin care unghiul de vizualizare se modifică odată cu
variația poziției de focalizare.
Când este executată compensarea respirației, o porțiune de imagine este decupată electronic
pentru a menține un unghi de vizualizare constant, astfel încât să nu apară fenomenul
respirației.

Notă

Când compensarea respirației este activată, unghiul de vizualizare și calitatea imaginii se pot
modifica ușor.

În funcție de obiectiv, există șansa să nu fie posibil să corectați modificarea unghiului de vizualizare
când compensarea respirației este activată.

Compensarea nu este posibilă când este atașat un obiectiv care nu acceptă compensarea
respirației.

Această funcție este setată la Off (fix) în cazurile de mai jos.

Când opțiunea [Technical] > [Lens] > [Distortion Comp.] este setată la [Off] din meniul camerei
Când opțiunea [Shooting] > [S&Q Motion] > [Setting] este setată la [On] din meniul web sau
meniul camerei
Când opțiunea [Project] > [Rec Format] > [Codec] este setată la [RAW] sau [RAW & XAVC-I] din
meniul web sau meniul camerei

[111] Funcții utile Înregistrarea proxy

Prezentarea generală a înregistrării proxy
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Această funcţie vă permite să înregistraţi simultan date proxy cu rezoluţie scăzută în acelaşi
timp în care înregistraţi videoclipul original cu rezoluţie înaltă.

Pentru detalii despre cardurile de memorie acceptate, formatarea cardurilor de memorie și
verificarea capacității rămase, consultați „Cardurile de memorie acceptate” din „Pregătirea
cardurilor de memorie”.

Despre fişierul înregistrat
Extensia denumirii fișierului este „.mp4”.
Codul de timp este înregistrat simultan.

Destinaţia de stocare a fişierului înregistrat
Fişierul înregistrat este stocat în următorul director.

Suport de înregistrare Cale folder

SDXC /PRIVATE/XDROOT/Sub

CFexpress Type A /XDROOT/Sub

Despre denumirea fişierului
Numele fişierului constă din numele clipului înregistrat pe cardul de memorie la care se
adaugă un sufix „S03”.
Pentru denumirile clipurilor, consultați [TC/Media] > [Clip Name Format] din meniul camerei.

[112] Funcții utile Înregistrarea proxy

Înregistrarea unui proxy

Puteți începe înregistrarea când este activată înregistrarea proxy.

Setați opțiunea [Project] > [Proxy Rec] > [Setting] la [On] din
meniul web sau meniul camerei.

1

Introduceți un card de memorie într-un slot pentru card CFexpress
Type A/SD.

2
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Pentru a opri înregistrarea
Opriți înregistrarea.

Setarea canalului audio pentru înregistrarea proxy
Setați canalul audio pentru înregistrarea datelor proxy, utilizând opțiunea [Project] > [Proxy Rec]
> [Audio Channel] din meniul camerei.

[113] Funcții utile Înregistrarea cu aspectul dorit

Prezentarea generală a aspectelor

Când unitatea este în modul Custom, puteți adăuga ajustări pentru negru, matrice și alți
parametri pentru a crea un „aspect” bazat pe aspectul de bază.

Pentru cardurile CFexpress, introduceți-le cu eticheta orientată în sus.
Pentru cardurile SD, introduceți-le cu eticheta orientată în jos și colțul tăiat oblic în partea
de jos.

Notă

Nu puteţi seta Proxy Rec la On în acelaşi timp cu S&Q Motion sau Interval Rec. Când Proxy
Rec este setat la On, celelalte moduri de înregistrare sunt setate forțat la Off.

Apăsați butonul record START/STOP.
Înregistrarea proxy începe.

Notă

În cazul în care unitatea este oprită sau cardul de memorie este scos în timp ce accesați
cardul de memorie, nu poate fi garantată integritatea datelor de pe card.
Toate datele înregistrate pe cardul de memorie pot fi eliminate. Asigurați-vă întotdeauna că
indicatorul de acces la cardul de memorie este stins înainte de a opri unitatea sau de a
scoate cardul de memorie.

Asiguraţi-vă că, atunci când îl introduceţi sau îl scoateţi, cardul de memorie nu sare brusc.

3
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De asemenea, puteţi selecta rapid un aspect diferit salvând diferite combinaţii de setări în
fişierele Scene.
Unitatea este prevăzută cu un total de șase aspecte prestabilite.

[114] Funcții utile Înregistrarea cu aspectul dorit

Selectarea unui aspect

Acest subiect descrie cum se selectează un aspect.

Verificați dacă opțiunea [Project] > [Base Setting] > [Shooting
Mode] este setată la [Custom] în meniul web sau meniul camerei.

Sugestie

În modul [Custom], butoanele [ISO/Gain] și [Scene File] sunt afișate pe panoul de
configurare de bază a camerei.

1

Apăsați butonul [Scene File] de pe panoul de configurare de bază a
camerei.
Cadrul butonului [Scene File] devine portocaliu.

Apare panoul de reglare pentru fișierul scenei.

2

Apăsați butonul [Scene File] de pe panoul de reglare și selectați un
fișier de scenă cu aspectul dorit din listă.

3
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[115] Funcții utile Înregistrarea cu aspectul dorit

Importul unui aspect de bază dorit

Puteţi importa un fişier 3D LUT, creat pe un computer sau alt dispozitiv, ca aspect de bază. Pot
fi importate până la 16 fişiere.
Format de fișier: fișier CUBE (*.cube) pentru un LUT 3D în 17 sau 33 de puncte creat utilizând
Catalyst Browse, RAW Viewer sau DaVinci Resolve* (de Blackmagic Design Pty. Ltd.).

Spațiu de culoare de intrare/gamma: [S-Gamut3.Cine/S-Log3] sau [S-Gamut3/S-Log3]

Următoarele presetări sunt configurate implicit din fabrică.

[Target Display] [SDR(BT.709)] [HDR(HLG)]

Scene file 1 [S-Cinetone] [HLG Live]

Scene file 2 [Standard] [HLG Natural]

Scene file 3 [Still] (Not registered)

Scene file 4 [ITU709] (Not registered)

Scene files 5 to 16 (Not registered) (Not registered)

Sugestie

De asemenea, puteți selecta un aspect, utilizând [Paint/Look] > [Scene File] > [Recall] din
meniul camerei. De asemenea, puteți reapela un aspect presetat utilizând [Scene File] >
[Preset Recall].

Verificat cu Resolve V9.0, V10.0 și V11.0.*
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Salvați fișierul 3D LUT pe dispozitivul pe care rulează aplicația
web.

1

Deschideți [Paint/Look] > [Base Look] din meniul web.
Apare o listă cu aspecte de bază înregistrate.

2

Apăsați butonul [Import] de pe rândul pe care doriți să importați
fișierul.
Apare dialogul de selectare a fișierului.

3

Selectați fișierul 3D LUT pregătit.
Fișierul 3D LUT importat devine aspectul de bază al unității.

4

Selectați fișierul 3D LUT importat, utilizând [Paint/Look] > [Base
Look] > [Select] din meniul camerei.

5

Configurați [Paint/Look] > [Base Look] > [Input] și [Output] din
meniul camerei pentru a corespunde atributelor fișierului 3D LUT
importat.

6
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Ajustarea pentru subexpunere
Dacă există tendința de subexpunere când expunerea automată este selectată la utilizarea
aspectului de bază importat, ajustați aspectul, utilizând [Paint/Look] > [Base Look] > [AE Level
Offset] din meniul web.

Notă

Simplul import al unui fişier 3D LUT nu afectează imaginea. Încărcați fișierul 3D LUT importat,
utilizând [Paint/Look] > [Base Look] > [Select] din meniul camerei.

Dacă [Input] este setată corect, nu va fi obținut aspectul corect.

Setările elementelor de meniu [Input], [Output] și [AE Level Offset] sunt aplicate aspectului de bază
selectat, utilizând [Select]. Dacă sunt importate mai multe fișiere 3D LUT, selectați fiecare fișier 3D
LUT, utilizând [Select] și configurați [Input], [Output] și [AE Level Offset] în mod individual pentru
fiecare fișier.

Setările [Input], [Output] și [AE Level Offset] configurate sunt salvate pentru fiecare fișier 3D LUT.

Opțiunile de selecție a aspectului de bază/LUT pentru fișierele 3D LUT importate sunt comune
pentru modurile [SDR(BT.709)], [HDR(HLG)] și Cine EI, dar spațiul de culoare și conversia gamma
nu sunt efectuate conform acestor moduri.

Fișierele 3D LUT nu sunt șterse când se execută [Maintenance] > [Reset] > [All Reset (except for
Network Settings)] în meniul web.

[116] Funcții utile Înregistrarea cu aspectul dorit

Personalizarea unui aspect

Puteți personaliza aspectul pe baza aspectului de bază, utilizând glisoarele [Master Black], [R
Black] și [B Black] de pe panoul de reglare pentru fișierul Scene din panoul de configurare de
bază a camerei, plus [Paint/Look] > [Matrix] și alte elemente de configurare din meniul camerei.
Conectați unitatea la un televizor sau un monitor și reglați calitatea imaginii în timp ce vizualizați
imaginea pe ecranul televizorului sau monitorului.
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1: Glisorul/butoanele de reglare [R Black]
2: Glisorul/butoanele de reglare [B Black]
3: Glisorul/butoanele de reglare [Master Black]

Notă

Când importați un fișier 3D LUT și îl aplicați pe imagine, aspectul dorit, definit în fișierul 3D LUT, nu
va fi obținut dacă [Paint/Look] > [Matrix] și sunt modificate unele setări diferite de cele ale
aspectului de bază din meniul camerei.

Puteți reseta toate setările personalizate, utilizând opțiunea [Paint/Look] > [Reset Paint Settings] >
[Reset without Base Look] din meniul camerei.

[117] Funcții utile Înregistrarea cu aspectul dorit

Salvarea unui aspect

Puteți salva aspectul curent ca fișier Scene în memoria internă, utilizând opțiunea [Paint/Look] >
[Scene File] > [Store] din meniul camerei.
Puteți reapela rapid un aspect salvat, utilizând panoul de reglare pentru fișierul Scene sau
operațiile din meniul direct.

Notă

Dacă selectaţi un alt aspect fără a salva aspectul curent, aspectul curent va fi eliminat.

Sugestie

Puteţi suprascrie fişierele Scene presetate. Pentru a restabili un fișier Scene presetat, încărcați
aspectul de restabilit utilizând opțiunea [Paint/Look] > [Scene File] > [Preset Recall] din meniul
camerei și apoi salvați-l utilizând [Scene File] > [Store].

Ștergerea unui aspect salvat
Puteți șterge un fișier Scene salvat în memoria internă, utilizând opțiunea [Paint/Look] > [Scene
File] > [Delete] din meniul camerei.

Sugestie

După ce este șters, acesta nu mai este afișat în panoul de reglare pentru fișierul Scene sau în
meniul direct.
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[118] Funcții utile Înregistrarea cu aspectul dorit

Ștergerea unui aspect de bază

Puteți șterge individual fișierele 3D LUT importate, utilizând [Paint/Look] > [Base Look] >
[Delete] din meniul camerei.
Puteți șterge toate fișierele 3D LUT importate, utilizând [Paint/Look] > [Base Look] > [Delete] din
meniul camerei.

Notă

Înainte de ştergere, verificaţi dacă aspectul de bază nu este utilizat în niciun fişier Scene. Dacă un
aspect de bază utilizat este şters, aspectul fişierelor Scene corespunzătoare va fi incorect.

Fișierele 3D LUT importate nu sunt șterse când se execută [Maintenance] > [Reset] > [All Reset
(except for Network Settings)] în meniul web.

Un aspect de bază șters nu mai poate fi utilizat ca LUT în modul Cine EI.

[119] Funcții utile Captura cu ajustarea aspectului în post-producție

Captura cu ajustarea aspectului în post-producție

Utilizând unitatea în modul Cine EI și înregistrând gradații uniform din zonele întunecate în
zonele luminoase, puteți efectua ajustări fine, cum ar fi restaurarea locală a gradațiilor zonelor
întunecate și a zonelor luminoase, în post-producție.
Cu toate acestea, atunci când vizualizaţi imaginile înregistrate pe un monitor convenţional,
contrastul general va apărea scăzut, ceea ce face dificilă ajustarea focalizării şi expunerii.
Puteți aplica un LUT țintei monitorului de pe unitate, pentru a ajuta cu diferite ajustări în timpul
capturii. De asemenea, puteţi aplica un LUT la redarea videoclipului pentru a verifica rezultatul
final.
Fişierele LUT sunt aplicate de următoarele sisteme. Cu toate acestea, se poate aplica doar un
singur LUT.

Ieşire SDI
Ieșirea HDMI și redarea în timp real
Clip proxy înregistrat pe suporturile de înregistrare
Clip la înaltă rezoluție înregistrat pe suporturile de înregistrare
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[120] Funcții utile Captura cu ajustarea aspectului în post-producție

Aplicarea unui LUT pentru ieșirea HDMI și redarea în
timp real

Puteți aplica un LUT pentru ieșirea HDMI și redarea în timp real.

Notă

Imaginea din panoul cu imaginea camerei din aplicația web este și ea inclusă în redarea în timp
real.

Verificați dacă opțiunea [Project] > [Base Setting] > [Shooting
Mode] este setată la [Cine EI] în meniul web sau meniul camerei.

Sugestie

În modul [Cine EI], butoanele [Base ISO/Exposure Index] și [Base Look/LUT] sunt afișate pe
panoul de configurare de bază a camerei.

1

Apăsați butonul [Base Look/LUT] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [Base Look/LUT] devine portocaliu.

Apare panoul de ajustare pentru Base Look/LUT.

2

Selectați [HDMI/Stream] > [MLUT].3
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Sugestie

Se poate seta și utilizând opțiunea [Shooting] > [LUT On/Off] > [HDMI/Stream] din meniul camerei.

Ieșirea SDI poate fi setată în același mod.

Pentru filmări pe suporturile de înregistrare, puteți face această setare, utilizând opțiunea [Shooting]
> [LUT On/Off] > [Internal Rec] și [Proxy] din meniul camerei.

[121] Funcții utile Captura cu ajustarea aspectului în post-producție

Schimbarea unui LUT

Puteți să schimbați LUT-ul de aplicat.

Sugestie

Unitatea oferă [s709], [709(800%)] și [S-Log3] ca LUT-uri presetate.

Apăsați butonul [Base Look/LUT] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [Base Look/LUT] devine portocaliu.

Apare panoul de ajustare pentru Base Look/LUT.

1

Apăsați butonul [Base Look/LUT] și selectați aspectul de bază de
aplicat.

2
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De asemenea, puteți importa și aplica un fișier 3D LUT. Pentru detalii, consultați „Importul unui
aspect de bază dorit” și „Ștergerea unui aspect de bază”.

Se poate seta și utilizând opțiunea [Paint/Look] > [Base Look] > [Select] din meniul camerei.

[122] Funcții utile Captura cu ajustarea aspectului în post-producție

Modificarea distribuției zonelor întunecate și
luminoase în imaginile înregistrate

Puteţi modifica distribuţia zonelor întunecate şi a zonelor luminoase, de exemplu, dacă doriţi să
stabiliţi prioritatea tonului zonelor întunecate comparativ cu zonele luminoase, schimbând
indicele de expunere Exposure Index din sensibilitatea de bază.

Apăsați butonul [Base Look/LUT] de pe panoul de configurare de
bază a camerei.
Cadrul butonului [Base Look/LUT] devine portocaliu.

Apare panoul de ajustare pentru Base Look/LUT.

1

Selectați [HDMI/Stream] > [MLUT].
Un LUT este aplicat pentru ieșirea HDMI și redarea în timp real.

2

Apăsați butonul [Base ISO/Exposure Index] de pe panoul de
configurare de bază a camerei.
Cadrul butonului [Base ISO/Exposure Index] devine portocaliu.

3
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Sugestie

Se poate seta și utilizând opțiunea [Shooting] > [ISO/Gain/EI] > [Exposure Index] din meniul
camerei.

Ieșirea SDI poate fi utilizată în același mod.

A doua valoare numerică a setării indică numărul treptelor de informaţii despre luminozitate atribuite
zonelor luminoase (luminozitate mai mare de 18% gri). Zonele mai luminoase decât acestea sunt
supraexpuse.
Exemplu: la „400EI/5.0E”, pașii 5.0 sunt atribuiți pentru partea luminoasă.

Puteţi utiliza acest lucru şi ca ghid de verificare a tonului zonelor întunecate şi luminoase în timpul
înregistrării. Nu uitați să reveniți la valoarea EI inițială după ce verificați expunerea.

[123] Funcții utile Înregistrarea RAW

Înregistrarea clipurilor video RAW

Apare panoul de ajustare pentru Base ISO/Exposure Index.

Ajustați indicele de expunere în funcție de distribuția dorită a
zonelor întunecate și luminoase, utilizând glisorul [Exposure
Index] sau butoanele de ajustare [Exposure Index].

4

Ajustați iluminatul și/sau filtrul ND astfel încât ieșirea video a
camerei de la [HDMI/Stream] să aibă expunerea corespunzătoare.

5
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Puteți înregistra ieșirea semnalului video RAW de la conectorul SDI OUT al unității pe un
recorder extern acceptat.
Formatele de ieşire RAW acceptate sunt prezentate mai jos.

Frecvența sistemului [Codec] [RAW Output Format]

59,94 / 50 / 29,97 / 25 / 23,98

RAW 4096×2160

RAW 3840×2160

RAW & XAVC-I 4096×2160

RAW & XAVC-I 3840×2160

24
RAW 4096×2160

RAW & XAVC-I 4096×2160

Conectați un recorder RAW extern la conectorul SDI OUT al
unității.

1

Setați [Project] > [Base Setting] > [Shooting Mode] la [Cine EI] din
meniul web sau meniul camerei.

2

Setați unghiul de vizualizare (numai FF) [Project] > [Rec Format] >
[Imager Scan Mode] din meniul web sau meniul camerei.

3

Setați [Project] > [Rec Format] > [Codec] la [RAW] în meniul web
sau meniul camerei.
Dacă selectați [RAW&XAVC-I] se vor înregistra simultan videoclipuri pe recorderul RAW
extern și pe cardurile de memorie din unitate.

4

Setați rezoluția utilizând [Project] > [Rec Format] > [RAW Output
Format] din meniul web sau meniul camerei.

5
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Notă

Când înregistrarea este pornită pe un recorder extern, fără a utiliza butonul record START/STOP de
pe ecranul de operare în timp real, este posibil ca videoclipurile să nu fie înregistrate corect.

[124] Funcții utile Înregistrarea RAW

Înregistrarea video RAW în modul Slow & Quick
Motion

Puteți înregistra video RAW în modul Slow & Quick Motion.

Pentru detalii despre ratele de cadre acceptate pentru captură, consultați „Mișcare cu
încetinitorul și rapidă”.

Verificați dacă recorderul extern este pornit, apoi apăsați butonul
record START/STOP de pe ecranul de operare în timp real.
Starea de înregistrare video RAW este indicată de o pictogramă de pe panoul cu imaginea
camerei.

Notă

Semnalul de control al înregistrării este transmis de la conectorul SDI OUT al unității, dar nu
este posibilă obținerea stării recorderului extern. În consecință, unitatea poate să indice că
înregistrarea video RAW este în desfășurare atunci când recorderul extern nu înregistrează
efectiv. Verificaţi indicatorul de pe recorderul extern pentru a obţine starea de funcţionare
corectă.

6
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[125] Funcții utile Ajustarea bokeh (funcție de control pentru bokeh)

Activarea/dezactivarea funcției de control pentru
bokeh

Puteți ajusta cu ușurință nivelul de efect bokeh conectând filtrul ND și amplificarea la operarea
diafragmei.

Activarea/dezactivarea funcției de control pentru bokeh

Această funcție poate fi activată numai când reglați expunerea manual. Setați filtrul ND la modul
variabil, apoi setați diafragma, amplificarea, obturatorul și filtrul ND la reglarea manuală.
Puteți să activați/dezactivați funcția de control pentru bokeh, utilizând [Shooting] > [Iris] >
[Bokeh Control] din meniul camerei.
Când funcția de control pentru bokeh este setată la On, este afișată o pictogramă  pe
indicatorii pentru filtrul ND și amplificare.

Notă

Această funcție este activată numai pentru obiectivele cu montură E care pot comunica cu unitatea.

Efectul maxim al acestei funcții poate fi obținut utilizând un obiectiv cu montură E Sony.

De asemenea, puteți atribui funcția [Bokeh Control] unui buton alocabil și comuta funcția de control
pentru bokeh între On și Off utilizând butonul.

Funcția de control pentru bokeh este setată la Off când sunt efectuate oricare dintre operațiile de
mai jos.

Când unitatea este oprită
Când oricare dintre diafragmă, amplificare, obturator sau filtrul ND este setat la Auto
Când modul de captură este comutat
Când filtrul ND este setat la modul Clear sau presetat
Dacă se demontează obiectivul
Când unitatea repornește, de exemplu, după comutarea frecvenței

[126] Funcții utile Ajustarea bokeh (funcție de control pentru bokeh)

Ajustarea nivelului de efect bokeh
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Notă

Aspectul poate varia în funcție de viteza de operare, obiectiv, setările de captură și subiect, se
poate schimba și luminozitatea. Vă recomandăm să testați camera înainte de captură.

Luminozitatea se poate schimba când direcția de operare a diafragmei se schimbă, de exemplu, la
deschiderea diafragmei după închiderea acesteia sau la închiderea diafragmei după deschiderea
acesteia. În acest caz, ajustați dinainte puțin mai mult decât este necesar și apoi reveniți puțin,
verificați luminozitatea și apoi începeți captura. De exemplu, dacă doriți să deschideți diafragma la
apertura F8 și să estompați fundalul, mai întâi închideți diafragma peste F8 și apoi reveniți la F8,
verificați luminozitatea și începeți captura.

Efectuați operațiile de control pentru bokeh lent. Dacă trebuie să accelerați operarea, încercați să
reglați treptat în timp ce verificați modificarea imaginii.

Sugestie

Când funcția de control pentru bokeh este setată la On, filtrul ND și amplificarea acționează
împreună pentru a decala modificările expunerii din cauza reglării diafragmei, permițându-vă să
schimbați nivelul de efect bokeh.

Controlul pentru bokeh este mai întâi asociat la filtrul ND ca răspuns la operarea diafragmei. Când
filtrul ND nu mai poate fi modificat, amplificarea este asociată.

În modul MF, vă recomandăm să deschideți mai întâi diafragma și apoi să reglați focalizarea.

Dacă utilizați opțiunea Auto ND Filter în locul funcției de control pentru bokeh, filtrul ND urmează
modificarea luminozității subiectului.

Afișajul în timpul operării legăturii amplificării
Când funcția de control pentru bokeh este setată la On, amplificarea se poate schimba pe
măsură ce diafragma este reglată.
Când legătura amplificării este activă și amplificarea se modifică, apare un mesaj în partea de
sus a ecranului și pictograma  (B) de pe indicatorul de amplificare luminează intermitent.

Setați funcția de control pentru bokeh la On.1

Reglați filtrul ND și amplificarea pentru a stabili expunerea.2

Reglează diafragma.
Nivelul de efect bokeh se schimbă.

3
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[127] Funcții utile Salvarea și încărcarea datelor de configurare

Prezentare generală a salvării și încărcării datelor de
configurare

Puteți să salvați setările unității ca date de configurare utilizând aplicația web. Acest lucru vă
permite să reapelați rapid un set adecvat de setări de meniu pentru situația actuală.
Cu această unitate, puteți salva aproape toate setările pentru funcțiile camerei, cu excepția
celor menționate în nota de mai jos, ca fișier ALL (fișier cu toate setările).

Notă

Setările funcțiilor de rețea și informațiile de autentificare nu sunt salvate. Pentru detalii despre
elementele salvate, consultați „Lista elementelor de meniu”.

[128] Funcții utile Salvarea și încărcarea datelor de configurare

Salvarea unui fișier ALL

Acest subiect descrie cum se salvează un fișier ALL.

[129] Funcții utile Salvarea și încărcarea datelor de configurare

Deschideți [Project] > [All File] în meniul web.1

Apăsați butonul [Save All File] > [Save].
Browserul va descărca un fișier denumit temporar all-file.ALL.

2

Specificați o locație și un nume de fișier pentru fișierul descărcat
all-file.ALL și salvați-l.
Pentru detalii despre operațiile asupra fișierului, consultați instrucțiunile de utilizare ale
dispozitivului dvs.

3
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Încărcarea unui fișier ALL

Acest subiect descrie cum se încarcă un fișier ALL.

Notă

Unitatea va reporni automat după încărcarea datelor de configurare. După repornire, reîncărcați
pagina în browser.

[130] Funcții de rețea Transferarea fișierelor

Despre transferul de fișiere

Puteți încărca un fișier proxy sau fișierul original care a fost înregistrat pe unitate pe un server
de pe Internet sau din rețeaua locală.

Notă

Deschideți [Project] > [All File] în meniul web.1

Apăsați butonul [Load All File] > [Load].
Apare dialogul de deschidere a fișierului pe dispozitivul pe care rulează aplicația web.

2

Deschideți fișierul pe care doriți să-l încărcați.
Pentru detalii despre operațiile asupra fișierului, consultați instrucțiunile de utilizare ale
dispozitivului dvs.

3

Când apare ecranul de confirmare a fișierului de încărcat, apăsați
butonul [OK].

4

Când apare ecranul cu rezultatul executării, apăsați butonul [OK].5

Așteptați repornirea unității și apoi reconectați aplicația web.6
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Când sursa de alimentare este setată la starea de standby, transferurile de fișiere sunt puse în
așteptare chiar dacă unitatea are încă alimentare.

[131] Funcții de rețea Transferarea fișierelor

Înregistrarea unei destinații de transfer al fișierelor

Puteți înregistra un server destinație de transfer înainte de a începe un transfer de fișiere.

Selectați [Network] > [File Transfer] > [Default Upload Server] >
[Server Settings1] (sau [Server Settings2], [Server Settings3]) în
meniul web.

Sugestie

Numele opțiunii de selectare se va schimba în funcție de valoarea [Display Name]
configurată la pasul următor.

1

Configurați următoarele elemente pentru [Network] > [FTP Server
1] la [FTP Server 3] în meniul web.
[Display Name]
Introduceți numele serverului de afișat în lista cu sarcini de transfer la selectarea unui
server destinație de transfer.
[Service]
Afișează tipul serverului.
[FTP]: server FTP
[Host Name]
Introduceți adresa sau numele gazdei serverului.
[Port]
Introduceți numărul portului serverului la care vă veţi conecta.
[User Name]
Introduceți numele de utilizator.
[Password]
Introduceţi parola.
[Passive Mode]
Activează/dezactivează modul pasiv.
[Destination Directory]
Introduceți numele directorului din serverul de destinație.

2
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[132] Funcții de rețea Transferarea fișierelor Selectarea și încărcarea unui fișier

Încărcarea unui fișier proxy pe un card de memorie din
ecranul cu miniaturi

Puteți încărca individual fișiere proxy pe un card de memorie din ecranul cu miniaturi.

Notă

În cazul în care caracterele nevalide de pe serverul destinație sunt introduse în [Destination
Directory], fișierele vor fi transferate în directorul de pornire al utilizatorului. Caracterele
nevalide vor varia în funcție de server.

[Using Secure Protocol]
Setați dacă se efectuează un transfer FTP securizat.
[Root Certificate]
Încărcați/ștergeți un certificat.
[Load]: încărcați un certificat CA. Încarcă certificate în format PEM.
[Clear]: ștergeți certificatul CA.
[None]: nu încărcați sau nu ștergeți niciun certificat.

Notă

Setați ceasul unității la ora corectă înainte de a încărca un certificat CA.

La înregistrarea în XAVC-I 4096×2160P/3840×2160P 59.94/50P, opțiunea [Load] nu poate fi
selectată.

[Root Certificate Status]: afișează starea de încărcare a certificatului.
[Reset]: restabilește setările Server Settings la valorile implicite.

Apăsați butonul [Thumbnail] de pe ecran de operare în timp real al
aplicației web.
Afișajul se schimbă de la imaginea camerei la ecranul cu miniaturi.

1

Selectați [Thumbnail] > [Transfer Clip (Proxy)] > [Select Clip] din
meniul camerei.

2
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Notă

Pot fi înregistrate până la 200 de lucrări de transfer.

[133] Funcții de rețea Transferarea fișierelor Selectarea și încărcarea unui fișier

Încărcarea unui fișier original pe un card de memorie
din ecranul cu miniaturi

Puteți încărca un fișier original pe un card de memorie din ecranul cu miniaturi.

Pentru a transfera toate fișierele proxy simultan, selectați [Transfer Clip (Proxy)] > [All
Clips].
Clipurile pot fi transferate de pe ecranul miniatural sau de pe ecranul miniatural al clipurilor
filtrate.

Selectați clipul pe care doriți să-l transferați, utilizând butonul [Set]
și apăsați butonul [Menu].
Apare un ecran de confirmare a transferului.

3

Selectați [Execute].
Fișierul proxy corespunzător clipului selectat este înregistrat ca o sarcină de transfer și
începe încărcarea.
Când activitatea de transfer este înregistrată cu succes, apare ecranul cu rezultatele
transferului.

4

Apăsați butonul [OK].5

Apăsați butonul [Thumbnail] de pe ecran de operare în timp real al
aplicației web.
Afișajul se schimbă de la imaginea camerei la ecranul cu miniaturi.

1
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Notă

Pot fi înregistrate până la 200 de lucrări de transfer.

[134] Funcții de rețea Transferarea fișierelor Selectarea și încărcarea unui fișier

Verificarea stării transferului de fișiere

Puteți să verificați starea transferului de fișiere, selectând [Network] > [File Transfer] > [View
Job List] din meniul camerei.

Notă

Pot fi înregistrate până la 200 de lucrări de transfer.

Sarcinile de transfer sunt stocate când unitatea este comutată în starea de standby, dar până la 10
minute din informațiile despre progresul recent pot fi pierdute dacă alimentarea este deconectată în

Selectați [Thumbnail] > [Transfer Clip] > [Select Clip] din meniul
camerei.
Pentru a transfera toate fișierele originale simultan, selectați [Transfer Clip] > [All Clips].
Clipurile pot fi transferate de pe ecranul miniatural sau de pe ecranul miniatural al clipurilor
filtrate.

2

Selectați clipul pe care doriți să-l transferați, utilizând butonul [Set]
și apăsați butonul [Menu].
Apare un ecran de confirmare a transferului.

3

Selectați [Execute].
Fișierul original corespunzător clipului selectat este înregistrat ca o sarcină de transfer și
începe încărcarea.
Când activitatea de transfer este înregistrată cu succes, apare ecranul cu rezultatele
transferului.

4

Apăsați butonul [OK].5
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alt mod.

Dacă apare o eroare în timpul transferului de fișiere, transferul unui clip cu același nume ca un clip
transferat nu poate fi reluat, în funcție de setările și starea serverului destinație a transferului. În
acest caz, verificați setările și starea serverului de destinație a transferului.

Sugestie

Dacă opțiunea [Network] > [File Transfer] > [Auto Upload (Proxy)] este setată la [On] din meniul
camerei și există o conexiune la rețea, fișierele proxy sunt încărcate automat pe serverul specificat,
utilizând [Default Upload Server] când înregistrarea se oprește.

[135] Funcții de rețea Transferarea fișierelor

Încărcarea utilizând un server FTP securizat

Puteți încărca fișiere cu criptare folosind FTPS în modul Explicit (FTPES) pentru conexiunea cu
serverul de fișiere de destinație.
Pentru un transfer FTP securizat, setați [Using Secure Protocol] la [On] în setările serverului de
fișiere destinație și încărcați un certificat.

Pentru detalii cu privire la configurare, consultați „Înregistrarea unei destinații de transfer al
fișierelor”.

[136] Funcții de rețea Configurarea redării în timp real

Despre redarea în timp real

Unitatea poate reda în timp real conținutul video și audio, care este transmis de conectorul
HDMI.

Notă

Pentru a utiliza redarea în timp real ca sursa video principală, setați [Monitoring] > [Output Display]
> [SDI] to [On] și [HDMI/Stream] la [Off] în meniul web și monitorizați starea camerei pe un monitor
SDI.

Dacă un monitor conectat la conectorul HDMI nu acceptă formatul de ieșire HDMI, configurat
utilizând meniul [Monitoring] din meniul web sau meniul camerei, imaginea camerei nu va fi
transmisă către aplicația web. Nu poate să fie transmisă redarea video în timp real.
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Rezoluția de redare în timp real nu poate fi setată să fie mai înaltă decât rezoluția semnalului de
ieșire HDMI.

Când este vizualizată de mai mulți utilizatori, imaginea se poate distorsiona în funcție de setările
codecurilor.

Unitatea acceptă următoarele metode de redare în timp real. Codecurile video disponibile
pentru selectare sunt afișate în paranteză.

RTSP (H.264, H.265)
SRT-Caller (H.264)
SRT-Listener (H.264)
NDI|HX (H.264, H.265)

Configurați setarea formatului de redare în timp real, setarea codecurilor video și a celor audio,
în această ordine.

Format de redare în
timp real

Setare codec

Video
Stream 1

Video
Stream 2

Video
Stream 3

Audio
Stream

RTSP
●
video 1

●
video 2

– ●

SRT ● – – ●

NDI|HX
●
Main

●
Sub

– ●

Web App – – ● –

●: Activat, –: Dezactivat

Sugestie

Imaginea din panoul cu imaginea camerei din aplicația web este de asemenea un sistem de redare
în timp real.

[137] Funcții de rețea Configurarea redării în timp real
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Setarea formatului de redare în timp real

Setați formatul de redare în timp real utilizând [Stream] > [Stream] > [Stream Setting] > [Setting]
din meniul web.

Când opțiunea [Setting] este setată la [RTSP]

La redarea în timp real RTSP, imaginea de la o singură cameră poate fi vizualizată simultan de
maximum cinci utilizatori.
Puteți seta până la două moduri de codec video.
[Port Number]
Setează numărul portului de utilizat pentru redarea în timp real RTSP. Valoarea implicită este
554.
Schimbarea setării va reinițializa serverul RTSP.
[Time Out]
Specifică timpul de expirare a comenzii Keep-Alive (Menține activ) pentru redarea în timp real
RTSP. Timpul de expirare poate fi setat între 0 și 600 de secunde. Valoarea implicită este 60 de
secunde.
Când este setat la 0 secunde, expirarea nu are loc pentru comanda Keep-Alive (Menține activ).
[Authentication]
Setează dacă este necesară autentificarea.
[Video Port Number 1], [Video Port Number 2]
Specifică numărul portului pentru comunicarea datelor despre imagini de utilizat pentru redarea
în timp real RTSP între două puncte. Valoarea implicită din fabrică pentru Video Port Number 1
este 51000. Valoarea implicită din fabrică pentru Video Port Number 2 este 53000. Specificați
un număr par în intervalul dintre 1024 și 65534. Numărul setat aici și numărul impar următor,
obținut adunând 1, devin cele două numere de porturi utilizate pentru controlul și comunicările
de date despre imagini.
[Video Port Number 1] și [Video Port Number 2] corespund opțiunilor [Stream] > [Video Stream]
> [Video Stream 1] și [Video Stream 2].
[Audio Port Number]
Specifică numărul portului pentru comunicarea datelor audio de utilizat pentru redarea în timp
real RTSP între două puncte. Valoarea implicită este 57000. Specificați un număr par în
intervalul dintre 1024 și 65534. Numărul setat aici și numărul impar următor, obținut adunând 1,
devin cele două numere de porturi utilizate pentru controlul și comunicările de date audio.

Când opțiunea [Setting] este setată la [SRT-Caller] sau [SRT-
Listener]
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Modul codecului video poate fi doar H.264.
[Destination]
Se afișează când modul de redare în timp real este setat la [SRT-Caller]. Setează URL-ul
destinație al conexiunii.
[Port Number]
Se afișează când modul de redare în timp real este setat la [SRT-Listener]. Setează numărul
portului pe care se ascultă. Valoarea implicită este 4201.
[Latency]
Setează latența în intervalul dintre 20 ms și 8000 ms. Valoarea implicită este 120.
[TTL]
Setează valoarea TTL în intervalul dintre 1 și 255. Valoarea implicită este 64.
[Encryption]
Selectează metoda de criptare. Selectați opțiunile Off, AES128 sau AES256. Valoarea implicită
este Off.
[Passphrase]
Setează expresia de acces utilizată pentru criptare. Apăsarea butonului [Reset] va reseta
expresia de acces configurată.
[ARC]
Pentru activa funcția Adaptive Rate Control, setați-o la On.
Când funcția Adaptive Rate Control este activată, întreruperile în imagine cauzate de
aglomerarea liniei de comunicare pot fi reduse.

Când opțiunea [Setting] este setată la [NDI|HX]

Unitatea este compatibilă cu NDI|HX, versiunea 2 de la NewTek.
Pentru a utiliza NDI|HX, trebuie achiziționată o cheie de licență.
Achiziționarea unei chei de licență
Achiziționați-o de la adresa URL NewTek de mai jos.
http://new.tk/ndi_sony

Notă

Descărcați cel mai recent driver NDI|HX și instalați-l într-un produs NewTek.

Pentru detalii despre înregistrarea și utilizarea NDI|HX, consultați instrucțiunile de utilizare pentru
produsul NewTek.

[License]
Afișați informațiile despre licență pentru o licență activată.
[Source Name]
Afișează numele sursei.
[Group]
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Pentru activa funcția de grupare NDI, setați-o la On.
[Group Name]: setează numele grupului NDI. Pot fi configurate mai multe setări, separate de o
virgulă.
[Discovery Server 1], [Discovery Server 2]
Setează serverul de descoperire NDI 1 și serverul de descoperire NDI 2.
[Reliable UDP Mode]
Pentru activa Reliable UDP Mode, setați-l la On.
[Multicast Mode]
Pentru activa redarea în timp real între mai multe puncte, setați-o la On.
[Multicast Prefix]: setează prefixul de utilizat pentru redarea în timp real între mai multe puncte.
[Multicast Netmask]: setează masca de rețea care stabilește intervalul de adrese pentru
comunicarea între mai multe puncte.
[Multicast TTL]: setează valoarea TTL pentru redare în timp real între mai multe puncte în
intervalul dintre 1 și 256. Valoarea implicită este 3.
[Multi-TCP Mode]
Pentru activa Multi-TCP Mode, setați-l la On.
[Unicast UDP Mode]
Pentru activa Unicast UDP Mode, setați-l la On.

Despre software-ul și serviciile terțe
Pot fi aplicabile condiții diferite.

Furnizarea serviciilor și a actualizărilor software poate fi întreruptă sau anulată fără
notificare.
Descrierea serviciilor și software-ului poate fi modificată fără notificarea.
Pot fi necesare înregistrare și abonare separate.

Sony nu va fi răspunzătoare pentru nicio plângere înaintată de utilizatori sau o parte terță din
cauza utilizării serviciilor și software-ului altor companii.

[138] Funcții de rețea Configurarea redării în timp real

Setarea codecului video pentru redarea în timp real

Setați codecul video utilizând opțiunea [Stream] > [Video Stream] din meniul web.

[Video Stream 1], [Video Stream 2], [Video Stream 3]
Puteți seta până la trei moduri pentru codecul de imagine. Configurați următoarele setări
separat pentru fiecare mod de imagine.
[Video Stream 3] se utilizează pentru afișarea pe panoul cu imaginea camerei din aplicația web.
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Notă

Când opțiunea [Stream] > [Stream Setting] > [Setting] este setată la [SRT-Caller] sau [SRT-
Listener], unele dintre setările [Video Stream 1], [Video Stream 2] și [Video Stream 3] ([Codec],
[Size], [Frame Rate], [Bit Rate Compression Mode]) au valori implicite.

[Codec 1], [Codec 2], [Codec 3]
Selectați [H.264], [H.265] sau [Off]. Rețineți că [Codec 1] nu poate fi setat la [Off]. De
asemenea, [Codec 3] este setat la [JPEG] (fix).

Notă

Următoarele simptome pot să apară în funcție de combinația diferitelor setări, cum ar fi
dimensiunea imaginii, rata de cadre și rata de biți pentru [Codec 1], [Codec 2] și [Codec 3].

Latență video mărită.
Omiterea cadrelor în timpul redării video.
Sunet intermitent.
Camera răspunde lent la diferite comenzi.
Camera răspunde lent la comenzi de la o telecomandă.
Afișarea și configurarea ecranului monitorului sunt lente.

Dacă vă confruntați cu aceste simptome, reduceți valorile parametrilor precum dimensiunea
imaginii, rata de cadre și rata de biți sau schimbați valorile altor parametri de configurare pentru a
rezolvat problema.

Când opțiunea [Stream] > [Stream Setting] > [Setting] este setată la [SRT-Caller] sau [SRT-
Listener], [Codec 1] este setat la [H.264] (fix). [Codec 2] este setat la [Off] (fix).

Când dimensiunea imaginii sau frecvența sistemului pentru ieșirea HDMI este schimbată, [Codec 2]
este setat la [Off].

[Size 1], [Size 2], [Size 3]
Selectează dimensiunea imaginii de redat în timp real de la cameră.
Opțiunile disponibile pentru dimensiunea imaginii variază în funcție de dimensiunea imaginii
pentru ieșirea HDMI.

Notă

Când dimensiunea imaginii sau frecvența sistemului pentru ieșirea HDMI este schimbată, va fi
selectată dimensiunea maximă a imaginii.

[Frame Rate 1], [Frame Rate 2], [Frame Rate 3]
Setează rata de cadre a imaginii.
Unitățile „cps” indică numărul de cadre redate în timp real pe secundă.
Opțiunile disponibile pentru rata de cadre variază în funcție de dimensiunea imaginii pentru
ieșirea HDMI.
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Notă

Când dimensiunea imaginii sau frecvența sistemului pentru ieșirea HDMI este schimbată, va fi
selectată rata de cadre maximă pentru imagine.

[I-Picture Mode 1], [I-Picture Mode 2]
Setează metoda de specificare a intervalului de inserare a imaginii I pentru H.264 și H.265 la
[Time] sau [Frame].
Nu se poate seta pentru [Codec 3].
[Time]: setează intervalul de inserare a imaginii I ca durată.
[Time]: setează intervalul de inserare a imaginii I ca număr de cadre.
[I-Picture Interval 1], [I-Picture Interval 2]
Setează intervalul de inserare a imaginii I în unități de secunde. Setează o valoare din intervalul
dintre 1 și 5 secunde. Valoarea implicită este 1 secundă.
Nu se poate seta pentru [Codec 3].
[I-Picture Ratio 1], [I-Picture Ratio 2]
Setează intervalul de inserare a imaginii I pentru H.264 și H.265 ca număr de cadre între 15 și
300. Valoarea implicită este 300 de cadre.
Nu se poate seta pentru [Codec 3].
[Profile 1], [Profile 2]
Setează profilul codecului de imagine H.264 sau H.265.
[H.264]: selectați profilul [high], [main] sau [baseline].
[H.265]: selectați profilul [main] sau [main10]. Când sunt activate două codecuri video, este
disponibilă numai opțiunea de selectare a profilului [main].
Eficiența de compresie a imaginii crește în următoarea ordine: [high], [main] și [baseline].
Selectați un profil acceptat de sistemul dvs.
Când [H.265] este setat la [main10], operarea are loc în [main10] când ieșirea HDMI este
YCrCb sau [main] când ieșirea HDMI este RGB.
Nu se poate seta pentru [Codec 3].
[Bit Rate Compression Mode 1], [Bit Rate Compression Mode 2]
Selectați [CBR] sau [VBR].
Pentru a menține o rată de biți constantă, selectați [CBR]. Pentru a menține calitatea imaginii,
selectați [VBR].
Nu se poate seta pentru [Codec 3].

Notă

Rata de cadre și rata de biți redate efectiv în timp real pot să fie diferite de valorile setate, în funcție
de dimensiunea imaginii, scena capturată, mediul rețelei și alți factori.

Când opțiunea [Stream] > [Stream Setting] > [Setting] este setată la [SRT-Caller] sau [SRT-
Listener], [Bit Rate Compression Mode 1] este setat la [CBR] (fix).

[Bit Rate 1], [Bit Rate 2]
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Puteți seta rata de biți per flux video când [Bit Rate Compression Mode] este setat la [CBR].
Setarea unei rate de biți ridicate vă permite să redați în flux imagini video de calitate înaltă.
Nu se poate seta pentru [Codec 3].
[Quality 1], [Quality 2], [Quality 3]
Setează calitatea imaginii în intervalul dintre 1 și 10. Valoarea 10 setează cea mai înaltă
calitatea a imaginii. Valoarea implicită este 6.
Pentru [Quality 1] și [Quality 2], puteți seta calitatea imaginii pentru H.264 setând [Bit Rate
Compression Mode] la [VBR] și [Codec] la [H.264]. Puteți seta calitatea imaginii pentru H.265
setând [Bit Rate Compression Mode] la [VBR] și [Codec] la [H.265].

[139] Funcții de rețea Configurarea redării în timp real

Setarea codecului audio pentru redarea în timp real

Setați codecul audio utilizând opțiunea [Stream] > [Audio Stream] din meniul web.
[Setting]
Pentru activa redarea în timp real audio, setați-o la On.
[Codec]
Selectează tipul de codec de utilizat pentru redarea în timp real audio.
[AAC (256kbps)]: selectați pentru a prioritiza calitatea sunetului.
[AAC (128kbps)]: selectați pentru a prioritiza capacitatea de date.
Această setare nu are niciun efect asupra clipului înregistrat de unitate sau semnalului audio
înglobat în semnalul HDMI/SDI.

[140] Funcții de rețea Configurarea redării în timp real

Pornirea/oprirea redării în timp real

Pentru [RTSP], [SRT-Listener] și [NDI|HX]

Unitatea așteaptă o solicitare de livrare a redării în timp real.
Lansați o aplicație client pentru a vizualiza redarea în timp real și accesați URL-ul afișat în
tabelul de mai jos.
Introduceți valorile pentru numele de utilizator și parola care sunt configurate pe unitate.
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Format de redare în
timp real URL

RTSP

Video Stream
1

rtsp://<camera_address>:<Port>/video1

Video Stream
2

rtsp://<camera_address>:<Port>/video2

SRT-Listener srt://<camera_address>:<Port>

NDI|HX
Consultați instrucțiunile de utilizare pentru dispozitivul client
compatibil cu NDI|HX.

<camera_address>: adresa IP a unității
<Port>: port de listener configurat utilizând [Port Number]

Exemplu de redare RTSP în timp real
Pe unitate pot fi activate două redări în timp real. URL-ul fiecărei redări în timp real este indicat
mai jos.
rtsp://<camera_address>:<Port>/video1 ([Video Stream 1])
rtsp://<camera_address>:<Port>/video2 ([Video Stream 2])

Notă

Nu se garantează redarea în toate aplicațiile sau pe toate dispozitivele.

Pentru [SRT-Caller]

Apăsați butonul [Stream now] de pe fila  (Stream) a ecranului de operare în timp pentru a
începe redarea în timp real. Eticheta butonului se schimbă la [Stop stream] și apare pictograma
[Stream] în partea de sus a panoului cu imaginea camerei.
Apăsați butonul [Stop stream] în timpul redării în timp real pentru a o opri. Eticheta butonului se
schimbă la [Stream now] și dispare pictograma [Stream] din partea de sus a panoului cu
imaginea camerei.

Exemplu de redare în timp real SRT-Listener
URL-ul redării în timp real este indicat mai jos.
srt://<camera_address>:<Port>
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<camera_address>: adresa IP a unității
<Port>: port de listener configurat utilizând [Port Number]

Notă

Nu se garantează redarea în toate aplicațiile sau pe toate dispozitivele.

[141] Ecranul cu miniaturi

Ecranul cu miniaturi

Când apăsați butonul [Thumbnail] de pe ecranul de control al redării sau butonul THUMBNAIL
de pe telecomanda cu infraroșu, clipurile înregistrate pe cardul de memorie sunt afișate pe
panoul cu imaginea camerei. Acest afișaj cu panoul cu imaginea camerei este denumit „ecranul
cu miniaturi”.
Puteți selecta un clip pe ecranul miniatural și puteți începe redarea acelui clip.
Dacă apăsați butonul [Thumbnail] când este afișat ecranul cu miniaturi, acest ecran va fi închis
și se revine la afișajul cu imaginea camerei.
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Notă

Pe ecranul miniatural sunt afișate doar clipurile înregistrate în formatul de înregistrare selectat în
prezent. Dacă nu este afișat un clip înregistrat dorit, verificați formatul de înregistrare. Acordați o
atenție specială acestui fapt, înainte de formatarea (inițializarea) suportului media.

Aspectul ecranului

Miniatura unui clip selectat este afișată pe fundal portocaliu.
Informațiile pentru clipul selectat sunt afișate în partea de jos a ecranului.

Cardul de memorie selectat
Când cardul de memorie este protejat împotriva scrierii, apare o pictogramă de blocare în
dreapta.

1.

Număr clip/număr total de clipuri2.

Miniatură (imagine index)
Afișează imaginea index a unui clip. Când un clip este înregistrat, primul său cadru este
setat automat ca imagine index.
Informațiile despre clip/cadru sunt afișate sub miniatură. Puteți modifica informațiile afișate
utilizând [Thumbnail] > [Customize View] > [Thumbnail Caption] din meniul camerei.

3.

Denumirea clipului
Afișează denumirea clipului selectat.

4.

Formatul de înregistrare5.
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[142] Ecranul cu miniaturi Redarea clipurilor și alte operații cu clipurile

Redarea clipurilor înregistrate

Puteți reda clipuri înregistrate când unitatea este în modul în de standby (Stby).
Acest subiect descrie cum se redau clipurile înregistrate utilizând panoul de control GUI.

Afișează formatul de fișier al clipului selectat.
Informaţii speciale despre înregistrare
Afișează modul de înregistrare numai dacă clipul a fost înregistrat folosind un mod special
de înregistrare.
Pentru clipurile Slow & Quick Motion, rata de cadre este afișată în dreapta.

6.

Durata clipului7.

Data creării8.

Introduceţi cardul de memorie de pe care doriţi să redaţi.1

Apăsați butonul [Thumbnail].
Apar miniaturile clipurilor.

2
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Folosiți butoanele cu săgeți sau panoul de control GUI, pentru a
muta cursorul la miniatura clipului pe care doriți să îl redați.

Notă

Clipurile nu pot fi selectate prin operare tactilă.

3

Apăsați butonul [Set] din panoul de control GUI.
Redarea porneşte de la începutul clipului selectat.

4
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Notă

Poate exista o „rupere” de scurtă durată a imaginii sau se pot afişa imagini statice la limita dintre
clipuri. Nu puteți acționa unitatea în acest timp.

Când selectați un clip în ecranul miniatural și începeți redarea, poate exista o „rupere” scurtă a
imaginii la începutul clipului. Pentru a vizualiza începutul clipului fără întrerupere, treceți unitatea în
modul de redare, puneți în pauză, apăsați butonul  (anterior) pentru a reveni la începutul
clipului și începeți din nou redarea.

Utilizați panoul de control al redării cum doriți.

Buton Function

Butonul  (redare/pauză) Redă un clip. În timpul redării, întrerupe clipul.

Butonul  (derulare rapidă
înainte),  (derulare rapidă
înapoi)

Redă un clip la viteză mare. Când butonul este
apăsat, viteza de redare se schimbă în trei
pași.

Butonul  (anterior), butonul
 (următor)

Sare la începutul clipului sau la clipul
anterior/următor.

Butonul  (oprire) Opreşte redarea.

Sugestie

Puteți controla operarea utilizând panoul de control GUI.
Redare: apăsați butonul [Set].
Întrerupere redare: apăsați butonul [Set] în timpul redării. Apăsați din nou pentru a reveni la
redarea normală.
Salt la începutul clipului/începutul următorului clip: apăsați pe butonul din stânga/butonul
din dreapta.
Derulare rapidă înainte/înapoi: apăsați lung butonul din stânga/butonul din dreapta.
Redarea revine la viteza normală când eliberați butonul.
Oprire redare: apăsați butonul [Cancel/Back].

5
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[143] Ecranul cu miniaturi Redarea clipurilor și alte operații cu clipurile

Operații cu clipurile înregistrate

Pe ecranul cu miniaturi, puteți efectua operații cu clipurile sau verifica proprietățile acestora
utilizând meniul [Thumbnail] din meniul camerei.
Apăsați butonul [Menu] de pe ecranul de control al redării, pentru a afișa meniul camerei în
panoul cu imaginea camerei.
Puteți efectua următoare operații utilizând meniul [Thumbnail] din meniul camerei.
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Sugestie
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Puteți apăsa și butonul [Menu] de pe ecranul de operare în timp real pentru a afișa meniul camerei.

Operații efectuate utilizând meniul [Thumbnail] din meniul
camerei

Selectați o funcție de utilizat utilizând butoanele cu săgeți de pe panoul de control GUI și
apăsați butonul [Set].
Apăsați butonul [Cancel/Back] pentru a reveni la ecranul anterior.

Notă

Unele elemente nu pot fi selectate, în funcție de starea în care a fost afișat meniul.

Elemente de meniu pentru operații cu clipuri

Meniul [Thumbnail] din meniul camerei are următoarele elemente pentru operațiile cu clipurile.
[Display Clip Properties]
[Set Clip Flag]
[Lock/Unlock Clip]
[Delete Clip]
[Transfer Clip]
[Transfer Clip (Proxy)]
[Filter Clips]
[Customize View]

Pentru detalii cu privire la fiecare element de meniu, consultați meniul „[Thumbnail]”.

Afișarea ecranului cu proprietățile clipului
Selectați [Thumbnail] > [Display Clip Properties] din meniul camerei pentru a afișa ecranul cu
proprietățile clipului.
Apăsați butonul  (anterior) sau butonul  (următor) pentru a sări la clipul
anterior/următor.

Adăugarea marcajelor în clipuri
Puteți adăuga marcaje în clipuri (marcajele OK, NG sau KP) pentru a filtra modul de afișare a
clipurilor în funcție de marcajele acestora.
Selectați miniatura pentru clipul în care doriți să adăugați un marcaj, apoi selectați marcajul de
clip utilizând [Thumbnail］] > [Set Clip Flag] din meniul camerei.
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Setting S-a adăugat marcaj în clip

[Add OK] OK

[Add NG] NG

[Add KEEP] KP

Sugestie

De asemenea, puteți utiliza un buton alocabil căruia i-a fost atribuită funcția de aplicare a
marcajelor în clipuri pentru a putea adăuga marcaje de clipuri.

Afișarea ecranului cu miniaturile clipurilor filtrate
Selectați [Thumbnail] > [Filter Clips] din meniul camerei și selectați un tip de marcaj de clip,
pentru a afișa numai clipurile care conțin marcajul specificat.
Pentru afișarea tuturor clipurilor, selectați [All].
De asemenea, puteți apăsa butonul [Display] pentru a sorta afișarea miniaturilor după marcaje.

Ștergerea clipurilor
Puteţi şterge clipuri de pe cardurile de memorie.
Selectați [Thumbnail] > [Delete Clip] > [Select Clip] sau [All Clips] din meniul camerei.
[Select Clip]: șterge clipul selectat. Este acceptată selectarea mai multor clipuri.
[All Clips]: șterge toate clipurile afișate.

Modificarea informațiilor afișate pe ecranul cu miniaturi
Puteți modifica informațiile despre clip/cadru afișate sub miniatură.
Selectați [Thumbnail] > [Customize View] > [Thumbnail Caption] din meniul camerei și selectați
informațiile de afișat.
[Date Time]: afișează data și ora la care a fost creat și modificat ultima dată clipul.
[Time Code]: afișează codul de timp.
[Duration]: afișează durata clipului.
[Sequential Number]: afișează un număr secvențial pe fiecare miniatură.

[144] Meniul camerei și setări detaliate

Configurația meniului camerei 
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Când este apăsat butonul [Menu] de pe panoul de control GUI sau butonul MENU de pe
telecomanda cu infraroșu, meniul camerei pentru configurarea diferitelor setări necesare pentru
captură și redare este afișat pe panoul cu imaginea camerei.

Acest meniu include următoarele meniuri.

Configurația meniului

Meniul [User]
Conține elemente de meniu, configurate de utilizator.
Se poate edita utilizând [Edit User Menu].
Meniul [Edit User]
Conține elemente de meniu pentru editarea meniului [User].
Meniul [Shooting]
Conține setări legate de înregistrare.
Meniul [Project]
Conține setări de bază ale proiectului.
Meniul [Paint/Look]
Conține setări legate de calitatea imaginii.
Meniul [Pan-Tilt]
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Conține setări legate de panoramare/înclinare.
Meniul [TC/Media]
Conține setări legate de coduri de timp și medii de înregistrare.
Meniul [Monitoring]
Conține setări pentru ieșirea video și afișarea ecranului.
Meniul [Audio]
Conține setări audio.
Meniul [Thumbnail]
Conține setări legate de afișarea miniaturilor.
Meniul [Technical]
Conține setări pentru elemente tehnice.
Meniul [Network]
Conține setări legate de rețele.
Meniul [Maintenance]
Conține setări ale dispozitivelor, cum ar fi ceasul și limba.

Configurația și ierarhia meniurilor camerei
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Nivelul 1 Nivelul 2

User
(setări din fabrică)

Base Setting

Focus

S&Q Motion

LUT activ./dezact.

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

Assignable Button

Scene File

Base Look

P/T Acceleration

Clip Name Format

Format Media

Video Signal Monitor

Marker

Zoom

Lens

Edit User Menu
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Nivelul 1 Nivelul 2

Shooting

ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

Alb

White Setting

Offset White

Focus

S&Q Motion

LUT activ./dezact.

Noise Suppression

Flicker Reduce

SteadyShot
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Nivelul 1 Nivelul 2

Project

Base Setting

Rec Format

Cine EI Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Paint/Look

Scene File

Base Look

Reset Paint Settings

Negru

Knee

Detail

Matrix

Multi Matrix

Pan-Tilt P/T Acceleration
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Nivelul 1 Nivelul 2

TC/Media

Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Media Life

Monitoring

Output Format

Display On/Off

Video Signal Monitor

Marker

Audio
Audio Input

Audio Output
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Nivelul 1 Nivelul 2

Miniatură

Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical

Color Bars

Genlock

Tally

Rec Review

Zoom

Lens

APR

Network
Wired LAN

File Transfer

Maintenance

Language

Clock Set

Hours Meter
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[145] Meniul camerei și setări detaliate Utilizarea meniului camerei

Utilizarea meniului camerei

Când este apăsat butonul [Menu] de pe panoul de control GUI sau butonul MENU de pe
telecomanda cu infraroșu, meniul camerei pentru configurarea diferitelor setări necesare pentru
captură și redare este afișat pe panoul cu imaginea camerei.
Meniul este utilizat cu ajutorul butoanelor de pe panoul de control GUI.

Butonul [Menu]: apăsați-l pentru a afișa meniul camerei. Apăsați-l din nou în timp ce este
afișat meniul camerei pentru a-l ascunde.
Butoanele cu săgeți: apăsați butoanele cu săgeți pentru a muta cursorul în sus/în jos/la
stânga/la dreapta în meniul camerei pentru a selecta elementele de meniu sau setările.
Butonul [Set]: apăsați-l pentru a aplica elementul selectat.
Butonul [Cancel/Back]: apăsați-l pentru a reveni la meniul anterior. O modificare nefinalizată
este anulată.

Notă

Unele elemente nu pot fi selectate, în funcție de starea în care a fost afișat meniul.

Setarea elementelor de meniu

Deplasați cursorul pe elementul pe care doriți să-l setați utilizând butoanele cu săgeți de pe
panoul de control GUI și apăsați butonul [Set] pentru a aplica setarea.

Zona de selectare a elementelor de meniu afișează până la opt rânduri. Dacă opțiunile
disponibile pentru un element nu pot fi afișate în același timp, derulați pe ecran mutând
cursorul în sus/în jos.
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Pentru elemente secundare cu un interval mare de setări (de exemplu, de la –99 la +99),
zona de setări nu este afișată. Setarea curentă este evidențiată pentru a indica faptul că
valoarea poate fi modificată.
Selectarea opțiunii [Execute] pentru o funcție va executa funcția respectivă.
Selectarea unui element care necesită confirmare înainte de execuție va ascunde temporar
meniul și va afișa un mesaj de confirmare. Verificați mesajul, apoi selectați dacă executați
sau anulați funcția.

[146] Meniul camerei și setări detaliate Utilizarea meniului camerei

Introducerea unui șir de caractere

Când selectați un element, cum ar fi o denumire de fișier, care necesită introducerea
caracterelor, apare ecranul de introducere a caracterelor.

Apăsați butoanele cu săgeți de pe panoul de control GUI pentru a
selecta tipul de caracter și a aplica setarea.
[ABC]: caractere alfabetice majuscule
[abc]: caractere alfabetice minuscule
[123]: caractere numerice
[!#$]: caractere speciale

1

Selectați un caracter și apăsați butonul [Set] pentru a aplica
setarea.
Cursorul se mută în câmpul următor.
[Space]: introduce un caracter spațiu la poziția cursorului.

2
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[147] Meniul camerei și setări detaliate Meniul User

User

Acest subiect descrie funcția și setările fiecărui element de meniu.

Element Descriere

Base Setting Elementul Project > Base Setting

Focus Elementul Shooting > Focus

S&Q Motion Elementul Shooting > S&Q Motion

LUT activ./dezact. Elementul Shooting > LUT On/Off

Simul Rec Elementul Project > Simul Rec

Proxy Rec Elementul Project > Proxy Rec

Interval Rec Elementul Project > Interval Rec

Picture Cache Rec Elementul Project > Picture Cache Rec

Assignable Button Elementul Project > Assignable Button

Scene File Elementul Project > Scene File

Base Look Elementul Paint/Look > Base Look

P/T Acceleration Elementul Pan-Tilt > P/T Acceleration

[←] [→]: mută poziția cursorului.
[BS]: șterge caracterul din stânga cursorului (backspace).

La final, apăsați butonul [Done] pentru a aplica setarea.
Șirul de caractere este confirmat și ecranul de introducere a caracterelor dispare.

3
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Element Descriere

Clip Name Format Elementul TC/Media > Clip Name Format

Format Media Elementul TC/Media > Format Media

Video Signal Monitor Elementul Monitoring > Video Signal Monitor

Marker Elementul Monitoring > Marker

Zoom Elementul Technical > Zoom

Lens Elementul Technical > Lens

Edit User Menu Afișează meniul Edit User.

Notă

Puteți adăuga și elimina elemente din meniul [User] folosind meniul [Edit User]. Pot fi configurate
până la 20 de elemente.

[148] Meniul camerei și setări detaliate Meniul Edit User

Edit User

Meniul [Edit User] este afișat la nivelul superior atunci când este selectat meniul [Edit User
Menu] în meniul [User].

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Add Item
Adăugați un element
în meniul [User]

– –
Adaugă un element de meniu de
nivelul 2 în meniul [User].

Customize Reset
Resetează

– – Restabilește elementele de
meniu înregistrate în meniul
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Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

elementele din
meniul [User]

[User] la valoarea implicită din
fabrică.

Element de meniu
de nivelul 2 selectat
în timpul editării

Delete –
Șterge elementul de meniu de
nivelul 2 înregistrat din meniul
[User].

Move –
Rearanjează elementele de
meniu înregistrate în meniul
[User].

Edit Sub
Item

–

Editează (înregistrează/șterge)
sub-elementul de meniu de
nivelul 3 înregistrat în meniul
[User].

[149] Meniul camerei și setări detaliate Meniul Shooting

ISO/Gain/EI

Setează setările pentru amplificare.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

flexib. ISO/dB dB
Selectează modul de
setare a amplificării.

ISO/Gain<L>

Pentru detalii cu
privire la setări,
consultați „Setările
și valorile implicite
pentru ISO/Gain”.

–
Setează valoarea
prestabilită a amplificării
<L>.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Exposure
Index<L>

Când Base ISO este
setat la ISO 800:
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E
Când Base ISO este
setat la ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Când Base
ISO este
setat la ISO
800: 800EI /
6.0E
Când Base
ISO este
setat la ISO
12800:
12800EI /
6.0E

Setează valoarea indicelui
de expunere<L>.

Shockless
Gain

On / Off Off
Activează/dezactivează
funcţia Shockless Gain.

Base
Sensitivity

High / Low Low
Setează sensibilitatea de
bază pentru modul
Custom.

Base ISO ISO 12800 / ISO 800 ISO 800 Setează sensibilitatea ISO
de bază pentru modul Cine
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

El.

[150] Meniul camerei și setări detaliate Meniul Shooting

ND Filter

Setează valorile prestabilite pentru filtrul ND.

Element Setare sub-element Valoare implicită
din fabrică Descriere

flexib. Presetat/Variabil Variable
Selectează modul filtrului
ND.

Preset1
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/4
Setează valoarea
prestabilită 1 pentru filtrul
ND.

Preset2
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/16
Setează valoarea
prestabilită 2 pentru filtrul
ND.

Preset3
1/4 / 1/8 / 1/16 / 1/32 /
1/64 / 1/128

1/64
Setează valoarea
prestabilită 3 pentru filtrul
ND.

[151] Meniul camerei și setări detaliate Meniul Shooting

Shutter

Setează condițiile de operare a obturatorului electronic.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

flexib. Speed / Angle Speed

Selectează modul de utilizare
al obturatorului electronic.
Speed: mod pentru setarea
vitezei obturatorului în
secunde. Selectați pentru a
captura în mod clar subiecți în
mișcare rapidă.
Angle: mod pentru setarea
vitezei obturatorului ca unghi.

Shutter
Speed
On/Off

On / Off Off

Setează dacă timpul de
expunere atunci când este
selectat modul Speed
urmează valoarea [Shutter
Speed] sau este setat pentru
expunere completă.

Shutter
Speed

64F to 1/8000
Setările disponibile
variază în funcție de
frecvența cadrelor
formatului video
selectat.
59.94P: 64F / 32F /
16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/50 /
1/60 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 /
1/4000 / 1/8000
50P: 64F / 32F / 16F /
8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 /
1/8000
29.97P: 64F / 32F /
16F / 8F / 7F / 6F / 5F /
4F / 3F / 2F / 1/30 /

59.94P:
1/60
50P: 1/50
29.97P: 1/30
25P: 1/25
24P/23.98P:
1/24

Setează viteza obturatorului
când este selectat modul
Speed.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

1/40 / 1/50 / 1/60 /
1/100 / 1/120 / 1/125 /
1/250 / 1/500 / 1/1000 /
1/2000 / 1/4000 /
1/8000
25P: 64F / 32F / 16F /
8F / 7F / 6F / 5F / 4F /
3F / 2F / 1/25 / 1/33 /
1/50 / 1/60 / 1/100 /
1/120 / 1/125 / 1/250 /
1/500 / 1/1000 / 1/2000
/ 1/4000 / 1/8000
24P/23.98P: 64F / 32F
/ 16F / 8F / 7F / 6F / 5F
/ 4F / 3F / 2F / 1/24 /
1/32 / 1/48 / 1/50 / 1/60
/ 1/96 / 1/100 / 1/120 /
1/125 / 1/250 / 1/500 /
1/1000 / 1/2000 /
1/4000 / 1/8000

Shutter
Angle

64F / 32F / 16F / 8F /
7F / 6F / 5F / 4F / 3F /
2F / 360.0° / 300,0° /
270,0° / 240,0° /
216,0° / 210,0° /
180,0° / 172,8° /
150,0° / 144,0° /
120,0° / 90,0° / 86,4° /
72,0° / 45,0° / 30,0° /
22,5° / 11,25° / 5,6°

180,0°
Setează unghiul obturatorului
când este selectat modul
Angle.

ECS
On/Off

On / Off Off
Activează/dezactivează funcţia
Extended Clear Scan.

ECS
Frequency

23.99 to 8000
Setările disponibile
variază în funcție de
frecvența cadrelor

59.94P:
60.00
50P: 50.00
29.97P:
30.00

Setează frecvența ECS când
Mode este setat la ECS.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 275/464

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

formatului de
înregistrare selectat.

23.98P:
23.99
25P: 25.02
24P: 24.02

[152] Meniul camerei și setări detaliate Meniul Shooting

Iris

Stabilește setările diafragmei.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Bokeh
Control

On / Off Off
Activează/dezactivează funcția de
control pentru bokeh.

[153] Meniul camerei și setări detaliate Meniul Shooting

Auto Exposure

Setează setările automate de reglare a expunerii.

Element Setare sub-element

Valoare
implicită

din
fabrică

Descriere

Level +3,0 / +2,75 / +2,5 /
+2,25 / +2,0 / +1,75 /
+1,5 / +1,25 / +1,0 /

±0 Setează nivelul de luminozitate
pentru expunerea detectată
automat.
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Element Setare sub-element

Valoare
implicită

din
fabrică

Descriere

+0,75 / +0,5 / +0,25 /
±0 / -0,25 / -0,5 / -0,75 /
-1,0 / -1,25 / -1,5 / -1,75
/ -2,0 / -2,25 / -2,5 /
-2,75 / -3,0

flexib.
Backlight / Standard /
Spotlight

Standard

Setează modul de utilizare al
reglării automate a expunerii.
Backlight: modul Backlight (mod
pentru întunecarea redusă a unui
subiect, atunci când subiectul
este iluminat din spate)
Standard: modul Standard
Spotlight: modul Spotlight (mod
pentru nuanțe de alb reduse
atunci când subiectul este luminat
de reflectoare)

Speed –99 – +99 ±0
Setează viteza de reglare a
expunerii automate.

AGC On / Off Off
Activează/dezactivează funcția
AGC (auto gain control – controlul
automat al amplificării).

AGC Limit

Pentru detalii cu
privire la setări,
consultați „Setările
și valorile implicite
pentru AGC Limit”.

–
Setează amplificarea maximă a
funcției AGC.

AGC Point F2.8 / F4 / F5.6 F2.8
Setează valoarea F-stop a irisului
unde începe funcționarea AGC,
dacă funcția AGC este On.

Auto
Shutter

On / Off Off
Activează/dezactivează funcția
Auto Shutter Control.
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Element Setare sub-element

Valoare
implicită

din
fabrică

Descriere

A.SHT
Limit

1/100 / 1/150 / 1/200 /
1/250 / 1/2000

1/2000
Setează cel mai scurt timp de
expunere pentru funcția Auto
Shutter.

A.SHT
Point

F5.6 / F8 / F11 / F16 F11
Setează valoarea F-stop a irisului
unde începe funcționarea Auto
Shutter.

Clip High
light

On / Off Off

Activează/dezactivează funcţia
care ignoră zonele cele mai
luminoase pentru a oferi o reacţie
mai uniformă la luminozitatea
ridicată.

Detect
Window

1 / 2 / 3 / 4 / 5 / 6 /
Custom

1

Setează domeniul de măsurare a
luminii pentru reglarea automată
a expunerii în funcție de
luminozitatea subiectului. (Nu
este disponibil la reglarea
manuală a expunerii)

Detect
Window
Indication

On / Off Off
Activează/dezactivează indicarea
domeniului de măsurare a luminii.

Custom
Width

40 – 999 500
Setează lățimea domeniului de
măsurare a luminii.

Custom
Height

70 – 999 500
Setează înălțimea domeniului de
măsurare a luminii.

Custom H
Position

–479 – +479 ±0
Setează poziția pe orizontală a
domeniului de măsurare a luminii.

Custom V
Position

–464 – +464 ±0
Setează poziția pe verticală a
domeniului de măsurare a luminii.
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[154] Meniul camerei și setări detaliate Meniul Shooting

White

Setează setările balansului de alb.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Preset
White

2000 K
până la
15000 K

3200K
Setează valoarea prestabilită a balansului de
alb.

Color
Temp
<A>

2000 K
până la
15000 K

3200K

Setează temperatura de culoare a balansului
de alb salvată în memoria A.

Notă

Deoarece Color Temp este trunchiat la
2000 K și 15000 K în timpul utilizării R
Gain/B Gain, este posibil să nu se poată
afișa valoarea corectă pentru temperatura
de culoare pentru valoarea R Gain/B
Gain.

Tint<A> –99 – +99 ±0

Setează valoarea Tint a balansului de alb
salvată în memoria de alb A.

Notă

Deoarece Tint este trunchiat la ±99 în
timpul utilizării R Gain/B Gain, este posibil
să nu se poată afișa valoarea Tint corectă
pentru valoarea R Gain/B Gain.

R Gain
<A>

–99,0 –
+99,0

±0,0
Setează valoarea R gain a balansului de alb
salvată în memoria A.

B Gain
<A>

–99,0 –
+99,0

±0,0
Setează valoarea B gain a balansului de alb
salvată în memoria A.
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[155] Meniul camerei și setări detaliate Meniul Shooting

White Setting

Reglează setările balansului de alb.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Shockless
White

Off / 1 / 2 / 3 2

Setează viteza de răspuns a
balansului de alb la trecerea în
modul balans de alb.
Off: comută instantaneu.
1 to 3: comută cu atât mai lent cu cât
numărul este mai mare.

ATW Speed
1 / 2 / 3 / 4 /
5

3

Setează viteza de răspuns în modul
ATW.
Cea mai mare viteză de răspuns este
1 și cea mai redusă viteză de
răspuns este 5.

[156] Meniul camerei și setări detaliate Meniul Shooting

Offset White

Setează setările de compensare a balansului de alb.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Offset White
<A>

On / Off Off
Selectează dacă este adăugată (On)
sau nu (Off) o valoare de compensare
la balansul de alb în memoria A.
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Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Offset Color
Temp<A>

–99 – +99 ±0

Setează compensarea temperaturii de
culoare care va fi adăugată la balansul
de alb din memoria A atunci când
[Offset White <A>] este setat la On.

Offset Tint<A> –99 – +99 ±0

Setează compensarea valorii Tint care
va fi adăugată la balansul de alb din
memoria A atunci când [Offset White
<A>] este setat la On.

Offset
White<ATW>

On / Off On
Selectează dacă este adăugată (On)
sau nu (Off) o valoare de compensare
la balansul de alb ATW.

Offset Color
Temp<ATW>

–99 – +99 ±0

Setează compensarea temperaturii
culorii care va fi adăugată la balansul
de alb ATW atunci când [Offset
White<ATW>] este setat la On.

Offset
Tint<ATW>

–99 – +99 ±0

Setează compensarea valorii Tint care
va fi adăugată la balansul de alb ATW
atunci când [Offset White<ATW>] este
setat la On.

[157] Meniul camerei și setări detaliate Meniul Shooting

Focus

Setează setările de focalizare.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

AF
Transition

1(Slow) / 2 / 3 /
4 / 5 / 6 / 7(Fast)

5 Setează viteza motorului de acționare
a focalizării când subiectul se modifică



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 281/464

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Speed în timpul focalizării automate.

AF Subj.
Shift Sens.

1(Locked On) / 2
/ 3 / 4 /
5(Responsive)

5(sensibil)
Setează sensibilitatea pentru
schimbarea focalizării pe subiect în
timpul focalizării automate.

Focus
Area

Wide / Zone /
Flexible Spot

Wide

Setează zona țintă pentru Auto Focus
și Push Auto Focus (AF).

Consultați „Reglarea automată a
focalizării (Auto Focus)” și „Setarea
zonei/poziției de focalizare
automată (Focus Area)”.

Wide: caută un subiect pe un unghi
larg al imaginii în timpul focalizării.
Zone: caută automat un punct de
focalizare în zona specificată.
Flexible Spot: focalizează pe o poziție
specificată din imagine.

Focus
Area (AF-
S)

Flexible Spot
Flexible
Spot

Setează zona țintă pentru Push Auto
Focus (AF-S).

Face/Eye
Detection
AF

Face/Eye Only
AF /
Face/Eye
Priority AF / Off

Face/Eye
Priority AF

Activează/dezactivează Face Detection
AF.

Consultați „Urmărirea utilizând
funcția de detectare a feței și a
ochilor (Face/Eye Detection AF)”.

Push AF
Mode

AF / Single-shot
AF(AF-S)

AF Setează modul Push Auto Focus.

Touch
Function in
MF

Tracking AF /
Spot Focus

Tracking AF
Setează operarea când ecranul cu
imaginea camerei este atins în modul
MF.

AF Assist On / Off On Când este setat la On, vă permite să
suprascrieți temporar Auto Focus și Set
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Focus, în mod manual.
Consultați „Setarea manuală a
țintei focalizării automate (AF
Assist) utilizând aplicația web” și
„Focalizarea manuală în timpul
focalizării automate utilizând
telecomandă cu infraroșu
furnizată”.

[158] Meniul camerei și setări detaliate Meniul Shooting

S&Q Motion

Configurează setările modului Slow & Quick Motion (consultați „Mișcarea cu încetinitorul și
rapidă”).

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Setting On / Off Off
Activează/dezactivează modul Slow
& Quick motion.

Frame
Rate

1 cps – 60 cps /
100 cps / 120 cps /
150 cps / 180 cps /
200 cps / 240 cps

–

Setează viteza cadrelor pentru
captura Mișcare cu încetinitorul și
rapidă.

Notă

Setările disponibile variază în
funcție de frecvența selectată a
sistemului, codec și formatul
video.
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[159] Meniul camerei și setări detaliate Meniul Shooting

LUT On/Off

Stabilește setările LUT.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

SDI
MLUT On / MLUT
Off

MLUT Off
Selectează dacă pentru
ieșirea video SDI se aplică
funcția Monitor LUT.

HDMI/Stream
MLUT On / MLUT
Off

MLUT Off

Selectează dacă pentru
ieșirea video HDMI și de
redare în timp real se aplică
funcția Monitor LUT.

Proxy
MLUT On / MLUT
Off

MLUT Off
Selectează dacă pentru
înregistrarea video proxy se
aplică funcția Monitor LUT.

Internal Rec
MLUT On / MLUT
Off

MLUT Off

Selectează dacă pentru
înregistrarea video
principală se aplică funcția
Monitor LUT.

LUT On/Off
Button Target

SDI /
HDMI/Stream /
SDI &
HDMI/Stream

HDMI/Stream

Setează ieșirea țintă
controlată de un buton
alocabil căruia i-a fost
atribuit elementul LUT
On/Off.

[160] Meniul camerei și setări detaliate Meniul Shooting

Noise Suppression
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Setează setările de suprimare a zgomotului.

Sugestie

Setările [Setting(Custom)] și [Level(Custom)] se reflectată în setarea [Target Display].

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Setting(Custom) On / Off On
Activează/dezactivează funcția de
suprimare a zgomotului în modul
Custom.

Level(Custom)
Low / Mid /
High

Mid
Setează nivelul de suprimare a
zgomotului în modul Custom.

Setting(Cine EI) On / Off Off
Activează/dezactivează funcția de
suprimare a zgomotului în modul
Cine El.

Level(Cine EI)
Low / Mid /
High

Mid
Setează nivelul de suprimare a
zgomotului în modul Cine El.

[161] Meniul camerei și setări detaliate Meniul Shooting

Flicker Reduce

Setează setările de corecție a pâlpâirii.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

flexib.
Auto / On /
Off

Off Setează modul de corecție a pâlpâirii.

Frequency 50Hz / 60Hz 60Hz Setează frecvența sursei care
alimentează lumina care generează
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

pâlpâirea.

[162] Meniul camerei și setări detaliate Meniul Shooting

SteadyShot

Setează setările de stabilizare a imaginii.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Setting
Active /
Standard /
Off

Off

Setează funcţia de stabilizare a imaginii.

Notă

Activat atunci când este atașat un
obiectiv compatibil.

Când comutatorul este setat la Active
sau Standard, poate apărea un
comportament imprevizibil la utilizarea
panoramării/înclinării.

[163] Meniul camerei și setări detaliate Meniul Shooting

Base Setting

Setează setările de bază.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Shooting
Mode

Custom / Cine
EI

Custom

Setează modul de fotografiere.
Consultați „Setarea modului de
captură” din „Configurarea
funcționării de bază”.

Target
Display

SDR(BT.709) /
HDR(HLG)

SDR (BT.709)
Setează spațiul de culoare al
înregistrării/ieșirii în modul Custom.

[164] Meniul camerei și setări detaliate Meniul Shooting

Rec Format

Setează setările formatului de înregistrare.

Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Frequency
59,94 / 50 / 29,97 / 25 /
24 / 23,98

59.94
Selectează frecvența
sistemului.

Imager
Scan Mode

FF / S35 FF
Selectează dimensiunea
imaginii.

Codec
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Setează codecul de
înregistrare/redare a clipurilor.

Notă

Când [Imager Scan Mode]
este setat la [S35], [RAW]
și [RAW & XAVC-I] nu pot
fi selectate.
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Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

RAW
Output
Format

Setările disponibile
variază în funcție de
setarea [Frequency].

Consultați „Setările
[RAW Output
Format]” de mai jos.

–

Setează dimensiunea imaginii
RAW la ieșirea către un
recorder RAW extern.

Notă

Când [Codec] este setat la
[RAW & XAVC-I], setarea
[Video Format], va fi
comutată în concordanță
cu setarea [RAW Output
Format].

Format
video

Setările disponibile
variază în funcție de
setările pentru
[Frequency], [Imager
Scan Mode] și [Codec].

Consultați „Setările
[Video Format]” de
mai jos.

–
Setează dimensiunea imaginii
și rata de biți.

Setările [RAW Output Format]

Frequency Imager Scan
Mode Codec Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF
RAW / RAW &
XAVC-I

4096×2160
3840×2160

24 FF
RAW / RAW &
XAVC-I

4096×2160

Valorile implicite sunt afișate cu caractere aldine.
Condițiile în care [RAW Output Format] nu poate fi setat au fost omise.
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Setările [Video Format]

Frequency Imager Scan
Mode Codec Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L

3840×2160P
1920×1080P
50
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P

Valorile implicite sunt afișate cu caractere aldine.

[165] Meniul camerei și setări detaliate Meniul Shooting

Cine EI Setting
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Pentru detalii despre setările modului Cine EI (consultați „Setarea modului de captură” din
„Configurarea funcționării de bază”).

Element Setare sub-element Valoare implicită din
fabrică Descriere

Color
Gamut

S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3
Setează spațiul de
culoare în modul
Cine EI.

[166] Meniul camerei și setări detaliate Meniul Shooting

Simul Rec

Configurează setările modului de înregistrare simultană în 2 sloturi (consultați „Înregistrarea pe
cardurile de memorie A și B simultan (2-slot Simul Rec)”).

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Setting On / Off Off
Activează/dezactivează modul
de înregistrare simultană în 2
sloturi.

Rec
Button
Set

Rec Button: [SlotA
SlotB] 2nd Rec Button:
[SlotA SlotB] / Rec
Button: [SlotA] 2nd Rec
Button: [SlotB] / Rec
Button: [SlotB] 2nd Rec
Button: [SlotA]

Rec Button:
[SlotA SlotB]
2nd Rec
Button: [SlotA
SlotB]

Atribuie butoanele de
înregistrare utilizate pentru a
controla fiecare mediu de
înregistrare.

[167] Meniul camerei și setări detaliate Meniul Shooting

Proxy Rec
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Configurează setările modului de înregistrare proxy (consultați „Înregistrarea proxy”).

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off Off
Activează/dezactivează modul de
înregistrare proxy.

Audio
Channel

CH1/CH2 /
CH3/CH4

CH1/CH2
Selectează canalul audio pentru a
înregistra date proxy.

[168] Meniul camerei și setări detaliate Meniul Shooting

Interval Rec

Configurează setările modului de înregistrare la anumite intervale (consultați „Înregistrarea
video în mod intermitent (Interval Rec)”).

Element Setare sub-element Valoare implicită din
fabrică Descriere

Setting On / Off Off

Activează/dezactivează
modul de înregistrare
la intervale. (Setarea
acestui mod la On va
seta toate celelalte
moduri speciale la Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sec.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min.)
1 / 2 / 3 / 4 / 6 / 12 / 24
(ore)

1

Setează intervalul
dintre înregistrări în
modul de înregistrare
Interval Rec (când
Interval Rec este setat
la On).

Number
of

1frame / 2frames /
3frames /

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:

Setează numărul de
cadre în înregistrări pe
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Element Setare sub-element Valoare implicită din
fabrică Descriere

Frames 6frames / 9frames /
12frames
Setările disponibile
variază în funcție de
frecvența cadrelor
formatului video selectat.
59.94P/50P: 2frames /
6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames /
6frames / 9frames

1frame filmare fără întrerupere
în modul de
înregistrare Interval
Rec (când Interval Rec
este setat la On).

[169] Meniul camerei și setări detaliate Meniul Shooting

Picture Cache Rec

Stabilește setările modului de înregistrare Picture Cache (consultați „Înregistrarea imaginilor în
memoria cache (Picture Cache Rec)”).

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Setting On / Off Off
Activează/dezactivează funcția de
înregistrare a imaginilor în cache.

Cache
Size

Short /
Medium /
Long / Max

Max

Setează timpul pentru acumularea
imaginilor în memoria cache a imaginilor
(timp de înregistrare în memoria cache a
imaginilor).

Cache
Rec Time

– –

Afișează durata pentru acumularea
imaginilor în memoria cache a imaginilor
(timp de înregistrare în memoria cache a
imaginilor).



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 292/464

[170] Meniul camerei și setări detaliate Meniul Shooting

SDI/HDMI Rec Control

Stabilește setările de control pentru înregistrarea SDI/HDMI.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Setting

Off /
SDI/HDMI
Remote I/F /
Parallel Rec

Off

Setează controlul pentru pornirea/oprirea
înregistrării pe un dispozitiv extern conectat,
prin semnalul de ieșire SDI/HDMI.
Off: nu folosiți telecomanda.
SDI/HDMI Remote I/F: controlul de
pornire/oprire a înregistrării pentru un
dispozitiv extern conectat, când în unitate
nu este introdus niciun suport. Nu este
sincronizat cu precizia cadrelor a suportului
din unitate.
Parallel Rec: controlul de pornire/oprire a
înregistrării pentru un dispozitiv extern
conectat, dacă în unitate este introdus un
suport. Este sincronizat cu precizia cadrelor
a suportului din unitate.

Notă

Pentru control utilizând semnalul de
ieșire HDMI, setați [TC/Media] > [HDMI
TC Out] > [Setting] la [On] din meniul
camerei.

[171] Meniul camerei și setări detaliate Meniul Shooting

Assignable Button

Setează funcțiile atribuite butoanelor alocabile (<1> to <9>) și [Focus Hold Button].
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Pot fi atribuite următoarele funcții.
[Off]: nicio funcție atribuită.
[Base ISO/Sensitivity]: Comută sensibilitatea de bază a senzorului de imagine.
[AGC]: activează/dezactivează funcția AGC.
[Push AGC]: activează funcția AGC în timp ce este apăsat butonul.
[ND Filter]

În modul variabil: reglează transmitanța filtrului ND. Apăsați lung pentru a comuta între
modurile Clear/Manual/Auto.
În modul presetat: apăsați lung pentru a comuta presetările.

[ND Filter Position]: comută filtrele ND.
[Auto ND Filter]: activează/dezactivează funcția de filtru ND automat.
[Push Auto ND]: activează funcția de filtru ND automat în timp ce este apăsat butonul.
[Auto Iris]: activează/dezactivează funcția diafragmei.
[Push Auto Iris]: activează funcția de diafragmă automată în timp ce este apăsat butonul.
[Bokeh Control]: activează/dezactivează modul de control pentru bokeh.
[Auto Shutter]: activează/dezactivează funcția de obturator automat.
[AE Level/Mode]: reglează nivelul de AE. Țineți-l apăsat pentru a comuta modul AE.
[Backlight]: comută între Backlight și Standard.
[Spotlight]: comută între Spotlight și Standard.
[Preset White Select]: comută valoarea modului prestabilit al balansului de alb.
[ATW]: activează/dezactivează funcția ATW.
[ATW Hold]: întrerupe operarea funcției ATW.
[AF Speed/Sens.]: comută setarea vitezei de tranziție AF și setarea sensibilității la comutarea
subiectului AF.
[Focus Setting]: setează zona de focalizare.
[Face/Eye Detection AF]: comută setările pentru focalizarea automată cu detecția feței.
[Push AF Mode]: comută setarea modului Push AF.
[Push AF/MF]: în modul de focalizare MF, activează AF în timp ce este apăsat butonul. În
modul de focalizare AF, activează MF în timp ce este apăsat butonul.
[Focus Hold]: în modul de focalizare AF, focalizarea este fixă în timp ce este apăsat butonul.
[S&Q Motion]: activează/dezactivează funcția Slow & Quick Motion. Când butonul este ținut
apăsat, setează rata de cadre pentru captură.
[LUT On/Off] activează/dezactivează funcția LUT. Ținta de comutare este setată utilizând
[Shooting] > [LUT On/Off] > [LUT On/Off Button Target].
[SteadyShot]: comută între Active, Standard și Off.
[Crop Select]: comută modul de scanare a imaginii. Comutarea este activată în interval, fără
modificarea formatului de înregistrare.
[Rec] pornește/oprește înregistrarea.
[Picture Cache Rec]: activează/dezactivează modul de înregistrare a imaginilor în memoria
cache.
[Rec Review]: activează/dezactivează funcția de revizualizare a înregistrării.
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[Clip Flag OK]: execută acțiunea Add OK. Apăsați de două ori pentru a executa Delete Clip
Flag.
[Clip Flag NG]: execută acțiunea Add NG. Apăsați de două ori pentru a executa Delete Clip
Flag.
[Clip Flag Keep]: execută acțiunea Add KEEP. Apăsați de două ori pentru a executa Delete
Clip Flag.
[Slot Select] comută între slotul cardului de memorie (A) și (B).
[Color Bars]: activează/dezactivează barele de culoare.
[DURATION/TC/U-BIT]: comută între Time Code, Users Bit și Duration.
[Display]: activează/dezactivează indicatoarele de pe ecran.
[Lens Info]: comută indicatorul pentru adâncimea câmpului.
[Video Signal Monitor]: comută monitorul de semnal video (cum ar fi un monitor de forme de
undă).
[Marker]: activează/dezactivează funcția de marcare.
[Thumbnail]: afișează/iese din ecranul cu miniaturi.
[Auto Upload (Proxy)]: activează/dezactivează transferul automat al fișierelor proxy.
[Direct Menu]: afișează/iese din meniul direct.
[User Menu]: afișează/iese din meniul User.

[172] Meniul camerei și setări detaliate Meniul Paint/Look

Scene File

Stabilește setările pentru fișierele Scene (consultați „Înregistrarea cu aspectul dorit”).

Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Reapelare – –

Încarcă un fişier Scene
stocat în memoria internă şi
aplică setările ca setări ale
calităţii imaginii curente.

Store – –
Salvează starea calităţii
imaginii curente ca fişier
Scene în memoria internă.

Delete – –
Şterge un fişier Scene
stocat în memoria internă.
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Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Preset
Recall

Când Shooting Mode este
setat la Custom și Target
Display este setat la
SDR(BT.709): S-Cinetone /
Standard / Still / ITU709
Când Shooting Mode este
setat la Custom și Target
Display este setat la
HDR(HLG): HLG Live / HLG
Natural

–

Aplică setările calităţii
imaginii presetate
(nereinscriptibile) ca setări
ale calităţii imaginii curente.

[173] Meniul camerei și setări detaliate Meniul Paint/Look

Base Look

Stabileşte setările legate de aspectul de bază.

Element Setare sub-element Valoare implicită din
fabrică Descriere

Select Când Shooting Mode este
setat la Custom și Target
Display este setat la
SDR(BT.709): S-Cinetone /
Standard / Still / ITU709 /
User1 - User16
Când Shooting Mode este
setat la Custom și Target
Display este setat la
HDR(HLG): HLG Live /
HLG Natural / User1 to
User16
Când Shooting Mode este
setat la Cine EI: s709 /

Când Shooting Mode
este setat la Custom și
Target Display este
setat la SDR(BT.709): S-
Cinetone
Când Shooting Mode
este setat la Custom și
Target Display este
setat la HDR(HLG):
HLG Live
Când Shooting Mode
este setat la Cine EI:
s709

Selectează un
aspect de bază.
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Element Setare sub-element Valoare implicită din
fabrică Descriere

709(800) / S-Log3 / User1 -
User16

Delete – –
Şterge aspectul
de bază
selectat.

Ştergere
toate

– –
Şterge toate
aspectele de
bază.

Intrare
S-Gamut3/SLog3 / S-
Gamut3.Cine/SLog3

S-Gamut3.Cine/SLog3

Setează gama
de intrare
pentru aspectul
de bază selectat
utilizând
[Select].

Output BT.709 / HLG BT.709

Setează gama
de culori de
ieșire pentru
aspectul de
bază selectat
utilizând
[Select].

AE Level
Offset

0EV / 1/3EV / 2/3EV / 1EV /
4/3EV / 5/3EV / 2EV

0EV

Setează
valoarea de
referință pentru
expunere pentru
aspectul de
bază selectat
utilizând
[Select].

[174] Meniul camerei și setări detaliate Meniul Paint/Look
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Reset Paint Settings

Restabilește setările meniului [Paint/Look], excluzând aspectul de bază.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Reset without
Base Look

Execute /
Cancel

–

Restabilește setările meniului
[Paint/Look], excluzând aspectul
de bază.
Execute: execută funcția.

[175] Meniul camerei și setări detaliate Meniul Paint/Look

Black

Stabilește setările de negru.

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Master
Black

–99,0 – +99,0 ±0,0
Setează nivelul master de
negru.

R Black –99,0 – +99,0 ±0,0
Setează nivelul de negru
R.

B Black –99,0 – +99,0 ±0,0
Setează nivelul de negru
B.

[176] Meniul camerei și setări detaliate Meniul Paint/Look

Knee



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 298/464

Stabilește setările de corecție pentru cotire.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Setting

Când Target
Display este
setat la
SDR(BT.709): On
/ Off / ---
Când Target
Display este
setat la
HDR(HLG): On /
Off / ---

Când Target
Display este setat
la SDR(BT.709):Off
Când Target
Display este setat
la HDR(HLG):Off

Activează/dezactivează funcţia
de corecție pentru cotire.

Notă

Este activat numai când
opțiunea [Base Look] >
[Select] este setată la
[Standard], [ITU709],
[HLG Live] sau [HLG
Natural].

Auto
Knee

Când Target
Display este
setat la
SDR(BT.709): On
/ Off / ---
Când Target
Display este
setat la
HDR(HLG): On /
Off / ---

Când Target
Display este setat
la SDR(BT.709):On
Când Target
Display este setat
la HDR(HLG):Off

Activează/dezactivează funcţia
pentru cotire automată.

Notă

Este activat numai când
opțiunea [Base Look] >
[Select] este setată la
[Standard] sau [ITU709].

Point 75 % – 109 % 90% Setează punctul de cotire.

Slope –99 – +99 ±0 Setează panta.

[177] Meniul camerei și setări detaliate Meniul Paint/Look

Detail

Setează setările de ajustare pentru detalii.
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Setting On / Off On
Activează/dezactivează funcţia legată de
detalii.

Level −7 - +7 ±0 Setează nivelul de detaliu.

Manual
Setting

On / Off / --- Off
Activează/dezactivează funcţia de ajustare
manuală a detaliilor.

V/H
Balance

−2 - +2 ±0
Setează balansul între detaliile de pe
verticală (V) şi de pe orizontală (H) pentru
ajustarea manuală a detaliilor.

B/W
Balance

Type1 /
Type2 /
Type3 /
Type4 /
Type5

Type3

Setează balansul între detaliile de negru
(B) pentru zonele cu luminozitate redusă şi
detaliile de alb (W) pentru zonele cu
luminozitate ridicată pentru ajustarea
manuală a detaliilor.

Limit 0 la 7 7
Setează nivelul limită al detaliilor pentru
ajustarea manuală a detaliilor.

Crispening 0 la 7 0
Setează nivelul de claritate pentru
ajustarea manuală a detaliilor.

High Light
Detail

0 la 4 0
Setează nivelul detaliilor zonelor cu
luminozitate ridicată pentru ajustarea
manuală a detaliilor.

[178] Meniul camerei și setări detaliate Meniul Paint/Look

Matrix

Stabilește setările de corecție ale matricei.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

User Matrix On / Off Off
Activează/dezactivează funcţia de
corecție a matricei utilizatorului.

User Matrix
Level

–99 – +99 ±0
Ajustează saturația culorii întregii
imagini.

User Matrix
Phase

–99 – +99 ±0
Ajustează tonul (faza) culorii întregii
imagini.

User Matrix
R-G

–99 – +99 ±0
Setează o matrice a utilizatorului R-G,
definită de utilizator.

User Matrix
R-B

–99 – +99 ±0
Setează o matrice a utilizatorului R-B,
definită de utilizator.

User Matrix
G-R

–99 – +99 ±0
Setează o matrice a utilizatorului G-R,
definită de utilizator.

User Matrix
G-B

–99 – +99 ±0
Setează o matrice a utilizatorului G-B,
definită de utilizator.

User Matrix
B-R

–99 – +99 ±0
Setează o matrice a utilizatorului B-R,
definită de utilizator.

User Matrix
B-G

–99 – +99 ±0
Setează o matrice a utilizatorului B-G,
definită de utilizator.

[179] Meniul camerei și setări detaliate Meniul Paint/Look

Multi Matrix

Stabilește setările de corecție ale matricei multiple.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Setting On / Off Off
Activează/dezactivează funcţia
de corecție a matricei multiple.

Reset Execute / Cancel –
Resetează nuanța și saturația
culorii fiecărei axe la valorile
implicite.

Axis

B / B+ / MG− / MG /
MG+ / R / R+ / YL− /
YL / YL+ / G− / G / G+
/ CY / CY+ / B−

B Selectează axa.

Hue –99 – +99 ±0
Setează nuanța culorii utilizate
pentru corecția matricei multiple.

Saturation –99 – +99 ±0
Setează saturația culorii utilizate
pentru corecția matricei multiple.

[180] Meniul camerei și setări detaliate Meniul Pan-Tilt

P/T Acceleration

Configurează setările legate de accelerare pentru operațiile de panoramare/înclinare.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Ramp
Curve

1 – 9 8

Selectează accelerarea/decelerarea pentru
operațiile de panoramare/înclinare. Cu cât
numărul este mai mare, cu atât mai mare este
și accelerarea.
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[181] Meniul camerei și setări detaliate Meniul TC/Media

Timecode

Stabilește setările codurilor de timp.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

flexib.
Preset /
Regen / Clock

Preset

Setează modul de rulare a codurilor
de timp.
Preset: începe rularea de la o
valoare presetată.
Regen: începe rularea de la codul de
timp de la finalul clipului precedent.
Clock: utilizează ceasul interior drept
cod de timp.

Run
Rec Run /
Free Run

Rec Run

Rec Run: rulează doar în timpul
înregistrării.
Free Run: rulează întotdeauna,
indiferent de funcționarea
înregistrării.

Setting – –
Setează codul de timp la o valoare
arbitrară.
Set: setați valoarea.

Reset
Execute /
Cancel

–
Resetează codul de timp la
00:00:00:00.
Execute: execută funcția.

TC
Format

DF / NDF DF
Setează formatul codului de timp.
DF: Drop Frame
NDF: Non-Drop Frame

[182] Meniul camerei și setări detaliate Meniul TC/Media
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TC Display

Stabilește setările de afișare a datelor despre timp.

Element Setare sub-element Valoare implicită
din fabrică Descriere

Display
Select

Timecode / Users Bit
/ Duration

Timecode
Comută afișarea datelor
despre timp.

[183] Meniul camerei și setări detaliate Meniul TC/Media

Users Bit

Stabilește setări legate de biții de utilizator.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

flexib. Fix / Time Fixare

Setează modul biți de utilizator.
Fix: utilizează o valoare fixă arbitrară
în biți de utilizator.
Time: utilizează ora, minutul și
secunda curentă în biți de utilizator.

Setting – –
Setează biții de utilizator la o valoare
arbitrară.

[184] Meniul camerei și setări detaliate Meniul TC/Media

HDMI TC Out

Stabilește setări legate de ieșirea codului de timp, la utilizarea HDMI.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off Off
Stabilește dacă se transmite codul de
timp către dispozitive în alte scopuri,
folosind HDMI.

[185] Meniul camerei și setări detaliate Meniul TC/Media

Clip Name Format

Stabilește setările legate de denumirea și ștergerea clipurilor.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Title
Prefix

nnn_ (nnn
reprezintă
ultimele 3 cifre
ale numărului de
serie)
(max. 7 cifre
afișate)

nnn

Setează partea de titlu (4 până la 46 de
caractere) a denumirii clipului.
Deschide un ecran de introducere a
unor șiruri de caractere.

Pentru detalii despre setarea titlurilor
și a ecranului de introducere a
caracterelor, consultați „Setarea
titlului” și „Structura ecranului de
introducere a șirurilor de caractere”
de mai jos.

Number
Set

0001 la 9999 0001
Setează ca sufix numărul format din 4
cifre al denumirii clipului.

Setarea titlului

Selectați caracterul de inserat la poziția cursorului, în zona [Title
Prefix], din zona de selectare a caracterelor folosind butoanele cu

1
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[186] Meniul camerei și setări detaliate Meniul TC/Media

Update Media

Actualizează fișierul de gestionare pe cardurile de memorie (consultați „Restaurarea cardurilor
de memorie”).

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Media(A)
Execute /
Cancel

–
Actualizează fişierul de gestionare de
pe cardul de memorie din slotul A.
Execute: execută funcția.

Media(B)
Execute /
Cancel

–
Actualizează fişierul de gestionare de
pe cardul de memorie din slotul B.
Execute: execută funcția.

săgeți de pe panoul de control GUI (caracterul este evidențiat) și
apăsați butonul [Set] de pe panoul de control GUI.
Caracterul selectat este inserat, iar cursorul se deplasează la dreapta.

Repetați pasul 1 pentru setarea titlului.
Utilizați [BS] după cum este necesar.

2

După setarea titlului, selectați [Done] pentru a închide ecranul de
introducere a caracterelor.

Pentru detalii despre utilizarea ecranului de introducerea a caracterelor, consultați
„Introducerea unui șir de caractere”.

Pot fi selectate caracterele de mai jos.
!#$%()+,-.;=@[ ]^_~ spațiu
0123456789
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ

3
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[187] Meniul camerei și setări detaliate Meniul TC/Media

Format Media

Formatează (inițializează) cardurile de memorie (consultați „Formatarea (inițializarea) cardurilor
de memorie”).

Element Setare sub-element Valoare implicită
din fabrică Descriere

Media(A)
Full Format / Quick
Format / Cancel

–
Formatează cardul de
memorie din slotul A.

Media(B)
Full Format / Quick
Format / Cancel

–
Formatează cardul de
memorie din slotul B.

[188] Meniul camerei și setări detaliate Meniul TC/Media

Media Life

Indică durata de viață rămasă a cardurilor de memorie.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Media(A) – –
Indică durata de viață rămasă a
cardului de memorie din slotul A.

Media(B) – –
Indică durata de viață rămasă a
cardului de memorie din slotul B.

Notă

Sunt necesare carduri de memorie care acceptă afișarea durata de viață rămasă a suporturilor.
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[189] Meniul camerei și setări detaliate Meniul Monitoring

Output Format

Stabilește setările formatului de ieșire.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

SDI Pentru detalii despre setări,
consultați „Formate de ieșire și
limitări”.

–
Setează rezoluția de
ieșire SDI și HDMI.

HDMI –

[190] Meniul camerei și setări detaliate Meniul Monitoring

Display On/Off

Stabilește setările elementului de afișare.
Pentru a afișa un element de pe afișaj, selectați On. Pentru a ascunde un element de pe afișaj,
selectați Off.

Element Setare sub-element Valoare implicită din fabrică

File Transfer Status On / Off On

Rec/Play Status On / Off On

RAW Output Control Status On / Off On

Tally On / Off On

Focus Mode On / Off On

Focus Position On / Off On

Focus Area Indicator On / Off On
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Element Setare sub-element Valoare implicită din fabrică

Focus Area Ind.(AF-S) On / Off On

Face/Eye Detection Frame On / Off On

Lens Info On / Off Off

Imager Scan Mode On / Off On

Rec Format On / Off On

Frame Rate On / Off On

Zoom Position On / Off On

SteadyShot On / Off On

Base Look/Rec Look On / Off On

SDI/HDMI Rec Control On / Off On

Monitoring Look On / Off On

Proxy Status On / Off On

Base ISO/Sensitivity On / Off On

Media Status On / Off On

Clip Name On / Off On

White Balance On / Off On

Scene File On / Off On

Focus Indicator On / Off On

Auto Exposure Mode On / Off On

Auto Exposure Level On / Off On

Timecode On / Off On
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Element Setare sub-element Valoare implicită din fabrică

ND Filter On / Off On

Iris On / Off On

ISO/Gain/EI On / Off On

Shutter On / Off On

Level Gauge On / Off On

Audio Level Meter On / Off On

Video Level Warning On / Off On

Clip Number On / Off On

Notice Message On / Off On

[191] Meniul camerei și setări detaliate Meniul Monitoring

Video Signal Monitor

Setează setările monitorului de semnale video.

Element Setare sub-element Valoare implicită
din fabrică Descriere

Setting
Off / Waveform /
Vector / Histogram

Off
Setează tipul monitorului de
semnale video.

Level
Marker 1

0 % – 109 % 70%
Setează nivelul de luminanță
al marcajului de nivel 1.

Level
Marker 2

0 % – 109 % 100%
Setează nivelul de luminanță
al marcajului de nivel 2.
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[192] Meniul camerei și setări detaliate Meniul Monitoring

Marker

Stabilește setările de afișare a marcajelor.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off On
Activează/dezactivează afișarea
tuturor marcajelor.

Color

White / Yellow /
Cyan / Green /
Magenta / Red /
Blue

Alb
Selectează culoarea de
semnalizare a marcajului.

Center
Marker

1 / 2 / 3 / 4 / Off Off Selectează marcajul central.

Safety
Zone

On / Off Off
Activează/dezactivează marcajul
zonei de siguranță.

Safety
Area

80% / 90% / 92.5%
/ 95%

90%

Selectează dimensiunea
marcajului zonei de siguranță (ca
procent din dimensiunea totală a
ecranului).

Aspect
Marker

Line / Mask / Off Off
Selectează tipul marcajului de
aspect.

Aspect
Mask

0 - 15 12
Setează nivelul semnalului video în
afara marcajului.

Aspect
Safety
Zone

On / Off Off
Activează/dezactivează marcajul
zonei de siguranță pentru aspect.

Aspect
Safety
Area

80% / 90% / 92.5%
/ 95%

90% Selectează dimensiunea
marcajului zonei de siguranță



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 311/464

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

pentru aspect (ca procent din
dimensiunea totală a ecranului).

Aspect
Select

1:1 / 4:3 / 13:9 /
14:9 / 15:9 / 16:9 /
17:9 / 1.66:1 /
1.85:1 / 2.35:1 /
2.39:1 / Custom

2.39:1
Setează modul la afișarea
marcajului de aspect.

Custom
Aspect
Ratio

Introduceți o
valoare arbitrară.

01.00:01.00

Setează raportul de aspect la o
valoare arbitrară.

Notă

Această setare este activată
când [Aspect Select] este
setat la [Custom].

Guide
Frame

On / Off Off
Activează/dezactivează afișarea
cadrului de ghidare.

100%
Marker

On / Off Off
Activează/dezactivează marcajul
100%.

User Box On / Off Off
Activează/dezactivează marcajul
casetei de utilizator.

User Box
Width

3 - 479 240
Setează lățimea marcajului casetei
de utilizator (distanța de la centru
la marginile stânga și dreapta).

User Box
Height

3 - 269 135

Setează înălțimea marcajului
casetei de utilizator (distanța de la
centru la marginile de sus și de
jos).

User Box
H Position

−476 - +476 0
Setează poziția orizontală a
centrului marcajului casetei de
utilizator.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

User Box
V Position

−266 - +266 0
Setează poziția verticală a
centrului marcajului casetei de
utilizator.

[193] Meniul camerei și setări detaliate Meniul Audio

Audio Input

Stabilește setările de intrare audio.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

AUDIO IN
Select

MIC / LINE MIC
Selectează tipul de dispozitiv cuplat la
conectorul AUDIO IN.

Phantom
Power
+48V

On / Off Off
Afișează starea sursei de alimentare
fantomă +48 V.

CH1 Input
Select

AUDIO IN
CH1

AUDIO IN
CH1

Afișează sursa de intrare pentru
înregistrarea pe canalul 1.

CH2 Input
Select

AUDIO IN
CH1 / AUDIO
IN CH2

AUDIO IN
CH2

Comută sursa de intrare pentru
înregistrare pe canalul 2.

CH3 Input
Select

Off / AUDIO
IN CH1

AUDIO IN
CH1

Comută sursa de intrare pentru
înregistrare pe canalul 3.

CH4 Input
Select

Off / AUDIO
IN CH1 /
AUDIO IN
CH2

AUDIO IN
CH2

Comută sursa de intrare pentru
înregistrare pe canalul 4.
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

AUDIO IN
CH1 MIC
Ref.

−80 dB /
−70 dB /
−60 dB /
−50 dB /
−40 dB /
−30 dB

–50 dB
Setează nivelul de înregistrare de
referință pentru intrarea de microfon XLR
de la AUDIO IN CH1.

AUDIO IN
CH2 MIC
Ref.

−80 dB /
−70 dB /
−60 dB /
−50 dB /
−40 dB /
−30 dB

–50 dB
Setează nivelul de înregistrare de
referință pentru intrarea de microfon XLR
de la AUDIO IN CH2.

Line Input
Reference

+4dB / 0dB /
−3dB / EBUL

+4 dB
Selectează nivelul de intrare de referință
atunci când [AUDIO IN Select] este setat
la LINE.

Reference
Level

−20dB /
−18dB /
−16dB /
−12dB /
EBUL

–20 dB
Selectează nivelul de înregistrare al
semnalului tonului de referință de 1 kHz.

CH1 Wind
Filter

On / Off Off
Activează/dezactivează filtrul de reducere
a vântului pentru înregistrarea pe canalul
1.

CH2 Wind
Filter

On / Off Off
Activează/dezactivează filtrul de reducere
a vântului pentru înregistrarea pe canalul
2.

CH3 Wind
Filter

On / Off Off
Activează/dezactivează filtrul de reducere
a vântului pentru înregistrarea pe canalul
3.

CH4 Wind
Filter

On / Off Off
Activează/dezactivează filtrul de reducere
a vântului pentru înregistrarea pe canalul
4.
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

CH1 Level
Control

Auto /
Manual

Auto
Selectează reglarea automată a nivelului
de intrare audio sau reglarea manuală
pentru canalul de înregistrare 1.

CH2 Level
Control

Auto /
Manual

Auto
Selectează reglarea automată a nivelului
de intrare audio sau reglarea manuală
pentru canalul de înregistrare 2.

CH3 Level
Control

Auto /
Manual

Auto
Selectează reglarea automată a nivelului
de intrare audio sau reglarea manuală
pentru canalul de înregistrare 3.

CH4 Level
Control

Auto /
Manual

Auto
Selectează reglarea automată a nivelului
de intrare audio sau reglarea manuală
pentru canalul de înregistrare 4.

CH1 Input
Level

0 to 99 49
Setează nivelul de intrare pentru
înregistrare pe canalul 1,

CH2 Input
Level

0 to 99 49
Setează nivelul de intrare pentru
înregistrare pe canalul 2,

CH3 Input
Level

0 to 99 49
Setează nivelul de intrare pentru
înregistrare pe canalul 3.

CH4 Input
Level

0 to 99 49
Setează nivelul de intrare pentru
înregistrare pe canalul 4.

Master
Input Level

0 to 99 99 Setează nivelul de intrare audio principal.

Limiter
Mode

Off / −6 dB /
−9 dB /
−12 dB /
−15 dB /
−17 dB

Off

Selectează caracteristica limitatorului
pentru semnale de intrare mari atunci
când reglați manual nivelul de intrare
audio.

CH1&2
AGC Mode

Mono /
Stereo

Stereo Setează modul de reglare automată a
nivelului pentru canalul 1 și canalul 2 de
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

înregistrare. Când este setat la Stereo,
AGC este legat între canale.

CH3&4
AGC Mode

Mono /
Stereo

Stereo

Setează modul de reglare automată a
nivelului pentru canalul 3 și canalul 4 de
înregistrare. Când este setat la Stereo,
AGC este legat între canale.

AGC Spec

−6 dB /
−9 dB /
−12 dB /
−15 dB /
−17 dB

–6 dB Selectează caracteristica AGC.

1kHz Tone
on Color
Bars

On / Off Off

Activează/dezactivează semnalul tonului
de referință de 1 kHz la afișarea barelor
de culoare.

Notă

Când este setat la [On], semnalul
tonului de referință de 1 kHz este
setat pentru înregistrarea pe canalul
3 și pe canalul 4, chiar dacă [CH3
Input Select] și [CH4 Input Select]
sunt setate la [Off].

[194] Meniul camerei și setări detaliate Meniul Audio

Audio Output

Stabilește setările de ieșire audio.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2
Setează combinația de canale
audio pentru ieșirea HDMI/de
redare în timp real.

[195] Meniul camerei și setări detaliate Meniul Thumbnail

Display Clip Properties

Afișează ecranul cu proprietățile clipului.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Display Clip
Properties

– –
Afișează ecranul cu
proprietățile clipului.

[196] Meniul camerei și setări detaliate Meniul Thumbnail

Set Clip Flag

Stabilește setările indicatorului clipului.

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Add OK – –
Adaugă un indicator
OK.

Add NG – –
Adaugă un indicator
NG.
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Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Add KEEP – –
Adaugă un indicator
KEEP.

Delete Clip
Flag

– –
Șterge toate
indicatoarele.

[197] Meniul camerei și setări detaliate Meniul Thumbnail

Lock/Unlock Clip

Stabilește setările de protecție a clipului.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Select Clip – –
Selectează și
blochează/deblochează un clip.

Lock All
Clips

– – Blochează toate clipurile.

Unlock All
Clips

– – Deblochează toate clipurile.

[198] Meniul camerei și setări detaliate Meniul Thumbnail

Delete Clip

Șterge clipurile.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 318/464

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Select
Clip

– –
Şterge clipul
selectat.

All Clips – –
Șterge toate
clipurile.

[199] Meniul camerei și setări detaliate Meniul Thumbnail

Transfer Clip

Transferă clipurile.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Select
Clip

– – Transferă clipurile selectate.

All Clips – –

Transferă toate clipurile.

Notă

Pot fi înregistrate până la 200
de lucrări de transfer.

[200] Meniul camerei și setări detaliate Meniul Thumbnail

Transfer Clip (Proxy)

Transferă clipurile proxy.
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Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Select
Clip

– –
Transferă clipurile proxy
corespunzătoare clipurilor selectate.

All Clips – –

Transferă clipurile proxy
corespunzătoare tuturor clipurilor.

Notă

Pot fi înregistrate până la 200 de
lucrări de transfer.

[201] Meniul camerei și setări detaliate Meniul Thumbnail

Filter Clips

Stabilește setările clipurilor care să fie afișate.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

OK – –
Afișează doar clipurile care au un
indicator OK.

NG – –
Afișează doar clipurile care au un
indicator NG.

KEEP – –
Afișează doar clipurile care au un
indicator KEEP.

None – –
Afișează doar clipurile care nu au
un indicator.

All – –
Afișează toate clipurile, indiferent
dacă există steaguri sau nu.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 320/464

[202] Meniul camerei și setări detaliate Meniul Thumbnail

Customize View

Comută vizualizarea ecranului miniatural.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Thumbnail
Caption

Date Time / Time Code /
Duration / Sequential
Number

Time Code
Comută informațiile
afișate sub miniaturi.

[203] Meniul camerei și setări detaliate Meniul Technical

Color Bars

Stabilește setările barelor de culoare.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Setting On / Off Off
Activează/dezactivează barele
de culoare.

Type
ARIB / 100% /
75% / SMPTE

ARIB
Selectează tipul barei de
culoare.

[204] Meniul camerei și setări detaliate Meniul Technical

Genlock
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Configurează afișajul stării genlock (consultați „Sincronizarea fazei semnalului video
(Genlock))”.

Element Setare sub-element Valoare implicită
din fabrică Descriere

Referință
Internal / External(HD) /
External(SD)

–
Afișează tipul semnalului
de referință genlock.

[205] Meniul camerei și setări detaliate Meniul Technical

Tally

Stabilește setările lămpii de înregistrare/semnalizare (consultați „Conectarea unui indicator de
semnalizare”).

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Tally Lamp
Brightness

High / Low
/ Off

High
Setează luminozitatea lămpii de
înregistrare/semnalizare.

G Tally
Lamp

Enable /
Disable

Activare
Activează/dezactivează lampa de
semnalizare G.

Tally Control
External /
Internal

Internal

Selectează ținta pentru acceptarea
informațiilor de control al unității despre
lampa de înregistrare/semnalizare.
External: controlul semnalizării din afara
camerei.
Internal: control prin operarea
înregistrării pe cameră.

[206] Meniul camerei și setări detaliate Meniul Technical
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Rec Review

Stabilește setările de revizualizare a înregistrării (consultați „Revizualizarea înregistrării (Rec
Review)”).

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting
3s / 10s /
Clip

3s
Setează timpul de redare a clipurilor
recent înregistrate pentru revizualizarea
înregistrării.

[207] Meniul camerei și setări detaliate Meniul Technical

Zoom

Stabilește setările de zoom („Reglarea zoomului”).

Element Setare sub-element Valoare implicită
din fabrică Descriere

Zoom
Type

Optical Zoom Only / On(Clear
Image Zoom)

Optical Zoom Only
Setează tipul de
zoom.

[208] Meniul camerei și setări detaliate Meniul Technical

Lens

Stabilește setările legate de obiective.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Lens
Calibration

Execute / Cancel –

Execută funcția care
compensează diferențele
privind poziția de zoom din
cauza diferențelor între
obiectivele individuale când se
utilizează un obiectiv cu zoom
electronic.

Zoom Ring
Direction

Left(W)/Right(T) /
Right(W)/Left(T)

Stânga(W)/Dr.
(T)

Setează direcția de operare a
inelului de zoom.

Notă

Este activat doar la
utilizarea unui obiectiv
cu montură E, care
acceptă comutarea
direcției de operare a
inelului de zoom.

Shading
Compensation

Auto / Off Auto
Setează compensarea
automată a umbrelor.

Chroma
Aberration
Comp.

Auto / Off Auto
Setează compensarea
automată a aberațiilor
cromatice.

Distortion
Comp.

Auto / Off Auto
Setează compensarea
automată a distorsiunilor.

Compensarea
respirației

Auto / Off Off

Stabilește compensarea
respirației pentru obiectiv.

Consultați „Compensarea
respirației”.

Distance
Display

Meter / Feet Meter Setează unitățile de măsură
de afișare pentru informațiile
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

despre obiectiv și poziția de
focalizare.

Zoom Position
Display

Focal Length /
Number / Bar

Number
Setează formatul de afișare
pentru poziția de zoom.

[209] Meniul camerei și setări detaliate Meniul Technical

APR

Execută APR.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

APR
Execute /
Cancel

–

Rulează APR (Automatic Pixel
Restoration) pentru reglarea automată a
senzorilor de imagine.
Execute: execută funcția.

Notă

Întotdeauna atașați capacul
obiectivului înainte de a rula APR.

[210] Meniul camerei și setări detaliate Meniul Network

Wired LAN

Stabilește setările legate de conexiunile LAN prin cablu.
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Element Setare sub-
element

Valoare implicită
din fabrică Descriere

HTTP Port – 80 Afișează portul de acces HTTP.

Detail
Settings

– –
Afișează proprietățile conexiunii
LAN prin cablu.

DHCP
On / Off

On
Afișează dacă DHCP este activat
(On) sau dezactivat (Off).

IP Address –
Afișează adresa IP a unității când
[DHCP] este setat la [Off].

Subnet Mask –
Afișează masca de subrețea a
unității când [DHCP] este setat la
[Off].

Gateway –
Afișează gateway-ul implicit când
[DHCP] este setat [Off].

DNS Auto
On / Off

On
Fișează setarea pentru achiziția
automată DNS.

[211] Meniul camerei și setări detaliate Meniul Network

File Transfer

Stabilește setările pentru transferurile de fișiere (consultați „Despre transferul de fișiere”).

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Auto
Upload
(Proxy)

On / Off Off
Activează/dezactivează încărcarea
automată a fișierelor proxy.

Default
Upload

Server
Settings1 to

– Selectează serverul de încărcare pentru
fișiere. Serverul selectat aici devine
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Server 3 > Display
Name

destinația de încărcare automată a
fișierelor proxy și destinația de încărcare a
fișierelor de pe ecranul miniatural.
Afișează setările pentru [Display Name],
configurate în [Server Settings1 to 3].

Clear
Completed
Jobs

Execute /
Cancel

–
Șterge din listă activitățile de transfer
finalizate.
Execute: execută funcția.

Clear All
Jobs

Execute /
Cancel

–
Șterge din listă toate activitățile de
transfer.
Execute: execută funcția.

View Job
List

– – Afișează lista de activități de transfer.

[212] Meniul camerei și setări detaliate Meniul Maintenance

Language

Setează limba de afişare.

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Select – –
Setează limba de
afişare.
Set: setați valoarea.

[213] Meniul camerei și setări detaliate Meniul Maintenance

Clock Set



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 327/464

Stabilește setările ceasului interior.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Time
Zone

UTC − 12:00 to
UTC + 14:00

–
Setează diferența de oră față de
UTC în unități de 30 de minute.

Date
Mode

YYMMDD /
MMDDYY /
DDMMYY

YYMMDD

Selectează formatul de afișare
pentru date.
YYMMDD: an, lună, zi
MMDDYY: lună, zi, an
DDMMYY: zi, lună, an

12H/24H 12H / 24H 24H

Selectează formatul de afișare
a ceasului.
12H: modul 12 ore
24H: modul 24 de ore

Date – –
Setează data curentă.
Set: setați valoarea.

Time – –
Setează ora curentă.
Set: setați valoarea.

[214] Meniul camerei și setări detaliate Meniul Maintenance

Hours Meter

Afișează timpul de rulare cumulat.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Hours(System) – –
Afișează orele de utilizare
cumulate (nu poate fi resetat).

Hours(Reset) – –
Afișează orele de utilizare
cumulate (poate fi resetat).
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Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Reset
Execute /
Cancel

–
Resetează la 0 timpul de rulare
acumulat.
Execute: execută funcția.

[215] Meniul camerei și setări detaliate Setările și valorile implicite ale meniului Shooting

Setările și valorile implicite pentru ISO/Gain

Gama de setări și valorile implicite pentru [ISO/Gain<L>] variază în funcție de setările [Mode],
[Base Look] > [Select] și [Base Sensitivity].
Valorile implicite din tabele sunt afișate cu caractere aldine.

Când [Mode] este setat la [ISO]

Când [Base Look] > [Select] este setat la [S-Cinetone], [Standard], [ITU709] sau
[Still]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 320
ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000

ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
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Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Când opțiunea [Base Look] > [Select] este setată la [HLG Live] sau [HLG
Natural]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 128000
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Când opțiunea [Base Look] > [Select] este setată la [User1] până la [User16]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 800
ISO 1000
ISO 1250

ISO 12800
ISO 16000
ISO 20000
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Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Când [Mode] este setat la [dB]

Poate fi configurată o valoare din intervalul dintre −3dB și +30dB în trepte de 1 dB.
Valoarea implicită este 0dB.

[216] Meniul camerei și setări detaliate Setările și valorile implicite ale meniului Shooting

Setările și valorile implicite pentru AGC Limit

Gama de setări și valorile implicite pentru [AGC Limit] variază în funcție de setările [Mode],
[Base Look] > [Select] și [Base Sensitivity].
Valorile implicite din tabele sunt afișate cu caractere aldine.

Când [Mode] este setat la [ISO]

Când [Base Look] > [Select] este setat la [S-Cinetone], [Standard], [ITU709] sau
[Still]
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Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 400
ISO 500
ISO 640
ISO 800
ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Când opțiunea [Base Look] > [Select] este setată la [HLG Live] sau [HLG
Natural]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
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Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 20000
ISO 25600

ISO 320000
ISO 409600

Când opțiunea [Base Look] > [Select] este setată la [User1] până la [User16]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [Low]

Când opțiunea [ISO/Gain/EI] > [Base
Sensitivity] este setată la [High]

ISO 1000
ISO 1250
ISO 1600
ISO 2000
ISO 2500
ISO 3200
ISO 4000
ISO 5000
ISO 6400
ISO 8000
ISO 10000
ISO 12800
ISO 16000
ISO 20000
ISO 25600

ISO 16000
ISO 20000
ISO 25600
ISO 32000
ISO 40000
ISO 51200
ISO 64000
ISO 80000
ISO 102400
ISO 128000
ISO 160000
ISO 204800
ISO 256000
ISO 320000
ISO 409600

Când [Mode] este setat la [dB]

Selectați o opțiune dintre 3dB / 6dB / 9dB / 12dB / 15dB / 18dB / 21dB / 24dB / 27dB / 30dB.
Valoarea implicită este 15dB.

[217] Meniul camerei și setări detaliate

Setările de calitate a imaginii salvate pentru fiecare
mod de captură
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Starea curentă a elementelor de configurare legate de calitatea imaginii se va salva pentru
fiecare dintre următoarele moduri de captură. Când schimbați modul de captură, sunt aplicate
setările corespunzătoare salvate pentru modul de captură țintă.

Afișaj țintă SDR(BT.709) în modul Custom
Afișaj țintă HDR(HLG) în modul Custom
Modul Cine EI

Elementele de configurare legate de calitatea imaginii care sunt salvate pentru fiecare mod de
captură sunt prezentate în tabelele de mai jos.
„Da” indică faptul că setarea este salvată, iar „Nu” indică faptul că setarea nu este salvată. „Da”
pentru mai multe coloane indică faptul că setările sunt comune.
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Element

Shooting mode

Modul Custom
Modul
Cine EISDR

(BT.709) HDR(HLG)

Meniul
Shooting

ISO/Gain/EI

ISO/Gain Da1) Nu

Exposure Index Nu Da

Base Sensitivity Da Nu

Base ISO Nu Da

Alb

Preset White Da Da

Altele decât cele
de mai sus

Da

White Setting Da

Offset White Da Nu

LUT activ./dezact. Nu Da

Noise
Suppression

Setting(Custom) Da Da Nu

Level(Custom) Da Da Nu

Setting(Cine EI) Nu Da

Level(Cine EI) Nu Da
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Element

Shooting mode

Modul Custom
Modul
Cine EISDR

(BT.709) HDR(HLG)

Meniul
Paint/Look

Base Look

Select Da Da Da

Input2) Da

Output2) Da

AE Level Offset2) Da

Negru Da Da Nu

Knee

Auto Knee Da Nu Nu

Altele decât cele
de mai sus

Da Da Nu

Detail Da Da Nu

Matrix Da Da Nu

Multi Matrix Da Da Nu

[218] Meniul web și setări detaliate

Configurația meniului web

Apăsați fila de comutare a ecranului de operare [Settings] pentru afișarea ecranului cu setări.
Utilizați ecranul cu setări pentru a seta diferitele elemente de configurare a unității, inclusiv
setările inițiale, setările rețelei, setările de captură/redare utilizând meniul web.

Setările de sensibilitate ISO separate sunt salvate atât pentru modul Custom [SDR(BT.709)], cât și [HDR(HLG)].1)

Setările sunt salvate pentru fiecare [Base Look] și nu depind de modul de captură.2)
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Acest meniu include următoarele meniuri.

Configurația și ierarhia meniurilor

Nivelul 1 Descrierea nivelului 1 Nivelul 2

Shooting Conține setări legate de înregistrare. Focus
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Nivelul 1 Descrierea nivelului 1 Nivelul 2

Project Conține setări de bază ale proiectului.

Base Setting

Rec Format

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

All File

Paint/Look Conține setări legate de calitatea imaginii. Base Look

Pan-Tilt
Conține setări legate de panoramare/
înclinare.

P/T Speed

P/T Acceleration

P/T Range Limit

P/T Direction

P/T Preset

Monitoring
Conține setări pentru ieșirea video și afișarea
ecranului.

Output Format

Output Display

Audio Conține setări audio. Audio

Technical Conține setări pentru elemente tehnice.
Tally

IR Remote
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Nivelul 1 Descrierea nivelului 1 Nivelul 2

Network Conține setări legate de rețele.

Camera Name

User

Wired LAN

File Transfer

FTP Server 1

FTP Server 2

FTP Server 3

SSL

Referer Check

Brute Force Attack
Protection

Stream Conține setări legate de redarea în timp real.

Stream

Video Stream

Audio Stream
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Nivelul 1 Descrierea nivelului 1 Nivelul 2

Maintenance
Conține setări ale dispozitivelor, cum ar fi
ceasul și limba.

Language

Accessibility

Clock Set

Reset

Information

System Log

HTTP Access Log

Service

EULA

Software

Notă

Opțiunea [Accessibility] este disponibilă numai pe modelele pentru America de Nord.

[219] Meniul web și setări detaliate

Operații cu meniul web

Apăsați fila de comutare a ecranului de operare [Settings] pentru afișarea ecranului cu setări,
pentru a seta diferitele elemente de configurare a unității, inclusiv setările inițiale, setările rețelei,
setările de captură/redare utilizând meniul web.
Configurați setările din meniul web pe o tabletă, utilizând operarea tactilă sau pe un computer
utilizând mouse-ul.
Apăsați meniul pentru elementele pe care doriți să le configurați, pentru afișarea elementelor de
configurare și setările lor din meniul respectiv.
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Metodă de configurare

Selectarea valorii

Apăsați butonul radio pentru un element. Butonul radio pentru elementul selectat este afișat cu
portocaliu.

Element activ/inactiv

Meniu (nivelul 1)1.

Meniu (nivelul 2)2.

Settings3.
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Apăsați comutatorul pentru a activa/dezactiva elementul. Comutatorul este portocaliu când
elementul este activ și alb când este inactiv.

Selectarea valorilor dintr-o listă

Apăsați butonul de detaliere și selectați un element din lista afișată.

Selectarea valorilor numerice

Apăsați e < sau > pentru a schimba valoarea numerică. Dacă valoarea numerică este
subliniată, puteți și introduce o valoare în mod direct.

Introducerea caracterelor/numerelor

Configurare pe un ecran separat
Apăsați butonul pentru a efectua operațiile de configurare pe un ecran separat.

Mesaj de ghidare

Sunt afișate informații care vă ajută să configurați unele setări și mesaje care atrag atenția
utilizatorului.
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Salvarea unei setări

Când ați terminat de configurat o setare, apăsați butonul [Done] pentru a o salva.
Apăsați butonul [Cancel] pentru a renunța la modificările aduse unei setări și a reveni la setarea
anterioară.
Apăsați butonul [Reload] pentru a actualiza afișajul ecranului.

Notă

Dacă apăsați butonul [Reload] înainte de a salva o setare, modificările aduse setării vor fi
abandonate.

Dacă treceți la altă pagină înainte de a salva o setare, modificările aduse setării vor fi abandonate.

[220] Meniul web și setări detaliate Meniul Shooting

Focus

Setează setările de focalizare.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Push AF
Mode

AF / Single-
shot AF(AF-
S)

AF Setează modul Push Auto Focus.

Touch
Function in
MF

Tracking AF
/ Spot
Focus

Tracking AF
Setează operarea când ecranul cu
imaginea camerei este atins în modul MF.

AF Assist
Control

On / Off On Când este setat la [On], puteți utiliza
glisorul Focus din aplicația web în modul
de focalizare automată, pentru a ajusta
poziția de focalizare.

Pentru detalii, consultați „Setarea
manuală a țintei focalizării automate
(AF Assist) utilizând aplicația web”.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 343/464

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Notă

Acest element este activat numai
când opțiunea [AF Assist] este setată
la [On] în meniul camerei.

[221] Meniul web și setări detaliate Meniul Project

Base Setting

Setează setările de bază.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Shooting
Mode

Custom / Cine EI Custom

Setează modul de fotografiere.
Consultați „Modul de captură”
din „Configurarea funcționării
de bază”.

Target
Display

SDR(BT.709) /
HDR(HLG)

SDR (BT.709)
Setează spațiul de culoare al
înregistrării/ieșirii în modul Custom.

[222] Meniul web și setări detaliate Meniul Project

Rec Format

Setează setările formatului de înregistrare.
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Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Frequency
59,94 / 50 / 29,97 / 25 /
24 / 23,98

59.94

Selectează frecvența
sistemului.

Notă

Dacă frecvența este
modificată, camera va fi
reporni. După repornire,
reîncărcați pagina în
browser.

Imager
Scan Mode

FF / S35 FF
Selectează dimensiunea
imaginii.

Codec
RAW / RAW & XAVC-I /
XAVC-I / XAVC-L

XAVC-I

Setează codecul de
înregistrare/redare a clipurilor.

Notă

Când [Imager Scan Mode]
este setat la [S35], [RAW]
și [RAW & XAVC-I] nu pot
fi selectate.

RAW
Output
Format

Setările disponibile
variază în funcție de
setarea [Frequency].

Consultați „Setările
[RAW Output
Format]” de mai jos.

–

Setează dimensiunea imaginii
RAW la ieșirea către un
recorder RAW extern.

Notă

Când [Codec] este setat la
[RAW & XAVC-I], setarea
[Video Format], va fi
comutată în concordanță
cu setarea [RAW Output
Format].

Format
video

Setările disponibile
variază în funcție de
setările pentru

– Setează dimensiunea imaginii
și rata de biți.
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Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

[Frequency], [Imager
Scan Mode] și [Codec].

Consultați „Setările
[Video Format]” de
mai jos.

Setările [RAW Output Format]

Frequency Imager Scan
Mode Codec Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF
RAW / RAW &
XAVC-I

4096×2160
3840×2160

24 FF
RAW / RAW &
XAVC-I

4096×2160

Valorile implicite sunt afișate cu caractere aldine.
Condițiile în care [RAW Output Format] nu poate fi setat au fost omise.

Setările [Video Format]
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Frequency Imager Scan
Mode Codec Setting

59,94 / 50 / 29,97 / 25 /
23,98

FF

RAW –

RAW & XAVC-I
4096×2160P
3840×2160P

XAVC-I
4096×2160P
3840×2160P
1920×1080P

XAVC-L

3840×2160P
1920×1080P
50
1920×1080P
35

S35

XAVC-I 1920×1080P

XAVC-L

1920×1080P
50
1920×1080P
35

24 FF

RAW –

RAW & XAVC-I /
XAVC-I

4096×2160P

Valorile implicite sunt afișate cu caractere aldine.

[223] Meniul web și setări detaliate Meniul Project

Simul Rec

Configurează setările modului de înregistrare simultană în 2 sloturi (consultați „Înregistrarea pe
cardurile de memorie A și B simultan (2-slot Simul Rec)”).



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 347/464

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off Off
Activează/dezactivează funcția de
înregistrare simultană și stabilește
mediul de destinație de înregistrare.

Butonul
Rec

SlotA / SlotB /
SlotA/SlotB

SlotA/SlotB
Afișează atribuirea butoanelor de
înregistrare pentru fiecare suport de
înregistrare.
Setați opțiunile [Project] > [Simul Rec]
> [Rec Button Set] din meniul camerei.

Butonul
2nd Rec

SlotA / SlotB /
SlotA/SlotB

SlotA/SlotB

[224] Meniul web și setări detaliate Meniul Project

Proxy Rec

Configurează setările modului de înregistrare proxy (consultați „Înregistrarea proxy”).

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Setting On / Off Off
Activează/dezactivează modul de
înregistrare proxy.

[225] Meniul web și setări detaliate Meniul Project

Interval Rec

Configurează setările modului de înregistrare la anumite intervale (consultați „Înregistrarea
video în mod intermitent (Interval Rec)”).
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Element Setare sub-element Valoare implicită din
fabrică Descriere

Setting On / Off Off

Activează/dezactivează
modul de înregistrare
la intervale. (Setarea
acestui mod la On va
seta toate celelalte
moduri speciale la Off.)

Interval
Time

1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (sec.)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10 / 15 / 20 / 30 / 40 /
50 (min.)
1 / 2 / 3 / 4 / 6 / 12 / 24
(ore)

1

Setează intervalul
dintre înregistrări în
modul de înregistrare
Interval Rec (când
Interval Rec este setat
la On).

Number
of
Frames

1frame / 2frames /
3frames / 6frames /
9frames / 12frames
Setările disponibile
variază în funcție de
frecvența cadrelor
formatului video selectat.
59.94P/50P: 2frames /
6frames / 12frames
29.97P/25P/24P/23.98P:
1frame / 3frames /
6frames / 9frames

59.94P/50P: 2frames
29.97P/25P/24P/23.98P:
1frame

Setează numărul de
cadre de înregistrat per
filmare fără întrerupere
în modul de
înregistrare Interval
Rec (când Interval Rec
este setat la On).

[226] Meniul web și setări detaliate Meniul Project

Picture Cache Rec

Stabilește setările modului de înregistrare Picture Cache (consultați „Înregistrarea imaginilor în
memoria cache (Picture Cache Rec)”).
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Setting On / Off Off
Activează/dezactivează funcția de
înregistrare a imaginilor în cache.

Cache
Size

Short /
Medium /
Long / Max

Max

Setează timpul pentru acumularea
imaginilor în memoria cache a imaginilor
(timp de înregistrare în memoria cache a
imaginilor).

Cache
Rec Time

– –

Afișează durata pentru acumularea
imaginilor în memoria cache a imaginilor
(timp de înregistrare în memoria cache a
imaginilor).

[227] Meniul web și setări detaliate Meniul Project

All File

Efectuează operații asupra fișierului ALL (consultați „Salvarea și încărcarea datelor de
configurare”).

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Load All
File

– –

Încărcați un fișier ALL în unitate de pe
dispozitivul pe care rulează aplicația web.

Notă

Când un fișier ALL este încărcat în
unitate, aceasta va reporni. După
repornire, reîncărcați pagina în
browser.
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Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Save All
File

– –
Salvați setările unității pe dispozitivul pe
care rulează aplicația web ca fișier ALL.

[228] Meniul web și setări detaliate Meniul Paint/Look

Base Look

Puteți să încărcați un aspect de bază pe unitate.
Pe ecran apare o listă cu aspectele de bază disponibile. Aspectul de bază aplicat curent este
indicat printr-un marcaj ● în stânga numărului aspectului de bază.

[No.]: numărul aspectului de bază
[Base Look Name]: numele aspectului de bază
[Input]: semnalul de intrare al aspectului de bază
[Input]: semnalul de ieșire al aspectului de bază
[AE Level Offset]: valoarea de referință pentru expunerea aspectului de bază
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Adăugarea unui aspect de bază
Apăsați butonul [Import] pentru a importa un aspect de bază nou. Urmaţi instrucţiunile de pe
ecran.
După import, setați valorile adecvate pentru [Input], [Output] și [AE Level Offset]. Pentru detalii,
consultați „Importul unui aspect de bază dorit”.

[229] Meniul web și setări detaliate Meniul Pan-Tilt

P/T Speed

Configurează setările legate de panoramare/înclinare.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Speed
Step

Normal /
Extended

Extended

Setează numărul de trepte de viteză a
unității de panoramare/înclinare.
Normal: viteza poate fi specificată utilizând
intervalul cu 24 de pași. Utilizați această
setare pentru compatibilitate cu camerele
Sony cu telecomandă existente.
Extended: viteza poate fi specificată
utilizând intervalul cu 50 de pași.

Speed
Mode

Normal /
Slow

Normal

Setează modul de viteză al unității de
panoramare/înclinare.
Activat numai când opțiunea [Speed Step]
este setată la [Normal].
Normal: funcționează în intervalul de viteză
normală (minimă - maximă (60 de
grade/secundă)).
Slow: funcționează în intervalul de viteză
redusă (minimă - maximă (40 de
grade/secundă)).

[230] Meniul web și setări detaliate Meniul Pan-Tilt
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P/T Acceleration

Configurează setările legate de panoramare/înclinare.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Acceleration 1 – 9 8

Selectează accelerarea/decelerarea pentru
operațiile de panoramare/înclinare. Cu cât
numărul este mai mare, cu atât mai mare
este și accelerarea.

[231] Meniul web și setări detaliate Meniul Pan-Tilt

P/T Range Limit

Configurează setările legate de limitarea intervalului de operare pentru panoramare/înclinare.
Setați limitele intervalului de operare pentru panoramare/înclinare utilizând ecranul de mai jos.

Notă

Când unitatea este pornită sau este executată resetarea panoramării/înclinării, această setare a
limitei intervalului este ignorată. Această funcție nu poate fi utilizată pentru a evita obstacolele de
lângă unitate.
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Setați comutatorul [Setting] la poziția On.
Funcția de limitare a intervalului operației de panoramare/înclinare este activată.

1

Verificați imaginea utilizând controalele de panoramare/înclinare
ale camerei.

2

Pentru a seta pozițiile la care este limitată operația, apăsați butonul
[Left], [Right], [Up], [Down] > [Set Current Value] în pozițiile
respective.
[Left]: în partea stângă a camerei
[Right]: în partea dreaptă a camerei
[Up]: în partea de sus a camerei
[Down]: în partea de jos a camerei

3
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Notă

Pozițiile camerei în afara limitelor nu pot fi salvate ca presetări.

Dacă setarea [Pan-Tilt] > [P/T Direction] > [Ceiling] este schimbată, setările pozițiilor limită
configurate sunt restabilite la valorile implicite din fabrică.

Setarea nu poate fi schimbată în timpul redării, în timpul afișării miniaturilor, când apare o eroare de
panoramare/înclinare, când panoramarea/înclinarea nu este inițializată și când panoramarea/
înclinarea este blocată.

[232] Meniul web și setări detaliate Meniul Pan-Tilt

P/T Direction

Configurează setările pentru direcția de panoramare/înclinare.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Plafon On / Off Off Când unitatea este montată pe birou, setați la
[Off]. Când unitatea este montată pe tavan,
setați la [Off]. Când opțiunea [Ceiling] este

Pozițiile limită sunt setate și afișate ca valori numerice (unghi).
Pentru a anula o limită, apăsați butonul [Reset] pentru fiecare poziție.

Apăsați butonul [OK].
Operarea panoramării/înclinării este restricționată să se încadreze în pozițiile limitei
configurate.

4
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Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

setată la [On], [Pan Direction] este setată
automat la [Opposite].

Pan
Direction

Normal /
Opposite

Normal
Setează direcția unității de panoramare.
Când setarea este schimbată, direcția unității
se inversează.

Tilt
Direction

Normal /
Opposite

Normal
Setează direcția unității de înclinare. Când
setarea este schimbată, direcția unității se
inversează.

Notă

Când este aplicată o setare [Ceiling] schimbată, toate pozițiile presetate sunt șterse, deoarece
coordonatele de panoramare/înclinare se inversează.

Intervalul unității de panoramare/înclinare se schimbă după cum se prezintă în diagrama de mai
jos, în funcție de setarea [Ceiling].

A. Când opțiunea [Ceiling] este setată la [Off]
B. Când opțiunea [Ceiling] este setată la [On]
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[233] Meniul web și setări detaliate Meniul Pan-Tilt

P/T Preset

Stabilește setările legate de presetările camerei.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Speed
Select

Separate /
Common

Separate
Stabilește dacă vitezele presetate sunt
configurate separat sau utilizează o setare
comună.

Common
Speed

1 - 50 50

Stabilește vitezele comune pentru presetări.

Notă

Când opțiunea [Pan-Tilt] > [P/T Speed]
> [Speed Step] este setată la [Normal],
se utilizează viteza maximă 24 a unității,
dacă este setată valoarea 25 sau alta
mai mare.

[234] Meniul web și setări detaliate Meniul Monitoring

Output Format

Stabilește setările formatului de ieșire.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

SDI Pentru detalii despre setări,
consultați „Formate de ieșire și
limitări”.

–
Setează rezoluția de
ieșire SDI și HDMI.

HDMI –
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[235] Meniul web și setări detaliate Meniul Monitoring

Output Display

Stabilește setările pentru semnalele de ieșire.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

SDI On / Off Off
Stabilește dacă meniul și starea
sunt înglobate în semnalul de
ieșire SDI.

HDMI/Stream On / Off On
Stabilește dacă meniul și starea
sunt înglobate în semnalul de
ieșire HDMI.

Notă

Această setare se aplică și pentru imaginea semnalului de ieșire HDMI, imaginea transmisă la
redarea în timp real și imaginea de pe panoul cu imaginea camerei din aplicația web.

[236] Meniul web și setări detaliate Meniul Audio

Audio Input

Stabilește setările pentru intrarea audio CH1 până la CH4.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Control de
nivel

Auto / Manual Auto
Selectează reglarea automată a
nivelului de intrare audio sau pe cea
manuală.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Level 0 to 99 49 Setează nivelul de intrare.

Input
Select

AUDIO IN CH1
/ AUDIO IN
CH2 / Off

CH1 and
CH3: AUDIO
IN CH1
CH2 and
CH4: AUDIO
IN CH2

Setează sursa de intrare audio.

Notă

CH1 este [AUDIO IN CH1] (fixă).

Wind
Filter

On / Off Off
Activează/dezactivează filtrul de
reducere a zgomotului vântului.

Setează nivelul de intrare audio principal. Nivelul de intrare audio principal este utilizat pentru
toate canalele, de la 1 la 4.

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Master 0 to 99 99
Setează nivelul de intrare
principal.

[237] Meniul web și setări detaliate Meniul Audio

Audio Output

Stabilește setările pentru ieșirea audio.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

HDMI/Stream
Output CH

CH1/CH2 /
CH3/CH4

CH1/CH2 Setează combinația de canale
audio pentru ieșirea HDMI/de
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

redare în timp real.

Notă

Această setare este aplicată și pentru ieșirea audio la redarea în timp real.

[238] Meniul web și setări detaliate Meniul Technical

Tally

Stabilește setările lămpii de înregistrare/semnalizare (consultați „Conectarea unui indicator de
semnalizare”).

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Tally Lamp
Brightness

High / Low
/ Off

High
Setează luminozitatea lămpii de
înregistrare/semnalizare.

G Tally
Lamp

Enable /
Disable

Activare
Activează/dezactivează lampa de
semnalizare G.

Tally Control
External /
Internal

Internal
Selectează ținta pentru acceptarea
informațiilor de control al unității despre
lampa de înregistrare/semnalizare.

[239] Meniul web și setări detaliate Meniul Technical

IR Remote
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Stabilește setările pentru telecomanda cu infraroșu.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off On
Activează/dezactivează utilizarea unității
prin telecomanda cu infraroșu.

[240] Meniul web și setări detaliate Meniul Network

Camera Name

Stabilește setările pentru numele camerei (numele unității).

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Camera
Name

– FR7
Setează numele
camerei.

Pot fi introduse maximum opt (0 - 8) dintre caracterele de mai jos pentru numele camerei.
Caractere alfanumerice
Simboluri (spațiu !#$`*+-./;<=>?@[\]^_`{|})

[241] Meniul web și setări detaliate Meniul Network

User

Stabilește setările pentru accesul utilizatorului unității.

Setările pentru utilizatorii administratori (Administrator) (obligatorii)
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Element Setare sub-
element

Valoare implicită
din fabrică Descriere

User Name – admin Setează numele de utilizator.

Current
Password

– –
Atunci când schimbați parola,
introduceți parola curentă.

New
Password

– – Introduceți parola nouă.

Re-Type
Password

– –
Reintroduceți parola nouă
pentru confirmare.

Setările pentru utilizatorii generali (utilizatorul 1 până la 9) (opționale)

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

User Name – – Setează numele de utilizator.

Current
Password

– –
Atunci când schimbați parola,
introduceți parola curentă.

New
Password

– – Introduceți parola nouă.

Re-Type
Password

– –
Reintroduceți parola nouă
pentru confirmare.

[242] Meniul web și setări detaliate Meniul Network

Wired LAN

Status
Afișează starea rețelei.
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Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Host Name – – Afișează numele gazdei.

MAC Address – –
Afișează adresa MAC a
unității.

Ethernet Status – –
Afișează viteza curentă de
comunicare.

IP Address – – Afișează adresa IP a unității.

Subnet Mask – –
Afișează masca de subrețea
a unității.

Gateway – –
Afișează gateway-ul implicit
IPv4 al unității.

Primary DNS
Server

– –
Afișează serverul DNS
principal al unității.

Secondary DNS
Server

– –
Afișează serverul DNS
secundar al unității.

IPv6 Address 1 – –
Afișează adresa 1 IPv6 a
unității.

IPv6 Address 2 – –
Afișează adresa 2 IPv6 a
unității.

IPv6 Gateway – –
Afișează gateway-ul implicit
IPv6 al unității.

Link-local IPv6
Address

– –
Afișează adresa legătură-
locală IPv6 a unității.

IPv4
Stabilește setările pentru rețeaua IPv4.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 363/464

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

DHCP On / Off On
Activează/dezactivează funcția
[DHCP].

IP
Address

– –
Setează adresa IPv4 când funcția
[DHCP] este setată Off.

Subnet
Mask

– –
Setează masca de subrețea când
funcția [DHCP] este setată Off.

Gateway – –
Setează gateway-ul implicit IPv4 când
funcția [DHCP] este setată Off.

IPv6
Stabilește setările pentru rețeaua IPv6.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Obtain an IP
Address
Automatically

On / Off On
Activează/dezactivează achiziția
adresei IPv6.

IP Address – –
Setează adresa IPv6 când funcția
[Obtain an IP Address Automatically]
este setată Off.

Prefix Length – –
Setează prefixul când funcția [Obtain
an IP Address Automatically] este
setată Off.

Gateway – –
Setează gateway-ul implicit IPv6
când funcția [Obtain an IP Address
Automatically] este setată Off.
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Common
Stabilește setările comune pentru rețelele IPv4/IPv6.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

HTTP Port
80, 1024 to
65534

80 Setează numărul portului HTTP.

DNS Auto On / Off On
Setează dacă adresele DNS se
obțin de la serverul DHCP.

Primary DNS
Server

IPv4/IPv6
address

–
Setează serverul DNS principal
când funcția [DNS Auto] este
setată la Off.

Secondary
DNS Server

IPv4/IPv6
address

–
Setează serverul DNS secundar
când funcția [DNS Auto] este
setată la Off.

[243] Meniul web și setări detaliate Meniul Network

File Transfer

Stabilește setările legate de transferurile de fișiere.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Auto
Upload
(Proxy)

On / Off Off
Activează/dezactivează încărcarea
automată a fișierelor proxy.

Default
Upload
Server

Server
Settings1 to
3 > Display
Name

Server
Settings1

Selectează serverul de încărcare pentru
fișiere. Serverul selectat aici devine
destinația de încărcare automată a fișierelor
proxy și destinația de încărcare a fișierelor
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

de pe ecranul miniatural.
Afișează setările pentru [Display Name],
configurate în [Server Settings1 to 3].

[244] Meniul web și setări detaliate Meniul Network

FTP Server 1 to 3

Stabilește setările pentru transferurile FTP.
Setările sunt comune pentru serverele FTP 1 până la 3.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Display
Name

– –
Setează numele de afișare indicat în
meniul de configurare a destinației de
transfer.

Service – – Afișează tipul de server.

Host Name – –
Setează numele gazdă al serverului de
destinație de transfer.

Port
21, 990,
1024 -
65534

21
Setează numărul portului serverului de
destinație de transfer.

User Name – –
Setează numele de utilizator pentru
autentificarea conexiunii la serverul de
destinație de transfer.

Password – –
Setează parola de autentificare a
conexiunii la serverul de destinație de
transfer.
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Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Passive
Mode

On / Off Off Activează/dezactivează modul pasiv.

Destination
Directory

– –
Setează numele directorului destinație
de transfer.

Using Secure
Protocol

On / Off Off
Setează dacă se folosește (On) sau nu
(Off) transferul FTP securizat.

Root
Certificate

– –

Încarcă certificatul rădăcină pentru
transferul FTP securizat.
Apăsați pe [Load] și selectați un
certificat rădăcină de pe ecranul afișat.
Apăsați butonul [Delete] pentru a șterge
certificatul rădăcină încărcat.

Root
Certificate
Status

– –
Afișează starea de încărcare a
certificatului rădăcină.

Reset – –
Resetează setările pentru [Server
Settings] la valorile implicite.

[245] Meniul web și setări detaliate Meniul Network

SSL

Stabilește setările pentru SSL.

SSL
Activează/dezactivează funcția SSL.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Function
Disable / Enable / Enable
(Allow HTTP connection for
some clients)

Disable
Activează/dezactivează
funcția SSL.

SSL Server Authentication
Stabilește setările pentru autentificarea la serverul SSL.

Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Certificate
Options

Use a self-signed
certificate (For
test use) / Use an
external certificate

–
Setează metoda de instalare a
certificatului serverului SSL.

Status – –

Afișează valabilitatea certificatului
serverului SSL când opțiunea
[Certificate Options] este setată la
[Use a self-signed certificate (For
test use)].

Issuer DN – –

Afișează numele distins al
emitentului certificatului serverului
SSL când opțiunea [Certificate
Options] este setată la [Use a
self-signed certificate (For test
use)].

Subject DN – –

Afișează numele distins al
subiectului certificatului serverului
SSL când opțiunea [Certificate
Options] este setată la [Use a
self-signed certificate (For test
use)].
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Available
Period

– –

Afișează perioada de valabilitate
a certificatului serverului SSL
când opțiunea [Certificate
Options] este setată la [Use a
self-signed certificate (For test
use)].

Extended Key
Usage

– –

Afișează metoda de utilizare a
cheii extinse când opțiunea
[Certificate Options] este setată la
[Use a self-signed certificate (For
test use)].

Delete – –

Acest buton este afișat când
opțiunea [Certificate Options] este
setată la [Use a self-signed
certificate (For test use)].
Șterge certificatul instalat al
serverului SSL.

Import – –

Instalează un certificat extern de
server SSL dintr-o listă când
opțiunea [Certificate Options] este
setată la [Use an external
certificate].

Private Key
Password

– –

Setează parola pentru informații
despre cheia privată a
certificatului serverului SSL când
opțiunea [Certificate Options] este
setată la [Use an external
certificate].

Reset – –
Acest buton golește afișajul
parolei cu o cheie privată pentru a
fi introdusă o parolă nouă.

Self-Signed
Certificate
Generation

– – Apăsați butonul [Generate] pentru
a genera un certificat autosemnat
când opțiunea [Certificate
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Element Setare sub-
element

Valoare
implicită

din fabrică
Descriere

Options] este setată la [Use a
self-signed certificate (For test
use)].

[246] Meniul web și setări detaliate Meniul Network

Referer Check

Stabilește setările pentru verificarea refererului.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Setting On / Off On
Activează/dezactivează funcția de
verificare a refererului.

Exception List
Stabilește setările pentru lista de excepții la verificarea refererului.
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Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Nu. 1 - 10 – Setează numărul excepției din listă.

Host
Name

– – Setează numele gazdei pentru excepție.

Port
Number

– – Setează numărul portului pentru excepție.

Set – –
Apăsați pentru a înregistra excepția
configurată în lista de excepții.

Delete – –
Selectați o excepție pe care doriți s-o
ștergeți și apăsați butonul pentru a șterge
excepția înregistrată, din lista de excepții.

[247] Meniul web și setări detaliate Meniul Network

Brute Force Attack Protection
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Stabilește setările pentru prevenirea atacurilor prin forță brută.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Setting On / Off On
Activează/dezactivează funcția [Brute
Force Attack Protection].

Count 3 - 100 8

Setează numărul de încercări care vor fi
considerate atacuri.
Activată când opțiunea [Setting] este
setată la On.

Release
Mode

Always /
Timer

Temporizator

Setează starea de eliberare.
Activată când opțiunea [Setting] este
setată la On.
Always: nu ștergeți din lista de atacatori.
Timer: ștergeți din lista de atacatori la
finalul perioadei de eliberare setată cu
opțiunea [Release Time].

Release
Time

30 to
86400 s

60

Setează durata de eliberare.
Activată când opțiunea [Setting] este
setată la On.
Când opțiunea Release Mode: este setată
la [Timer], intrările sunt șterse din lista de
atacatori după scurgerea perioadei de
eliberare.

Când este detectat un atacator, sunt afișate informațiile din lista de atacatori.

[248] Meniul web și setări detaliate Meniul Stream

Stream

Stabilește setările pentru redarea în timp real (consultați „Despre redarea în timp real”).

Stream Setting
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Stabilește setările pentru protocolul de redare în timp real.

Element Setare sub-element Valoare implicită
din fabrică Descriere

Setting
RTSP / SRT-Caller / SRT-
Listener / NDI|HX / Off

RTSP
Selectează protocolul de
redare în timp real.

RTSP
Următoarele elemente sunt afișate când opțiunea [Stream Setting] este setată la [RTSP].
Stabilește setările pentru redarea în timp real prin RTSP.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Port Number
554, 1024
to 65534

554 Setează numărul portului RTSP.

Time Out 0 - 600 60
Specifică timpul de expirare a comenzii
[Keep Alive] pentru redarea în timp real
prin RTSP.

Authentication On / Off On
Activează/dezactivează funcția de
autentificare pentru RTSP.

Video Port
Number 1

1024 -
65534

51000

Setează numărul portului pentru
trimiterea videoclipului 1 pentru redarea
în timp real prin RTSP între două
puncte.

Video Port
Number 2

1024 -
65534

53000

Setează numărul portului pentru
trimiterea videoclipului 2 pentru redarea
în timp real prin RTSP între două
puncte.

Audio Port
Number

1024 -
65534

57000
Setează numărul portului pentru
trimiterea sunetului pentru redarea în
timp real prin RTSP între două puncte.
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SRT
Următoarele elemente sunt afișate când opțiunea [Stream Setting] este setată la [SRT-Caller]
sau [SRT-Listener].
Stabilește setările pentru redarea în timp real prin SRT.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Destination – –
Setează URL-ul destinație al
conexiunii când unitatea acționează
ca apelant.

Port
Number

1024 - 65534 4201
Setează URL-ul destinație al
conexiunii când unitatea acționează
ca listener.

Latency 20 to 8000 ms 120 Setează latența.

TTL 1 - 255 64 Setează valoarea pentru TTL.

Encryption
Off / AES128 /
AES256

Off
Activează/dezactivează criptarea și
setează metoda de criptare.

Passphrase
0 sau șir de 10
până la 79 de
caractere

0

Setează expresia de acces utilizată
pentru criptare.
Apăsați Reset pentru a șterge
expresia de acces introdusă.

ARC On / Off On
Activează/dezactivează funcția
[Adaptive Rate Control].

NDI|HX
Următoarele elemente sunt afișate când opțiunea [Stream Setting] este setată la [NDI|HX].
Stabilește setările pentru NDI|HX.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Licenţă – –
Afișează starea de instalare a cheii de
licență NDI.

Source
Name

– – Afișează numele sursei NDI.

Group On / Off Off
Activează/dezactivează funcția de
grupare NDI.

Group
Name

– –
Se afișează când funcția de grupare
NDI este setată la On.
Setează numele grupului.

Discovery
Server 1

– –
Setează serverul 1 de descoperire
NDI.

Discovery
Server 2

– –
Setează serverul 2 de descoperire
NDI.

Reliable
UDP Mode

On / Off On
Activează/dezactivează modul
Reliable UDP.

Multicast
Mode

On / Off Off
Activează/dezactivează redarea în
timp real între mai multe puncte.

Multicast
Prefix

239.255.0.0 239.255.0.0

Se afișează când opțiunea [Multicast
Mode] este setată la On.
Setează prefixul de utilizat pentru
redarea în timp real între mai multe
puncte.

Multicast
Netmask

255.255.0.0 255.255.0.0

Se afișează când opțiunea [Multicast
Mode] este setată la On.
Setează masca de rețea care
stabilește intervalul de adrese pentru
comunicarea între mai multe puncte.

Multicast
TTL

1 - 256 3 Se afișează când opțiunea [Multicast
Mode] este setată la On.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 375/464

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setează valoarea TTL pentru redarea
în timp real între mai multe puncte.

Multi-TCP
Mode

On / Off Off
Activează/dezactivează modul Multi-
TCP.

Unicast
UDP Mode

On / Off On
Activează/dezactivează modul Unicast
UDP.

[249] Meniul web și setări detaliate Meniul Stream

Video Stream

Stabilește setările pentru codecurile video de redare în timp real.

Video Stream 1
Stabilește setările pentru codecul video 1.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Codec 1 H.264 / H.265 H.264
Setează codecul
imaginii 1.

Size 1
4096×2160 / 3840×2160 /
2048×1080 / 1920×1080 /
1280×720 / 640×360

1920×1080
Setează dimensiunea
imaginii 1.

Frame Rate 1 Pentru detalii despre
ratele de cadre
acceptate, consultați
„Setarea codecului

– Setează rata de cadre
a imaginii 1.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

video pentru redarea
în timp real”.

I-Picture Mode
1

Time / Frame Time

Setează intervalul de
introducere a valorii
[IDR-Frame] pentru
imaginea 1 ca timp sau
număr de cadre.

I-Picture
Interval 1

1 / 2 / 3 / 4 / 5 s 1

Se afișează când
opțiunea [I-Picture
Mode 1] este setată la
Time.
Setează intervalul de
introducere a valorii
IDR-Frame pentru
H.264 și H.265 ca timp.

I-Picture Ratio
1

15 to 300 frames 30

Se afișează când
opțiunea [I-Picture
Mode 1] este setată la
Frame.
Setează intervalul de
introducere a valorii
IDR-Frame pentru
H.264 și H.265 ca
număr de cadre.

Profile 1
H.264: high / main /
baseline
H.265: main / main10

H.264: high
Setează profilul pentru
H.264 sau H.265.

Bit Rate
Compression
Mode 1

CBR / VBR VBR
Setează modul de
compresie pentru rata
de biți a imaginii 1.

Bit Rate 1 512 / 768 / 1000 / 2000 /
3000 / 4000 / 5000 / 6000
/ 7000 / 8000 / 16000 /

16000 Se afișează când
opțiunea [Bit Rate
Compression Mode 1]
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

24000 / 32000 / 50000 /
64000 / 80000 kbps

este setată la On.
Setează valoarea țintă
a ratei de biți când
modul de compresie a
ratei de biți este setată
la CBR.

Quality 1
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9
10

6
Setează calitatea
pentru H.264 sau
H.265.

Video Stream 2
Stabilește setările pentru codecul video 2.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Codec 2 H.264 / H.265 / Off Off
Setează codecul imaginii
2.

Size 2

4096×2160 / 3840×2160
/ 2048×1080 /
1920×1080 / 1280×720 /
640×360 / 512×270

1920×1080
Setează dimensiunea
imaginii 2.

Frame Rate 2

Pentru detalii despre
ratele de cadre
acceptate, consultați
„Setarea codecului
video pentru redarea
în timp real”.

–

Se afișează când
opțiunea [Codec 2] nu
este setată la Off.
Setează rata de cadre a
imaginii 2.

I-Picture Mode
2

Time / Frame Time Se afișează când
opțiunea [Codec 2] nu
este setată la Off.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Setează intervalul de
introducere a valorii IDR-
Frame pentru imaginea
2 ca timp sau număr de
cadre.

I-Picture
Interval 2

1 / 2 / 3 / 4 / 5 s 1

Se afișează când
opțiunea [Codec 2] nu
este setată la Off și
opțiunea [I-Picture Mode
2] este setată la [Time].
Setează intervalul de
introducere a valorii IDR-
Frame pentru H.264 și
H.265 ca timp.

I-Picture Ratio
2

15 to 300 frames 30

Se afișează când
opțiunea [Codec 2] nu
este setată la Off și
opțiunea [I-Picture Mode
2] este setată la [Frame].
Setează intervalul de
introducere a valorii IDR-
Frame pentru H.264 și
H.265 ca număr de
cadre.

Profile 2
H.264: high / main /
baseline
H.265: main

–
Setează profilul pentru
H.264 sau H.265.

Bit Rate
Compression
Mode 2

CBR / VBR VBR

Se afișează când
opțiunea [Codec 2] nu
este setată la Off.
Setează modul de
compresie pentru rata de
biți a imaginii 2.

Bit Rate 2 512 / 768 / 1000 / 2000 /
3000 / 4000 / 5000 /

8000 Se afișează când
opțiunea [Codec 2] nu
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

6000 / 7000 / 8000 /
16000 / 24000 / 32000 /
50000 / 64000 / 80000
kbps

este setată la Off și
opțiunea [Bit Rate
Compression Mode 2]
este setată la [On].
Setează valoarea țintă a
ratei de biți când modul
de compresie a ratei de
biți este setată la CBR.

Quality 2
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 /
9 / 10

6

Se afișează când
opțiunea [Codec 2] este
setată la H.264 și
opțiunea [Bit Rate
Compression Mode 2]
este setată la Off.
Setează calitatea pentru
H.264 sau H.265.

Video Stream 3
Stabilește setările pentru codecul video 3.

Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Codec 3 JPEG JPEG
Setează codecul
imaginii 3.

Size 3 1280×720 / 1024×540 / 640×360 1280×720
Setează
dimensiunea
imaginii 3.

Frame
Rate 3

Pentru detalii despre ratele de
cadre acceptate, consultați
„Setarea codecului video pentru
redarea în timp real”.

–
Setează rata de
cadre a imaginii
3.
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Element Setare sub-element
Valoare

implicită din
fabrică

Descriere

Quality 3 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 6
Setează
calitatea.

[250] Meniul web și setări detaliate Meniul Stream

Audio Stream

Stabilește setările pentru codecul audio de redare în timp real.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Setting On / Off Off
Activează/dezactivează ieșirea
pentru redarea audio în timp real.

Codec
AAC (128kbps) /
AAC (256kbps)

AAC 128kbps

Se afișează când opțiunea [Setting]
este setată la On.
Setarea codecului audio pentru
redarea în timp real.

[251] Meniul web și setări detaliate Meniul Maintenance

Language

Setează limba de afişare.

Element Setare sub-
element

Valoare implicită din
fabrică Descriere

Language – – Setează limba de
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Element Setare sub-
element

Valoare implicită din
fabrică Descriere

afişare.

Notă

Limbile disponibile poate varia în funcție de țară sau regiune.

[252] Meniul web și setări detaliate Meniul Maintenance

Accessibility

Stabilește setările pentru citirea audio (text în vorbire).

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Cititor de
ecran

On / Off Off 
Activează/dezactivează funcția de
cititor de ecran din panoul cu
imaginea camerei a aplicației web.

Speech
Rate

Slow2 / Slow1 /
Normal / Fast1 /
Fast2 / Fast3 /
Fast4

Normal

Setează viteza funcției de cititor de
ecran.
Un exemplu de paragraf este citit cu
voce tare la viteza configurată.

Speech
Volume

1 - 15 7

Setează volumul funcției de cititor de
ecran a aplicației web.
Un exemplu de paragraf este citit cu
voce tare la volumul configurat.

Notă

Această funcție este disponibilă doar pe modelele vândute în America de Nord. Funcția de cititor de
ecran poate fi utilizată numai când limba este setată la English (engleză) (la data lansării).
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Activați funcția de cititor de ecran a browserului de pe dispozitivul pe care rulează aplicația web.

[253] Meniul web și setări detaliate Meniul Maintenance

Clock Set

Stabilește setările ceasului interior.

Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Current
Date &
Time

– –
Afișează ora curentă,
configurată pe unitate.

PC Clock – –
Afișează ora curentă a
tabletei sau computerului
utilizat pentru configurare.

Date &
Time
Format

yyyy-mm-dd hh:mm:ss /
mm-dd-yyyy hh:mm:ss /
dd-mm-yyyy hh:mm:ss

yyyy-mm-dd
Setează formatul de afișare a
datei și orei.

12 h / 24 h 12 h / 24 h 24 h
Setează afișarea orei în
formatul de 12 ore/24 de ore.

Time
Setting

Keep current setting /
Synchronize with PC /
Manual setting /
Synchronize with NTP

–
Setează metoda de
configurare a datei și orei.

yy-mm-dd
hh:mm:ss

yy: 19 to 37
mm: 01 to 12
dd: 01 to 31
hh: 00 to 23
mm: 00 to 59
ss: 00 to 59 (seconds)

–

Se afișează când opțiunea
[Time Setting] este setată la
Manual setting.
Setează manual data și ora.

NTP Auto On / Off Off Se afișează când opțiunea
[Time Setting] este setată la
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Element Setare sub-element
Valoare
implicită

din fabrică
Descriere

Synchronize with NTP.
Setează dacă adresa IP a
serverului NTP se obține de la
serverul DHCP.

NTP
Server

IPv4/IPv6 address or
host name

–

Se afișează când opțiunea
[Time Setting] este setată la
[Synchronize with NTP] și
[NTP Auto] este setată la Off.
Specifică serverul NTP utilizat
pentru sincronizarea orei.

Time Zone
UTC − 12:00 to UTC +
14:00

– Selectează fusul orar.

[254] Meniul web și setări detaliate Meniul Maintenance

Reset

Inițializează unitatea.

Reboot
Reinițializează unitatea.

Element Setare sub-
element

Valoare implicită
din fabrică Descriere

Reboot Execute –

Reinițializează unitatea.
Execute: execută funcția.

Notă

După repornire, reîncărcați
pagina în browser.



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 384/464

Reset
Restabilește setările unității.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

All Reset
(except for
Network
Settings)

Execute –

Restabilește setările unității (cu
excepția celor pentru rețea).
Execute: execută funcția.

Notă

Aspectele de bază și fișierele LUT
importate nu sunt șterse.

Network Reset Execute –

Restabilește setările rețelei de pe
unitate.
Execute: execută funcția.

Notă

După executarea funcției Network
Reset, unitatea se va reinițializa.
După repornire, reîncărcați pagina
în browser.

Factory Default Execute –

Restabilește setările unității la starea
implicită din fabrică.
Execute: execută funcția.

Notă

După executarea funcției Factory
Default, unitatea se va reinițializa.
După repornire, reîncărcați pagina
în browser.

[255] Meniul web și setări detaliate Meniul Maintenance
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Information

Afișează informații despre cameră și obiectiv. Se utilizează și pentru actualizarea software-ului.

Cameră
Afișează informațiile despre cameră și actualizează software-ul.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Model
Name

– – Afișează numele modelului de cameră.

Număr
serial

– – Afișează numărul de serie al camerei.

Version
Number

– – Afişează versiunea software a camerei.

Version
Up

– –

Apăsați butonul [Choose File] și urmați
instrucțiunile de pe ecran pentru a
actualiza software-ul camerei.

Notă

După actualizare, unitatea se va
reinițializa. După repornire,
reîncărcați pagina în browser.

Lens
Afișează informațiile despre obiectiv și actualizează software-ul.

Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Model – – Afișează numele modelului de obiectiv.
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Element
Setare
sub-

element

Valoare
implicită din

fabrică
Descriere

Name

Număr
serial

– – Afișează numărul serial al obiectivului.

Version
Number

– –
Afișează versiunea de software a
obiectivului.

Version
Up

– –

Apăsați butonul [Choose File] și urmați
instrucțiunile de pe ecran pentru a
actualiza software-ul obiectivului.

Pentru detalii, consultați „Actualizarea
software-ului obiectivului cu montură
E”.

Notă

După actualizarea obiectivului,
unitatea se va reinițializa. După
repornire, reîncărcați pagina în
browser.

[256] Meniul web și setări detaliate Meniul Maintenance

System Log

Stabilește setările pentru jurnalul sistemului.

Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Log Level Critical, Warning &
Info / Critical &

Critical,
Warning &

Stabilește nivelul pentru
adăugarea unei înregistrări în
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Warning / Critical Info jurnalul sistemului.

Log Size 200 - 1024 1024
Stabilește dimensiunea jurnalului
de salvat pentru sistem.

Download
as File

– –

Apăsați butonul [Download] și
salvați jurnalul sistemului pe o
tabletă sau computer de pe
ecranul afișat.

Jurnalul obținut este afișat ca în exemplul de mai jos.

[257] Meniul web și setări detaliate Meniul Maintenance

HTTP Access Log

Stabilește setările pentru jurnalul de acces HTTP.
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Element Setare sub-
element

Valoare
implicită din

fabrică
Descriere

Log Level
Critical, Warning
& Info / Critical &
Warning / Critical

Critical,
Warning &
Info

Stabilește nivelul pentru
adăugarea unei înregistrări în
jurnalul de acces HTTP.

Log Size 200 - 1024 1024
Stabilește dimensiunea jurnalului
de acces HTTP de salvat.

Download
as File

– –

Apăsați butonul [Download] și
salvați jurnalul de acces HTTP pe
o tabletă sau computer de pe
ecranul afișat.

[258] Meniul web și setări detaliate Meniul Maintenance

Service

Obține informații despre dispozitiv pentru unitate. Se utilizează la contactarea reprezentantului
de service Sony.

Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

Sunt de acord cu
descărcarea
informațiilor despre
dispozitiv.

– – Bifați această casetă de validare
pentru a vă exprima acordul cu
preluarea informațiilor despre
dispozitiv și apăsați butonul [OK].
Apăsați butonul [Download] afișat.
Browserul va descărca un fișier
denumit temporar
deviceinformation.dat.

Notă
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Element
Setare
sub-

element

Valoare
implicită

din fabrică
Descriere

După descărcare, unitatea se va
reinițializa. După repornire,
reîncărcați pagina în browser.

[259] Meniul web și setări detaliate Meniul Maintenance

EULA

Afișează Acordul de licență cu utilizatorul final (EULA).

[260] Meniul web și setări detaliate Meniul Maintenance

Software

Afișează licența software.

[261] Conexiunea dispozitivelor externe

Conectarea monitoarelor și a dispozitivelor de
înregistrare externe

Pentru a afișa imagini înregistrate/redate pe un monitor extern, setați tipul de ieșire video pentru
monitorul extern și folosiți un cablu adecvat pentru monitorul care va fi conectat.
De asemenea, puteți conecta un recorder extern și înregistra semnalul de ieșire din unitate.
Puteți afișa aceleași informații vizibile pe panoul cu imaginea camerei, cum ar fi informații de
stare și meniuri, pe un monitor extern. Setați tipul dorit de sistem pentru afișajul ecranului la On,
utilizând [Monitoring] > [Output Display] din meniul web.
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Notă

Dacă un monitor conectat la conectorul HDMI nu acceptă formatul de ieșire HDMI, configurat
utilizând meniul [Monitoring] din meniul web sau meniul camerei, imaginea camerei nu va fi
transmisă către aplicația web. Nu poate să fie transmisă redarea video în timp real.

Puteți seta atât [Output Display] > [SDI], cât și [HDMI/Stream] la [Off], dar această acțiune nu va
permite utilizarea meniurilor și funcțiilor camerei care depind de afișarea pe ecran. În plus,
notificările erorilor unității vor fi limitate la lămpile (aprinse sau luminând intermitent) unității și la
afișarea simbolului de notificarea în zona din dreapta sus a aplicației web. Pentru a vedea detalii
despre stare, setați opțiunea [Output Display] la [On].

Sugestie

Opțiunea [Output Display] > [SDI] este setată la [Off] și [HDMI/Stream] este setată la [On] în mod
implicit din fabrică. Pentru a utiliza redarea în timp real ca sursă video principală, setați [SDI] la [On]
și [HDMI/Stream] la [Off] și monitorizați starea camerei pe un monitor SDI.

Conector SDI OUT (tip BNC)

Setați formatul de ieșire utilizând meniul [Monitoring] din meniul web sau meniul camerei.
Pentru conectare, folosiți un cablu coaxial 75 Ω disponibil în comerț.

Notă

Verificați dacă conexiunea dintre unitate și dispozitivul extern este împământată înainte de a porni
dispozitivele.

Se recomandă ca dispozitivul extern și unitatea să fie pornite după conectarea cablului
coaxial de 75 Ω.
Dacă dispozitivul extern trebuie conectat la camera video în timp ce unitatea este pornită,
conectați mai întâi cablul coaxial de 75 Ω la dispozitivul extern și apoi conectați-l la unitate.

Pentru a începe înregistrarea pe unitate și pe dispozitivul extern simultan
Cu ieșirea de semnal SDI activată, setați [Project] > [SDI/HDMI Rec Control] > [Setting] la
[SDI/HDMI Remote I/F] sau [Parallel Rec] din meniul camerei, pentru a activa transmiterea unui
semnal de declanșare REC către dispozitivul extern conectat la conectorul SDI OUT. Aceasta
va sincroniza înregistrarea pe dispozitivul extern cu unitatea.

Notă
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Dacă un dispozitiv extern conectat nu acceptă un semnal de declanșare REC, dispozitivul nu poate
fi acționat.

Când opțiunea [Project] > [SDI/HDMI Rec Control] > [Setting] este setată la [SDI/HDMI Remote I/F]
din meniul camerei, numai semnalul de declanșare REC este transmis dacă în momentul respectiv
nu există suporturi de înregistrare introduse și este acționat butonul record START/STOP.

Conector HDMI OUT (conector tip A)

Configurați setarea On/Off pentru ieșire și formatul de ieșire în meniul [Monitoring] din meniul
camerei.

Pentru a începe înregistrarea pe unitate și pe dispozitivul extern simultan
Când ieșirea semnalului HDMI este activată, setați [TC/Media] > [HDMI TC Out] > [Setting] la
[On] și [Project] > [SDI/HDMI Rec Control] > [Setting] la [SDI/HDMI Remote I/F] sau [Parallel
Rec] din meniul camerei, pentru a activa transmiterea unui semnal de declanșare REC către
dispozitivul extern conectat la conectorul HDMI OUT. Aceasta va sincroniza înregistrarea pe
dispozitivul extern cu unitatea.

Notă

Dacă un dispozitiv extern conectat nu acceptă un semnal de declanșare REC, dispozitivul nu poate
fi acționat.

Când opțiunea [Project] > [SDI/HDMI Rec Control] > [Setting] este setată la [SDI/HDMI Remote I/F]
din meniul camerei, numai semnalul de declanșare REC este transmis dacă în momentul respectiv
nu există suporturi de înregistrare introduse și este acționat butonul record START/STOP.

[262] Conexiunea dispozitivelor externe Operarea utilizând o telecomandă RM-IP500
(opțiune)

Despre operarea utilizând o telecomandă RM-IP500
(opțiune)

Puteți controla unitatea, utilizând o telecomandă Sony RM-IP500 pe care rulează versiunea de
software 2.2 sau alta ulterioară. Dispozitivele comunică utilizând VISCA prin IP (LAN).
În funcție de elementul țintă de utilizat, poate fi necesar să verificați afișajul de pe ecranul
unității. Pregătiți un monitor care poate fi utilizat pentru a verifica afișajul ecranului.
Următoarele operații pot fi efectuate cu ajutorul unei telecomenzi RM-IP500.
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Selectarea camerei țintă
Reglarea încadrării (panoramare, înclinare, zoom)
Reglarea focalizării (excluzând operarea tactilă)
Înregistrarea și reapelarea pozițiilor presetate
Operarea meniului unității (excluzând meniul web)
Reglarea luminozităţii
Reglarea balansului de alb
Reglarea balansului de negru
Reglarea nivelului de intrare audio
Începerea/oprirea înregistrării
Executarea funcțiilor cu butoanele alocabile ale unității

Pentru detalii despre utilizarea conectare RM-IP500, consultați instrucțiunile de utilizare ale
telecomenzii.

Sugestie

Când utilizați o telecomandă RM-IP500, folosiți fișa cu panouri pentru această unitate, care este
furnizată împreună cu RM-IP500.

RM-IP500 (utilizarea fișei cu panouri pentru această unitate)

[263] Conexiunea dispozitivelor externe Operarea utilizând o telecomandă RM-IP500
(opțiune)
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Conectarea unei telecomenzi RM-IP500

Pentru detalii despre atribuirea funcțiilor, consultați instrucțiunile de utilizare ale telecomenzii
RM-IP500.

[264] Conexiunea dispozitivelor externe Sincronizarea cu un dispozitiv extern

Rotiți comutatorul SETUP 3 al unității în poziția ON pentru a activa
comunicarea VISCA prin IP.

Notă

Setarea comutatorului este aplicată la următoarea pornire a unității.

1

Conectați telecomanda RM-IP500 la aceeași rețea ca unitatea.2

Urmați procedura din instrucțiunile de utilizare RM-IP500 pentru a
configura conexiunea VISCA prin IP (LAN) pe RM-IP500.
Atribuiți această unitate cu ajutorul meniului RM > AUTO IP SETUP > ASSIGN CAM.

3

Atribuiți funcțiile acestei unități butoanelor și selectoarelor, în
funcție de caz, utilizând elementele din meniul RM al RM-IP500, de
mai jos.
SW ASSIGN
AE CONFIG2
WB MODE

4



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 394/464

Despre sincronizarea cu un dispozitiv extern

Când filmați cu mai multe unități, acestea pot fi sincronizate cu un anumit semnal de referință
sau un cod de timp specific prin intermediul conectorului GENLOCK al unităților.

Pentru detalii despre genlock, consultați „Sincronizarea fazei semnalului video (Genlock)”.
Pentru detalii despre sincronizarea codurilor de timp, consultați „Blocarea codului de timp pe
alte dispozitive”.

[265] Conexiunea dispozitivelor externe Sincronizarea cu un dispozitiv extern

Sincronizarea fazei semnalelor video (Genlock)

Puteți să furnizați un semnal de referință către conectorul GENLOCK pentru a activa genlock.
Semnalele de referință de intrare, care pot fi utilizate, variază în funcție de frecvența sistemului
pentru formatul de înregistrare selectat.

Frecvența sistemului pentru formatul de
înregistrare

Semnale de referință de intrare
acceptate

59.94P
1920×1080 59.94i
720×486 59.94i

50P
1920×1080 50i
720×576 50i

29.97P
1920×1080 59.94i
720×486 59.94i

25P
1920×1080 50i
720×576 50i

24P 1920×1080 24PsF

23,98P 1920×1080 23.98PsF

59.94i
1920×1080 59.94i
720×486 59.94i
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Frecvența sistemului pentru formatul de
înregistrare

Semnale de referință de intrare
acceptate

50i
1920×1080 50i
720×576 50i

Puteți verifica starea de sincronizare externă, utilizând opțiunea [Technical] > [Genlock] >
[Reference] din meniul camerei.

Notă

Dacă semnalul de referință este instabil, genlock nu poate fi obținut.

Unda subpurtătoare nu este sincronizată.

[266] Conexiunea dispozitivelor externe Sincronizarea cu un dispozitiv extern

Blocarea codului de timp pe alte dispozitive

Setați unitatea care furnizează codul de timp într-un mod în care ieșirea de cod de timp
continuă să funcționeze (cum ar fi Free Run sau Clock).

Setați următoarele funcții utilizând opțiunea [TC/Media] >
[Timecode] din meniul camerei.
Setați [Mode] la [Preset].
Setați [Run] la [Free Run].

1

Apăsați butonul alocabil căruia i-a fost atribuită funcția
[DURATION/TC/U-BIT] pentru afișarea codului de timp de pe ecran.

2

Furnizați un semnal video de referință HD sau SD către conectorul
GENLOCK și codul de timp de referință către conectorul TC IN.
Generatorul de coduri de timp al unității realizează blocarea utilizând codul de timp de
referință, iar „EXT-LK” apare pe ecran.

3
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Notă

Verificați dacă există o relație fazată între codul de timp de referință furnizat și semnalul video de
referință, care respectă standardul pentru coduri de timp SMPTE.

Când utilizați blocarea externă, codul de timp realizează instantaneu blocarea utilizând codul de
timp extern și valoarea codului de timp extern apare în zona de afișare a orei și datei. Cu toate
acestea, nu începeți înregistrarea imediat. Așteptați câteva secunde până când generatorul de cod
de timp se stabilizează înainte de înregistrare.

Dacă frecvența semnalului video de referință și frecvența cadrelor de pe unitate nu sunt aceleași,
blocarea nu poate fi realizată și unitatea nu va funcționa corect. Dacă se întâmplă acest lucru, codul
de timp nu va realiza blocarea reușită cu codul de timp extern.

Dacă este deconectată sursa de coduri de timp externe, codul de timp se poate schimba cu un
cadru pe oră în raport cu codul de timp de referință.

Pentru eliberarea blocării externe
Schimbați setarea [TC/Media] > [Timecode] din meniul camerei.
Sincronizarea externă este, de asemenea, activată dacă frecvența sistemului este modificată și
când începeți înregistrarea într-un mod special de înregistrare (Slow & Quick Motion sau
Interval Rec).

[267] Conexiunea dispozitivelor externe

Conectarea unui microfon extern sau a unui dispozitiv
audio extern

Puteți recepționa semnalul de la un microfon extern sau de la un dispozitiv audio extern și
încorpora sunetul în videoclipul înregistrat sau în videoclipul transmis de unitate.

După ce au trecut aproximativ zece secunde după ce se blochează codul de timp, starea
de blocare externă este păstrată chiar dacă sursa externă de coduri de timp de referință
este deconectată.

Conectați un microfon extern sau un dispozitiv audio extern printr-
un cablu XLR.
Când sunetul este setat la [LINE], utilizând opțiunea [Audio] > [Audio Input] > [AUDIO IN
Select] din meniul camerei, conectorul AUDIO IN funcționează precum conectoarele
AUDIO IN CH-1 și AUDIO IN CH-2.

1
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Pin nr. Function

1 GND

2 AUDIO IN CH-1+ (HOT)

3 AUDIO IN CH-1− (COLD)

4 AUDIO IN CH-2+ (HOT)

5 AUDIO IN CH-2− (COLD)

Opriți unitatea și conectați cablul XLR la conectorul AUDIO IN.2

Setați comutatorul 2 SETUP pentru a activa alimentarea fantomă în
funcție de caz.

Comutați alimentarea +48 V (fantomă) așa cum se descrie mai jos.
Comutatorul 2
Setează dacă alimentarea cu +48 V (fantomă) este activată/dezactivată când este
conectat un dispozitiv de intrare audio.

Setting Descriere

OPRIT
(implicit)

Această acțiune dezactivează alimentarea fantomă +48 V și setează
intrarea LINE sau MIC ca sursă audio CH-1 și CH-2.

3
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[268] Conexiunea dispozitivelor externe

Gestionarea/editarea clipurilor folosind un computer

Puteți să gestionați/editați clipurile utilizând un computer.

Importul clipurilor cu ajutorul unui cititor de carduri (opțional)

Conectați un cititor de carduri CFexpress Type A sau un cititor de carduri SD la computer și
utilizați software-ul compatibil cu formatul de înregistrare al acestei unități, precum Catalyst
Browse, pentru a importa clipurile.

Utilizarea unui sistem de editare neliniară

Într-un sistem de editare neliniară, este necesar un software de editare (opțiune) care acceptă
formatele înregistrate de unitate.

Setting Descriere

PORNIT
Această acțiune activează alimentarea fantomă +48 V și setează
microfonul compatibil cu alimentarea fantomă ca sursă audio CH-1 și
CH-2.

Notă

Dacă rotiți acest comutator la poziția ON și conectați un microfon care nu este compatibil cu
o sursă de +48 V, dispozitivul conectat poate fi deteriorat. Verificaţi setarea înainte de
conectarea dispozitivului.

Porniți unitatea și setați tipul dispozitivului conectat, utilizând
opțiunea [Audio] > [Audio Input] > [AUDIO IN Select] din meniul
camerei.

4
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[269] Conexiunea dispozitivelor externe

Transmiterea unui semnal prin fibră optică

Puteți transmite un semnal SDI convertit în semnal optic prin conectarea unui modul SFP+
(opțional) la conectorul OPTICAL al unității. Utilizați un modul SFP+ care se potrivește cu banda
semnalului fiecărui format.
Banda semnalului

4K (59.94p, 50p): 12G
4K (altul în afară de 59.94p, 50p): 6G
HD (59.94p, 50p): 3G
HD (altul în afară de 59.94p, 50p): 1.5G

Notă

Utilizați un modul care respectă următoarele standarde.

Standardele SFF
SFF-8083/SFF-8418/SFF-8419*/SFF-8432/SFF-8433/SFF-8071/SFF-8472

Standardele SDI
ST297/ST292/ST424/ST425/ST2081/ST2082

Același semnal ca și al conectorului de ieșire SDI este transmis către modulul SFP+.

Unitatea nu acceptă intrarea de semnal prin fibră optică.

Utilizați un modul SFP+ pentru transmiterea semnalului prin fibră optică. Pentru detalii despre
modulele SFP+, contactați reprezentanța de service Sony locală.

[270] Conexiunea dispozitivelor externe

Conectarea unui indicator de semnalizare

Acest subiect explică controlul asupra indicatorului de semnalizare.

Aprinderea lămpii de semnalizare cu un semnal de la o
telecomandă

* Nivel de putere I (1,0 W)
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Puteți aprinde lampa de semnalizare utilizând o comandă VISCA prin IP de la un dispozitiv
extern, cum ar fi RM-IP500.
Setați opțiunea [Technical] > [Tally] > [Tally Control] la [External] din meniul web sau meniul
camerei.

Aprinderea lămpii de semnalizare de pe un dispozitiv extern

Puteți aprinde lampa de semnalizare a unității în roșu sau verde de la un dispozitiv extern, cum
ar fi RM-IP500 sau un comutator. Puteți să controlați semnalizarea utilizând comenzi transmise
prin rețea sau un indicator de semnalizare pe conectorul OPTION al unității.
Setați opțiunea [Technical] > [Tally] > [Tally Control] la [External] din meniul web sau meniul
camerei.
La intrarea unui indicator de semnalizare pe conectorul OPTION, scurtcircuitați pinul 7 la GND
(sau pinul 4 sau 5), pentru a aprinde lampa de semnalizare în verde, sau pinul 8 la GND (sau
pinul 4 sau 5) pentru a aprinde lampa de semnalizare în roșu.

Notă

Când [Tally Control] este setată la [External], starea de înregistrare a unității nu este indicată de
lampa de semnalizare.

La intrarea simultană ca unei semnalizări roșii și verzi, lampa de semnalizare a unității se va
aprinde în roșu.

Specificațiile pinilor conectorului OPTION

Pin
nr.

Direcția
semnalului Specificațiile semnalului

1 – Rezervat

2 – Rezervat

3 OUT Ieșire lampă de semnalizare verde
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Pin
nr.

Direcția
semnalului Specificațiile semnalului

Ieșire de nivel redus când lampa de semnalizare verde
este aprinsă.
Hi-Z (ieșire priză deschisă) când lampa de semnalizare
verde nu este aprinsă.

4 – GND (masă)

5 – GND (masă)

6 OUT

Ieșire lampă de semnalizare roșie
Ieșire de nivel redus când lampa de semnalizare roșie
este aprinsă.
Hi-Z (ieșire priză deschisă) când lampa de semnalizare
roșie nu este aprinsă.

7 IN
Intrare de control extern de semnalizare verde
Scurtcircuitul la masă (pinul 4 sau 5) provoacă aprinderea
lămpii de semnalizare a unității în verde.

8 IN
Intrare de control extern de semnalizare roșie
Scurtcircuitul la masă (pinul 4 sau 5) provoacă aprinderea
lămpii de semnalizare a unității în roșu.

Aprinderea lămpii de semnalizare a unui dispozitiv extern,
utilizând un semnal de la unitate

Puteți aprinde lampa de semnalizare a unui dispozitiv extern utilizând un semnal de la unitate,
conectând pinul 3 și pinul 6 al conectorului OPTION așa cum se descrie mai jos.
Exemplu de conexiune la pinii 3 și 6 ai conectorului OPTION
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Notă

Nu aplicați tensiune pe pinii 7 și 8.

Nu conectați niciun dispozitiv extern care poate aplica tensiune pe conectorul OPTION.

Dacă este aplicată o tensiune de vârf sau inversă care depășește valoarea nominală pe pinul 3 sau
6, poate fi provocată o defecțiune, fum sau un incendiu.

Setați semnalul de ieșire utilizând opțiunea [Technical] > [Tally] > [Tally Control] din meniul web sau
meniul camerei.
[Internal]: starea operației de înregistrare cu unitatea
[External]: operator logic AND al indicatoarelor de semnalizare roșii/verzi primite de unitate prin
semnalele IN și prin telecomenzi.

[271] Anexă

Măsuri de precauție la utilizare

Condens
Dacă unitatea este dusă brusc de la frig într-un loc călduros, sau dacă temperatura ambiantă
crește brusc, se poate forma umezeală pe suprafața exterioară a unității și/sau în interiorul
unității. Acest fenomen este cunoscut sub numele de condens. Dacă apare condensul, opriți
unitatea și așteptați până când condensul dispare, înainte de a opera unitatea. Operarea unității
în prezența condensului poate deteriora unitatea.

Fenomenele senzorului de imagine CMOS ale camerei

Notă
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Următoarele fenomene care pot apărea în imagini sunt specifice senzorilor de imagine. Acestea nu
indică o defecțiune.

Pete albe
Deși senzorii de imagine sunt produși cu tehnologii de înaltă precizie, pe ecran pot fi generate
pete albe fine, în cazuri rare, cauzate de raze cosmice etc.
Acest lucru este legat de principiul senzorilor de imagine și nu reprezintă o defecțiune.
Petele albe, în mod special, apar cu preponderență în următoarele cazuri:

În timpul operării într-o temperatură ridicată a mediului
Atunci când măriți amplificarea (sensibilitatea)

Flicker
Dacă faceți capturi în condiții de iluminat produse de lumini fluorescente, lămpi cu sodiu, lămpi
cu vapori de mercur sau LED-uri, ecranul poate pâlpâi sau culorile pot varia.

Unitățile cu obiectiv și unitate de panoramare/înclinare
Dacă obiectivul și mecanismul unității de panoramare/înclinare nu sunt utilizate o perioadă
lungă de timp, vâscozitatea vaselinei aplicate în interior poate să crească, împiedicând
mișcarea mecanismului. Acționați obiectivul și mecanismul de panoramare/înclinare periodic.

Despre piesele consumabile
Ventilatorul și bateria reîncărcabilă încorporată sunt piese consumabile, care trebuie
înlocuite periodic.
În timpul operării la temperatura camerei, un ciclu normal de înlocuire va fi de aproximativ 5
ani. Cu toate acestea, acest ciclu de înlocuire reprezintă doar o orientare generală și nu
implică faptul că speranța de viață a acestor părți este garantată.
Pentru detalii despre înlocuirea pieselor, contactați distribuitorul.

Speranța de viață a adaptorului de curent alternativ și a condensatorului electrolitic este de
aproximativ 5 ani la temperaturi normale de funcționare și utilizare normală (8 ore pe zi; 25
de zile pe lună). Dacă utilizarea depășește frecvența normală de utilizare, speranța de viață
poate fi redusă corespunzător.

Se recomandă inspecții periodice pentru ca unitatea să continue să funcționeze corect și pentru
prelungirea duratei de viață utile. Contactați o reprezentanță de service Sony pentru mai multe
informații despre inspecții.

Despre bateria reîncărcabilă încorporată
Unitatea are o baterie reîncărcabilă încorporată folosită pentru memorarea datei, a orei și a altor
setări, chiar și atunci când este oprită. Bateria reîncărcabilă încorporată se va încărca după ce
au trecut 24 de ore, dacă unitatea este conectată la o priză de alimentare cu ajutorul
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adaptorului c.a. sau dacă este alimentată prin PoE++, indiferent dacă unitatea este
pornită/oprită. Bateria reîncărcabilă se va descărca complet în aproximativ 2 luni dacă adaptorul
c.a. nu este conectat la o sursă de alimentare. Utilizați unitatea după încărcarea bateriei. Cu
toate acestea, chiar dacă bateria reîncărcabilă nu este încărcată, funcționarea unitatea nu va fi
afectată atât timp cât nu trebuie să înregistrați data.

Utilizare și locații de depozitare
A se depozita într-un loc ventilat, plan.
Evitați utilizarea sau depozitarea unității în următoarele locații.

Locații expuse la ploaie sau apă (inclusiv sub acoperișuri)
În aer liber și în locațiile un care se depășesc 40 °C (104 °F)
Nu uitați că vara, în zone cu o climă caldă, temperatura din interiorul unei mașini cu
geamurile închise poate depăși cu ușurință 50 °C (122 °F).
Locații cu temperaturi sub 0 °C (32 °F).
În locaţii umede sau cu praf. Locații în care unitatea poate fi expusă la ploaie
Locații supuse vibrațiilor sau șocurilor
Locații în care sunt generate radiații, raze X și câmpuri magnetice puternice.
Aproape de emițătoare radio sau TV, care produc câmpuri electromagnetice puternice.
În lumina directă a soarelui sau aproape de radiatoare pentru perioade îndelungate

Notă privind fasciculele laser
Fasciculele laser pot deteriora senzorul de imagine CMOS. Dacă filmați o scenă care include un
fascicul laser, aveți grijă să nu direcţionaţi fasciculul laser în obiectivul unității. În mod special,
fasciculele laser de mare putere de la dispozitivele medicale sau de la alte dispozitive pot
provoca pagube din cauza luminii reflectate și a luminii dispersate.

Pentru a preveni interferențele electromagnetice de la dispozitivele de
comunicații portabile
Utilizarea telefoanelor portabile și a altor dispozitive de comunicații în apropierea acestei unități
duce la defecțiuni și interferențe cu semnale audio și video. Se recomandă ca dispozitivele de
comunicații portabile din apropierea acestei unități să fie oprite.

Nu aşezaţi acest produs în apropierea dispozitivelor medicale
Acest produs (inclusiv accesoriile) conţine magneţi care pot interfera cu stimulatoarele cardiace,
valvele cu şunturi programabile pentru tratamentul hidrocefaliei sau cu alte dispozitive medicale.
Nu aşezaţi acest produs aproape de persoanele care folosesc astfel de dispozitive medicale.
Consultaţi-vă cu doctorul înainte de a utiliza acest produs, în cazul în care folosiţi un dispozitiv
medical de acest fel.

Precauții de securitate
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SONY NU VA FI RĂSPUNZĂTOARE PENTRU NICIUN FEL DE DAUNE GENERATE DE
NEIMPLEMENTAREA MĂSURILOR DE SECURITATE ADECVATE PRIVIND
DISPOZITIVELE DE TRANSMISIE, PENTRU SCURGERILE DE DATE INEVITABILE CARE
REZULTĂ DIN SPECIFICAŢIILE DE TRANSMISIE SAU PENTRU PROBLEMELE DE
SECURITATE DE NICIUN FEL.
În funcţie de mediul de operare, părţile terţe neautorizate din reţea pot avea acces la
unitatea dvs. Atunci când conectaţi unitatea la reţea, asiguraţi-vă că reţeaua este protejată
şi securizată.
Conținutul comunicării poate fi interceptat, în mod accidental, de terți neautorizați aflați în
vecinătatea semnalelor. La utilizarea comunicațiilor LAN wireless, implementați măsuri de
securitate pentru a proteja în mod corespunzător conținutul comunicării.
Când conectaţi acest produs la o reţea, conectaţi-vă printr-un sistem care oferă o funcţie de
protecţie, cum ar fi un router sau un firewall. Dacă produsul este conectat printr-un sistem
care nu oferă o astfel de protecţie, pot apărea probleme de securitate.

Alimentare
Unitatea nu este echipată cu un comutator de alimentare. Pentru a opri unitatea, verificați
dacă au fost finalizate toate operațiile și dacă unitatea este în starea de standby, apoi
deconectați adaptorul c.a. Când utilizați alimentarea prin PoE++, deconectați cablul LAN.
Când este posibil, utilizați o sursă de alimentare dintr-un loc în care este ușor de introdus și
scos ștecherul.
Dacă utilizați o priză dintr-un loc în care există praf, curățați zona din jurul prizei periodic
pentru a preveni conturnarea.

Măsuri de precauție pentru piesele mobile
Asigurați-vă că în piesele mobile nu pătrund particule străine.
Nu aplicați o sarcină excesivă când transportați piesele în mână. Acest lucru poate provoca
o defecţiune.
Nu perturbați funcționarea pieselor mobile în timp ce se mișcă. Acest lucru poate provoca
leziuni sau defecțiuni.
Dacă unitatea nu este utilizată o perioadă îndelungată de timp, piesele mobile pot să nu mai
funcționeze normal. Acționați periodic funcțiile de panoramare/înclinare ale unității.

Măsuri de precauție pentru funcția de înregistrare
Faceţi întotdeauna o înregistrare de test şi verificaţi dacă înregistrarea a fost reuşită. SONY
NU VA FI RESPONSABILĂ PENTRU NICIUN FEL DE DAUNE, INCLUSIV, DAR FĂRĂ A SE
LIMITA LA COMPENSAREA SAU RAMBURSAREA ÎN CAZUL DEFECTĂRII ACESTEI
UNITĂŢI SAU A SUPORTURILOR DE ÎNREGISTRARE SAU A ORICĂROR ALTOR MEDII
SAU SISTEME DE STOCARE PENTRU ÎNREGISTRAREA ORICĂRUI TIP DE CONŢINUT.
Verificaţi întotdeauna dacă unitatea funcţionează corect înainte de utilizare. SONY NU VA FI
RĂSPUNZĂTOARE PENTRU NICIUN FEL DE DAUNE CARE INCLUD, DAR NU SE
LIMITEAZĂ LA COMPENSAREA SAU RAMBURSAREA ÎN CONTUL PIERDERII
PROFITURILOR PREZENTE SAU POTENŢIALE CAUZATE DE DEFECŢIUNEA ACESTEI
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UNITĂŢI, FIE ÎN TIMPUL PERIOADEI DE GARANŢIE, FIE DUPĂ EXPIRAREA
GARANŢIEI, SAU DIN NICIUN ALT MOTIV.
SONY NU VA FI RĂSPUNZĂTOARE PENTRU PRETENŢIILE DE NICIUN FEL
TRANSMISE DE UTILIZATORII ACESTEI UNITĂŢI SAU DE TERŢI.
SONY NU VA FI RESPONSABILĂ PENTRU PIERDEREA SAU REPRODUCEREA
ORICĂROR DATE ÎNREGISTRATE ÎN SISTEMUL DE STOCARE INTERN, PE MEDII DE
ÎNREGISTRARE SAU PE ORICARE ALT MEDIU SAU SISTEM DE STOCARE.
SONY NU VA FI RĂSPUNZĂTOARE PENTRU ÎNCHEIEREA SAU ÎNTRERUPEREA
NICIUNUI SERVICIU ASOCIAT ACESTEI UNITĂŢI, CE POATE FI CAUZAT DE
CIRCUMSTANŢE DE ORICE FEL.

[272] Anexă

Formate de ieșire și limitări

Acest subiect descrie formatele de ieșire și limitările.

Notă

Rezoluția formatului de ieșire este limitată de setările [Project] > [Rec Format] > [Frequency],
[Codec] și [Video Format] din meniul web sau meniul camerei.

Rezoluția formatului de ieșire este limitată și de combinația cu rata de cadre pentru S&Q. Pe lângă
tabelul cu formate de ieșire ale conectorului SDI OUT/HDMI OUT, de mai jos, ieșirea HDMI se
schimbă la Full HD sau la altă valoarea mai redusă când sunt îndeplinite toate condițiile de mai jos.

Opțiunea [Shooting] > [S&Q Motion] > [Setting] este setată la [On]
Opțiunea [Shooting] > [S&Q Motion] > [Frame Rate] este setată la peste 60 cps

Când condițiile de mai sus sunt îndeplinite, ieșirea HDMI și opțiunile de selectare 4096×2160P și
3840×2160P pentru [Monitoring] > [Output Format] > [SDI/HDMI] sunt dezactivate și nu pot fi
selectate.

Imaginea nu este transmisă dacă a fost configurată o rezoluție mai înaltă decât rezoluția imaginii de
redare.

Formatele de ieșire ale conectorului SDI OUT/HDMI OUT

Când frecvența sistemului este de 50/59,94 Hz



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 407/464

Setting Format de ieșire selectabil

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare

internă

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
(implicit)
1920×1080i

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
(implicit)
1920×1080i
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Setting Format de ieșire selectabil

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare

internă

SDI HDMI

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P
1920×1080i
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Setting Format de ieșire selectabil

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare

internă

SDI HDMI

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (nivel
A) (implicit)

1920×1080P
(implicit)
1920×1080i

1920×1080P (nivel
B)

1920×1080P
1920×1080i

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P
1920×1080i

1920×1080P (nivel
A) (implicit)

1920×1080P
(implicit)
1920×1080i

1920×1080P (nivel
B)

1920×1080P
1920×1080i

1920×1080i 1920×1080i

1920×1080

1920×1080P (nivel
A) (implicit)

1920×1080P
(implicit)
1920×1080i

1920×1080P (nivel
B)

1920×1080P
1920×1080i

1920×1080i 1920×1080i

(Transmisie oprită) 720×480P1)

720×576P2)
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Când frecvența sistemului este de 25/29,97 Hz

Setting Format de ieșire (rezoluție de ieșire)

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare internă

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160 RAW)

4096×2160P
3840×2160P
1920×1080P
1920×1080i
(implicit)

3840×2160
(RAW)

(3840×2160 RAW)

3840×2160P
1920×1080P
1920×1080i
(implicit)

XAVC-I
XAVC-L

4096×2160

4096×2160 (2SI)
4096×2160P
1920×1080P

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(implicit)

1920×1080i
(implicit)

3840×2160

3840×2160 (2SI)
3840×2160P
1920×1080P

1920×1080P 1920×1080P

1920×1080PsF
(implicit)

1920×1080i
(implicit)

1920×1080
1920×1080P
1920×1080PsF

1920×1080P
1920×1080i

Când frecvența sistemului este de 59,941)

Când frecvența sistemului este de 502)
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Când frecvența sistemului este de 23,98 Hz

Setting Format de ieșire (rezoluție de
ieșire)

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare internă

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160
RAW)

4096×2160P
3840×2160P
1920×1080P
(implicit)

3840×2160
(RAW)

(3840×2160
RAW)

3840×2160P
1920×1080P
(implicit)

XAVC-I
XAVC-L

4096×2160

4096×2160
(2SI)

4096×2160P
1920×1080P

3840×2160
(2SI)

3840×2160P
1920×1080P

1920×1080P
(implicit)

1920×1080P
(implicit)

3840×2160

3840×2160
(2SI)

3840×2160P
1920×1080P

1920×1080P
(implicit)

1920×1080P
(implicit)

1920×1080
1920×1080P
(implicit)

1920×1080P
(implicit)

Când frecvența sistemului este de 24 Hz
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Setting Format de ieșire (rezoluție de
ieșire)

Modul de
înregistrare/redare

Rezoluția de ieșire
RAW/

Rezoluție de
înregistrare internă

SDI HDMI

RAW
RAW & XAVC-I

4096×2160
(RAW)

(4096×2160
RAW)

4096×2160P
1920×1080P
(implicit)

XAVC-I 4096×2160

4096×2160
(2SI)
1920×1080P
(implicit)

4096×2160P
1920×1080P
(implicit)

[273] Anexă

Depanare

Alimentare
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Simptom Cauză Soluţie

Unitatea nu se
alimentează cu
energie.

Adaptorul c.a. nu este conectat
bine la conectorul DC IN.

Introduceți ferm cablul de
alimentare până la capătul
cursei.

Cablul de alimentare c.a. nu este
introdus ferm în adaptorul c.a. sau
în priza c.a.

Introduceți ferm cablul de
alimentare până la capătul
cursei.

Cablul LAN nu este conectat ferm
între dispozitivul de alimentare
prin PoE++ și unitate.

Verificați dacă ați introdus
cablul până când s-a blocat.

Cablul LAN este conectat la
conectorul OPTION, nu la
conectorul LAN.

Conectați cablul LAN corect la
conectorul LAN.

Unitatea este conectată la un
dispozitiv de alimentare care nu
acceptă PoE++ (conform
IEEE802.3bt, tip 4, clasa 8).

Conectați-o la un dispozitiv de
alimentare care acceptă
PoE++ (conform IEEE802.3bt,
tip 4, clasa 8).

Consumul total de energie
depășește valoarea nominală
maximă a dispozitivului de
alimentare prin PoE++.

Consultați instrucțiunile de
utilizare pentru dispozitivul de
alimentare PoE++.

Este conectat un cablu de rețea
dintr-o categorie care nu acceptă
alimentarea prin PoE++.

Utilizați un cablu de rețea din
categoria 5e sau alta mai
mare, conectat la conectorul
LAN.

Camera, dispozitivul de
alimentare prin PoE++ și
perifericele nu sunt conectate la
masă.

Conectați camera, dispozitivul
de alimentare prin PoE++ și
perifericele la masă.

Transmisia de imagini
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Simptom Cauză Soluţie

Nu se transmit
imagini.

Dispozitivele nu este conectate corect.
Conectați în mod
corect dispozitivele.

Configurarea inițială nu a fost finalizată.
Finalizați configurarea
inițială utilizând
aplicația web.

Nu se transmit
imagini prin
conectorul HDMI.

Este transmis un semnal care nu este
acceptat de dispozitivul destinație de
ieșire HDMI.

Schimbați setarea
formatului de ieșire
HDMI sau utilizați un
dispozitiv care
acceptă semnalul de
ieșire.

Este utilizat un cablu care nu acceptă
standardul HDMI de ieșire.

Utilizați un cablu care
acceptă standardul
HDMI de ieșire aflat
în uz.

Nu se transmit
imagini prin
conectorul SDI.

Este utilizat un cablu care nu acceptă
standardul SDI de ieșire.

Utilizați un cablu care
acceptă standardul
SDI de ieșire aflat în
uz.

Monitorul cuplat la conectorul SDI nu
acceptă semnalul de ieșire.

Utilizați un monitor
care acceptă
standardul SDI de
ieșire.

Formatul de înregistrare este setat
pentru ieșirea RAW.

Schimbați formatul de
înregistrare la o
setare diferită de
ieșirea RAW.

Ieșirea HDMI este setată la rezoluția SD.
Setați ieșirea HDMI la
o rezoluție diferită de
SD.

Nu se transmit
imagini prin fibra

Modulul utilizat nu respectă standardele
SFF sau SMPTE sau nu este conform cu
nivelul de putere I (1,0 W).

Consultați
„Transmiterea unui
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Simptom Cauză Soluţie

optică sau imaginile
sunt distorsionate.

semnal prin fibră
optică”.

Nu sunt transmise
imagini sau sunt
distorsionate la
utilizarea
sincronizării
externe.

Nu se recepționează un semnal de
sincronizare externă adecvat pentru
formatul semnalului video configurat.

Introduceți un semnal
de sincronizare
externă adecvat
pentru formatul
semnalului video
configurat.

Se aude zgomot în
semnalul audio.

Camera, dispozitivul de alimentare prin
PoE++ și perifericele nu sunt conectate
la masă.

Conectați camera,
dispozitivul de
alimentare prin
PoE++ și perifericele
la masă.

Unitatea este utilizată într-un mediu
ambiant în care există dispozitive care
generează câmpuri electrice și
magnetice puternice (cum ar fi antene de
transmițător TV/radio, transmițătoare
radio de amatori, motoare de aer
condiționat, transformatoare de
alimentare cu energie electrică).

Stați la distanță de
dispozitive care
generează câmpuri
electrice și magnetice
puternice.

Obiectivul, suportul acestuia și unitatea
de acționare intră în contact cu produsul
sau un obiectiv din mediul ambiant și
este emis un zgomot anormal.

Atașați obiectivul
corect.

Verificați dacă
există obstacole
lângă cameră.

Telecomandă

Telecomandă cu infraroşu
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Simptom Cauză Soluţie

Telecomanda cu
infraroșu nu
funcționează când îi
sunt apăsate
butoanele.

Funcționarea telecomenzii
este dezactivată.

Setați opțiunea [Technical] > [IR
Remote] > [Setting] la [On] în
meniul web.

Bateria s-a descărcat sau
polaritatea acesteia este
incorectă.

Acționați telecomanda cu
infraroșu lângă senzorul IR al
unității. Dacă LED-ul de
alimentare se aprinde
intermitent, înlocuiți bateria.

Configurarea inițială nu a
fost finalizată.

Finalizați configurarea inițială
utilizând aplicația web.

Viteza operației de
panoramare/înclinare
este redusă.

Viteza de panoramare/
înclinare comandată de
telecomanda cu infraroșu
este setată la modul
normal.

Setați comutatorul 4 SETUP la
poziția ON pe panoul din spate.

S-a încercat acționarea
altei camere în locul
celei dorite.

Semnalul infraroșu a fost
recepționat de o altă
cameră în locul celei dorite.

Setați opțiunea [Technical] > [IR
Remote] > [Setting] la [Off] din
meniul web al camerei pe care
nu doriți s-o controlați.

RM-IP500
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Simptom Cauză Soluţie

Camera nu poate fi
controlată cu telecomanda
RM-IP500.

Alimentarea camerei
nu este conectată.

Verificați dacă lampa POWER a
camerei se aprinde în verde sau
portocaliu.

Camera sau
telecomanda nu este
conectată la rețea.

Verificați conexiunile camerei și
telecomenzii.

Configurarea inițială
a camerei nu a fost
finalizată.

Finalizați configurarea inițială
utilizând aplicația web.

Comunicarea VISCA
prin IP nu este
activată.

Setați comutatorul 3 SETUP la
poziția ON pe panoul conectorilor
camerei și reinițializați unitatea.

Adresa IP a camerei
s-a schimbat.

Verificați adresa IP a camerei,
utilizând [Network] > [Wired LAN]
din meniul web sau meniul
camerei.

Adresa IP a camerei a fost
schimbată utilizând AUTO
IP SETUP de pe
telecomanda RM-IP500.

Au trecut cel puțin 20
de minute de la
pornirea camerei.

Reinițializați camera. Adresa IP
poate fi schimbată utilizând AUTO
IP SETUP în primele 20 de
minute după pornirea camerei.

Web App
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Simptom Cauză Soluţie

Nu este posibilă conectarea
printr-un browser.

Nu este conectat un
cablu LAN din
categoria 5e sau
alta superioară.

Conectați un cablu LAN din
categoria 5e sau alta superioară.
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Simptom Cauză Soluţie

Conexiunea la LAN
nu este corectă sau
rețeaua conectată
nu funcționează
normal.

Verificați dacă LED-ul LINK
pentru conectorul LAN este
aprins. Dacă LED-ul LINK nu este
aprins, contactați administratorul
de rețea.

Alimentarea camerei
nu este conectată.

Consultați secțiunea „Alimentarea
electrică” de mai sus.

Nu a fost
configurată o adresă
IP validă pentru
unitate.

Resetați rețeaua.

Adresa IP
configurată este
utilizată pe alt
dispozitiv.

Verificați dacă adresele IP ale
perifericelor sunt unice.

Masca de subrețea
configură nu
corespunde
subrețelei rețelei.

Resetați rețeaua.

Unitatea este
accesată prin
aceeași rețea locală
printr-un server
proxy.

Schimbați configurația, astfel
încât să nu fie utilizat un server
proxy.

Gateway-ul implicit
configurat pentru
unitate este
incorect.

Resetați rețeaua.

URL-ul introdus este
incorect.

Introduceți URL-ul corect și
încercați din nou.

Portul HTTP este
incorect.

Afișați meniul camerei pe un
monitor extern și verificați setarea
pentru [Network] > [Wired LAN] >
[HTTP Port]. Dacă este
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Simptom Cauză Soluţie

configurată o valoare diferită de
80, adăugați portul HTTP la
numele gazdei sau adresa IP
introdusă în browser.
Exemplu: dacă portul HTTP este
setat la 8080, introduceți
http://<IP Address>:8080

Numărul portului
HTTP al unității este
filtrat sau blocat.

Schimbați numărul portului HTTP
al unității la un port care nu este
filtrat sau blocat.

Memoria cache
veche a browserului
are un efect negativ.

Ștergeți memoria cache browser.

Nu este posibilă conectarea
la aplicația web, utilizând
codul 2D (codul QR).

Dispozitivul utilizat
nu acceptă mDNS.

Utilizați un dispozitiv care acceptă
mDNS.
Dacă utilizați un dispozitiv care nu
acceptă mDNS, introduceți
adresa IP direct în browser.

Tableta sau
computerul este
conectat la altă
rețea decât camera.

Conectați tableta sau computerul
la aceeași rețea ca și camera.

Nu este posibilă conectarea
la aplicația web introducând
URL-ul manual.

Dispozitivul utilizat
nu acceptă mDNS.

Utilizați un dispozitiv care acceptă
mDNS.

Tableta sau
computerul este
conectat la altă
rețea decât camera.

Conectați tableta sau computerul
la aceeași rețea ca și camera.
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Simptom Cauză Soluţie

Ecranul de autentificare
este afișat continuu.

Nu a fost introdus
numele de utilizator
corect sau parola
corectă.

Introduceți numele de utilizator și
parola înregistrate. Dacă ați uitat
informațiile utilizatorului
înregistrat, consultați
„Comutatoarele RESET” din „Bloc
de conectori” pentru a reseta
informațiile utilizatorului pentru
conexiunea la rețea.

Este posibil ca
numele de utilizator
și parola să fi fost
schimbate de un
utilizator conectat
prin alt browser.

Verificați care sunt numele de
utilizator și parola corecte cu
administratorul camerei.

Imaginea camerei nu este
afișată în aplicația web.

Ieșirea HDMI a
camerei este setată
la 720×480 sau
720×576.

Schimbați rezoluția de ieșire
HDMI a camerei.

Este conectat un
monitor HDMI care
nu acceptă semnalul
de ieșire HDMI al
camerei.

Eliminați monitorul HDMI sau
utilizați un monitor HDMI care
acceptă semnalul de ieșire HDMI.

Unitatea a
reinițializată și
sesiunea a fost
deconectată.

Așteptați aproximativ un minut și
reîncărcați browserul.

Memoria cache
veche a browserului
are un efect negativ.

Ștergeți memoria cache browser.

Rezoluția imaginii camerei
afișate în aplicația web este
redusă.

Rezoluția pentru
redarea video în
timp real 3 utilizată
de aplicația web
este setată redusă.

Măriți valoarea utilizând [Stream]
> [Video Stream] > [Size 3] din
meniul web.
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Simptom Cauză Soluţie

Meniul camerei nu apare
când apăsați butonul
[MENU].

Meniul camerei este
configurat astfel
încât să nu fie
înglobat în semnalul
de ieșire HDMI.

Setați opțiunea [Monitoring] >
[Output Display] > [HDMI/Stream]
la [On] în meniul web.

Valoarea unei setări de pe
ecranul cu setări nu este
actualizată/afișată corect.

Ecranul cu setări al
aplicației web nu
reflectă automat
setările schimbate în
altă aplicație web.

Apăsați butonul [Reload] din
partea de jos a ecranului cu setări
al aplicației web. Valorile setărilor
de pe ecranul de configurare
afișat sunt reîncărcate și
actualizate.

Setările fișierelor
temporare de
Internet au un
impact.

Ștergeți memoria cache browser.

Nu se poate descărca
fișierul sau jurnalul de
configurare.

Este dezactivată
funcția de
descărcare a
fișierelor din
browser.

Activați funcția de descărcare a
fișierelor din browser.

Ecranul cu setări al
aplicației web este accesibil,
dar nu poate efectua
operații pe ecran de operare
în timp real și ecranul de
control al redării.

Ecranul de operare
al aplicației web
este blocat.

Setați comutatorul de blocare a
operării din dreapta sus, în
aplicația web, la poziția 
(operare blocată).

Afișarea ecranului aplicației
durează mult.

Imaginea de redare
în timp real a unității
este vizualizată
simultan de mai
mulți utilizatori.

Reduceți numărul de utilizatori
care pot accesa simultan aplicația
web.

Shooting
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Cameră

Simptom Cauză Soluţie

Imaginea arată
distorsionată la începutul și
sfârșitul operației de
panoramare/înclinare.

Imaginea poate fi distorsionată
dacă funcția de stabilizare a
imaginii a obiectivului este
activată.

Dezactivați funcția de
stabilizare a imaginii a
obiectivului.

Unghiul de vizualizare s-a
schimbat fără intervenția
utilizatorului.

A apărut efectul de respirație a
obiectivului.

Consultați
„Compensarea
respirației”.

Nu se poate controla
focalizarea, zoomul sau
diafragma.

Setările comutatoarelor de pe
obiectiv pot fi incorecte.

Consultați „Verificarea
comutatoarelor
obiectivului”

Panoramarea/înclinarea

Simptom Cauză Soluţie

Nu se poate
reseta
panoramarea/
înclinarea.

Clapeta de blocare pentru
panoramare/înclinare este
în poziția LOCK.

Glisați clapeta de blocare pentru
panoramare/înclinare în poziția
UNLOCK.
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Simptom Cauză Soluţie

Camera nu se
oprește în poziția
preconizată.

Blocul camerei este
dezechilibrat.

Deplasați blocul camerei înainte/
înapoi, într-o poziție corespunzătoare,
după cum se descrie în „Atașarea
unui obiectiv” și apoi reporniți
unitatea.

Este atașat un obiectiv care
nu acceptă panoramarea/
înclinarea.

Consultați informațiile privind
compatibilitatea obiectivelor și atașați
un obiectiv care acceptă
panoramarea/înclinarea și apoi porniți
din nou unitatea.

Nu se poate executa
resetarea panoramării/
înclinării.

Executați o resetare a panoramării/
înclinării așa cum se descrie în
„Resetarea panoramării/înclinării”.

A fost aplicată o forță
neașteptată asupra capului
camerei, provocând o
eroare de control pentru
panoramare/înclinare.

Camera nu
revine în față
când este apăsat
butonul [Pan-Tilt
Home].

A fost activat modul de
montare pe tavan.

Setați opțiunea [Pan-Tilt] > [P/T
Direction] > [Ceiling] din meniul web
în funcție de instalația efectivă și apoi
reporniți unitatea. La montarea pe
tavan, blocul de conectori se va afla
în partea din față a camerei.

Operația de
panoramare/
înclinare este
restricționată.

Este configurată limita
intervalului de panoramare/
înclinare.

Ștergeți setările pentru limita
intervalului de panoramare/înclinare,
în funcție de caz, așa cum se descrie
în „P/T Range Limit.”

A fost aplicată o forță
neașteptată asupra capului
camerei, provocând o
eroare de panoramare/
înclinare.

Executați o resetare a panoramării/
înclinării așa cum se descrie în
„Resetarea panoramării/înclinării”.
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Simptom Cauză Soluţie

Panoramarea/
înclinarea s-a
deplasat în
direcția opusă.

Setarea modului de
montare pe tavan este
diferită de starea reală de
montare.

Setați opțiunea [Pan-Tilt] > [P/T
Direction] > [Ceiling] din meniul web
în funcție de instalația efectivă.

Setările pentru direcția de
panoramare/înclinare au
fost schimbate.

Verificați setările [Pan-Tilt] > [P/T
Direction] din meniul web.

Imaginea nu se
mișcă fluid la
începutul și
sfârșitul operației
de panoramare/
înclinare.

Setarea de
accelerare/decelerare a
operației de panoramare/
înclinare este prea ridicată.

Reduceți setarea de
accelerare/decelerare a operației de
panoramare/înclinare pentru ca
mișcarea de la începutul și sfârșitul
operației de panoramare/înclinare să
fie mai fluidă, utilizând [Pan-Tilt] >
[P/T Acceleration] > [Ramp Curve] din
meniul web sau meniul camerei.
Rețineți că acest lucru înseamnă că
obiectivul are nevoie de mai mult timp
pentru a ajunge la viteză maximă.

Operația de
panoramare/
înclinare s-a
oprit.

Blocul camerei este
dezechilibrat.

Deplasați blocul camerei înainte/
înapoi, într-o poziție corespunzătoare,
după cum se descrie în „Atașarea
unui obiectiv” și apoi reporniți
unitatea.

Setarea pentru curba
rampei
(accelerare/decelerare)
este prea mare pentru
obiectivul atașat.

Dacă este atașat un obiectiv mare,
reduceți valoarea pentru [Pan-Tilt] >
[P/T Acceleration] > [Ramp Curve] din
meniul web sau meniul camerei.

Este utilizat un obiectiv
mare.

Contactați reprezentantul de
asistență Sony.
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Simptom Cauză Soluţie

Unitatea este
blocată de un
obstacol când
este acționată
panoramarea/
înclinarea.

Maneta de fixare a
șurubului de atașare a
bazei suportului obiectivului
lovește camera.

Rotiți maneta de fixare a șurubului de
atașare a bazei suportului obiectivului
astfel încât să fie orientată în sus.

Maneta de fixare a
suportului obiectivului
lovește camera.

Rotiți maneta de fixare a suportului
obiectivului astfel încât să fie
orientată în sus.

Clapeta de blocare a
capului camerei lovește
camera.

Clapeta de blocare a capului camerei
trebuie să fie complet în poziția
LOCK.

Se aud zgomote
anormale în
timpul operației
de panoramare/
înclinare.

Camera este
dezechilibrată.

Deplasați capul camerei înainte/
înapoi într-o poziție adecvată, astfel
încât baza glisantă să fie orizontală.

Setarea pentru curba
rampei
(accelerare/decelerare)
este prea mare pentru
obiectivul atașat.

Dacă este atașat un obiectiv mare,
reduceți valoarea pentru [Pan-Tilt] >
[P/T Acceleration] > [Ramp Curve] din
meniul web sau meniul camerei.

Capul camerei nu este fixat
în poziție și se aude un
zgomot de mișcare în
timpul operării.

Setați clapeta de blocare a capului
camerei în poziția LOCK.

Nu se poate
salva sau încărca
o presetare.

Salvarea și încărcarea unei
presetări nu este
disponibilă când opțiunea
[Zoom Type] este setată la
[On(Clear Image Zoom)].

Setați opțiunea [Technical] > [Zoom] >
[Zoom Type] la [Optical Zoom Only]
din meniul camerei.
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Simptom Cauză Soluţie

Panoul de control
al încadrării din
aplicația web
este dezactivat și
nu poate fi
utilizat.

Operația de panoramare/
înclinare nu este disponibilă
în timpul afișării ecranului
cu miniaturi și al redării.

Opriți afișarea ecranului cu miniaturi
sau redarea.

Operația de panoramare/
înclinare nu este disponibilă
când imaginea camerei nu
poate fi afișată în aplicația
web.

Consultați „Aplicația web” din
„Depanare”.

Clapeta de blocare pentru
panoramare/înclinare este
în poziția LOCK.

Glisați clapeta de blocare pentru
panoramare/înclinare în poziția
UNLOCK.

Sub panoul de
control al
încadrării se
afișează
„Execute Pan-Tilt
Reset”, în
aplicația web.

A fost aplicată o forță
neașteptată asupra capului
camerei, provocând o
eroare de panoramare/
înclinare.

Executați o resetare a panoramării/
înclinării așa cum se descrie în
„Resetarea panoramării/înclinării”.

Înregistrare/redare
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Simptom Cauză Soluţie

Înregistrarea nu
începe atunci când
apăsaţi butonul de
PORNIRE/OPRIRE a
înregistrării.

Cardul de memorie este plin.
Înlocuiţi cardul de memorie cu
unul cu spaţiu suficient.

Cardul de memorie trebuie
restaurat.

Restaurați cardul de memorie
așa cum se descrie în
„Restaurarea cardurilor de
memorie”.

Unitatea funcționează
utilizând alimentarea prin
PoE++.

Alimentați conectorul DC IN
cu ajutorul adaptorului c.a.

Lampa de
înregistrare/semnalizare este
configurată ca lampă de
semnalizare, de aceea starea
înregistrării nu poate fi
determinată de lampă.

Configurați lampa de
înregistrare/semnalizare să
funcționeze ca lampă de
înregistrare, așa cum se
descrie în „Conectarea unui
indicator de semnalizare”.

Înregistrarea audio nu
este posibilă.

Nu este conectat niciun
microfon.

Conectați un microfon sau
dispozitiv audio la conectorul
AUDIO IN de pe blocul de
conectori.

Setarea [Master Input Level]
este la valoarea minimă.

Reglați [Master Input Level].

Sunetul înregistrat
este distorsionat.

Setarea nivelului de intrare
audio este prea ridicată.

Ajustați [CH1 Input Level] la
[CH4 Input Level] și [Master
Input Level].

Sunetul înregistrat are
un nivel ridicat de
zgomot.

Setarea nivelului de intrare
audio este prea redusă.

Ajustați setările [Audio Input
Level] și [Audio] > [Audio] >
[Audio Input] > [AUDIO IN
CH1 MIC Ref.] sau [AUDIO IN
CH2 MIC Ref.].
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Simptom Cauză Soluţie

Nu pot fi redate clipuri.

Clipul este în curs de editare.

Clipurile nu pot fi redate dacă
ați modificat denumirile de
fișiere sau folderele, sau dacă
un clip este folosit pe un
computer. Aceasta nu
reprezintă o defecţiune.

Clipul a fost înregistrat
utilizând altă cameră, nu
această unitate.

Este posibil ca unele clipuri
înregistrate altă cameră să nu
poată fi redate sau să fie
afișate în dimensiunea greșită.
Aceasta nu reprezintă o
defecţiune.

Transferul de fișiere

Simptom Cauză Soluţie

Încărcarea
fișierului
eșuează.

Este posibil ca numele de
utilizator și parola de pe
server să nu fie corecte.

Este posibil ca numele de utilizator și
parola de pe server să nu fie corecte.
Introduceți datele corecte.

Redarea în timp real IP
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Simptom Cauză Soluţie

Redarea în timp real
nu este disponibilă.

Numele de utilizator sau
parola introdusă în
aplicația client pentru
vizualizarea redării de la
unitate este incorect/ă.

Dacă formatul de redare în timp
real al unității este setat la [RTSP],
[SRT-Listener] sau [NDI|HX], este
necesar să introduceți numele de
utilizator și parola setată pentru
această unitate în aplicația client.
Introduceți numele de utilizator și
parola corecte.

Protocolul de redare în
timp real nu este
configurat când modul de
redare în timp real este
setat la [RTSP/SRT] sau
[Listener/NDI].

Setați protocolul țintă utilizând
[Stream] > [Stream Setting] din
meniul web.

Au fost setate șase sau
mai multe sesiuni RTSP.

Setați numărul de sesiuni la cinci
sau mai puține.

Numărul portului UDP nu
este setat corect.

Setați numărul portului și alte
setările pentru protocolul țintă,
utilizând [Stream] > [Stream] >
[Stream Setting] din meniul web.

Comunicarea UDP este
blocată.

Verificați setările de securitate ale
software-ului.

Sunetul nu este redat
în timp real.

Redarea în timp real a
ieșirii audio este setată la
[Off].

Setați opțiunea [Stream] > [Audio
Stream] > [Setting] la [On] în
meniul web.

Redarea în timp real a
fost deconectată.

Setarea protocolului sau
setările codecului de
redare în timp real au fost
schimbate în timpul
redării în timp real.

Configurați setarea protocolului și
setările codecului de redare în
timp înainte de a începe redarea
în timp real.

Dimensiunea imaginii
pentru [Video Stream
1] nu poate fi setată la
4096×2160 sau
3840×2160.

Dimensiunea imaginii
este 1920×1080 când
[Output Format] este
setată la HDMI.

Dimensiunea imaginii pentru
redarea în timp real nu poate fi
setată la o valoare mai mare decât
dimensiunea imaginii HDMI.
Modificați dimensiunea imaginii
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Simptom Cauză Soluţie

HDMI utilizând opțiunea
[Monitoring] > [Output Format] din
meniul web.

Rata de cadre pentru
[Video Stream 1] nu
poate fi setată la 60
cps sau 50 cps.

Rata de cadre pentru
redarea în timp real este
setată la 29,97 sau la o
valoare mai mică.

Rata de cadre utilizată pentru
redarea în timp real este limitată
de frecvența sistemului. Schimbați
frecvența sistemului utilizând
opțiunea [Rec Format] >
[Frequency] din meniul web.

Redarea în timp real
[Video Stream 3] nu
poate fi accesată.

[Video Stream 3] nu
acceptă RTSP/SRT/NDI.

Utilizați [Video Stream 1] sau
[Video Stream 2].

Ecranul RTSP/SRT nu
este actualizat/afișat
corect.

Numărul portului utilizat
pentru RTSP sau SRT
este filtrat sau blocat.

Schimbați numărul portului RTSP
sau SRT la un port care nu este
filtrat sau blocat de dispozitive
care recepționează redarea în
timp real. Sau schimbați numărul
portului utilizat pentru RTSP sau
SRT pe unitate.

Imaginea este
distorsionată sau
sacadată.

Informațiile video nu sunt
transmise corect din
cauza congestionării căii
de comunicare.

Reduceți rata de biți a redării în
timp real sau setați codecul [Video
Stream 2] ([Codec 2]) la [OFF]
pentru a crea o marjă în banda de
comunicare.

Ordinea pachetelor video
s-a schimbat în cadrul
canalului de comunicare.

Utilizați același furnizor de servicii
de internet atât pentru cameră, cât
și pentru receptor.

Nu se detectează
dispozitivul NDI.

Protocolul de redare în
timp real nu este setat la
NDI|HX.

Protocolul de redare în timp real
trebuie să fie setat la NDI|HX
pentru a detecta unitatea ca
dispozitiv NDI. Setați opțiunea
[Stream] > [Stream Setting] la
[NDI|HX] în meniul web.

Nu se poate utiliza ca
dispozitiv NDI.

Nu este instalată nicio
licență NDI|HX.

Instalați o licență NDI|HX. Puteți
verifica dacă există o licență
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Simptom Cauză Soluţie

NDI|HX utilizând opțiunea
[Stream] > [Stream] > [Stream
Setting] > [NDI|HX] > [License] din
meniul web.

Conexiunea cu dispozitive externe

Sincronizarea externă

Simptom Cauză Soluţie

Nu se poate
sincroniza cu o
sursă externă.

Nu se recepționează un semnal
de sincronizare externă
adecvat pentru formatul
semnalului video configurat.

Introduceți un semnal de
sincronizare externă adecvat
pentru formatul semnalului video
configurat.

Unitatea are două terminale.

Unitatea are o cutie terminală
încorporată de 75 Ω. Conectați
direct la o sursă de semnal (unu-la-
unu) sau utilizați un distribuitor
(divizor).

Tally
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Simptom Cauză Soluţie

Lampa de
semnalizare
nu se aprinde.

Luminozitatea lămpii de
semnalizare este setată la Off.

Setați luminozitatea adecvată
utilizând [Technical] > [Tally] > [Tally
Lamp Brightness] din meniul web.

Lampa de
înregistrare/semnalizare este
configurată ca lampă de
înregistrare.

Configurați lampa de
înregistrare/semnalizare să
funcționeze ca lampă de
semnalizare, așa cum se descrie în
„Conectarea unui indicator de
semnalizare”.

Dispozitivul RM-IP500 este
conectat și comunicarea
VISCA prin IP este
dezactivată.

Setați comutatorul 3 SETUP la
poziția ON pe blocul de conectori.

Conexiunea conectorului
OPTION este incorectă sau
pinul țintă nu este scurtcircuitat
la GND.

Scurtcircuitați pinul 7 sau pinul 8 al
conectorului OPTION la GND așa
cum se descrie în „Conectarea unui
indicator de semnalizare”.

[274] Anexa

Mesaje de eroare/avertizare

Dacă pe unitate apare un avertisment, o atenționare sau o condiție de operare care necesită
confirmare, este afișat un mesaj pe panoul cu imaginea camerei, iar lampa POWER și lampa
NETWORK de pe panoul frontal și lampa de înregistrare/semnalizare încep să lumineze
intermitent.

Notă

Indicația prin aprinderea intermitentă a lămpii de înregistrare/semnalizare este activată numai când
opțiunea [Technical] > [Tally] > [Tally Control] este setată la [Internal] și opțiunea [Tally Lamp
Brightness] este setată la [Off] în meniul web sau meniul camerei.
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Mesaje de eroare

Dacă lampa POWER și lampa NETWORK luminează intermitent așa cum se descrie mai jos,
luați următoarele măsuri.

Lampă
POWER

Lampă
NETWORK Cauză și soluție

Luminează
intermitent lent
portocaliu

Luminează
intermitent lent
verde

Unitatea nu poate să funcționeze normal. Pentru
detalii, consultați [Maintenance] > [System Log] din
meniul web. Dacă problema persistă chiar și după
trecerea unității în modul standby sau după oprire și
repornire, contactați reprezentantul de service Sony.

Luminează
intermitent
rapid
portocaliu

Luminează
intermitent
rapid verde

Unitatea are o defecțiune. Contactați reprezentantul
de service Sony.

Unitatea se oprește din funcționare atunci când apare următorul afișaj.

Mesaj
afișat

Lampă de
înregistrare/semnalizare Cauză și soluție

E + cod
de
eroare

Luminează intermitent
rapid

Indică o anomalie a unității. Înregistrarea se
oprește, chiar dacă se afișează ●REC pe
panoul cu imaginea camerei.
Opriți unitatea și verificați dacă există vreo
problemă la dispozitivele, cablurile sau
suporturile conectate. Dacă eroarea persistă
atunci când unitatea este repornită, contactați
reprezentanța de service Sony locală. Este
posibil să nu apară un afișaj de eroare sau un
sunet de avertizare, în funcție de starea unității.

Mesaje de avertizare
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Urmați instrucțiunile furnizate dacă apare următorul afișaj.

Mesaj afișat Lampă de
înregistrare/semnalizare Cauză și soluție

Temperature
High

Luminează intermitent
Temperatura internă este mare.
Opriți camera video și lăsați-o să se
răcească înainte de a o folosi din nou.

Media
Temperature
High

Luminează intermitent

Temperatura cardului CFexpress este
ridicată.
Înlocuiţi cardul sau lăsaţi-l să se
răcească înainte de a-l utiliza din nou.

Voltage Low Luminează intermitent
Tensiunea DC IN este scăzută (nivel
1). Verificați sursa de alimentare.

Insufficient
Voltage

Luminează intermitent rapid

Tensiunea DC IN este prea scăzută
(nivel 2). Înregistrarea este
dezactivată.
Conectați o altă sursă de alimentare.

Media Near Full Luminează intermitent
Capacitatea rămasă pe cardul de
memorie se reduce.
Înlocuiți cât mai curând.

Media Full Luminează intermitent rapid

Clipurile nu au putut fi înregistrate sau
copiate din cauză că nu a mai rămas
spaţiu pe cardul de memorie.
Înlocuiți imediat.

Clips Near Full Luminează intermitent

Numărul de clipuri suplimentare care
pot fi înregistrate pe un card de
memorie se reduce.
Înlocuiți cât mai curând.

Clips Full Luminează intermitent rapid

Numărul maxim de clipuri care pot fi
înregistrate pe cardul de memorie a
fost atins.
Înregistrarea sau copierea mai multor
clipuri nu este posibilă. Înlocuiți
imediat.
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Mesaj afișat Lampă de
înregistrare/semnalizare Cauză și soluție

Last Clip
Recording

Luminează intermitent

Clipul înregistrat în prezent este
ultimul clip care poate fi înregistrat,
deoarece a fost atins numărul maxim
de clipuri.
Pregătiţi un card de memorie nou.

Media(A) Life
Near End1) Luminează intermitent

Cardul de memorie se apropie de
sfârşitul duratei sale de viaţă. Înlocuiți
cât mai curând.

Media(A) Life
End1) Luminează intermitent rapid

Cardul de memorie a ajuns la sfârșitul
duratei sale de viață. Înlocuiți imediat.

Media(A) Near
Full1) Luminează intermitent La utilizarea funcției Simul Rec

Media(A) Full1) Luminează intermitent rapid La utilizarea funcției Simul Rec

Media(A) Clips
Near Full1) Luminează intermitent La utilizarea funcției Simul Rec

Media(A) Clips
Full1) Luminează intermitent rapid La utilizarea funcției Simul Rec

Media(A) Last
Clip Rec1) Luminează intermitent La utilizarea funcției Simul Rec

Mesaje de atenţionare şi de operare

Următoarele mesaje de atenționare și operare pot apărea în centrul ecranului. Urmați
instrucțiunile furnizate pentru a rezolva problema.

„(B)” se afișează pentru cardul din slotul B.1)
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Mesaj pe afișaj Cauză și soluție

Backup Battery End
Please Change

Capacitatea rămasă a bateriei de rezervă este
insuficientă.
Încărcaţi acumulatorul.

Unknown Media(A)1)

Please Change

A fost introdus un card de memorie care a fost
partiționat sau un care conține mai multe clipuri
decât pot fi gestionate de unitate.
Cardul nu poate fi utilizat în unitate și trebuie înlocuit.

Cannot Use Media(A)1)

Unsupported File System

A fost introdus un card care utilizează un sistem de
fișiere diferit sau un card neformatat.
Cardul nu poate fi utilizat în unitate și trebuie înlocuit
sau formatat utilizând unitatea.

Media Error
Media(A) Needs to be Restored1)

A apărut o eroare pe cardul de memorie și cardul
trebuie restaurat.
Restaurați cardul de memorie.

Media Error
Cannot Record to Media(A)1)

Cardul de memorie poate fi deteriorat și nu mai
poate fi folosit pentru înregistrare.
Redarea este posibilă, de aceea este recomandată
realizarea unei copii și înlocuirea cardului de
memorie.

Media Error
Cannot Use Media(A)1)

Cardul de memorie poate fi deteriorat și nu mai
poate fi folosit pentru înregistrare sau redare.
Cardul nu poate fi utilizat în unitate și trebuie înlocuit.

Media(A) Error1)

Recording Halted
Playback Halted

Înregistrarea și redarea au fost oprite, deoarece a
apărut o eroare la utilizarea cardului de memorie.
Dacă problema persistă, înlocuiți cardul de memorie.

Media Reached Rewriting Limit
Change Media(A)1)

Cardul de memorie a ajuns la sfârșitul duratei sale
de viață.
Faceți o copie de rezervă și înlocuiți cardul imediat.
Dacă veți continua să utilizați cardul, este posibil ca
acesta să nu mai poată înregistra sau reda conținut.
Pentru detalii, consultaţi instrucţiunile de utilizare
pentru cardul de memorie.
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Mesaj pe afișaj Cauză și soluție

Adresa specificată nu este validă.
Adresa specificată nu este validă.
Verificaţi dacă setarea este corectă.

Cannot Use Specified Port
Number

Numărul de port specificat este nevalid.
Verificaţi dacă setarea este corectă.

Lens I/F Error(xx:xx)

O eroare a obiectivului a fost detectată în
comunicarea I/F a obiectivului, la atașarea unui
obiectiv cu montură E.
Verificați starea conexiunii cu obiectivul cu montură
E.
Dacă problema persistă, contactați reprezentanța de
service Sony locală, prezentând codul de eroare
(cinci caractere între paranteze).

Cannot add auto upload job of
Proxy file because maximum
number of upload jobs was
reached.

Numărul maxim de activități de transfer a fost atins.
Ștergeți posibilele activități nedorite. De asemenea,
și setarea destinației de încărcare automată a
fișierelor proxy poate fi incorectă. Verificaţi dacă
setarea este corectă.

Fan Stopped

Ventilatorul s-a oprit.
verificați dacă există praf sau obiecte străine.
Dacă eroarea persistă și după îndepărtarea prafului
și a obiectelor străine, contactați reprezentanța de
service Sony locală.

[275] Anexă

Lista elementelor de meniu

Următoarele tabele prezintă elementele de meniu ale unității.

Legendă
„Meniul camerei” și „meniul web”

„(B)” se afișează pentru cardul din slotul B.1)
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●: Disponibil
▲: Unele elemente sunt disponibile
–: Indisponibil

„All File” și „Scene File”
Da: element salvat într-un fișier ALL sau Scene
Nu: element nesalvat

„All Reset (except for Network Settings)”
Când este executată opțiunea [Reset]> [Reset] > [All Reset (except for Network Settings)]
din meniul web:
Da: Element inițializat (exclude setările de rețea)
Nu: Nu este aplicabil

„Network Reset”
Când este executată opțiunea [Reset]> [Reset] > [Network Reset] din meniul web:
Da: Element inițializat (setare rețea)
Nu: Nu este aplicabil

„Factory Default”
Da: Element resetat la valoarea implicită din fabrică
Nu: Nu este aplicabil

Shooting

Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

ISO/Gain/EI ● – Da Da Da Da Da

ND Filter ● – Da Da*1 Da Nu Da

Shutter ● – Da Da Da Nu Da

Iris ● – Da Da Da Nu Da

Auto
Exposure

● – Da Da*2 Da Nu Da
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Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Alb ● – Da Da*3 Da Nu Da

White
Setting

● – Da Nu Da Nu Da

Offset White ● – Da Nu Da Nu Da

Focus ● ▲ Da Nu Da Nu Da

S&Q Motion ● – Da Nu Da Nu Da

LUT
activ./dezact.

● – Da Nu Da Nu Da

Noise
Suppression

● – Da Da Da Nu Da

Flicker
Reduce

● – Da Nu Da Nu Da

SteadyShot ● – Da Nu Da Nu Da

Project

[Mode] nu se aplică*1

[Clip High light], [Detect Window], [Average Peak Level Ratio], [Custom Width], [Custom H Position], [Custom V
Position] nu se aplică

*2

[Preset White] nu se aplică*3
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Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Base
Setting

● ● Da Nu Da Nu Da

Rec
Format

● ● Da Nu Da*1 Nu Da

Cine EI
Setting

● – Da Nu Da Nu Da

Simul Rec ● ● Da Nu Da Nu Da

Proxy Rec ● ▲ Da Nu Da Nu Da

Interval
Rec

● ● Da*2 Nu Da Nu Da

Picture
Cache
Rec

● ● Da*2 Nu Da Nu Da

SDI/HDMI
Rec
Control

● – Da Nu Da Nu Da

Assignable
Button

● – Da Nu Da Nu Da

All File – ● Nu Nu Nu Nu Nu

Paint/Look

[Frequency] nu se aplică*1

[Setting] nu se aplică*2
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Scene
File

● – Nu Nu Nu Nu Nu

Base
Look

● ▲ Da*1 Nu Da*1 Nu Da*1

Reset
Paint
Settings

● – Nu Nu Nu Nu Nu

Negru ● – Da Da Da Nu Da

Knee ● – Da Da Da Nu Da

Detail ● – Da Nu Da Nu Da

Matrix ● – Da Da Da Nu Da

Multi
Matrix

● – Da*2 Da*2 Da Nu Da

Pan-Tilt

Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

P/T Speed – ● Nu Nu Da Nu Nu

Datele LUT importate ca aspect de bază nu se aplică*1

[Axis] nu se aplică*2
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Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

P/T
Acceleration

● ● Nu Nu Da Nu Nu

P/T Range
Limit

– ● Nu Nu Da Nu Nu

P/T
Direction

– ● Nu Nu Da Nu Nu

P/T Preset – ● Nu Nu Da Nu Nu

TC/Media

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Timecode ● – Da*1 Nu Da Nu Da

TC
Display

● – Da Nu Da Nu Da

Users Bit ● – Da*1 Nu Da Nu Da

HDMI TC
Out

● – Da Nu Da Nu Da

Clip
Name
Format

● – *2 Nu Da Nu Da
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Update
Media

● – Nu Nu Nu Nu Nu

Format
Media

● – Nu Nu Nu Nu Nu

Media
Life

● – Nu Nu Nu Nu Nu

Monitoring

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Output
Format

● ● Da Nu Da Nu Da

Output
Display

– ● Da Nu Da Nu Da

Display
On/Off

● – Da Nu Da Nu Da

Video
Signal
Monitor

● – Da Nu Da Nu Da

[Setting] nu se aplică*1

[Auto Naming] se aplică, [Camera ID] nu se aplică*2
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Marker ● – Da Nu Da Nu Da

Audio

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Audio
Input

● ▲ Da Nu Da Nu Da

Audio
Output

● ▲ Da Nu Da Nu Da

Miniatură

Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Display Clip
Properties

● – Nu Nu Nu Nu Nu

Set Clip
Flag

● – Nu Nu Nu Nu Nu
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Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Lock/Unlock
Clip

● – Nu Nu Nu Nu Nu

Delete Clip ● – Nu Nu Nu Nu Nu

Transfer
Clip

● – Nu Nu Nu Nu Nu

Transfer
Clip (Proxy)

● – Nu Nu Nu Nu Nu

Filter Clips ● – Nu Nu Nu Nu Nu

Customize
View

● – Da Nu Da Nu Da

Technical

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Color
Bars

● – *1 Nu *1 Nu Da

Genlock ● – Nu Nu Nu Nu Nu

Tally ● ● Da Nu Da Nu Da

Rec
Review

● – Da Nu Da Nu Da
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Zoom ● – Da Nu Da Nu Da

IR
Remote

– ● Nu Nu Da Nu Da

Lens ● – Da Nu Da Nu Da

APR ● – Nu Nu Nu Nu Nu

Network

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Camera
Name

– ● Nu Nu Nu Nu Da

User – ● Nu Nu Nu Da Da

Wired
LAN*1 ▲ ● Nu Nu Nu Da Nu

File
Transfer

● ▲ Da Nu Da Da Da

FTP
Server 1

– ● Nu Nu Da Nu Da

[Type] se aplică, [Setting] nu se aplică*1
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

FTP
Server 2

– ● Nu Nu Da Nu Da

FTP
Server 3

– ● Nu Nu Da Nu Da

SSL – ● Nu Nu Nu Da Da

Referer
Check

– ● Nu Nu Nu Da Da

Brute
Force
Attack
Protection

– ● Nu Nu Nu Da Da

Stream

Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Stream
Setting

– ● Nu Nu Da*1 Nu Da*1

Video
Stream

– ● Da Nu Da Nu Da

Nu se poate configura utilizând meniul camerei (numai afișare)*1
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Element
(nivelul

2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Audio
Stream

– ● Da Nu Da Nu Da

Maintenance

Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

Language ● ● Da Nu Da Nu Da

Accessibility – ● Da Nu Nu Nu Da

Clock Set ● ● Da*1 Nu Da*2 Nu Da

Reset – ● Nu Nu Nu Nu Nu

Hours
Meter

● – Nu Nu Nu Nu Nu

Information – ● Nu Nu Nu Nu Nu

System Log – ● Nu Nu Nu Nu Da

HTTP
Access Log

– ● Nu Nu Nu Nu Da

Service – ● Nu Nu Nu Nu Nu

[NDI|HX] > [License] nu se aplică*1
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Element
(nivelul 2)

Meniul
camerei

Meniul
web

All
File

Scene
File

All Reset
(except

for
Network
Settings)

Network
Reset

Factory
Default

EULA – ● Nu Nu Nu Nu Nu

Software – ● Nu Nu Nu Nu Nu

[276] Anexă

Elementele salvate în pozițiile presetate

„Da” indică faptul că setarea este salvată pentru poziția presetată, iar „Nu” indică faptul că
setarea nu este salvată.

Elemente de panoramare/înclinare

Afișarea locației Element Salvare
țintă

Panoul de control al încadrării al ecranului de
operare în timp real

Poziția de panoramare/
înclinare

Da

[Pan-Tilt Speed] Nu1)

Informațiile despre dată și oră nu se aplică*1

[Time Zone], plus informațiile despre dată și oră nu se aplică*2
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Afișarea locației Element Salvare
țintă

[Pan-Tilt] în meniul web

[P/T Speed] Nu

[P/T Acceleration] Nu

[P/T Range Limit] Nu

[P/T Direction] Nu

[P/T Preset] Nu

Elemente de zoom

Afișarea locației Element Salvare
țintă

Panoul de control al încadrării al ecranului de
operare în timp real

Poziția de zoom
(distanța focală)

Da

[Zoom Speed] Nu1)

[Technical] > [Zoom] din meniul camerei [Zoom Type] Nu

Elemente de focalizare

Se poate configura separat pentru fiecare poziție presetată. Pentru detalii, consultați [Pan-Tilt] > [Preset] din
meniul web.

1)

Se mișcă la viteză maximă la restabilirea unei poziții presetate.1)
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Afișarea locației Element Salvare
țintă

Panoul cu imaginea camerei al
ecranului de operare în timp real

Urmărirea țintei specificate pentru
focalizarea automată cu urmărire în timp
real

Nu

Coordonate specificate pentru
focalizarea punctuală

Nu

Fila  (Focus) a ecranului de
operare în timp real

Comutatorul [Touch Focus] Nu

Comutatorul [Auto Focus] Da

Starea butonului [Focus Hold] Nu

Starea butonului [Push AF/MF] Nu

[Face/Eye Detection AF] Da

[AF Subj. Shift Sens.] Da

[AF Transition Speed] Da

Poziția de focalizare Da1)

[Shooting] > [Focus] din meniul
web

[Push AF Mode] (inclusiv setările care
utilizează butoanele alocabile)

Nu

[Touch Function in MF] Nu

[AF Assist Control] Nu

[Shooting] > [Focus] din meniul
camerei

Dimensiunea și poziția de focalizare
setate utilizând opțiunea [Focus Area]

Da

Poziția de focalizare setate utilizând
opțiunea [Focus Area (AF-S)]

Da

Nu se restaurează când comutatorul [Auto Focus] este în poziția On. Se restaurează când este setat la Off.1)
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[277] Anexă

Scheme sinoptice

Audio Input

Audio Output

[278] Anexă
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Actualizarea software-ului obiectivului cu montură E

Puteți actualiza software-ul unui obiectiv cu montură E cu ajutorul unității.
Consultați site-ul obiectivului pentru obiectivele pentru pot fi actualizate și software-ul
corespunzător.
Software-ul este actualizat utilizând meniul web.

Notă

Nu efectuați următoarele acțiuni până când actualizarea nu este finalizată.

Deconectarea de la rețea
Demontarea unui obiectiv
Oprirea alimentării

Dacă este afișat un mesaj care anunță că actualizarea a eșuat, citiți descrierea afișată și încercați
din nou să actualizați.

Atașați un obiectiv cu montură E la unitate.1

Consultați [Maintenance] > [Information] > [Lens] > [Model Name]
și [Version Number] în meniul web.
Numărul versiunii software a obiectivului cu montură E este afișat în lateral.
Verificați numărul versiunii de software și apoi actualizați software-ul după cum este
necesar.

2

Descărcați fișierul de actualizare a software-ului obiectivului
pentru Windows (extensia .exe) pe dispozitivul pe care rulează
aplicația web.

3

În [Maintenance] > [Information] > [Lens] > [Version Up], apăsați
butonul [Choose File] și selectați fișierul de actualizare descărcat.

4

Urmaţi instrucţiunile de pe ecran.5



1/3/23, 12:06 PM ILME-FR7 / ILME-FR7K | Ghid de asistență

file://corpnasunifil01.global.sdl.corp/Delivery (M-Z)/SON/SON_GHOAXU_110/220928_YAGI ILME-FR7_SG_HG - URGENT/03_Prod/03b_DTP/0… 455/464

[279] Anexă

Atașarea capacului butonului de eliberare a
obiectivului

Puteți să preveniți îndepărtarea neintenționată a obiectivului, atașând capacul butonului de
eliberare a obiectivului furnizat cu suportul pentru tavan CIB-PCM1 (opțiune) la butonul de
eliberare.

Atașați un obiectiv.
Pentru detalii despre atașarea unui obiectiv, consultați „Atașarea unui obiectiv”.

1

Glisați clapeta de blocare a panoramării/înclinării în poziția LOCK
pentru a bloca panoramarea/înclinarea capului camerei.

2

Deplasați camera înapoi în poziție, astfel încât să poată fi atașat
capacul de deblocare a obiectivului.

3

Atașați capacul de deblocare a obiectivului, astfel încât capacul să
acopere butonul de eliberare a obiectivului.

4

Securizați capacul de deblocare a obiectivului utilizând șurubul de
fixare a capacului de deblocare a obiectivului.

5
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Notă

Această măsură nu previne complet scoaterea obiectivului.

[280] Anexă

Licențe

Licența pentru portofoliul de brevete MPEG-4 AVC

ACEST PRODUS DEŢINE LICENŢĂ ÎN BAZA LICENŢEI PENTRU PORTOFOLIUL DE
BREVETE AVC ÎN SCOPUL UTILIZĂRII PERSONALE DE CĂTRE CONSUMATORI SAU ALTE
SCOPURI NEREMUNERATE ÎN LEGĂTURĂ CU
(i) CODIFICAREA VIDEO ÎN CONFORMITATE CU STANDARDUL AVC („AVC VIDEO”) ŞI/SAU
(ii) DECODIFICAREA DE MATERIALE VIDEO AVC ÎN URMA CODIFICĂRII DE CĂTRE UN
CONSUMATOR IMPLICAT ÎNTR-O ACTIVITATE PERSONALĂ ŞI/SAU OBŢINUTE DE LA UN
FURNIZOR DE MATERIALE SUB LICENŢĂ PENTRU FURNIZAREA DE MATERIALE VIDEO
AVC.
NU SE ACORDĂ NICIO LICENŢĂ ŞI NICI NU SE VA PRESUPUNE EXISTENŢA VREUNEI
LICENŢE IMPLICITE PENTRU NICIO ALTĂ UTILIZARE. PENTRU INFORMAŢII
SUPLIMENTARE CONTACTAŢI MPEG LA, L.L.C. A SE VEDEA HTTP://WWW.MPEGLA.COM
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Obținerea software-ului în baza licenței GPL/LGPL

Acest produs utilizează software pentru care se aplică GPL/LGPL. Aceste licenţe vă informează
că aveţi dreptul de a accesa, modifica şi redistribui codul sursă al acestor programe software, în
conformitate cu condiţiile impuse de licenţele GPL/LGPL.
Codul sursă este furnizat pe internet. Folosiți următoarea adresă URL și urmați instrucțiunile de
descărcare.
https://oss.sony.net/Products/Linux/
Este de preferat să nu ne contactaţi în legătură cu conţinutul codului sursă.

Codul sursă μT-Kernel

Acest produs utilizează codul sursă al μT-Kernel în temeiul T-License 2.1 acordată de pe TRON
Forum (www.tron.org).

[281] Anexă

Specificații

Generalităţi

Greutate
Aprox. 4,6 kg (10 lb. 2,3 oz) (doar corpul)
Aprox. 6,0 kg (13 lb 3,6 oz) (inclusiv obiectivul SELP28135G)

Dimensiuni
Consultați „Dimensiuni externe”.

Cerinţe de alimentare
19,5 V c.c.
PoE++ (IEEE802.3bt tip 4, conform cu clasa 8)

Consum electric
19,5 V c.c.: 80,0 W (max.)

https://oss.sony.net/Products/Linux/
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PoE++: 71,3 W (max.)　

Temperatură de funcţionare
Între 0 °C şi 40 °C (între 32 °F şi 104 °F)

Temperatură de depozitare
Între −20 °C și +60 °C (între −4 °F și +140 °F)

Format de înregistrare (video)
XAVC Intra
Modul XAVC-I 4K/QFHD: VBR, rată de biți de 600 Mbps (max.), MPEG-4 AVC/H.264
Modul XAVC-I HD: CBG, rată de biți de 223 Mbps (max.), MPEG-4 AVC/H.264

XAVC Long
Modul XAVC-L QFHD: VBR, rată de biți de 150 Mbps (max.), MPEG-4 H.264/AVC
Modul XAVC-L HD 50: VBR, 50 Mbps (max.), MPEG-4 H.264/AVC
Modul XAVC-L HD 35: VBR, 35 Mbps (max.), MPEG-4 H.264/AVC

Format de înregistrare (audio)
LPCM 24 biţi, 48 kHz, 4 canale

Rată de cadre la înregistrare

XAVC Intra
Modul XAVC-I 4K: 4096×2160/59.94P, 50P, 29.97P, 25P, 24P, 23.98P
Modul XAVC-I QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modul XAVC-I HD: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

XAVC Long
Modul XAVC-L QFHD: 3840×2160/59.94P, 50P, 29.97P, 25P, 23.98P
Modul XAVC-L HD 50: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P
Modul XAVC-L HD 35: 1920×1080/59.94P, 50P, 29.97P, 25P, 23.98P

Durată de înregistrare/de redare
XAVC Intra
Modul XAVC-I QFHD: 59.94P, aprox. 30 de minute (utilizând CEA-G160T)
Modul XAVC-I HD: 59.94P, aprox. 78 de minute (utilizând CEA-G160T)

XAVC Long
Modul XAVC-L QFHD: 59.94P, aprox. 115 minute (utilizând CEA-G160T)
Modul XAVC-L HD 50: 59.94P, aprox. 155 minute (utilizând CEA-G80T)
Modul XAVC-L HD 35: 59.94P, aprox. 210 minute (utilizând CEA-G80T)
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Notă

Durată de înregistrare/de redare poate varia în funcţie de condiţiile de utilizare şi de caracteristicile
memoriei. Duratele de redare şi de înregistrare sunt valabile pentru o înregistrare fără pauze (un
singur clip). Duratele efective pot fi mai scurte, în funcţie de numărul de clipuri înregistrate.

Secțiunea unității de panoramare/înclinare

Viteză minimă de panoramare: 0,02 grade/sec.
Viteză minimă de înclinare: 0,02 grade/sec.
Viteză maximă de panoramare: 60 grade/sec.
Viteză maximă de înclinare: 60 grade/sec.
Interval de panoramare: între −170 de grade și +170 de grade
Interval de înclinare: între −30 de grade și +195 de grade
Clasificare pe baza zgomotelor: NC35 sau o clasă inferioară
Poziții presetate: 100

Secțiunea camerei

Dispozitiv de imagistică
Senzor R CMOS Exmor R Full Frame (35,6 × 23,8 mm) de 35 mm

Număr de pixeli
Aprox. 12,9 megapixeli (total pixeli)
Aprox. 10,3 megapixeli (pixeli efectivi)

Focalizare automată
Metodă de detecție: detecția fazei/detecția contrastului

Filtre ND interne
CLEAR: OFF
1: 1/4ND
2: 1/16ND
3: 1/64ND
Filtru ND variabil liniar: de la 1/4 ND la 1/128 ND

Sensibilitate ISO
ISO 800/12800 (modul Cine EI, sursă de lumină D55)
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Montură obiectiv
Montură tip E

Latitudine
Peste 15 opriri

Timp de expunere
Între 64F și 1/8.000 sec. (23.98P)

Unghi obturator
între 5,6 și 360°, între 2 și 64 de cadre

Mişcare cu încetinitorul şi rapidă
XAVC QFHD: între 1 cps și 120 cps
XAVC HD: între 1 cps și 240 cps
XAVC 4K: între 1 cps și 60 cps
XAVC HD (S35): între 1 cps și 120 cps

Echilibru de alb
2000 K - 15000 K

Amplificare
Între –3 dB și +30 dB (incremente de 1 dB)

Aspect de bază
S-Cinetone, Standard, Still, ITU709, s709, 709(800%), S-Log3, HLG Live, HLG Natural

Secțiunea audio

Frecvenţă de eşantionare
48 kHz

Cuantizare
24 biţi

Răspuns în frecvenţă
Modul MIC cu intrare XLR: între 20 Hz și 20 kHz (±3 dB sau mai puțin)
Modul LINE cu intrare XLR: între 20 Hz și 20 kHz (±3 dB sau mai puțin)
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Interval dinamic
Modul MIC cu intrare XLR: 80 dB (tipic)
Modul LINE cu intrare XLR: 90 dB (tipic)

Distorsiune
Modul MIC cu intrare XLR: 0,08% sau mai puțin (-40 dBu nivel de intrare)
Modul LINE cu intrare XLR: 0,08% sau mai puțin (+14 dBu nivel de intrare)

Secțiunea Intrare/ieșire

Intrări
DC IN

Conform cu EIAJ, 19,5 V c.c.

AUDIO IN

Tip XLR, 5 pini, mamă
LINE / MIC / MIC+48V comutabil
MIC: Referință între –30 dBu și –80 dBu

GENLOCK IN

Conector BNC, 1,0 Vp-p, 75 Ω

TC IN

Conector BNC

Ieşiri
SDI OUT

Conector BNC, 12G-SDI, 6G-SDI, 3G-SDI (nivel A/B), HD-SDI

HDMI

Conector tip A

Conectorul de ieșire OPTICAL

Conform cu SFP+
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* Unitatea nu acceptă intrarea de semnal optic.

Intrare/ieşire
Conector LAN

RJ-45, 1000BASE-T

Conector OPTION

Conectorul de intrare/ieșire pentru semnalizare RJ-45

Secțiunea sloturilor pentru suporturi media

Slot pentru card CFexpress Type A/SD (2)

Accesorii furnizate

Adaptor c.a. (1)
Cablu de alimentare (1)
Telecomandă cu infraroșu (1)
Capac pentru corpul camerei (1) (atașat la unitate)
Placă de reținere a cablului HDMI (1)
Înainte de utilizarea acestei unităţi (1)
Broşură de garanţie (1)

Dimensiunile externe

Dimensiunile sunt valori aproximative.
Unitate: mm (ţoli)
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Designul şi specificaţiile se pot modifica fără notificare prealabilă.

[282] Anexă

Mărci comerciale

 este marcă comercială a Sony Group Corporation.
XAVC și  sunt mărci comerciale înregistrate ale Sony Group Corporation.
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Termenii HDMI, HDMI High-Definition Multimedia Interface şi sigla HDMI sunt mărci
comerciale sau mărci comerciale înregistrate ale HDMI Licensing Administrator, Inc. în
Statele Unite şi în alte ţări.
Microsoft şi Windows sunt mărci comerciale sau mărci comerciale înregistrate ale Microsoft
Corporation în Statele Unite şi/sau în alte ţări.
Mac și macOS sunt mărci comerciale înregistrate ale Apple Inc. în S.U.A. şi alte ţări.
Sigla „Catalyst Browse” este o marcă comercială sau o marcă comercială înregistrată a
Sony Group Corporation.
iOS este o marcă comercială sau o marcă comercială înregistrată a Cisco în S.U.A. și alte
țări și este utilizată sub licență.
iPadOS, Safari și iPad sunt mărci comerciale ale Apple Inc. înregistrate în S.U.A. și alte țări
și regiuni.
Android și Google Chrome sunt mărci comerciale sau mărci comerciale înregistrate ale
Google LLC.
Wi-Fi este o marcă comercială înregistrată a Wi-Fi Alliance.
Sigla SDXC este marcă comercială a SD-3C, LLC.
CFexpress şi sigla CFexpress Type A sunt mărci comerciale ale CompactFlash Association.
NewTek™ și NDI® sunt mărci înregistrate sau mărci comerciale înregistrate ale NewTek,
Inc.
JavaScript este o marcă comercială înregistrată a Oracle și/sau a afiliaților săi.
Intel, sigla Intel și Intel Core sunt mărci comerciale ale Intel Corporation sau filialelor sale.
Codul QR este marcă comercială înregistrată a Denso Wave Inc.
Toate celelalte denumiri de companii și nume de produse sunt mărci comerciale înregistrate
sau mărci comerciale ale deținătorilor de drept ai acestora. Elementele cu marcă comercială
nu sunt indicate prin simbolurile ™ sau ® în acest document.


